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FOREWORD

The Government of India has set an ambitious target of imparting skills to 30 crore people, one out of every

four Indians, to help them secure jobs as part of the National Skills Development Policy. Industrial Training

Institutes (ITIs) play a vital role in this process especially in terms of providing skilled manpower.  Keeping

this in mind, and for providing the current industry relevant skill training to Trainees, ITI syllabus has been

recently updated with the help of Mentor Councils comprising various stakeholders, viz., Industries,

Entrepreneurs, Academicians and representatives from ITIs.

The National Instructional Media Institute (NIMI), Chennai, has now come up with instructional material to

suit the revised curriculum for Stenographer Secretarial Assistant (English) - Trade Theory - NSQF

Level - 3 (Revised 2022) in Office Administration and Facility Management Sector. The NSQF Level

- 3 (Revised 2022) Trade Practical will help the trainees to get an international equivalency standard where

their skill, proficiency and competency will be duly recognized across the globe and this will also increase

the  scope of recognition of prior learning. NSQF Level - 3 (Revised 2022) trainees will also get the opportunities

to promote life-long learning and skill development. I have no doubt that with NSQF Level - 3 (Revised 2022)

the trainers and trainees of ITIs, and all stakeholders will derive maximum benefits from these Instructional

Media Packages (IMPs) and that NIMI's efforts will go a long way in improving the quality of Vocational

training in the country.

The Executive Director & Staff of NIMI and members of Media Development Committee deserve appreciation

for their contribution in bringing out this publication.

Jai Hind

Directorate General of Training
Ministry of Skill Development & Entrepreneurship,

Government of India.

         New Delhi - 110 001
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PREFACE

The National Instructional Media Institute (NIMI) was established in 1986 at Chennai by the then Directorate

General of Employment and Training (D.G.E & T), Ministry of Labour and Employment, (now under Directorate

General of Training, Ministry of Skill Development and Entrepreneurship) Government of India, with technical

assistance from the Govt. of the Federal Republic of Germany. The prime objective of this institute is to

develop and provide instructional materials for various trades as per the prescribed syllabi (NSQF Level 3)

under the Craftsmen and Apprenticeship Training Schemes.

The instructional materials are created keeping in mind, the main objective of Vocational Training under

NCVT/NAC in India, which is to help an individual to master skills to do a job. The instructional materials are

generated in the form of Instructional Media Packages (IMPs). An IMP consists of Theory book, Practical

book, Test and Assignment book, Instructor Guide, Audio Visual Aid (Wall charts and Transparencies) and

other support materials.

The trade practical book consists of a series of exercises to be completed by the trainees in the workshop.

These exercises are designed to ensure that all the skills in the prescribed syllabus are covered. The trade

theory book provides related theoretical knowledge required to enable the trainee to do a job. The test and

assignments will enable the instructor to give assignments for the evaluation of the performance of a trainee.

The wall charts and transparencies are unique, as they not only help the instructor to effectively present a

topic but also help him to assess the trainee's understanding. The instructor guide enables the instructor to

plan his schedule of instruction, plan the raw material requirements, day to day lessons and demonstrations.

In order to perform the skills in a productive manner instructional videos are embedded in QR code of the

exercise in this instructional material so as to integrate the skill learning with the procedural practical steps

given in the exercise. The instructional videos will improve the quality of standard of practical training and

will motivate the trainees to focus and perform the skill seamlessly.

IMPs also deal with the complex skills required to be developed for effective team work. Necessary care

has also been taken to include important skill areas of allied trades as prescribed in the syllabus.

The availability of a complete Instructional Media Package in an institute helps both the trainer and

management to impart effective training.

The IMPs are the outcome of collective efforts of the staff members of NIMI and the members of the Media

Development Committees specially drawn from Public and Private sector industries, various training institutes

under the Directorate General of Training (DGT), Government and Private ITIs.

NIMI would like to take this opportunity to convey sincere thanks to the Directors of Employment & Training

of various State Governments, Training Departments of Industries both in the Public and Private sectors,

Officers of DGT and DGT field institutes, proof readers, individual media developers and coordinators, but for

whose active support NIMI would not have been able to bring out this material.

Chennai - 600 032      EXECUTIVE DIRECTOR
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INTRODUCTION

TRADE  PRACTICAL

The trade practical manual is intented to be used in workshop . It consists of a series of practical exercises

to be completed by the trainees during the one year course  of the  Stenographer Secretarial Assistant

(English) under Office Administration and Facility Management sector. Trade supplemented and

supported by instructions/ informations to assist in performing the exercises. These exercises are designed

to ensure that all the skills in compliance with NSQF LEVEL - 3 (Revised 2022) . The manual is divided into

Ten modules.

Module 1 Fundamentals of Shorthand and Windows operating system

Module 2 Formation of words, Phrases and Practice of MS-Word

Module 3 Speed Developing exercises and English Language skills

Module 4 Speed enhancing techniques

Module 5 Note taking and transcription techniques

Module 6 MS Excel - Importance of Office - Office Layouts - Registers - Dication Exercises

Module 7 MS Power Point - Office Secretary - Filing - Dictation Exercises

Module 8 Internet - Office tools &  Equipments - Networking - Dictation Exercises

Module 9 Postal services - E-mail - Excel Tabulation Work -Enhanching Dictation Speed

Module 10 Letter Format - Online Tasks and Creation of Performance Sheet

The skill training in the computer lab is planned through a series of practical exercises centred  around some

practical project. However, there are a few instances where the individual exercise does not form a part of

project.

While developing the practical manual a sincere effort was made to prepare each exercise which will be easy

to understand and can be carried out even by a below average trainee. However, the development team accepts

that there is scope for further improvement. NIMI looks forward  to the suggestions from the experienced training

faculty for improving the manual.

TRADE THEORY

The manual of trade theory consists of theoretical information of the Stenographer Secretarial Assistant

(English) Trade. The contents are sequenced according to the practical exercise contained in the NSQF LEVEL

- 3 (Revised 2022) syllabus on Trade practical. Attempt has been made to relate the theoretical aspects with

the skill covered in each exercise to the extent possible. This co-relation is maintained to help the trainees to

develop the perceptional capabilities for performing the skills.

The Trade Theory has to be taught and learnt along with the corresponding exercise contained in the manual

on trade practical. The instructions about the corresponding practical exercise are given in every sheet of this

manual.

It will be preferable to teach/learn the trade theory connected to each exercise atleast one class before

performing the related skills on the shop floor. The trade theory is to be treated as an integrated part of each

exercise.

The material is not for the purpose of self-learning and should be considered as supplementary to class room

instruction.
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LEARNING OUTCOME

On completion of this book you shall be able to

S.No Learning Outcome Ref. Ex No.

1 Acquire knowledge about the computer hardware & stenography
introduction. (Mapped NOS: MEP/N0201, MEP/N0216 1.1.01 & 1.1.02

2 Identify the various Consonants, vowels  and its application.
(NOS: MEP/N09401) 1.1.03  - 1.1.05

3 Construct the various words to maintain the position of long, short, dot,
dash, preceding, following & intervening  vowels.
(Mapped NOS:MEPN0201) 1.1.06 & 1.1.07

4 Recognize the various types of computer keys & Prepare a complete
sentence with use of logograms grammalogues, contractions, tick
‘The’& punctuation. Use Window operating system on computer.
(Mapped NOS: MEP/N0201, MEP/N0216) 1.1.08 -1.1.12

5 Identify the strokes R &H, Abbreviated W and explain the  sitting posture
on computer. (Mapped NOS:  MEP/N0201, MEP/N0216) 1.1.13 - 1.2.19

6 Identify small circle for S & Z, Large circle for SW/large loop& small loop/
understand MS-Word by using all tools.(Mapped NOS: MEP/N0201,
MEP/N0216) 1.2.20 - 1.2.26

7 Recognize the direction of SHR, SHL and alternative forms.
(Mapped NOS: MEP/N0201) 1.2.27 - 1.2.30

8 Use curved hook and compound  consonant.(Mapped NOS: MEP/N0201) 1.2.31 - 1.2.33

9 Recognize different types of hook. (Mapped NOS: MEP/N0201) 1.3.34 - 1.3.35

10 Develop new sentences applying halving / doubling principles.
(NOS: MEP/N9426 1.3.36 - 1.3.41

11 Apply the prefixes. (Mapped NOS: MEP/N0201) 1.4.42 & 1.4.43

12 Apply the suffixes. (Mapped NOS: MEP/N0201) 1.4.44 & 1.4.45

13 Identify the monetary units & use it.(NOS: MEP/N09402 1.4.46 & 1.4.47

14 Form words with advance phrases, intersections and write simple letter.
Mapped NOS: MEP/N0243) 1.4.48

15 Translate all types of sentences.(NOS: MEP/N09403) 1.4.49 & 1.5.50

16 Practice on MSˆExcel. (Mapped NOS: MEP/N0216) 1.6.51 - 1.6.53

17 Label the office layout.(NOS: MEP/N09404 1.6.54 - 1.6.56

18 Name the dispatch and diary register & detect computer virus.
(NOS: MEP/N09405) 1.6.57 - 1.6.60

19 Identify all types of file requirements & implement the same on MS-Power
point. (Mapped NOS: MEP/N0216) 1.7.61 - 1.7.64

20 Prepare  MSˆPowerPoint Presentation.(Mapped NOS: MEP/N0216) 1.7.65 & 1.7.66

21 Demonstrate features of MS power Point. (Mapped NOS: MEP/N0216) 1.7.67 - 1.7.69

22 Create Email Id. (Mapped NOS: MEP/N0216) 1.8.70 - 1.8.72

23 Identify all types of  official tools & equipments.
(Mapped NOS: MEP/N0216, MEP/N0241) 1.8.73 - 1.8.75

24 Observe all types of postal services.(NOS: MEP/N09406) 1.9.70 - 1.9.75

25 Prepare all types of letter. (Mapped NOS: MEP/N0241, MEP/N0243,
MEP/N1201, MEP/N0216) 1.10.80 - 1.10.83
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Duration Reference
Learning
Outcome

Professional Skills
(Trade Practical)

With Indicative Hours

Professional Knowledge
(Trade Theory)

SYLLABUS

Professional
Skill 21 Hrs;
Professional
Knowledge
06 Hrs

Computer:
1. Awareness of the computer hardware

and its peripherals in the lab to
accustom the trainees for use of
computer. (11 hrs)

2. Stenographer: Name the Consonants
according to their pairs and dictation
thereof. (10 hrs)

a) Introduction
b) Career opportunities in the Industry.
c) Different types of establishments.
d) An orientation programme on the

course and related job
opportunities by the industry
expert and instructor.

e) Organizational hierarchy
f) Attributes of a Stenographer &

Secretarial Assistant.
g) Duties and responsibilities of a

secretary / Stenographer.
h) Inter-departmental coordination.

(06 hrs)

Acquire knowledge
about the computer
hardware &
stenography
introduction.
(Mapped NOS:
MEP/N0201,
MEP/N0216

Professional
Skill 42 Hrs;
Professional
Knowledge
12 Hrs

Identify the various
Consonants, vowels
and its application.
(NOS: MEP/
N09401)

Develop:
3. Practice of Stroke Consonants and

their
joining. (08 hrs)

4. Practice of Joining stroke consonants.
(08 hrs)

5. Demonstrate:
a) Long and Short vowels, (09 hrs)
b) Dot & Dash Vowels, (09 hrs)

c) Preceding and Following vowels.
(04 hrs)

d) Intervening Vowels etc. (04 hrs)

a) Introduction to Shorthand,
     Consonants:

• Definition,
• Classification,
• Arrangements and directions,
• Table of consonants,
• Joining of Strokes

b) Vowels:
• Long & Short Vowel,
• Dot & Dash Vowel,
• Places of Vowel,
• preceding and Following vowel,
• Intervening vowel and positions.

c) Computer Fundamentals:
• Introduction,
• Definition,
• Utility and types of Computers.

d) Computer Hardware:
• Definition & Introduction,
• Motherboard & Processor,
• Input, Output & Storage devices.

e) Software:
• Definition & Introduction to

System Software,
Application Software. (12 hrs)

Professional
Skill 21
Hrs;
Professional
Knowledge
06 Hrs

Construct the
various words to
maintain the
position of long,
short, dot, dash,
p r e c e d i n g ,
following &
i n t e r v e n i n g
vowels.(Mapped
NOS:MEPN0201)

6. Dictation of the same as above. (11 hrs)
7. Point out: (10 hrs)
a) Logograms,
b) Grammalogues
c) Contractions,
d) Use of:
I. Tick ‘The’
II. Punctuation marks
III. Dictation Practice
e) Dipthong
f) Triphones

a) Short Forms:
• Logograms,
• Grammalogues,
• Contractions,
• Use of tick ‘The’ in

phrasing,
• Punctuation Marks.

b) Dipthongs &Triphones:
• Definition & types

a) Abbreviated ‘W’ (06 hrs)
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(xii)

Professional
Skill 21
Hrs;

Recognize the
various types of
computer keys &
Prepare a complete
sentence with use of
l o g o g r a m s
g r a m m a l o g u e s ,
contractions, tick
‘The’& punctuation.
Use Window
operating system on
computer.(Mapped
NOS: MEP/N0201,
MEP/N0216)

8. Keys Identification and practice of the
same. (6hrs)

9. Computer:
b) Familiarisation with keyboard keys
c) Express Practical use of Window

Operating System. (07 hrs)
10. Spelling practice using English

Dictionary (02 hrs)
11. Create a log-in account and

customise windows. (03 hrs)
12. Practice of typing in computer using

tool-bars and menu bars/ tools in
ribbons. (03 hrs)

Windows Operating System:
• Introduction,
• Log on accounts & Passwords,
• Windows Menu,
• Minimizing,
• Windows resizing & Moving,
• Closing Windows,
• Tool Bar,
• Task Bar
• Menu bar
• Start Button,
• Shutting down Windows.
• Desktop,
• Windows Explorer,
• Control Buttons,
• Open, Cut, Copy & Paste etc.

d) Computer Keyboard Functions and
its operations:
• Alphabetic keys
• Numeric keys
• Special keys
• Function keys (F1 to F12) (06

hrs)

Professional
Knowledge
06 Hrs

Professional
Skill 42
Hrs;
Professional
Knowledge
12 Hrs

Identify the strokes
R &H, Abbreviated
W and explain the
sitting posture on
c o m p u t e r .
(Mapped NOS:
MEP/N0201, MEP/
N0216)

13. Practice of Alternative signs of R & H.
(04 hrs)

14. Dictation Practice (04 hrs)
15. Practice (07 hrs)

i) Downward H,
ii) Tick H
iii) Dot H
iv) Upward SH
v) Dictation Practice

16. Practice of Phraseography  and
dictation (07 hrs)

17. Computer:
a) Explain the sitting posture on computer

b) Demonstrate Finger positioning on
the keyboard. (11 hrs)

18. Computer Typing:
a) Practice on Computer
b) Creation of MS- Word files on Computer

with the Use of various options of MS-
Word. (07 hrs)

19. Practice voice change (02 hrs)

Alternative forms of R &H Strokes,
b) Thick Downward R & H.
c) Alternative forms & their uses:

• Abbreviated W,
• Diphone

d) Computer keyboard Operations:
• Sitting posture,
• Sight & Touch Methods,
• Practicing Home Row,

UpperRow& Bottom Row Keys
• Shift Key Operation and

Number Row.
• Alternative form of Aspirate H,

Tick & Dot H,
• Downward H Stroke & Upward

H Stroke.
e) Phraseography- Formation
of Simple Phrases.
f) Computer:

• MS- Word
• Creation of File
• Use of its various option

g) Grammar-Voice
• Active and passive voice (12 hrs)

The Circle:

Professional
Skill 42
Hrs;
Professional
Knowledge
12 Hrs

Identify small circle
for S & Z, Large
circle for SW/large
loop& small loop/
understand MS-
Word by using all
t oo l s . (Mapped
NOS: MEP/N0201,
MEP/N0216)

20. Practice of Small Circle for S & Z. (05
hrs)

21. Use of circle S & Z with other stroke
Consonants and apply it to the new
sentences. (08 hrs)

22. Computer Speed Typing: Computer
typing practice with the minimum
errors by following the typing rules. (08
hrs)

• Small circle for S & Z,
• Circle and the strokes,
• Circle S with H stroke,
• Stroke L and circle S.

b) Computer Speed Typing:
• Speed Calculation,
• Signs & Symbols,
• Roman Numbers,
• Capitalizations of Letters,
• Display, Counting Errors
• Calculating speed and errors,
• Evaluation & Marking Scheme

C) Punctuation- full stop, comma,
semi colon, inverted commas,
hyphen. (06 hrs)
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(xiii)

23. Demonstrate:
a) Large Circle – SW, SS, SZ and their

medially and finally uses and dictation.
(02 hrs)

b) Small Loop for ST/SD. (03 hrs)
c) Large loop of STR and dictation. (04

hrs)
24. Computer: Practice in MSˆWord by

using various tools. (05 hrs)
25. Calculate Speed Typing on Computer.

(05 hrs)
26. Practice all punctuations. (02 hrs)

a) Large Circle:
• Large Initial Circle for SW,
• Use of large circle,
• Medially and finally,
• Circle and vowel places.

b) The loops:
• Small Loop of ST/SD,
• Large loop for STR

c) Computer:
• MS Word-
• Processing with MSˆWord,
• Use of Different Menus like

entering, Selecting, Deleting,
Copying, Cutting and Pasting.

• Finding and replacing Text,
• Use of Auto Correct,
• Formatting with word, •

Inserting Numbers,
Bullets

• Paragraphs formatting
d) Punctuation

• Sign of interrogation
• Sign of exclamation
• Dash
• Brackets
• Apostrophe
• Capitals (06 hrs)

Professional
Skill 21
Hrs;
Professional
Knowledge
06 Hrs

Recognize the
direction of SHR,
SHL
and alternative
forms.
(Mapped NOS:
MEP/N0201)

27. Practice of Initial small hooks for R &
L. (05 hrs)

28. Apply the above on different types of
sentences (08 hrs)

29. Computer: Prepare many sentences to
follow the rules on Computer for Speed
Typing. (07 hrs)

30. Spelling practice and common errors.
(01 hrs)

a) Initial small hooks (Double
Consonants):
• R & L Hooks,
• SHR & SHL hooked strokes,
• Vowels and double consonants

b) Computer:
• Setting indents and spacing,
• Use of help Options,
• Page Set up, Margins, Ruler,
• Paper Size in Word.
• Inserting Lines and Page Breaks
• Insertion and Use of Tables,
• Deletion of Rows and Columns,
• Alignments between Rows &

Columns
• Viewing Documents Properties

& Printing, and
• Other MS- Word Feature.

c) Alternative forms of curved hooked
strokes,

d) Left & Right Curves of f/ v/ th/ TH,
upward SH with hooked strokes,

e) intervening vowels, circles and
hooks

f) Compound Consonants:
• Initial large hooks of WH/

WHL/ KY/ GY/ KW/ GW/ MP/
MB strokes.

• Study of words commonly
misspelt. (06 hrs)

Professional
Skill 21 Hrs;
Professional
Knowledge
06 Hrs

Use curved hook
and compound
consonant.(Mapped
NOS: MEP/N0201)

31. Demonstrate:
a) Curved hooked strokes i.e. F/ V / ith/

TH.
b) Develop new sentences to follow the

above rules
c) Compound Consonants and develop WH/

WHL/ KY/ GY/ KW/ GW/ MP/ MB and
apply on different types of words. (07
hrs)

Study of conversational
English. (06 hrs)
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(xiv)

32. Computer typing of passages from
books, magazines, journal and
newspaper for enhancing the speed
and accuracy. (12 hrs)

33. Practice of conversational English (02
hrs)

Professional
Skill 21
Hrs;
Professional
Knowledge
06 Hrs

Recognize different
types of hook.
(Mapped NOS:
MEP/N0201)

34. Construct:
a) Final hook N and F/V and apply it on

various types of sentences (07hrs)
b) Shun Hook and joining with other

Strokes and apply it on the different
types of sentences. (07 hrs)

35. Computer: Evaluate on Computer for
Speed Typing  (07 hrs)

a) Final Hooks:
• N & F/V small hooks,
• Hooks and Vowels,
• Circles and Loops with finally

hooked strokes.
b) Large Final: • (Shun Hook) Use of

Shun after Circle,
• Use of shun hook after certain

strokes. (06 hrs)

Professional
Skill 84 Hrs;
Professional
Knowledge
24 Hrs

Develop new
sentences applying
halving / doubling
principles.(NOS:
MEP/N9426

36. Demonstrate Halving Principles on
different types of words & sentences.
(21hrs)

37. Halving of other compound consonants
and apply it on Computer for Speed
Typing. (20 hrs)

38. Practice pairs of word confused and
misused. (01 hrs)

a) Halving Principles:
• Halving of Strokes for T or D,
• Halving of M,N,L,R.
• Halving of MP/MB/NG/KR

hooked etc.
b) Pairs of word confused and

misused. (12 hrs)

39. Demonstrate Doubling Principles,
doubling of other compound consonant
and apply it on sentences. (17 hrs)

40. Construct the sentences apply on
halving and doubling principles& to
develop the speed to type on Computer.
(21 hrs)

41. Practice of one-word substitution. (04
hrs)

a) Doubling Principles:
• Doubling of Strokes for TR & DR,
• Doubling of MP/MB/NG and L

Strokes etc.
b) Single word substitution.(12 hrs)

Professional
Skill 21 Hrs;
Professional
Knowledge
06 Hrs

Apply the prefixes.
(Mapped NOS:
MEP/N0201)

42. Point out of Prefixes and their
representative strokes and apply on
sentences. (09hrs)

43. Apply on Computer for Speed Typing.
(12 hrs)

a) Prefixes:
• Definition and uses (06 hrs)

Apply the suffixes.
(Mapped NOS:
MEP/N0201)

Professional
Skill 42 Hrs;
Professional
Knowledge
12 Hrs

44. Point out of Suffixes and their
representative strokes and apply on.
(21 hrs)

45. Develop the word to maintain the above
rules & apply on Computer for Speed
Typing. (21 hrs)

Suffixes:
• Definition and uses (12 hrs)

Professional
Skill 21 Hrs;
Professional
Knowledge
06 Hrs

Identify the monetary
units & use it.(NOS:
MEP/N09402

46. Explain the figuresˆa) Monetary Units
& Round Figures and use it on
sentences. (04 hrs)

b) Contractions- formation and uses,
Essential Vowels and dictation (04 hrs)

47. Develop the sentences to follow above
rules writing in shorthand & apply on

Computer for Speed Typing. (13 hrs)

Figures-
• Monetary Units & Round

Figures
b) Contractions-

• Formation and uses, • Essential
Vowels. (06 hrs)

Professional
Skill 42
Hrs;
Professional
Knowledge
12 Hrs

Form words with
advance phrases,
intersections and
write simple letter.
Mapped NOS: MEP/
N0243)

48. Contract:
a) Practice of advance phraseography. (07

hrs)
b) Practice of intersections. (07 hrs) c)

Complete the Simple Letter writing
taking dictation in shorthand and
translate it on computer for speed
typing. (14 hrs)

a) Simple Letter Writing (12 hrs)
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(xv)

d) Complete simple letter with taking
dictation & translate on Computer for
Speed typing. (14hrs)

Professional
Skill 42
Hrs;
Professional
Knowledge
12 Hrs

Translate all types
of sentences.(NOS:
MEP/N09403

49. Prepare of Note Taking Techniques &
translate it. (22 hrs)

50. Translate matter typed on Computer for
Speed Typing. (20 hrs)

Translation & Note Taking
Techniques (12 Hrs)

Professional
Skill 42
Hrs;
Professional
Knowledge
12 Hrs

Practice on
MSˆExcel.
(Mapped NOS:
MEP/N0216)

51. Demonstrate:
a) Introduction to MSˆExcel (03 hrs)
b) Functions in MS-Excel (09 hrs)
52. Data Entry using MS – Excel (10 hrs)
53. Take down Dictation of the shorthand

from the books and transcribe on
computer. (20 hrs)

a) Office-
• Introduction,
• Importance of Office,
• Departments of Office.
• Functions, Duties and

characteristics of Office
Manager.

b) Introduction of MS- Excel:
• Opening a Worksheets;
• Entering text in worksheets.
• Editing Excel
• Selecting & editing cell

contents / worksheet
• Saving & Printing;

C) Motivation:
• Introduction
• Process (12 hrs)

Professional
Skill 42 Hrs;
Professional
Knowledge
12 Hrs

Label the office
layout.(NOS: MEP/
N09404

54. Sketch of various layouts of office with
space management. (08 hrs)

55. Formulas and Functions in MS- Excel.
(21 hrs)

56. Complete note down shorthand dictation
from the books and transcribe of the
same on computer. (13 hrs)

a) Office Layout, Types of Office
Layout, Open and Private Office.

b) MS Excel:
• Inserting / deleting, rows and

columns in a Worksheet
inserting / deleting data using
cut, copy and paste.

• Method: Using Formulas and
functions in MS-Excel

c) Office Environment: • Importance,
Elements like Light, Temperature,

Ventilation, Noise, Interior Decoration,
cleanliness and Safety. (12 hrs)

Professional
Skill 21 Hrs;
Professional
Knowledge
06 Hrs

Name the dispatch
and diary register
& detect computer
virus.(NOS:
MEP/N09405

57. Demonstrate of Dispatch and Diary
Register with the entry Procedure and

practical use (02 hrs)
58. Construct of Various Formulas, Charts

etc. in MS- Excel. (05 hrs)
59. Use of anti –virus (01 hrs)
60. Take dictation of the shorthand from the

books and transcribe of the same on
Computer (13 hrs)

a) Handling of Mails- Inward &
Outward Mails.

b) MS- Excel:
• Arithmetic, logical, Relative

and absolute cell referencing;
• Formatting options of cell in

worksheets,
• Align centre, left, right and

justify cell contents,
• Concept of charts. c) Office

Stationery, Office Forms and
Manuals. Types of Office
Stationery

d) Computer viruses:
e) Use of Anti-Virus,
f) Precautions & Scanning etc.
g) Motivation- Types of motivation

• Intrinsic motivation, ? Extrinsic
motivation (06 hrs)
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(xvi)

Professional
Skill 63
Hrs;
Professional
Knowledge
18 Hrs

Identify all types of
file requirements &
implement the same
on MS-Power point.
(Mapped NOS:
MEP/N0216)

61. Show various files and practical use
thereof. (08 hrs)

62. MS-power point – Prepare the PPT on
current topic (15 hrs)

63. Add Graphics and the practice of the
same on MS-power point (15 hrs)

64. Take Dictation of the shorthand from
the magazines and transcribe the same
on Computer (25 hrs)

a) Filing - Meaning of Records,
Compilation and Classification.

b) MS POWER-POINTˆIntroduction of
PPT, presenting documents in
Power point, add graphics to the
document, Create a selfˆrunning
presentation, (18 hrs)

Professional
Skill 21 Hrs;
Professional
Knowledge
06 Hrs

P r e p a r e
MSˆPowerPoint
Presentation.(Mapped
NOS: MEP/N0216)

65. MS-Power Point presentation
a) Use Themes and Designs of the Slides
in Power Point. (04hrs)
b) Apply Clipart and various objects into
PPT slides. (04 hrs)
66. Take Dictation of the shorthand from

the magazines and transcribe the same
on Computer (13 hrs)

a) Filing:
•Importance of Filing,
• Essentials of Good Filing Method.

Classification of files –
• Alphabetical,
• Numerical,
• Geographical and Subject wise.
• Centralization& Decentralization

of Filing.
• E-filing

b) MS- PowerPoint:
• Layouts, themes and designs,
• Adding clip arts, diagrams,

pictures, tables and charts. (06
hrs)

Professional
Skill 21 Hrs;
Professional
Knowledge
06 Hrs

Demonstrate
features of MS
power Point.
(Mapped NOS:
MEP/N0216)

67. MS- power Point Show
a) Editing slides (03 hrs)
b) Slide Animation, (02 hrs)
c) Transition etc. (02 hrs)
d) Publish in MS-power point Show. (02

hrs)
68. Prepare MS-power point presentation.

(04 hrs)
69. Take Dictation of the shorthand from

the magazines and transcribe the
same on Computer (08 hrs)

a) Office secretary
b) Definition, Qualities,
Qualification & Types of Secretary
c) MS- Power Point:

• Building animation
effects,

• Transitions,
• Speaker notes,
• Copying a presentation to

a CD/DVD/Pen drives,
• Editing and Printing

Presentations /slides
d) Material Management-

• Introduction (06 hrs)

Professional
Skill 21 Hrs;
Professional
Knowledge
06 Hrs

Create Email Id.
(Mapped NOS:
MEP/N0216)

70. Use Internet – Create EˆMail Account.
(04 hrs)

71. Send mails to multiple recipients. (05
hrs)

72. Apply all rules to take Dictation of the
shorthand from the Newspapers and
transcription of the same on Computer.
(12 hrs)

a) Professional, personal duties and
Functions of Office / private
Secretary.

b) INTERNET:
• Introduction to Internet

c) Material Management-
• Importance
• Function (06 hrs)

Professional
Skill 21
Hrs;
Professional
Knowledge
06 Hrs

Identify all types of
official tools &
e q u i p m e n t s .
(Mapped NOS:
MEP/N0216, MEP/
N0241)

73. Practical knowledge of various office
tools & equipment and their uses. (05
hrs)

74. Searching of Information on Various
search portals by using of Internet. (04
hrs)

75. Take down Dictation of the shorthand
from the Newspapers and transcription
of the same on Computer. (12 hrs)

a) Office Equipment:
• Principle for selection of Office

equipment.
• Types of Office equipment &

MailingˆRoom equipment.
• Photocopier and

Communicating  equipment.
b) Other Useful equipment:

• Xerox Machine,
• Intercom & EPABX
• Scanner
• Personal Computer
• Internet, FAX, Printer etc.

c) Networking: types of network
• LAN, MAN, WAN
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(xvii)

• Sending and receiving e-mail;
• Searching,browsing websites,

using search engines.
d) Office Security: Meaning &

concept (06 hrs)

Professional
Skill 42
Hrs;
Professional
Knowledge
12 Hrs

Observe all types of
postal services.(NOS:
MEP/N09406)

76. Visit to the various post offices. (08 hrs)
77. Take down Dictation of the shorthand

from the Newspapers and transcription
of the same on Computer. (24 hrs)

78. Apply MS-Excel to create tabulation
work (07 hrs)

79. Sending & receiving E-Mail. (03 hrs)

a) Postal Services
b) Post Office Services:

• Importance of Pin Code,
• Postcard, Registered

Letters,
•    Ordinary, Insured Letters,
• Parcels, Business Reply

Postcards, VPP, UPC,
Monetary Services etc.

c) Speed Post and Courier Services.
 Postal Services: Post Bag, Post box

etc.
d) Office Security:

• Importance
• Types of office security (12 hrs)

Professional
Skill 42
Hrs;
Professional
Knowledge
12 Hrs

Prepare all types of
letter.
(Mapped NOS:
MEP/N0241,
MEP/N0243,
MEP/N1201,
MEP/N0216)

80. Take down Dictation of the shorthand
from the Newspapers, books and
magazines and transcribe the same on
Computer (18 hrs)

81. Take down dictation in letter format &
transcribe it (06 hrs)

82. Prepare of various online forms by using
internet i.e. rail, bus, air tickets and
booking of hotels etc. (08 hrs)

83. Create Record/ performance Sheet
applying in MS-Excel Formula. (10 hrs)

a) Application Writing
b) Enquiry, quotation, order,

collection and Complaint
letters.

c) Social Letters like Informal
Letters/ Invitation Letters/
Congratulation Letters/ Thanks
Giving Letters/ Condolence
Letters etc. and letters to the
editors.

d) Office Correspondence:
Drafting of notice / agenda/
minutes and reports, circular
& memorandum.

e)General Banking
Correspondence

• Opening of savings / current /
Fixed deposit account

• Request for loan / overdraft. (12
hrs)
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1

Office Administration and Facility Management          R.Theory for Ex 1.1.01
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Introduction of trade - Job opportunities - types of establishment

Objectives: At the end of this lesson you shall be able to
• state the importance of this trade
• state the skills to be acquired
• list the job opportunities available
• state the establishments that require stenographers.

Importance of Trade: This course enables a learner to
perform the duties and responsibilities of a secretary to
an officer.  Apart from performing the secretarial tasks, it
develops understanding about the organisational struc-
ture and develops skill not only in taking notes in short-
hand, transcribing, typing on computer and taking print-
outs but also in handling the various office machines and
equipment.  This is in addition to performing the recep-
tionist duties.  Indeed a stenographer cum secretarial as-
sistant is a boon to any office without whom any office
can function effectively.

Skills imparted: An efficient stenographer can take notes
at a rate of 80-100 words per minute and can transcribe
flawlessly on computer at a speed of 40 wpm duly punc-
tuating the notes, capitalizing and displaying the matter.
As  good communication skills are required,  trainees are
imparted language skills as well-not only  in written lan-
guage but also in spoken language.

Job Opportunities

There are plenty of vacancies in private sector and Gov-
ernment as well.  The Government offers stenography  jobs
from entry-level  all the way to supervisory positions.  If a
shorthand writer with a skill of 80/100 wpm clears the Staff
Selection Commission examination conducted every year,
will  be selected in various Government  organizations,
such as  Government  departments, High Courts, Supreme
Court, District courts, and the like. After due training, one
can work as private secretary or personal assistant in
multinational companies, private offices, banks, institutes,
colleges, schools, law departments, social organizations,
etc.

Organisational Hierarchy: A Stenographer has ample
opportunities to climb up the ladder in any Organization.
From a Stenographer Grade D to Personal Assistant (PA)
to Private Secretary (PS) to Principal Private Secretary
(PPS) to even Senior Private Secretary …he/she has enor-
mous opportunities in the hierarchy of any organization.

Attributes of Stenographer & Secretarial Assistant - Duties and
Responsibilities

Objectives: At the end of this lesson you shall be able to
• state the qualities of an ideal stenographer
• explain the duties and responsibilities of a stenographer.

Qualities of a Good Stenographer

A good stenographer should be tolerant and not in a hurry
to leave the office at the stroke of the hour.  He/she should
be prepared to stay back and assist the boss in complet-
ing the tasks.  He/she should  possess balance of mind
and should not lose temper while dealing with the public.
Some of the qualities that will add value to a stenographer
cum secretarial assistant are:

a) Ability to deal effectively with officials and the public

b) Resourcefulness

c) Tact

d) Good judgment

e) Discretion

f) Good physique and a pleasing personality

g) Accuracy

Duties and responsibilities of a Stenographer

A good stenographer should have high speed and accu-
racy in Stenography. Yet another trait of a good stenogra-
pher is  proficiency in English as the whole art is based

on English. Stenographers without a good vocabulary, good
grammatically accurate writing power,  may have to face a
number of difficulties at the time of transcription. The du-
ties of a Stenographer also calls for independent corre-
spondence on behalf of his/her boss. Finally the impor-
tance of spoken English is an asset which cannot be over-
looked.  Other duties include:

a Receiving and handling complaints, enquiries, requests,
etc.

b Answering calls, taking messages and handling corre-
spondence

c Receiving callers, ascertaining their business and an-
swering their questions

d Using computer applications in performing work as-
signments

e Arranging appointments and meetings

f Producing agendas and taking minutes

g Maintaining  files
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Computer fundamentals- Introduction, Definition, Utility and types of
computers. Computer Hardware and Software

Objectives: At the end of this lesson you shall be able to
• understand fundamentally the general scope of the computer system
• distinguish between hardware and software
• describe the various  types of  computers
• explain how to connect accessories to  computer
• narrate how to shutdown the system safely.

Introduction

Today's world is an information-rich world and it has be-
come a necessity for everyone to know about computers.
A computer is an electronic data processing device, which
accepts and stores data input, processes the data input,
and generates the output in a required format. The pur-
pose of this lesson is to introduce you to Computers and
its fundamentals.

Functions of a Computer

If we look at it in a very broad sense, any digital computer
carries out the following  functions

• Takes data as input.

• Stores the data/instructions in its memory and uses
them as required.

• Processes the data and converts it into useful infor-
mation.

• Generates the output.

• Controls all the above four steps.

Advantages of Computers

Following are certain advantages of computers.

High Speed

• Computer is a very fast device.

• It is capable of performing calculation of very large
amount of data.

• The computer has units of speed in microsecond, nano-
second, and even the picoseconds.

• It can perform millions of calculations in a few seconds
as compared to man who will spend many months to
perform the same task.

Accuracy

• In addition to being very fast, computers are very accu-
rate.

• The calculations are 100% error free.

• Computers perform all jobs with 100% accuracy pro-
vided that the input is correct.

Storage Capability

• Memory is a very important characteristic of comput-
ers.

• A computer has much more storage capacity than
human beings.

• It can store large amount of data.

• It can store any type of data such as images, videos,
text, audio, etc.

Diligence

• Unlike human beings, a computer is free from mo-
notony, tiredness, and lack of concentration.

• It can work continuously without any error and bore-
dom.

• It can perform repeated tasks with the same speed
and accuracy.

Versatility

• A computer is a very versatile machine.

• A computer is very flexible in performing the jobs to be
done.

• This machine can be used to solve the problems re-
lated to various fields.

• At one instance, it may be solving a complex scientific
problem and the very next moment it may be playing a
card game.

Reliability

• A computer is a reliable machine.

• Modern electronic components have long lives.

• Computers are designed to make maintenance easy.

Automation

• Computer is an automatic machine.

• Automation is the ability to perform a given task auto-
matically. Once the computer receives a program i.e.,
the program is stored in the computer memory, then
the program and instruction can control the program
execution without human interaction.

• Reduction in Paper Work and Cost

• The use of computers for data processing in an organi-
zation leads to reduction in paper work and results in
speeding up the process.

• As data in electronic files can be retrieved as and when
required, the problem of maintenance of large number
of paper files gets reduced.

• Though the initial investment for installing a computer
is high, it substantially reduces the cost of each of its
transaction.

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.1.01
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3

What is Computer?

The term "computer" is derived from Latin word "computare"
which means to calculate.

Computer is a programmable electronic device that ac-
cepts raw data as input and processes it with set of in-
structions to produce result as output. It renders output
just after performing mathematical and logical operations.
The device also has memory that stores the data, pro-
grams and result of processing.

It is believed that Analytical Engine was the first com-
puter. It was invented by Charles Babbage in 1837. Charles
Babbage is also considered as the father of computer.

On the basis of data handling capabilities, the computer
is of three types:

• Analogue Computer

• Digital Computer

• Hybrid Computer

First Generation Computers

The first generation (1946-1959) computers were slow, huge
and expensive. In these computers, vacuum tubes were
used as the basic components of CPU and memory. These
computers were mainly depended on batch operating sys-
tem and punch cards. Magnetic tape and paper tape were
used as output and input devices in this generation;

Second Generation Computers

The second generation (1959-1965) was the era of the
transistor computers. These computers used transistors
which were cheap, compact and consuming less power;
it made transistor computers faster than the first genera-
tion computers.

Third Generation Computers

The third generation computers used integrated circuits
(ICs) instead of transistors. A single IC can pack huge
number of transistors which increased the power of a com-
puter and reduced the cost. The computers also became
more reliable, efficient and smaller in size.

Fourth Generation Computers

The fourth generation (1971-1980) computers used very
large scale integrated (VLSI) circuits; a chip containing
millions of transistors and other circuit elements. These
chips made this generation computers more compact,
powerful, fast and affordable. These generation comput-
ers used real time, time sharing and distributed operating
system

Fifth Generation Computers

In fifth generation (1980-till date) computers, the VLSI tech-
nology was replaced with ULSI (Ultra Large Scale Integra-
tion). It made possible the production of microprocessor
chips with ten million electronic components. This gen-
eration computers used parallel processing hardware and
AI (Artificial Intelligence) software. Some of the popular
fifth generation computers are;

• Desktop

• Laptop

• NoteBook

• UltraBook

• ChromeBook

• CPU

• Output Devices

• Primary Memory

• Secondary Memory

The operations of computer components are given below:

1 Inputting: It is the process of entering raw data, in-
structions and information into the computer. It is performed
with the help of input devices.

2 Storing: The computer has primary memory and sec-
ondary storage to store data and instructions. It stores
the data before sending it to CPU for processing and also
stores the processed data before displaying it as output.

3 Processing: It is the process of converting the raw
data into useful information. This process is performed by
the CPU of the computer. It takes the raw data from stor-
age, processes it and then sends back the processed
data to storage.

4 Outputting: It is the process of presenting the pro-
cessed data through output devices like monitor, printer
and speakers.

5 Controlling: This operation is performed by the con-
trol unit that is part of CPU. The control unit ensures that
all basic operations are executed in a right manner and
sequence.

Application of computer

The various applications of computers in today's are:

1 Word processing

• Word processing software automatically corrects spell-

ing and grammar mistakes.

• The copy and paste features repeat the content of the

document.

• Printout documents and makes several copies.

• Images can be added to your document.

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.1.01
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2 Internet

• A network of all the computers in the world, we can

browse through much more information then you could
do in a library.

• Because computer can store enormous amounts of

information.

• Very fast and convenient access to information

• You can communicate with a person sitting thousands

of miles away in seconds via E-mail.

• Chat software that enables one to chat with another

person on a real time basis.

• Video conferencing tools are becoming readily avail-

able to the common man.

Digital video or audio composition

• Audio or video composition and editing have been made

much easier by computers.

• The Graphic engineers use computers to generate short

or full length films or even to create three dimensional
models.

• Special effects in science fiction and action movies

are created using computers.

Desk top publishing

• In desk top publishing, we can create page layouts for

entire books on the personal computer.

• Mathematical calculations

• Large calculations are made easy in computer soft-

ware in Excel format

Travel

• We can book tickets for air travel, railway, bus journey

and make hotel reservations online.

Gambling

• One can gamble online instead of going to casinos.

Examinations

• One can write examinations online and get instant re-

sults.

Certificates

• Different types of certificates can be generated.

• ATM Machines

• The computer software authenticates the used and dis-

penses cash.

Matrimonial sites

• There are matrimonial sites through which one can

search for a suitable groom or bride.

News

• There are many websites through which you can read

the latest or old news.

Classmates

• There are many alumni websites through which you

can regain contact with your classmates.

Robotics

• Robots are controlled by software.

• Washing machines & Microwave ovens

• They are operated by software.

Planning and scheduling

• Software can be used to store contact information for

generating plans, scheduling appointments and dead-
lines.

Plagiarism

• Software can examine content for plagiarism.

Greeting cards

• We can send and receive greetings pertaining to differ-

ent occasions.

Sports

• Software is used for making umpiring decisions.  There

are simulation software using Which a sportsperson
can practice his skills.  Computers also identify flaws
in technique.

Weather analysis

• Super computers are used to analyse and predict

weather.

Business

A computer has high speed of calculation, diligence, ac-
curacy, reliability, or versatility which made it an integrated
part in all business organisations.

Computer is used in business organisations for: Payroll
calculations, Sales analysis, Budgeting, Financial fore-
casting, Managing employees database and Maintenance
of stocks etc.

Education

Computers have its dominant use in the education field
which can significantly enhance performance in learning.
Even distance learning is made productive and effective
through internet and video-based classes. Researchers
have massive usage of these computers in their work from
the starting to till the end of their scholarly work.

Marketing

In marketing, uses of computer are:

Advertising - with computers, advertising professionals
create art and graphics, write and revise copy, and print
and disseminate ads with the goal of selling more prod-
ucts.

Home Shopping - Home shopping has been made pos-
sible through use of computerised catalogues that provide
access to product information and permit direct entry of
orders to be filled by the customers.

Banking

Today banking is almost totally dependent on computer.
Banks provide the facilities of:

Banks provide online accounting facility, which includes
current balances, deposits, overdrafts, interest charges,
shares, and trustee records.

ATM machines are making it even easier for customers to
deal with banks.
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5

Insurance

Insurance companies are keeping all records up-to-date
with the help of computers. The insurance companies,
finance houses and stock broking firms are widely using
computers for their concerns.

Communication

Communication means to convey a message, an idea, a
picture or speech that is received and understood clearly
and correctly by the person for whom it is meant for. Some
main areas in this category are: Chatting, E-mail, Usenet,
FTP, Video-conferencing and Telnet.

Health Care

Most of the medical information can now be digitized from
the prescription to reports. Computation in the field of
medicine allows us to offer varied miraculous therapies to
the patients.

Military

Computers are the main tools which help in developing
missiles and other equipment in the deference system.
Designing and the maintenance are possible only through
computers. Computer builds the links between the sol-
diers and commanders through the satellite. Construction
of weapons and controlling their function is not possible
without the aid of computers. The list of the criminals and
the records of the cops are maintained regularly in the
system.

Engineering Design

As per the title, computers aid in designing buildings,
magazines, prints, newspapers, books and many others.
The construction layouts are designed beautifully on sys-
tem using different tools and software.

Types of Computer

Computers can be broadly classified by their speed and
computing power.

S.No. Type Specifications

1 PC (Personal Computer) It is a single user computer system having moderately powerful
microprocessor

2 Workstation It is also a single user computer system, similar to personal
computer however has a more powerful microprocessor.

3 Mini Computer It is a multi-user computer system, capable of supporting
hundreds of users simultaneously.

4 Main Frame It is a multi-user computer system, capable of supporting
hundreds of users simultaneously. Software technology is
different from minicomputer.

5 Supercomputer It is an extremely fast computer, which can execute hundreds
of millions of instructions per second.

Computer Hardware and Software

Objectives: At the end of this lesson you shall be able to
• identify different types of hardware  connected to a computer system
• state functions of each component
• demonstrate how to connect and disconnect each component
• explain types of software
• narrate system software and application software.

Computer hardware is the collection of physical parts of a
computer system. This includes the computer case, moni-
tor, keyboard, and mouse. It also includes all the parts
inside the computer case, such as the hard disk drive,
motherboard, video card, and many others. Computer hard-
ware is what you can physically touch.

Input Devices (Fig.1)

Touch Screen: (Fig.2)  A touch screen is a display de-
vice that the user to interact with a computer by using
their finger or stylus.

They can be  a useful alternative to a mouse or keyboard
for navigating a GUI (Graphical User Interface) touch
screens are used on a variety of devices, such as com-
puter and laptop displays, smart phones, tablets, cash
registers, and information kiosks. Some touch screens
use a grid of infrared beams to sense the presence touch-
sensitive input of a finger instead of utilizing touch sensi-
tive input. (Fig.2)
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6

Camera (Fig.3): Most digital cameras can use a USB
cable that connects into a computer to send pictures that
are in the camera to the computer.

Digital photography is a kind of photography where a digi-
tal camera is used to take photos. Digital cameras use
an image sensor instead of photographic film.

Scanner: (Fig.4) A scanner is an input device that scans
documents such as photographs and pages of text. This
creates an electronic version of the document that can be
viewed and edited on a computer. Most scanners are
flatbed devices, which means they have a flat scanning
surface. (Fig.4)

Microphone: (Fig.5) A microphone is plugged into
the back of desktop computers into the sound card mi-
crophone port and depending on your computer case may
also have a port on the front. On a laptop computer, the
microphone is plugged into the microphone port found on
the front or side of the laptop. (Fig.5)

Mouse: (Fig.6) A computer mouse is an input device that
is used with a computer. Moving a mouse along a flat
surface can move the cursor to different items on the
screen. Items can be moved or selected by pressing the
mouse buttons (called clicking). (Fig.6)

Keyboard: (Fig.7) A computer keyboard is an input de-
vice used to enter characters and functions into the com-
puter system by pressing buttons, or keys. It is the pri-
mary device used to enter text. A keyboard typically con-

Fig 1

Fig 2

Fig 3

Fig 4

Fig 5

Fig 6
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7

tains keys for individual letters, numbers and special char-
acters, as well as keys for specific functions. (Fig.7)

Joystick: (Fig.8) A lever that can be moved in several di-
rections to control the movement of an image on a com-
puter or similar display screen. (Fig.8)

Web cam: (Fig.9) The term webcam is a combination of
"Web" and "video camera". The purpose of webcam is,
to broadcast video on the Web. Webcams are typically
small cameras that either attach to a user's monitor or sit
on a desk. Most webcams connect to the computer via
USB. (Fig.9)

Track ball: (Fig.10) A trackball is a computer pointing
device which can perform the same as a mouse. Com-
puter mice have small balls inside of them, and when a
user move mouse, the ball rolls, causing the pointer the
screen to move (Fig.10)

Output Devices (Fig.11) Printers, Scanners and fax ma-
chines - Printers are output devices that create hard cop-
ies of computer files.  Other all in one type printers are
designed to provide multiple services such as scanning,
fax, copier functions.

Classification of printers (Fig.12)

• Impact printers

Impact printer refers to a class of printers that work by
banging a head or needle against an ink ribbon to make a
mark on the paper. This includes  dot-matrix printers, daisy-
wheel printers, and line printers.

Non impact printers

Printer that prints without banging a ribbon onto paper.
Laser, LED, inkjet, solid ink, thermal wax transfer and
dye sublimation printers are examples of non-impact print-
ers.

Fig 7

Fig 8

Fig 9

Fig 10

Fig 11
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LED (light-emitting diodes) Monitors: LED monitors are
the latest types of monitors on the market today. These
are flat panel, or slightly curved displays which make use
of light-emitting diodes for back-lighting, instead of cold
cathode fluorescent (CCFL) back-lighting used in LCDs.
LED monitors are said to use much lesser power than
CRT and LCD and are considered far more environmen-
tally friendly. The advantages of LED monitors are that
they produce images with higher contrast, have less nega-
tive environmental impact when disposed. (Fig.15)

Most computers have audio support either integrated into
the motherboard or on an adapter card. Audio support in-
cludes ports that allow input and output of audio signals.

Visual display units

Monitors

There are three main types of monitors available for com-
puters:

• CRT - Cathode Ray Tube

• LCD - Liquid Crystal Display

• LED - Light Emitting Diodes

Cathode Ray Tube: (CRT) Monitor is the most common
monitor type in the initial stages. Most televisions also
used this technology in earlier stages. These monitors
employ CRT technology, which was used most commonly
in the manufacturing of television screens. With these
monitors, a stream of intense high energy electrons is
used to form images on a fluorescent screen. (Fig.13)

LCD - Liquid Crystal Display Monitors: The LCD moni-
tor incorporates one of the most advanced technologies
available today. Typically, it consists of a layer of colour or
monochrome pixels arranged schematically between a
couple of transparent electrodes and two polarizing filters.
Optical effect is made possible by polarizing the light in
varied amounts and making. It pass through the liquid crys-
tal layer. (Fig.14)

Storage Devices (Fig.16)

Hard Disc Drive

• Spins at 5,400 - 7,200 rpm.

• Can store anywhere between  GB to TB of data.

Floppy Drive

• 3.5 - inch disks store 1.44 MB of data

CDs/DVDs - Compact Discs

• Available in a variety of formats - CD-ROM, CD-R, CD-

RW

• A typical CD holds about 700 MB of data

DVDs

• Available in DVD-ROM, DVD-R, DVD-RW

• Can hold 4.7 GB of data (standard)

USB Flash drive

• Storage capacity between MB - GB

Memory Card

MicroSD is a type of removable flash memory card used
for storing information. SD is an abbreviation of Secure
Digital, and micro SD cards are sometimes referred to as
μSD or uSD. The cards are used in mobile phones and
other mobile devices. Storage capacity between 2-512 GB.

Central processing unit (Fig.17)

The central processing unit (CPU) of a computer is a piece
of hardware that carries out the instructions of a computer
program. It performs the basic arithmetical, logical, and
input/output operations of a computer system. The CPU
is like the brain of the computer - every instruction, has to
go through the CPU. The CPU is sometimes also referred
to as the central processor unit.

Fig 12

Fig 13

Fig 14

Fig 15
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Hard Disc Drive

Floppy Disc Drive

DVD/CD Drive

USB Flash Drive

Magnetic tape
Memory Card

There are different brands and speeds
• Pentium  made by Intel
• Celeron made by Intel
• Athlon made by AMD

Memory

Random Access Memory (RAM)

• Temporary storage for data and programs that are be-
ing accessed by the CPU

• Volatile memory, which means that the contents are
erased when the computer is powered off.

• More Ram means more capacity to hold and process
large programs and files, as well as enhanced system
performance.

Types of RAM

• Dynamic Random Access Memory 9DRAM)

• Static Random Access Memory (SRAM)

• Fast Page Mode DRAM (FPM Memory)

• Extended  Data Out RAM (EDO Memory)

• Synchronous DRAM (SDRAM)

• Double Data Rate SDRAM (DDR SDRAM)

• Double Data Rate 2 SDRAM (DDR2 SDRAM)

• RAMBus DRAM (RDRAM)

Fig 16
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Fig 18

Read Only Memory (ROM)

ROM is a storage medium that is used with computers
and other electronic devices. As the name indicates, data
stored in ROM may only be read.  Unlike RAM (Random
Access Memory), ROM is non-volatile, which means it
keeps its contents regardless of whether or not it has
power.

Basic instructions for booting the computer and loading
the operating system are stored in ROM.

Processors & Memory (Fig.18)

• Byte-one character of data (8 bit)

• 1 Kilobyte (KB) = 1024 Bytes

• 1 Megabyte (MB) = 1024 kilobytes

• 1 Gigabyte (GB) = 1024 Megabytes

• 1 Terabyte (TB) = 1024 Gigabytes

Fig 17
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Power Supply (Fig 19)

The computer gets its power from the external power
supply to system through SMPS (Fig.11) (Switch Mode
Power Supply) which acts as a AC to DC converter and
step down the volts to 3 - 12 DC. The external power card
is to be connected to the power supply plug in system
and the power supply on/off switch is switched on and the
power switch in the front side of the system is also
switched on then the power supply fan must run. If it is not
running then there may be a problem of power supply, if it
runs properly then we can assure that we got power to our
system.

  ROM types      ROM types                Description

ROM Read-only memory chips Information is written to a ROM chip when it is
manufactured. A ROM chip cannot be erased or
re-written and can become obsolete.

PROM Programmable read-only memory Information is written to a PROM chip after it is
manufactured. A PROM chip cannot be erased or
re-written.

EPROM Erasable programmable read-only Information is written to an EPROM chip after it is
memory manufactured. An EPROM chip can be erased

with exposure to UV light. Special equipment is
required.

EEPROM Electrically erasable programmable Information is written to an EEPROM chip after it
read-only is manufactured. EEPROM chips are also called

Flash ROMs. An EEPROM chip can be erased
and re-written without having to remove the chip
from the computer.

Fig 19

Motherboard (Fig.20)

Fig 20
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The motherboard serves as a single platform to connect
all of the parts of a computer together. It connects the
CPU, memory, hard drives, optical drives, video card, sound
card, and other ports and expansion cards directly or via
cables. It can be considered as the backbone of a com-
puter.

Features of Motherboard

A motherboard comes with following features

• Motherboard varies greatly in supporting various types

of components.

• Motherboard supports a single type of CPU and few

types of memories.

• Video cards, hard disks, sound cards have to be com-

patible with the motherboard to function properly.

• Motherboards, cases, and power supplies must be com-

patible to work properly together.

• Description of Motherboard

The motherboard is mounted inside the case and is se-
curely attached via small screws through pre-drilled holes.
Motherboard contains ports to connect all of the internal
components. It provides a single socket for CPU, whereas
for memory, normally one or more slots are available.
Motherboards provide ports to attach the floppy drive,
harddrive, and optical drives via ribbon cables. Motherboard
carries fans and a special port designed for power supply.
There is a peripheral card slot in front of the motherboard
using which video cards, sound cards, and other expan-
sion cards can be connected to the motherboard. On the
left side, motherboards carry a number of ports to con-
nect the monitor, printer, mouse, keyboard, speaker, and
network cables. Mother boards also provide USB ports,
which allow compatible devices to be connected in plug-
in/plug-out fashion. For example, pen drive, digital cam-
eras, etc.

Different types of software

Key difference (Fig.21)

Software refers to a set of programs which is capable of
performing some specific tasks on a computer system.
They can be broadly classified into two categories - Sys-
tem software and Application software.

or may refer to a number of programs collectively. These
instructions are defined in proper step by step manner.  It
is important to mention that hardware becomes incapable
for extending its capabilities without support of the soft-
ware.  These software programs assist computer and net-
work to start and work.

Softwares are broadly classified into two categories

System Software

This software is usually engaged in background processes.
This software sync the work of hardware and other types
of programs.  It acts as a middle layer between hardware
and user applications.  System software includes pro-
grams like

Operating System

It is a well - known example of system software. This
software interacts with the hardware and provides the ca-
pability for running various types of programs. Desktop
uses operating systems like Window, Linux and MacOS,
whereas Android and Windows are commonly used oper-
ating systems for mobiles. There are different types of
operating systems like real time, distribute, embedded,
etc., It is necessary to consider the hardware specifica-
tions before deciding the operating system.

Language translators - It includes assemblers, compilers
and interpreters.  These programs have been designed for
programming languages like C, Cobol, Pascal, etc.  Ma-
chine Language is translated into machine code with the
help of an assembler.  Compiler translates the code writ-
ten in a high level language to a lower one.  An interpreter
is capable of executing programs directly.  It executes
the program in a line by line manner.

Common Utility Programs

These programs are designed specifically for managing
the computer device and its resources. It includes pro-
grams like communication tools and disk formatter. They
are more focused on the operations of computer infra-
structure. For example - Virus scanner is a kind of com-
mon utility programs which provides protection to the sys-
tem from unwanted guests like Trojans and viruses.

Application Software

System softwares are more concerned about the back-
ground programs of the computer system. However, an
application software performs some specific task on a
system. There are numerous types of application soft-
ware. They deal mainly with solving out some specific
computing types of problems. They work for fulfillment of
specific needs only. These types of software are also known
as apps in short. Some of the common application soft-
ware are.

Word processors

These softwares programs are used for creation of docu-
ments. In addition to basic activity of creating a docu-
ment, it also assists in storing and printing that docu-
ment. Changes can be easily made in the document

Software refers to computer programs which perform spe-
cific functions as instructed.  It can be a single program

Fig 21

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.1.01

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



13

through these word processors. It is one of the most com-
monly used application software. MS - Word is an ex-
ample of a word processor program.

Database software

This software is capable of creating databases. In addi-
tion to it, it also manages the data or information residing
inside the database. It is also known as DBMS some-
times. They help in organizing data. Some of the examples
of database software are Access, Oracle and Sysbase.

Multimedia software

These softwares have been devised to work with different
types of media which are connected with each other, they
are usually used in multimedia presentation.

Education and reference software

These softwares have been devised in order to assist in
learning about any specific thing. There are many different
types of tutorial software programs which fall under this
category. Many of these software programs have been
designed for children for assisting them in their learning.
They are also known as academic software. Ultimate Maths
invaders and My Amazing Human body are two such
softwares.

Graphic software

These software programs assist in working with graphics,
as they enable the user to edit or manipulate visual im-
ages. It includes image editors and illustration software.
Adobe Photoshop and Corel Photo paint are two popular
examples of graphic software. These types of software
usually work on either bitmap or vector images.

Some Important Tools of Controls panel

Administrative Tools

This control panel is for Very Advanced Users only. It allows
Partitioning a Hard Drive, Stop/Start System Services,
Schedule System Tasks, Manage Windows Firewall
Settings and so on.

Backup  and  Restore  Center

Allows to back up (and then restore) Picture files, Music
files, Videos files, E-Mails, Documents, Windows Media
Center, Recorded TV Shows and Compressed files either
as a custom backup or as part of a full (hard drive image)
backup. System files, Program/Executable files and
temporary files will also be backed up alongside the own
personal data files.

Date and Time

As well as for the obvious changing of the Data and Time
this control panel also allows to change the Time Zone
(i.e. to Hong Kong), synchronize the time with a time server
(internet clock) and have two additional times (clocks) as
part of the notification area clock.

Device Manager

Allows to Install or uninstall the driver software for a
particular piece of hardware. Device Manager is good if a

piece of hardware is not working correctly and needs to
be uninstalled. Or when a piece of hardware cannot be
installed because no Installation CD for it, that contains
its driver software, and therefore need to check the Internet
for its driver software. Even if the hardware is working fine
sometimes you might want to disable the hardware, for
whatever reason(s) - Device Manager allows you to Enable
or Disable hardware as well.

Devices Printer

Allows to set the default Printer, adjust Keyboard and
Mouse properties, control Windows Fax And Scan software
as well as view/control other aspects of the hardware (i.e.
the computer and a flash drive).

Display

Allows to adjust certain aspects of the display screen,
such as its Resolution (Desktop Size), its Clear Type (Font
Readability), Text Size, Brightness and so on.

Internet Options

Allows to change the Internet Settings - Settings such as
Security, Privacy, Content, History, Connections and so
on. This control panel is for Very Advanced Users only.

Keyboard

Allows to change the speed of the keyboard and the speed
of the flashing cursor.

Mouse

Allows to change Mouse and Mouse Pointer settings. For
example one can change the look of the mouse pointer,
the speed of the mouse, whether or not the mouse is left-
handed or right-handed, the number of lines scrolled when
using a wheel mouse and so on.

Network and Sharing Centre

Manages the Network side of Windows 7.setup and then
connects to a network, checks a network's status, changes
network settings and sets preferences for sharing files
and printers amongst other things.

This control panel is for Very Advanced Users only.

Sound

Allows to configure the Sound and Audio Devices (Sound
Themes, Volume and so on).

Taskbar and Start Menu

Allows to configure the Taskbar and Start Menu settings -
Their appearance mainly.

User Accounts

Allows to configure the User Accounts, their Rights,
password, picture and so on.This control panel is for Very
Advanced Users only.

Windows Firewall

Allows to configure Windows 7's, built-in, Firewall settings.
This control panel is for Advanced Users only.
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Systems of Shorthand

1837 Sir Isaac Pitman published  Pitman's Shorthand

1884 J.M. Sloan (England) & Duployan (France) published
Sloan Duployan System of Shorthand

1888 John Robert Gregg  published Gregg's System of
Shorthand

(This system is popular in the United States but not in
India. This system is not based on Position writing)

Other writing systems like Morse code & Braille code
(meant for the blind) were based on the phonetic concept
of shorthand.

Shorthand and  Stenography

Shorthand is the art of recording spoken words in even
time.  It is a script with which human thoughts can be
recorded quickly and effectively.  It is recording the speed
with which a man can speak out his thoughts for the ben-
efit of others.  Speed and accuracy are the essential  fac-
tors for a shorthand writer.

Office Administration and Facility Management     R.Theory for Ex 1.1.02-04
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Introduction to shorthand - consonants - classification - arrangement &
direction of strokes - table of consosnants - joining of consonants

Objectives: At the end of this lesson you shall be able to
• state the different systems of shorthand
• define consonants
• classify consonants
• explain  how the different Consonants are represented
• join two or more consonants.

Stenography is the art of writing a communication in short-
hand and then transcribing it in the respective language
script.  Thus the art of stenography includes both short-
hand and typewriting.  That is why Stenography is referred
to as 'Twin Arts'.

Shorthand - Uses

In the past, shorthand was used to write the sermons of
religious leaders of the church.  It was used for 'notations'
or marginal notes in public documents to protect them
against forgery.  George Bernard Shaw wrote all his litera-
ture in shorthand.

Charles Dickens was a shorthand reporter.  Shakespeare's
plays were all preserved by means of shorthand.  Julius
Caesar is also known to have written in shorthand.  The
mythological story that the Mahabharata  was dictated by
Vyasa to Lord Ganesha  also indicates a system of short-
hand writing in existence in ancient India.

Now-a-days, shorthand is used  in  legislative bodies, law
courts, business correspondence, etc.

Consonants: Definition, Classification, Arrangements and Directions, Table
of consonants, Joining of strokes

Objectives: At the end of this lesson you shall be able to
• define consonants
• list the number of consonants in shorthand
• describe the classification of  the consonants
• narrate the pairs and arrangement of consonants
• state the size and directions of shorthand strokes

• join the consonants/strokes.

Definition of consonants

"Consonants are the result of audible friction in some part
of the mouth or throat", by -Prof. Sweet.  According to
Indian Linguists - "Consonants are the body of a language
and vowels are its soul".

Consonants

According to Indian Linguists, Consonants are the body
of a language and vowels are its soul.  In fact no language
can exist without them. They are so inter-related that no
consonant can be used in a language without a vowel and
no vowel can be used in a language without a consonant.

In Shorthand consonants are the body (Strokes) on which
the soul (vowel signs) can be put. Therefore, Consonants
have a major role in Shorthand (phonetic) writing, while
vowels can be omitted subject to rules of theory.

The Consonants (strokes) are phonetic units (syllables)
of the language and are not fully dependent on the Conso-
nant letters of English language. Therefore, a phonetic
stroke of Shorthand can represent one or more conso-
nant letters of English, e.g., the Stroke of K represents
the sounds of C (call), Q (queen), K (king) and Ch (chem-
ist); the Stroke of J represents the sounds of J (Jolly) and
G (Geography); the stroke of S represents S (see, sea)
and C (cite, cease); the stroke of Z represents X (Xerox),
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Size and directions of stroke consonants

The consonants should be written about 2/3 of the length of shorthand notebook linespace. Shorthand strokes are
written in three directions and are called

i Downward strokes,

ii Horizontal strokes and

iii Upward strokes.

Strokes are written with the shorthand pencil with light and heavy touch according to their, light or heavy sounds, Heavy
strokes are never written upwards.

ii Fricatives (Continuants): The next eight consonants (F,V, th, THE, S,Z, SH, ZH) are called fricatives (Continuants)
because in pronouncing them the outgoing breath passes slowly in a continuous stream through the mouth barriers.

C (Czar) and Z (zero); while the single stroke sound of (‘/

’), Ch, ‘)’ Sh, ‘(‘ Th or ‘(‘ Thee is represented by two or

more consonant-letters of English.  Therefore, Shorthand
script has less consonantal strokes and has certain limi-
tations compared to the longhand script.

There are only 24 consonants in English shorthand as -
P,B,T,D, CH, J, K, G, M, N, NG, F, V, th, THE, S, Z, SH,
ZH, L, R, W, Y, H.

Pairs and arrangement of consonants

The consonantal strokes of English Shorthand have been
paired into light and heavy strokes according to their pho-
netic sounds.  There are, first sixteen consonants in pairs,
thus, P/B, T/D,CH/J, K/G, F/V,ith/THE, S/Z, SH/ZH.  The
articulations in these pairs are the same but the sound is
light for the first consonant of each pair and heavy sound
for the second consonant of each pair.

Straight Strokes         Curved Strokes

The consonants of each pair are represented by the same
strokes, but for the second consonant this is written thick
instead of thin, as P,B etc., We have therefore a light sign
for the light sound and heavy sign(Thick Sign) for the heavy
sound.

The consonants, M,N,R, L, W, Y, H do not have phonetic
pairs and are represented by light strokes according to
their phonetic sounds. The consonant NG does not have
pair but it is written thick instead of thin since the sound of
this consonant is heavy.

For the representation of all the consonantal sounds (ex-
cept W,Y,H) the simplest geometrical forms are used,
namely, the straight line and shallow curve. Those strokes
formed by part of a straight line are called straight strokes
while strokes formed by part of a circle are called curved
strokes as shown in the following diagrams.
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iii Nasals: The next three consonants (M,N,NG) are called  nasals as in pronouncing them the air passes through the
nose also.

iv Liquids: The consonants L and R are called liquids, which flow into union with the other consonants and thus make
double consonants as cliff, dry, etc., (where the L or R unites with the preceding consonants)

Letter Sound Character/Stroke Example (as in)

L el ……..     (Up) life

R ar ……..     (Down) Arm

R ray …….. (Up) right

v Coalescents: W & Y are semi-vowels (coalescents), precede vowels and coalesee or unite with them.

Letter Sound Character/Stroke Example (as in)

W way ……..     (Up) wage

Y yay ……..     (Up) yellow

vi Aspirate: The consonant H is aspirate, which is a breathing upon a following vowel.

Letter Sound     Character/Stroke Example (as in)

H hay ……..  (Up) hope

……..  (Down) he

Joining of strokes

Strokes when joined must be written without lifting the pen. The beginning of a following stroke should be joined to the end
of a preceding stroke, as-

P, PR,  PT, PH …………..........…………

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.1.02-04
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Vowels - Definition

"If the mouth passage is left so open as not to cause audible friction, and voiced breath is sent through it, we have a
vowel" (Prof. Sweet).

Vowels are the soul of the language without which language cannot be used.  Therefore, 12 vowels have been adopted in
English shorthand according to their sounds.

Vowel Sounds: There are six long vowel sounds and six corresponding short vowel sounds in English shorthand. The
long vowels may be remembered by repeating the sentence "Pa may we all go too". The short vowels may be remem-
bered by repeating the sentence "That pen is not much good".

Vowel Signs: The long vowels are represented by a heavy dot and a heavy dash.  The short vowels are represented by
a light dot and a light dash.

Vowel places: There are three points on a stroke in which a vowel sign may be placed, namely, at the beginning, in the
middle and at the end.  The vowels are accordingly called first place, second place and third place vowels.

Office Administration and Facility Management          R.Theory for Ex 1.1.05
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Vowels - Long Vowels -Short Vowels - Vowel Places - Preceding & following
vowels - Intervening vowels and their position

Objectives: At the end of this lesson you shall be able to
• define a 'vowel'
• represent long vowels and short vowels along a stroke
• represent preceding and following vowels
• represent intervening vowels between two strokes
• write strokes in position according to first vowel sound.

Example Heavy Vowels      Light Vowels

Dot   • Dash  -             Dot  • Dash  -

Ist place  ah   • aw  - a   • o     -

IInd place   a   • o    -
e   • u 

   
 -

III rd place
  

e
   

•
oo      - i    • oo   -

                        "Pa may we all go too".                            "That pen is not much good".

Preceding & Following Vowels

If a vowel sign is written on the left hand side of an upstroke or down stroke, it is read before the stroke, as in

If a vowel sign is written on the right side of an upstroke or downstroke, it is read after the stroke, as in

If a vowel sign is written above a horizontal stroke, it is read before  the stroke, as in

If  vowel sign is written below a horizontal stroke, it is read after the stroke, as in

∪

∪

∪

∪

∪

∪
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Position of outline

Just as there are three places in which vowel signs are put, there are three positions of shorthand outlines of the words.

The first position of shorthand outline is above the line, the second position is on the line, and the third position is through

the line.  The first sounded vowel in the word determines the position of the outline, as in

Intervening Vowels: First and Second place vowels, when occurring between two strokes are written after the first stroke,

but the third place vowel signs are written before the second stroke at the end, because the vowel sign is more conve-

niently written in that place.

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.1.05
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Office Administration and Facility Management          R.Theory for Ex 1.1.06
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Computer keyboard functions

Objectives: At the end of this lesson you shall be able to
• recognize the keyboard and position of character keys
• understand the functions of the function keys
• use shortcut keys for different operations
• state how to use combination keys like Ctrl, Alt and Shift keys
• explain the operation of Esc and Arrow keys
• use alphanumeric and numeric key pad.

Shortcut Keys

The Escape (ESc) key allows you to stop a function
or action

Ctrl + C or Ctrl + Insert

Both Ctrl + C and Ctrl + Insert copy the highlighted text
or selected item.

Ctrl + F

Pressing Ctrl + F opens the "Find" in any program.  This
includes your internet browser to find text on the current
page.  For instance if you want to find a person's name in
a registry this shortcut would be a fast way to do that.

Ctrl + P

Open a print preview of the current page or document be-
ing viewed.  For example, press Ctrl + P now to view a
print preview of this page.

Ctrl + S

While working on a document or other file in almost every
program pressing Ctrl + S saves that file.  This shortcut
key should be used frequently anytime you're working on
anything important.

Ctrl + V or Shift + Insert

Both the Ctrl + V and Shift + Insert paste the text or

object that's in the clipboard.

Ctrl + Z and Ctrl + Y

Ctrl+Z will undo any change.  For example, if you cut out
some text, this shortcut will undo it. This can also be
pressed multiple times to undo multiple changes.  Press-
ing Ctrl + Y would redo the undo.

Alt + Tab or Ctrl + Tab

This allows you to quickly switch between open programs

moving forward.

Tip: Press Ctrl + Tab to switch between tabs in  a pro-
gram such as your internet browser.

Tip: If you also add in the Shift key to Alt + Tab or Ctrl +
Tab it will move backwards.  For example, if you are press-
ing Alt + Tab and pass the program you want to switch to,
press Alt + Shift + Tab to move backwards to that pro-
gram.

Tip: Windows Vista and 7 Users can also press the Win-
dows Key + Tab to switch through open programs in a
full screenshot of the Window.

Ctrl + Back space and Ctrl + Left or Right arrow

Pressing Ctrl + Backspace will delete a full word at a

A computer keyboard is an input device used to enter
characters and functions into the computer system by
pressing buttons, or keys. It is the primary device used to

enter text. A keyboard typically contains keys for indi-
vidual letters, numbers and special characters, as wel as
keys for specific functions. (Fig.1)

Fig 1
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time instead of only a single character.

Hold down the Ctrl key while pressing the left or right
arrow to move the cursor one word at a time instead of
one character at a time.  If you wanted to highlight one
word at a time you can hold down Ctrl + Shift and then
press the left or right arrowkey to move one word at a
time in that direction while

Ctrl + Home or Ctrl + End

Ctrl + Home will move the cursor to the beginning of the
document and Ctrl + End will move the cursor to the end
of a document.

Page up, Space bar, and Page Down

Press either the page up or page down key to move
that page one page at a time in that direction. When brows-
ing the internet pressing the space bar also moves the
page down one page at a time.

Computer key board operations

Keyboard

The keyboard (Fig.1) is used for typing text into the com-
puter.  It is also known as the standard input device.  A
computer keyboard is similar to that of a typewriter, but it
has additional keys as well.  The most commonly avail-
able computer keyboard has 104 keys.

Key Board

Print Screen, Scroll Lock, Pause/Break. The print Screen,
Scroll Lock, and Pause/Break keys are at the top - right
corner of the keyboard.

• Escape key. The Eacape (Esc) Key allows you to stop

a function or action.

Function Keys

• Tab key

• Alphanumeric Keys

• Ctrl, Alt, and Shift

• Arrow Keys

• Numeric Keypad

There are different types of keys on the keyboard. The
keys are categorised as:

• Alphanumeric Keys, including letters and numbers.

• Punctuation Keys, Such as the colon(:), the semico-

lon (;) the question mark (?), single quotes (‘) and double
quotes (“).

• Special keys, such as Arrow keys, control keys and

Function keys (F1 to F12)

These keys have different functions depending on where
they are used. For example, the ENTER key starts a
new paragraph in a word processor, but in the com-
mand line, it executes a command.

Function keys are special keys that are used to perform
specific functions.  They are labelled as F1, F2, F3 and so
on, up to F12. The functionality of the keys differs from
software to software. The function of the F1 key in most
software is to provide help with the software.
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Office Administration and Facility Management          R.Theory for Ex 1.1.07
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Windows operating system: Log on accounts & passwords, windows menu,
minimising, windows resizing & moving, closing windows, tool bar, task
bar, menu bar, start button, shutting down windows, desk top, windows
explorer, control buttons, open, cut, copy & paste

Objectives: At the end of this lesson you shall be able to
• explain windows operating system
• identify the Windows screen elements and parts of a window
• create logon account and passwords
• resize, Move, and Scroll windows
• maximize, Restore, Minimize, and Close windows
• create, Copy, Move, Rename, and Delete files
• find files and folders
• use the Windows operating system to practice performing common tasks.

Introduction to Windows

Windows is a collection of programs known as an operat-
ing system (OS) that controls a PC personal computer).
First produced by Microsoft in November 1985, it has been
frequently updated since, as computer memory has  , as
processing chips have got faster and, of course, when the
internet was  invented. Prior to Windows, PCs were oper-
ated by a series of text commands.

Windows' key benefits and features

• Allows the user to interact with the computer (through

the keyboard, mouse, microphone, etc.).

• Controls the storage of data (images, files, music).

• Controls hardware attached to the computer such as

webcams, scanners and printers.

• Helps to open and close programs (word processors,

games, photo editors, etc.), and gives them part of the
computer's memory to allow them to work.

• What accesses to computer different users have and

the computer's security.

• Deals with errors and user instructions, and issues

simple error messages.

• Promotes multitasking by allowing the user to do sev-

eral things on the computer at once - for example,
watch a video while writing a letter.

Other operating systems are available, notably the Apple
OS X used in Mac computers. In addition, with the in-
creased use of smart phones, notepads and tablets, there
are systems aimed directly at mobile devices. However,
most people who learn to use computers do so on a sys-
tem running Windows.

The Windows Operating System

Every computer needs an operating system for operating
the computer. There are a few around and Microsoft
Windows is just one of them.

Some of the functions the Windows operating system
allows to do are:

• Access applications (programs) on the computer (word
processing, games, spread sheets, calculators and so
on)

• Load any new programs on to the computer

• Manage hardware such as printers, scanners, mike,
digital cameras

• Manage how files are stored on computer (File
Management covered later in this module)

• Change computer settings such as colour schemes,
screensavers, and the resolution of monitor.

There are several versions of Microsoft Windows in
existence. They are Windows XP, Windows Vista,
Windows 7 and Windows 10.

Windows versions

Windows 7 continues the Microsoft tradition of releasing
different versions of Windows for different users. There are
four versions of Windows 7 available - Starter, Home Pre-
mium, Professional and Ultimate (Fig 1).

Fig 1
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Documents: The DOCUMENTS menu links to default
saving location.

Pictures: This will link for pictures folder

Music: This links to a folder for storing music

Computer: Clicking this link will show the drives connected
to this computer

Control Panel: Allows making changes to the current
settings on the computer.

Devices and Printers: The Devices and Printers folder
displays devices connected externally to the computer,
including devices connected wirelessly or over the network.

The Devices and Printers folder allows to performing many
tasks, which vary depending on the device. Here are the
main tasks it can do:

• View all the external devices and printers connected
to the computer.

• Add a new device or printer to the computer.

• Check to see if a specific device is connected and
working properly

• Display detailed information about the devices, such
as make, model, and manufacturer

• See what tasks one can do with a particular device.

Search programs and files: Allows to search for files,
folders, printers, software applications, etc. by entering
search criteria

Help and Support: Access to a help facility where one
can find out how to do certain things on the computer.

Log Off: Allows you to log off as a User without turning off
the computer.  This would allow someone else to log on.

Desktop in Windows 7

The desktop (Fig 3) is the main screen area that one will
see after Turn On the computer and Log On to Windows.
Like the top of an actual desk, it serves as a surface for
the work. When one opens programs or folders, they appear
on the desktop. And one can also put things on the
desktop, such as files and folders, and arrange them.

The desktop is sometimes defined more broadly to include
the taskbar. The taskbar sits at the bottom of the screen.
It shows which programs are running and allows switching

between them. It also contains the Start button , which

can be used to access programs, folders, and computer
settings.

Glossary of Desktop Icons

  My Documents

MY DOCUMENTS is the default storage folder for the files
to create.  When you want to save or open a file, Microsoft
Windows initiallyopens the MY DOCUMENTS dialog box.

 My Computer

MY COMPUTER displays information about the computer,
such as the contents of the computer drives and which
printers have installed. It also allows finding, viewing and
organising files.

The Recycle Bin

The computers data files should be tidied up regularly and
any unwanted files deleted from the system.  Any file deleted
from the hard drive will be placed first in the RECYCLE
BIN.

Windows 7 Starter can't be purchased at retail. It is meant
primarily for net books and is a replacement to Windows
XP in that market. Windows 7 Starter has some features
disabled. There is no Windows Aero theme, Personaliza-
tion features (such as changing the wallpaper) are not
available, and there is no support for multi-media features
such as Windows Media Centre.

Windows 7 Home Premium is considered the least
expensive full version of Windows 7 and it is the least
expensive version one can buy at a retailer. Windows 7
Professional is an upgrade that includes some useful
utilities that both home and business users can appreciate.
Windows 7 Ultimate has advanced security and language
features.

The START button

The START button is located at the bottom of the screen
on the left-hand side of the taskbar and has access to
most things available on the computer.  When clicked  on
the START button the following can be accessed (Fig 2).

Fig 2
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 Internet Explorer

With INTERNET EXPLORER and Internet connection we
can search and view the information on the World Wide
Web. It is used to search the Internet for people,
businesses  and information about subjects, download
music, copy graphics, stay in touch with or meet new
friends and a host of other activities.

Working with desktop icons

Icons are small pictures that represent files, folders,
programs and other items. Windows, has at least one
icon on the desktop and starts the Recycle Bin (more on
that later). The computer manufacturer might have added
other icons to the desktop.

Adding and removing icons from the desktop

You can choose which icons appear on the desktop-you
can add or remove an icon at any time. Some people like
a clean, uncluttered desktop with few or no icons. Others
place dozens of icons on their desktop to give them quick
access to frequently used programs, files, and folders.

User can easily access from the desktop to the favourite
files or programs, and can create shortcuts to them. A
shortcut is an icon that represents a link to an item, rather
than the item itself. When double-click a shortcut, the
item opens. If you delete a shortcut, only the shortcut is
removed, not the original item. Identification of shortcut is
by the arrow on the icon (Fig 4).

Selecting multiple icons

To move or delete a bunch of icons at once, you must first
select all of them. Click an empty area of the desktop and
drag the mouse. Surround the icons to select with the
rectangle that appears (Fig 5). Then release the mouse
button. Drag the icons as a group or delete them.

Fig 4

Fig 5

Taskbar History (Fig.6)

The first thing that one notices when using Windows 7 is
that the Windows taskbar (Fig 6) has been given its first
major revision since Windows 95. Instead of using boxes
with text and an icon to indicate an open task, the new
taskbar uses icons only. The taskbar also no longer shows
every single task that is open - instead, tasks are grouped
by program, and all instances of an open program are
displayed by hovering over a program's icon.

Windows Explorer (Fig 7)

Windows Explorer has become a very powerful utility for
navigation and searching directories for files in the system.

Fig 3
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Fig 7

Fig 6

The field at the top is used to contain an address like
C:\Documents and Settings\Directory. This address is now
much more functional.

Windows Search (Fig 8)

Windows helps to search the files from any directory. It
just navigates to the folder and initiates search from the
search field in the upper-right corner of the window. Next,
Windows Explorer now gives the ability to preview
documents as select them from search results. This is
an option which can be enabled and disabled on the right
side of the Menu Toolbar.

Windows 7 Control Panel (Fig 9)

The Control Panel in Windows 7 is the place to go when
one needs to make changes to various settings of the
computer system, to control most Windows commands
and features using the various options and sliders in the
Control Panel.

Category view (Fig 10)

By default, the Control Panel is displayed in Category
view, which is separated into eight categories, ranging from
System and Security to Ease of Access. To open a window
with the Control Panel options for any one of these
categories, simply click the category's hyperlink.

To open the Control Panel, click the Start button on the
taskbar and then click Control Panel on the Start menu.
Windows 7 gives three different views for looking at the
computer's Control Panel: To switch views, click the View
by drop-down button (labelled Category by default) in the
upper-right corner of the Control Panel and then choose
one of the views from the button's drop-down menu.
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Fig 8

Fig 9

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.1.07

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



26

Fig 10
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Office Administration and Facility Management          R.Theory for Ex 1.1.08
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Computer keyboard functions and its operations

Objectives: At the end of this lesson you shall be able to
• explain function keys
• explain numerical and key pad keys
• state the functions of caps lock and shift keys
• narrate delete and backspace keys functions
• explain short cut key (Ctrl and Alt).

The keyboard is the most important part of a computer. It
consists of different sets of keys that help us to enter
information into the computer.  A standard keyboard has
104 keys.

Types of Keys in a Keyboard

Alphabet Keys

Number Keys

Special Keys

Function Keys

Navigation Keys

1. Alphabet Keys

26 alphabet keys are present on a keyboard from A to Z.
these keys are not present in the alphabetical order. These
keys are used to type words, sentences or paragraphs.

2. Number Keys

These keys are used for typing numbers. These keys are
present above the top row of the alphabet keys and also
present on the right side of the keyboard.

3. Special Keys

Keyboard has more special keys such as Space bar Key,
caps lock key, backspace key, shift key, enter key, sym-
bol keys and tab key etc.

4. Function Keys

12 function keys are present on a keyboard. They keys
are perform specific tasks. They are present on the top-
most row of the keyboard. Label F1, F2, F3, F4, F5, F6,
F7, F8, F9, F10, F11 and F12. These keys have different
functions for different programs.

5. Navigation Keys

Every keyboard has some special navigation keys such
as Cursor control keys (Arrow Keys), Home key, End key,
Ctrl, Alt, Page Up, Page Down, Delete, Insert etc.
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Office Administration and Facility Management          R.Theory for Ex 1.1.09
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Short forms in shorthand (logograms, contractions, tick ‘the’) & punctuation
marks

Objectives: At the end of this lesson you shall be able to
• define logograms and grammalogues
• distinguish between grammalogues and contractions
• explain the use of tick ‘the’
• state the punctuation marks used in shorthand.

Short forms

For the purpose of quick and easy writing frequently occurring words are represented by small signs in shorthand called

short forms. These can be divided into three categories, i.e., Logograms, Grammalogues and Contractions.

1 Logogram: A frequently occurring word represented by a small imaginary sign in shorthand is called a logogram.

There are only 24 logograms formed by dots, dashes, angular signs, circles and loops in English shorthand as

           a/an,        the,           all,        and, etc.,

2 Grammalogues:  A frequently occurring word represented by a single consonant stroke in shorthand is called a

grammalogue  as                     can,              give/given,               Any/in               put, etc.,

3 Contraction: A frequently occurring word represented by two or more consonantal strokes is called a contraction.

Simple contractions can be formed by joining / disjoining strokes to the grammalogues, thus,                   income,

            being,                     going,                because, etc.

4 Phrasing: Writing of two or more words or short forms without lifting the pen is called phrasing, thus               to do,

   should be, etc.,

5 Tick 'the': The word 'the' is frequently used in English and may be represented by a light slanting tick, joined after

a stroke or short form of words and written in opposite direction of stroke as           of the ,                 to the,

on the,            at the, etc.,

Punctuation Mark       Sign   Shorthand Sign

Full Stop . x

Comma , ,

Semi-colon ; x
,

Colon : x
x

Hyphen - =

Dash _

Exclamation !

Question ?

Brackets ( )

Paragraph // //

Proper nouns Capital Letters //

Punctuation Marks in Shorthand
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Diphthongs & Triphones

Objectives: At the end of this lesson you shall be able to
• define a Diphthong
• state the dipthong sounds, their signs and places
• define a Triphone
• illustrate the different Triphonic signs and their places.

Definition

Numerous definitions of Diphthongs are given in English
language.  Without going into the linguistic controversies,
for Shorthand writing, a Diphthong can be defined as "a
union of two vowel-sounds" by (Daniel Jones), as in tie,
lie, by, my, cow, type, boil, guide, duty, beauty, etc.  In
shorthand (phonetic) writing the actual presence of two-
vowels is not necessary.  In words like by, how, shy, my,
boy, etc., though a diphthongal (two vowel) sound occurs,
the actual occurrence of two vowels is absent.

Similarly, in words like maid, aim, she, zoo, see, keep,
meal, load, Paul, etc. though two vowels actually occur
the two-vowel (diphthongal) sound is absent. These are
thus written in Shorthand by long vowels according to their
sounds about which we have already learnt.

Diphthongs and their places: There are 4 common diph-
thongs, i, ow, oi and u as heard in the sentence “I now
enjoy music”.

Sound lllll-1st place

Sound owowowowow-3rd place

Sound oioioioioi-1st place

sound uuuuu-3rd place

The formation of diphthongs are shown below
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DIPHTHONG ‘I’:

The diphthong ‘I’ is written in the first place; as in

           pipe,            pike,           right,           tire,              fire

The diphthong ‘I’ is joined initially to downstrokes and N; thus,

            eye-ball,            item,            idle,                ice,                 I-know.

The abbreviated form of ‘I’ i.e. the first tick may be joined initially to

upward L and M; thus,

           isle,              I’m

The diphthong ‘I’ may be joined finally to N; thus            Nigh,              deny

DIPHTHONG ‘OW’:

The diphthong ‘OW’ is written in the third-place.

        Ouch,            couch,               mouth,              loud,                 county.

Initially and finally it is joined to other consonants

Initially ‘OW’ is attached to upward L; thus,            owl.

Finally, ‘OW’ is joined to downstrokes, when convenient; thus,

          bow,               vow,            sow,           anyhow.

The diphthong ‘OW’ may be abbreviated when attached to N; as in

            now.

DIPHTHONG ‘OI’

The diphthong ‘OI’ is a first place diphthong and is always written

at the beginning of the consonant; thus

             boy,           joy,                 boiling,            toil,              coil.

It is always joined initially to upward L; thus,

           oil,                  oiling,             oilship.
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DIPHTHONG ‘U’.

Diphthong ‘U’ is a third-place diphthong and must always be written

at the end of the stroke. It may be joined to downstrokes; thus,

             pew,          due,             few,            Mathew,            issue.

It is joined finally to k, g, m, n, l by slightly changing the angle for

convenience in joining; thus,

            kew,              argue,          mew,            value,               renew.

TRIPHONES

The TRIPHONE (tri = three + phone = sound) is a three vowel sound i.e. diphthong + any vowel. The triphone is

represented by adding a tick to the relevant diphthong sign; thus,

          dire, but           diary,              dialogue,              viola

           towl, but            towel,              tower,            power

          boy, but            buoyant,        boyish,             loyal

         due, but             dual,              tenuous,           duet.

Abbreviated ‘W’ and Diphones

Objectives: At the end of this lesson you shall be able to
• explain abbreviated ‘w’
• state alternative forms and their uses
• explain Diphones.

Alternative forms and their uses

• Abbreviated W
• Diphone

Abbreviated ‘w’

The consonant ‘w’ represented by initially hooked straight upstroke is also represented by an abbreviated form of right

semi circle. The initial sound of ‘w’ before ‘k’, ‘g’, ‘m’, ‘ray’, ‘ar’, is represented by the right semi-circle; thus,

Alternative forms and their use

a. Abbreviated W (Semi circle): The initial sound of W, is represented in many cases by semi-circles to obtain clear

outlines, Thus
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but when initial sound of W is preceded by a vowel the stroke ‘w’ must be written, as in

b.  A small hook is attached before L stroke to represent the initial W sound, as in

c. The semi-circle can also be used in the middle and in the end to represents W/V sounds wherever convenient,
as in

Diphones
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Office Administration and Facility Management          R.Theory for Ex 1.1.10
Stenographer Secretarial Asst. (Eng) -  Fundamentals of SH & Windows OS

Practicing of spelling using dictionary

Objectives: At the end of this lesson you shall be able to
• explain how to find words which you are not familiar
• state the method of finding words quickly
• explain the correct meaning of the word.

How to use a dictionary effectively

A dictionary is a very important tool for anyone who is
learning a new language. With a good dictionary you can
do the following:

• look up the meaning of an English word you see or
hear

• check the spelling of a word

• check the plural of a noun or past tense of a verb

• find out other grammatical information about a word

• check the part of speech of a word

• find out how to say a word

• find examples of the use of a word

To be a good dictionary user, however, it is not enough to
know what to use the dictionary for. You must also decide
which is the best dictionary for any of the purposes listed
above. As well as this, you need to be able to find what
you are looking for quickly; you need to be sure that you
have found what you were looking for; and, most impor-
tantly, you need to know when to use your dictionary.

Finding words quickly

This is a skill that you need to practise. Ask someone to
write down 5 words and see how long it takes you to find
them. Of course, you will need to know the English alpha-
bet perfectly, so practise this too. Use the guide words at
the top of each dictionary page; and keep practising until
you can find any word within 10 seconds. You should also
practise finding words in your own language in your bilin-
gual dictionary. If you use an electronic dictionary, take
some time at home to learn how it works and, again, prac-
tise finding words quickly.

Finding the right meaning of an English word

Very often when you look up a new English word, you find
that it has more than one meaning. If you are not sure
which one is correct, here's what you can do:

• First, check through all the meanings and find the one

that makes most sense in the context where you found
the word. (Very often, many of the different meanings
are similar and this should be enough to give you a
good idea what the word means)

• Second, if you really want to make sure, think what

the word is in your own language and look it up in a
bilingual dictionary. If one of the English translations is
the original word you looked up, then you can be satis-
fied that you have found the right meaning.

Finding the right spelling

Another problem you may have is when you want to check
your spelling but you can't find the word you're looking for.
What can you do?

• If you are sure of the first few letters, just look down

the page until you find the right spelling. (Again, it is
helpful to check the meaning is the one you expect.)

• If you are not sure of the first few letters, try some

other possibilities. You know for example that some
words that start with an -n sound have k as their first
letter; e.g. knife, knight. So if you can't find the word
under N, try looking in the K pages.

• If you still can't find the word, think what it is in your

language and look it up in When you find a new word
while reading, finish the sentence (better: the para-
graph). If you haven't guessed the meaning and it still
seems important, then you can look it up. To avoid
interrupting your reading for too long, you should find
its meaning in your own language using a bilingual dic-
tionary.

• When you hear a new word in class (or the teacher

has written it on the board), wait and continue listen-
ing. What the teacher says next may help you to un-
derstand the word. If you look in your dictionary, you
will not hear what comes next, and this will make un-
derstanding the lesson more and more difficult.

If you think the word is very important, you could copy it
from the board or write how you think it is spelled. Then
later you could ask the teacher or another student what it
means.
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Office Administration and Facility Management          R.Theory for Ex 1.1.11
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Creation of login account

Objectives: At the end of this lesson you shall be able to
• explain how to create log-in account on your computer
• state the steps to create user accounts
• explain how to set user name and passwords.

Creating a new user account in Windows 7 and
Windows Vista

Windows 7 and Windows Vista allow you to have multiple
users sharing the same computer under their own indi-
vidual accounts. This allows each individual user to have
their own location on the computer where they can store
their personal documents, pictures, videos, saved games,
and other personal data. This also allows the owner of the
computer to assign certain accounts the ability to perform
administrative tasks like installing software, while limiting
other user's abilities.

Steps to create a new account in Windows 7 and
Windows Vista

1 Click on the Start button. This is the small round but-
ton ( ) in the lower left corner of your screen that has a
Windows flag on it.

2 Click on the Control Panel menu option.

3 When the control panel opens you will see a screen
as in Figure 1.

Fig 1

1 Click on the Add or remove user accounts control panel
option as shown by the red arrow in figure 1.

2 You will now be in the Manage Accounts control panel
as in Figure 2

3 This screen shows all the accounts currently on your
computer. To create a new account, click on the Cre-
ate a new account option as shown by the red arrow
above.

4 You will now be at the Create New Account screen.
(Fig.3)
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Fig 2

Fig 3

1 In the New account name field enter the name of the
new account that you would like to create. This could
be a person's first name, full name, or whatever other
designation you would like to give. You then need to
decide which of the two types of accounts you would
like to create. An Administrator account has full ac-
cess to the computer and can make all changes, in-
stall software, and create and delete accounts. The
other type of account is Standard user and has limited
privileges as to what settings and changes it can make
to the computer. It is suggested that for all users, you
set them as a Standard User account and have one
administrator account that you can logon to as needed.
This will protect your computer from malware and other
harmful activities.

When you have finished selecting a name and the type
of account you wish to setup, you should click on the
Create Account button.

2. Your new account will have been created and you will
see it listed in the Manage Accounts screen. (Fig.4)
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Fig 4

1 As you can see  new user, named Test Account, has
been created.

Now when you start Windows 7 or Vista, you will see the
additional account listed in the logon screen. That user
can then select their login name and login into their profile
so they can access their private data.
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Office Administration and Facility Management          R.Theory for Ex 1.1.12
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Practicing of typing using tool bars and menu bars

Objectives: At the end of this lesson you shall be able to
• state different tool bars and menu bars
• identify different tool bars and its functions
• explain how to open menu bar for different functions.

Tool bars and Menu bars

The toolbar, also called bar or standard toolbar, is a
row of boxes, often at the top of an application window,
that control various functions of the software. The boxes

often contain images that correspond with the function
they control, as demonstrated in the image below.

Microsoft Windows Window (Fig.1)

Fig 1

A toolbar often provides quick access to functions that are
commonly performed in the program. For example, a for-
matting toolbar in a Microsoft Excel gives you access to
things like making text bold or changing its alignment,
along with other common buttons. In an Internet browser,

toolbars add functionality that may not come pre-installed.
For example, with the Google toolbar, you can get access
to exclusive Google features.

Common computer software toolbars and other bars.

Bar chart

Barcode

Browser toolbar

Bookmarks bar

Commands bar

Formatting toolbar

Formula bar

Menu bar

Navigation bar

Places bar

Progress bar

Scroll bar

Split bar

Status bar

Title bar

A chart consisting of horizontal or vertical bars.

A series of lines that identifies an address, product, or other information

Any toolbar in a net Browser

Bar showing frequently visited bookmarks or favourites

A bar that shows available commands in a program

Toolbar that shows text formatting options.

Bar in a spreadsheet program that allows you to edit a formula.

A bar at the top of the screen that gives access to all of the  menus

Gives access to all navigation features in a browser.

A pane that shows common places to access files.

An indicator that shows how long until something is  completed

A bar on the bottom or side of the window to scroll through a page.

A bar that divides the window into multiple sections

One of the few bars at the bottom of the window that shows the   status

A bar at the very top of a window that describes the program or window
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Office Administration and Facility Management    R.Theory for Ex 1.1.13&14
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Alternative form of R&H strokes - Thick downward R&H - their uses
abbreviated W & Diphone

Objectives: At the end of this lesson you shall be able to
• state the rules governing the use of upward and downward R
• explain when and where upward H and downward H are used
• explain the use of Thick downward R & H.

Downward R & H

Alternative forms For ‘R’ And ‘H’

Consonant ‘R’

The  Liquid consonant ’r’ is the most frequently occuring consonant in English language.  It is provided with two alterna-

tive forms; one is downward             and the other is upward           .These two forms are provided for easy joining with other

strokes and also to indicate the occurrence of initial or final vowel sound.

When preceded by a vowel, initial ‘r’ is written downward; thus,

When not preceded by a vowel, upward ‘R’ is written; thus,

Generally,initial or final ‘r’ is written upward when followed by vowel; thus,

Initial or final ‘r’ is written downward when not followed by vowel; thus,

Before ‘m’, initial ‘r’ is always written downward for easier joining; thus,

CONSONANT ‘H’

The consonant ‘h’ is also provided with two alternative forms – upward          and          downward .

The upward form of ‘h’ is generally employed; thus
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A small circle can only be attached finally to the compound consonant ‘lr’; thus,

                                       counsellors

When a strongly sounded vowel occurs between ‘l’ and ‘r’, strokes ‘l’ and ‘r’ are to be used;

When a vowel follows final ‘lr’, stroke ‘l’ and ‘r’ are to be used; thus,

                foolery,

When ‘l’ is having an initial attachment like circle, loop, or hook, ‘lr’ is not used and strokes ‘l’ and ‘r’ are to be used;

thus,

The downward ‘l’ is thickened for the addition of ‘r’ and thereby represents the compound consonant of ‘lr’. The vowel
between ‘l’ and ‘r’ is generally unaccented. Short vowels ‘e’, ‘a’, ‘u’, etc. generally occur between ‘l’ and ‘r’( –lar, -ler, -lour),
thus,

The downward form is used when ‘h’ is standing alone or when it is immediately followed by ‘k’ or ‘g’; thus,

Thickened LR/RR

After straight downstrokes of p, b, t, d, ch, j, k, g, s, m. l(up) ‘lr’ is written with strokes ‘l’ and ‘r’; thus,

After straight downstrokes, horizontals or upstrokes or right-hand curves with final circle, ‘lr’ is written with strokes ‘l’ and
‘r’; thus,

The downward ‘r’ is thickened for the addition of ‘r’ and thereby represents the compound consonant of ‘r+er’. The vowel
between ‘r’ and ‘r’ is restricted to the short vowel ‘e’. Hence, if any other vowel occurs between ‘r-r’, the compound
consonant of ‘rer’ is not used; thus,
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Aspirate H

The consonant H is represented not only by the upward stroke but also by a downward form of H. Various forms of H have
been provided for easy and speedy writing in shorthand.

Downward ‘H’

The downward form of ‘h’ is used when standing alone; thus,             hew,              high; and in the compound words

and derivative words, such as,            hewer,           highway,           high-class.

Before ‘k’ ‘g’ ‘m’ ‘l (up)’ ‘r(down)’, downward form of ‘h’ is used;

thus,          hook,          hog,              hackney,              Higgins,            ahem.

After upward ‘l’ and horizontal strokes, ‘h’ is written downward;

thus,            Lahore,             cohere,             maharaja,            unhook.

In a few cases when ‘h’ occurs after curved strokes, the circle of ‘h’ is

written inside the curve; thus,          Sahara,            Sheehy.

In a few cases where ‘s’ and ‘h’ occur consecutively and medially, the circle is enlarged to represent ‘s’ and ‘h’; thus,

          Fitzhugh,             race-horse.

Aspirate H: Tick & Dot H, Downward & Upward stroke H, Upward & Down-
ward stroke ‘SH’

Objectives: At the end of this lesson, you shall be able to
• explain the alternative forms of aspirate H
• state the TICK & DOT H & UPWARD SH
• describe phraseography.

Initially, small circle ‘s’, large circle ‘sw’, small loop ‘st’, tick ‘h’ may be prefixed; thus,

Finally, small circle ‘s’ can only be added to the compound consonant ‘rer’; thus,
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In a few cases when ‘h’ occurs after another stroke, it is to be written in such a way that ‘h’ should

not be misread as ‘s-ch’ or ‘s-r’; thus,

compare           cohere but          exchequer;            observer but                 abhor.

Upward ‘H’

The upward form of ‘h’ is used in most of the cases, as it joins with other strokes and abbreviated

forms, more easily; thus,         happy,          head,        hitch,        huge,        hash,  honey,

          hang,        hurry,       host,         hisses,        hive,        hen,         hawker,          heckle,

         hammer,        behave,         overhaul.

Before ‘m’ ‘l’ and ‘r’, initial ‘h’ is represented by a small tick written in the direction of downward ‘h’; thus,                ham,

             hell,             hare.

The tick ‘h’ may be used medially also in phraseography words); thus,

                 with-whom,                    for-her,               to-her,             of-her

DOT ‘H’

In some cases where stroke ‘h’ cannot easily be written in the middle of a word, ‘h’ is represented by a light dot

before the vowel to which ‘h’ is attached; thus,                      manhood,                      likelihood,                 pinhole,

                  glasshouse,                    neighbourhood,                downhill,                  uphill,                  leasehold.

The dot ‘h’ is never used initially.

Upward and downward ‘SH’

‘sh’ when standing alone with or without initial or final attachment is written downward; thus,

           ash,           ashes,           shoe,            shoes,           usher,          Swash,          shine,

           ocean,          ushers.

When attached to a straight stroke, ‘sh’ is generally written downward; thus,            rash,

            sherry,     cherish,           shake.

When attached to straight downstroke with initial attachment, ‘sh’ is written on the opposite side of

the initial attachment; thus,          splash,                 brush,              blush, but after ‘d’ it is

written upward; thus,        dash.

When ‘sh’ is joined to a curve, it generally follows the motion of that curve; thus,            fresh,

           afresh.

‘Sh’ is written downward after ‘n’; thus,             gnash

TICK ‘H’
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Office Administration and Facility Management           R.Theory for Ex 1.1.15
Stenographer Secretarial Asst. (Eng) - Fundamentals of SH & Windows OS

Phraseography - Formation of simple phrases

Objectives: At the end of this lesson, you shall be able to
• define Phraseography and Phraseogram
• explain the importance of Phraseography
• explain the importance of position writing of a phraseogram.

Phraseography - Formation of Simple Phrases

Phraseography in shorthand is writing two or more words together, without lifting the pen. The resultant outline is
called phraseogram.

• You can write your own phrases subject to the following rules:

• The qualities of best phraseogram are facility, lineality and legibility.

• A phraseogram should neither ascend too far above the line, nor descend too far below the line, the reason being, if

the hand is carried too far away from writing line, it will take some time to come back to the writing line to take up
the next outline.

• A phrase must be easy to write.

The terms of facility, lineality and legibility are discussed below:

Facility: Phraseogram should be easy to write even in high speed.

Lineality: Phraseogram should not go up too far above the line of writing and should not go down too far below the
line of writing.

Legibility: Phraseogram should be easily readable at first sight.

The first word hould be written in its own position and the rest will follow it; thus,         how-can-they,         it-would-be,

             I-have-the.

When the first stroke in the phraseogram is of first place, the same may be slightly raised or lowered, so that the

second stroke can also be written in its own position for easy deciphering; thus,          I-thank-you,          with-much,

         with-which,             with-each.

Before ‘k’, ‘m’, ‘l’(up) ‘I’ is written with a single tick; thus,            I-can-be,              I-may-be,            I-will-be.

In phraseography        ‘he’ is represented by stroke initially, and by logogram medially; thus,         he-may,

                if-he-may,              heshould-know,                 if-he-should-know.

In phrases,         ‘much’ is written in full as            for easier joining and also to distinguish from ‘which’ and ‘each’;

thus,           so-much,            how-much,          too-much.

‘Were’ is represented by         or             whichever joins easily in phrases; thus,            you-were,              if-you-

were,             they were,                if-they-were.

In phrases, the word ‘him’ is represented by inserting a dot vowel at third place, to distinguish it from ‘me’ ‘am’, ‘my’

etc.; thus,                 of-him,              to-him.

Generally there is no need of vocalization (placing vowel signs) in phraseography.

-----------

--------
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Phrases

I thank you why have you

I think you should be with you

I have the too much

I have had with much

I saw the with which

I see with each

I am when they

I may be what do you

I will what was

I will be what can be

you should it would be

you should be it should be

you can it will be

you will it was

you will be which was

you may be which were

you were he should be

if you were he will be

they were if he

how can they if he were

why do you too much
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Special Phrases and Words

A group of words which makes sense, though not complete sense, is called a phrase. In addition to these, a number  of
Verbal Phrases (idioms) Parliamentary, Executive, Judicial, Departmental and Foreign phrases (words) are also used in
English language, which have to be practised thoroughly for speed writing.

Verbal Phrases

All languages have certain expressions which are peculiar to them and lend special meaning to the words and phrases
known as idioms.  English language is rich in such expressions. Thus idiomatic phrases are formed by the combination
of verbs, prepositions, adjectives, adverbs, nouns, etc., However, some important phrases given in this lesson will help
you realize their utility in the day to day working.

Phrases are of great help in Shorthand. Therefore, phrases should be short, simple and sure to enable speedy writing
reading and correct transcription.

Verbal Phrases (idioms)
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Parliamentary Phrases

S.No. Words    Out lines

1. I would like to know

3. I would like to submit

5. My hon'ble friends

7. In this House

9. Human lives

11. both Houses of Parliament

13. To the best of their ability

15. From time to time

17. Inspite of the fact that

19. In regard to the

21. With regard to the

23. Keep(ing) in view

25. In view of

27. on his behalf

29. on their  behalf

31. Members of Parliament

33. Ifs and buts

35. Mr Deputy Speaker

S.No. Words     Out lines

2. I would like to state

4.          Hon'ble Members of this House

6. In the first instance

8. Pointed out

10. It will not be

12. To the best of my ability

14. To the best of your ability

16. Come to the conclusion

18. Having regard to the

20. In relation to

22. They were able to

24. On account of

26. On my behalf

28. On your behalf

30. Brought out

32. Social and economic

34. Honourable Minister

36. In this connection
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Executive Phrases

S. No.       Words    Out lines

2. From my point of view

4. Apart from the fact that the

6. In the course of the

8. On the table

10. Rajya Sabha

12. Will be taken into account

14. Taken into consideration

16. What is happening

18. What would happen

20. State of affairs

22. Assets and liabilities

24. Finance Minister

26. Fiscal targets

28. Mr. Vice Chairman

30. Let us try

32. Has to be considered

34. For your consideration

36. Shall be considered

38. Ought to be considered

S.No.     Words    Out lines

1. From the point of view

3. In view of the circumstances

5. I should like to conclude

7. From the facts

9. Lok Sabha

11. Will be taken into consideration

13. Will have to be considered

15. What has happened

17. It would have been

19. Balance sheet

21. Profit and loss

23. Deficit financing

25. Fiscal policies

27. Mr. Deputy Chairman

29. For a long time

31. Special consideration

33. For consideration

35. Under consideration

37. As a result of
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Office Administration and Facility Management          R.Theory for Ex 1.2.16
Stenographer Secretarial Asst. (Eng) - Formation of words, phrases and
practice of MS Word

Computer keyboard operations

Objectives: At the end of this lesson you shall be able to
• narrate the correct sitting posture in front of a computer
• explain sight and touch method of typing
• understand the correct finger positioning
• explain home row, upper row and botton row of keyboard.

• Adjust the chair height so your feet are flat on the floor

and your knees are in line (or slightly lower) with your
hips.

• Sit up straight and keep your hips far back in the chair.

• The back of the chair should be somewhat reclined at

a 100- to 110-degree angle.

• Ensure the keyboard is close and directly in front of

you.

• To help your neck stay relaxed and in a neutral posi-

tion, the monitor should be directly in front of you, a
few inches above eye level.

• Sit at least 20 inches (or an arm's length) away from

the computer screen.

• Relax the shoulders and be aware of them rising to-

ward your ears or rounding forward throughout the work-
day.

Sight & touch method

Sight method: In the Sight Method the Typewriting is
done by looking at the Keyboard and the material which is
to be typed by the Operator. The Operator reads a few
words from the matter to be typed, types the same by
looking at the Keyboard and then again reads some words
and types them again and goes on repeating this process
till the whole page is typed. In this method all the fingers
are not used. Only the 'forefingers' of both the hands are
used for typing in the sight method of typewriting. This
method is not scientific. In this method the Operator can-

Fig 1

not concentrate on the copy. It is not good for acquiring
high speed in typewriting.

Touch method: Touch typing is a method of typing with-
out the use of the sense of sight, or simply by feeling the
keyboard. However, the sense of touch is only slightly
involved since this typing method is governed by muscle
memory through rigorous training with the proper typing
method. This way, the fingers get so used to typing that
they instinctively go to the appropriate keys without the
typist needing to see or even feel around the keyboard.

Sitting posture (Fig.1)

Fig 2
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Home row

The home row keys are the row of keys on the com-
puter keyboard your fingers rest on when not typing. For
example, on the standard QWERTY United States key-

board, the home row keys for your left hand are A, S, D,
F and G and  your right hand are  ; (semicolon),L, K, J,H.
( Left index finger will touch F and G and right index finger
will touch J and H)

Fig 3

Upper row keys

The upper row keys are the ten keys found above the
home row keys on a QWERTY US keyboard. The top
row keys include the Q, W, E, R, and T keys for the left
hand and P,O,I,U, and Y keys for the right hand. (left in-

dex finger will touch R and T while right index finger will
touch  U and Y)

Bottom row keys

The bottom row keys are the ten keys found below the
home row keys on a QWERTY US keyboard. The bot-
tom row keys include the Z, X, C, V, and B keys for the
left hand and forward slash, period, coma, M, and N for
the right hand. (left index finger will touch V and B, while
right index finger will touch M & N)

Shift keys

The shift key is a modifier key on a keyboard, used to
type capital letters and other alternate "upper" charac-

ters. There are typically two shift keys, on the left and
right sides of the row below the home row.

Number row

The keys on which you see numbers: 0 - 9 are called
number keys. These are used to type numbers.
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MS Word - Creation of file and use of various tools

Objectives: At the end of this lesson you shall be able to
• explain MS Word 2007
• define how to start MS Word 2007
• explain office button, quick access toolbar, tabs, and ribbon
• explain common tools in MS Word 2007
• state how to create, open, save and close the word document
• define editing text, table, mail merge, page layout, clip arts, picture, shapes, page numbering
• explain formatting text, styles, table, page layout, clip arts, picture, shapes
• explain change the text style in Word document.

Microsoft Office 2007

Microsoft Office 2007 is a bundled application software
package introduced by Microsoft Corporation. Office 2007
has more features than the earlier version of office 2003.
Microsoft Office 2007 consists of the following popular
application packages:

• Microsoft Office Word 2007

• Microsoft Office Excel 2007

• Microsoft Office Access 2007

• Microsoft Office PowerPoint 2007

• Microsoft Office Publisher 2007

• Microsoft Office Outlook 2007

Microsoft Office Word 2007

Microsoft Office Word 2007 is a word processor. A word
processor is a software package that helps to create and
edit a document. Word perfect, Word star, Write, Microsoft
word are the popular word processors. Now, Microsoft word
is the most popular word processor today. It helps you
produce professional-looking documents by providing a
comprehensive set of tools for creating and formatting a
document, memos, letters, reports, brochures, business
documents and even internet web pages.

Starting word 2007 application

Click the Mouse on Start  All Programs  Microsoft
Office 2007  Microsoft Office Word 2007. Microsoft
Office Word 2007 opens along with a default blank document
named with Document1 and has tabs and buttons. 1) Office
button, 2) Quick Access Toolbar, 3) Tabs, and 4) Ribbon
as on Fig 1.

Office Administration and Facility Management          R.Theory for Ex 1.2.17
Stenographer Secretarial Asst. (Eng) - Formation of words phrases and
practice of MS Word

MS Word - Creation of files - use of various options

Objectives: At the end of this lesson you shall be able to
• explain MS word 2007
• define how to start MS word 2007
• identify and explain office button, quick access toolbar, tabs and ribbon
• state how to create, open, save and close the word documents
• define editing text, table, mail merge, page layout, clip arts, picture, shapes, page numbering.

MS Office 2007

Microsoft Office 2007 is a bundled application software
package designed specifically to be used for office, home
or business use. It is a proprietary product of Microsoft
Corporation and was first released in 1990. Microsoft of-
fice consists of the following popular application packages:

• Microsoft Word 2007: Helps users in creating text

documents.

• Microsoft Excel 2007: Creates simple to complex data/

numerical spreadsheets.

• Microsoft PowerPoint2007: Stand-alone application

for creating professional multimedia presentations.

• Microsoft Access 2007: Database management ap-

plication.

• Microsoft Publisher 2007: Introductory application for

creating and publishing marketing materials.

• Microsoft Office Outlook 2007: Used mainly as an

email application.

Introduction to MS Word 2007

Microsoft Word is one of the most popular software pro-
grams in the world, used by millions of office workers,
students and home users to create, read and edit docu-
ments. Many people don't use all the features of MS Word
because not all of them are necessary for every user. It
can be useful to familiarize yourself with the basic fea-
tures and characteristics of MS Word, even if you don't
need them all immediately.
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Office Button Quick Access Toolbar Tabs RibbonFig 1

1 This is the Office button which is similar to the File menu
in MS word 2003 as on Fig 2.

A Start new project; Open a Project, Save, Print, etc.

B This shows recent documents and is a quick way to
open a recent project.

C This opens the Word Options window where you can
change settings and customize your Quick Access
Toolbar.

Fig 2

They will be placed in the order they are selected. Again to
customize this Quick Access Toolbar go to the office
button and select Word Options. Click customize on the
left and search for any buttons that suit needs. A Shortcut
to customize this bar is to right click in the Tabs bar and
select Customize Quick Access Toolbar.

3 This is the Tabs Bar. Tabs are similar to the menu
system of MW2003 instead of having dropdown menus.
MsWord 2007 created the Tab and Ribbon system.
When you select a tab it will display the Ribbon
associated with that tab. Here everything has been
changed into button form.

4 The tabs display a Ribbon. In this Ribbon there are
many buttons that are grouped into categories such as
Clipboard, Font, and Paragraph as on Fig 3.

It will help if you take a couple minutes to look through all
the tabs and Ribbons to learn the layout and to remember
where to find buttons when working on projects and papers.
Another new feature is the preview feature.

If you scroll your mouse over one of the Styles in the Home
tab it will show in your paper what it will look like before
clicking the style. Now the categories in each Ribbon may
have a button at the end of its bar.

If you click this button it will expand into a window and show
more options.(Fig 4). For example the Font category will
expand into a window where it will have all the settings for
the font and character spacing.

1 Title bar will appear at the top of the application
window. It displays the name of the currently active
word document1 along with a name of application.

2 Office button contains the file attribute options and
recently opened document list to quick access. It has
the word options to set the properties of few actions.

3 Menu bar Shows the Home, Insert, Page Layout,
references, Mailings, Review, View menus and Help
button.

4 Vertical scroll is bar used to align text or objects in the
document. The measuring units can be changed ac-
cording to our requirements.

5 Status bar shows the current position of the cursor
and indicates page number and words.

2 This is the Quick Access Toolbar. With this tool bar
one can set it up to needs. To do so just click the arrow
at the end of this bar and select which items best suit
needs.
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1. Title bar

2. Office button

3. Menus

4. Vertical Ruler

5. Status bar

6. Layout view

7. Zoom

8. Vertical Scroll bar

9. Close button

10.Maximize button

11.Minimize button

12.Styles

13.Horizontal Ruler

14.Formatting tools

15. Tab setting button

16.Customize Quick Access Toolbar

17.Work area

Fig 4

6 Layout View can be used to switch the view mode of
the active document. This contains Print Layout, Full
Screen Reading, Web Layout, Outline and Draft.

7 Zoom option can be used to zoom the document to
fine tune the objects and read text clearly. The Zoom
options has 10% to 500% enlargement.

8 Horizontal Scroll bar is used to move the document
up/down to view the entire document

9 Close button is located at the top right corner of the
window. It is used to close the document as well as
the application window.

10 Maximize buttons are used to maximize the docu-
ment when it was minimized.

11 Minimise button, when this button is clicked the
active document will be minimized on to the taskbar
of the windows.

12 Styles are some pre-defined format for the quick
format for the text.

13 Horizontal ruler is useful to align text and objects and
the tab settings can be done on the horizontal ruler.

14 Formatting tool bar is important to give print effects to
the text document such as fonts, point size, toggle
bold, italic & underline, bulleting and number- ing

15 Tab button is the place where the type of tab can be
selected such as left tab, right tab, centre tab, deci-
mal tab, etc.,

Fig 3
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16 Customize Quick Access toolbar is a shortcut bar
where the familiar and repeat functions tools can be
kept there.

17 Work space the space is the area in which you can
enter the text of your document.

Create a New Document

There are several ways to create new documents, open
existing documents, and save documents in Word:

• Click the Microsoft Office Button and Click New or

• Press CTRL+N (Depress the CTRL key while pressing
the "N") on the keyboard

When you click on the Microsoft Office Button and Click
New, you have many choices about the types of docu-
ments you can create. If you wish to start from a blank
document, click Blank as on Fig 5.

If you wish to start from a template, you can browse through
your choices on the left, see the choices on center screen,
and preview the selection on the right screen.

Fig 5

Opening an Existing Document

• Click the Microsoft Office Button and Click Open, or

• Press CTRL+O (Depress the CTRL key while pressing
the "O") on the keyboard, or

• If you have recently used the document you can click
the Microsoft Office Button and click the name of the
document in the Recent Documents section of the
window. Insert picture of recent docs

Saving a Document

• Click the Microsoft Office Button and Click Save or Save
As (remember, if you're sending the document to
someone who does not have Office 2007, you will need
to click the Office Button, click Save As, and Click
Word 97-2003 Document), or

• Press CTRL+S (Depress the CTRL key while pressing
the "S") on the keyboard, or

• Click the File icon on the Quick Access Toolbar

Close a Document

To close a document

• Click the Office Button

• Click Close Editing a Document

Typing and inserting Text

The text will appear where the blinking cursor is located.
Move the cursor by using the arrow buttons on the
keyboard or positioning the mouse and clicking the left
button. The keyboard shortcuts listed below are also
helpful when moving through the text of a document

Move Action Keystroke

Beginning of the line HOME

End of the line END

Top of the document CTRL+HOME

End of the document CTRL+END

Selecting Text

To change any attributes of text it must be highlighted first.
Select the text by dragging the mouse over the desired text
while keeping the left mouse button depressed, or hold
down the SHIFT key on the keyboard while using the arrow
buttons to highlight the text. The following table contains
shortcuts for selecting a portion of the text.

Selection            Technique

Whole word double-click within the word

Whole paragraph triple-click within the para
graph

Several words or lines hold down SHIFT while using
the arrow keys

Entire document choose Editing | Select | Se
lect All from the Ribbon or
press CTRL+A

Deselect the text by clicking anywhere outside of the
selection on the page or press an arrow key on the
keyboard.

Inserting Additional Text

Text can be inserted in a document at any point using any
of the following methods as on Fig 6.
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Cut and Paste Text: Highlight the text you wish to copy,
right click, and click Cut, put your cursor where you want
the text in the document, right click, and click Paste.

Drag Text: Highlight the text you wish to move, click on it
and drag it to the place where you want the text in the
document. As on No.

Rearranging Blocks of Text

To rearrange text within a document, you can utilize the
Clipboard Group on the Home Tab of the Ribbon as on
Fig 7

Insert picture of clipboard group labelled

• Move text: Cut and Paste or Drag as shown above

• Copy Text: Copy and Paste as above or use the
Clipboard group on the Ribbon

Paste Text: Ctrl + V (hold down the CTRL and the "V" key
at the same time) or use the Clipboard group to Paste,
Paste Special, or Paste as Hyperlink

Deleting Blocks of Text

Use the BACKSPACE and DELETE keys on the key-
board to delete text. Backspace will delete text to the left

Fig 7

Fig 8

Fig 9

Fig 10

Fig 6
of the cursor and Delete will erase text to the right. To
delete a large selection of text, highlight it using any of the
methods outlined above and press the DELETE key.

Search and Replace Text

To find a particular word or phrase in a document:

• Click Find on the Editing Group on the Ribbon

• To find and replace a word or phrase in the document,
click Replace on the Editing Group of the Ribbon as on
Fig 8.

Undo Changes To undo changes

• Click the Undo Button on the Quick Access Toolbar as
on Fig 9.

Format text

The easiest way to format text is to make use of the
formatting toolbar. The formatting toolbar is shown in
(Fig.10) and can be found under the HOME Menu toolbar.
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Font menu: Allows you to choose from a wide number of
fonts. To select a particular font click on the arrow head
beside the box, scroll down with the scrollbar until you
select a particular font and select it by clicking on it.

Font Size: Select a size for your font by clicking on the
arrowhead and scrolling down and clicking on the size that
you desire. If you want to change the font of text which has
already been typed in, highlight the text and then select the
size as mentioned above.

Font Style: You may select whether you want to make the
font Bold, Italicized or underlined.

Alignment: The text may be aligned to the left, right or
center or can be aligned to the right side or can be justified
across the page.

Fig 11

Outside Border: Add a border around a text selection.

Highlight Color: This option may be used to change the
color behind the selected text.

Text Color: This option changes the color of the text
selected.

The Font dialogue box allows you to select from a larger
selection of formatting options. Click on the down arrow
button on the Font toolbar to access the box as on Fig 11.

Numbered and Bulleted lists: Creates a numbered or
bulleted list.

Increase/Decrease indent: Change the indentation of a
paragraph in relation to the side of the page.

Formatting Paragraphs

A paragraph may be formatted by placing the cursor within
the paragraph and selecting the downward arrow, in the
paragraph Section of the HOME menu toolbar. (Fig 12)

• Alignment: This is used to align the text horizontally
either to the

• left, center, right or justified.

• Indentation: This indicates the distance the text is
indented from

• the left and right edges of the page.

• Special: Select special indents for first lines and
hanging indents.

• Line Spacing: Set the line spacing for the text.

Change a Style in Microsoft Word 2007

Using Styles in Microsoft Word 2007 is an efficient way to
format documents as on Fig 13. However, you may on
occasion have problems changing Styles. If you are having
problems changing Styles, the following may help you.

This may even be helpful for you if you have successfully
changed Styles in Microsoft Word 2007 in the past, but for
some reason the changes now do not seem to take effect.

Quick Styles are styles promoted into Word 2007's Styles
gallery on the Home ribbon.

• Quick Styles provide easy access to and visibility of
frequently used styles.

• Quick Styles provide an thumbnail preview to the
formatting of a style.

• Styles applied in a document, by default, appear in the
Quick Styles gallery.

• New styles created in Word 2007, by default, become
a Quick Style.

• Quick Styles are quickly defined from the right click
menu and travel with the document.

Insert Tab

The Insert Tab is right next to the Home Tab in Microsoft
Word 2007. This tab has a lot of useful features that will let
you insert things like pictures, clip art images, shapes,
Smart Art graphics, charts and a host of other items. Let
us review a few of these features in this exciting new tab.
Before that here is a screen shot of the insert tab shown
Fig 14.

A common task in Microsoft Word is to add a Page Break.
For this practice use the definition assignment document
as illustrated below.
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Fig 13

Fig 14

Fig 15

Fig 12

To add a page break right before the Research Analysis
section. In order to do this in Microsoft Word 2007 select
the Insert Tab and then select the Pages group and then
choose Page Break.

Here is a screen shot of this action as on Fig 15.

Adding Tables

Tables are used to display data in a table format.

Create a Table

To create a table

• Place the cursor on the page where you want the new
table

• Click the Insert Tab of the Ribbon as on Fig.16

• Click the Tables Button on the Tables Group. You can
create a table in one of four ways

• Highlight the number of row and columns

• Click Insert Table and enter the number of rows and
columns
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Fig 16 • Click the Draw Table, create your table by clicking and
entering the rows and columns

• Click Quick Tables and choose a table

Enter Data in a Table

Place the cursor in the cell where you wish to enter the
information. Begin typing.

Modify the Table Structure and Format a Table

To modify the structure of a table

• Click the table and notice that you have two new tabs
on the Ribbon: Design a Layout as on Fig 17.

These pertain to the table design and layout.

On the Design Tab, you can choose

• Table Style Options

Fig 17

• Table Styles

• Draw Borders

Fig 18

To format a table, click the table and then click the Layout
Tab on the Ribbon as shown in Fig 18.

This Layout tab allows you to

• View Gridlines and Properties (from the Table Group)

• Insert Rows and Columns (from the Rows & Columns
Group)

• Delete the Table, Rows and/or Columns (from the Rows
& Columns Group)

• Merge or Split Cells (from the Merge Group)

• Increase and Decrease cell size (Cell Size Group)

• Align text within the cells and change text directions
(Alignment Group)

Word 2007 allows you to insert illustrations and pictures
into a document. To insert illustrations as shown in Fig 19.

Insert Picture

The first selection in Illustrations is Insert a picture from a
file as on Fig 20.

When clicked on this a window will open. Browse to a
photograph or other picture you have saved on your

Fig 19

computer. Use this to create birthday invitation for friends
with their current picture in the background. It can have a
lot of fun incorporating personal photos into the documents.

Clip Art

• Place your cursor in the document where you want the
illustration/picture

• Click the Insert Tab on the Ribbon

• Click the Clip Art Button
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• The dialog box will open on the screen and you can
search for clip art as on Fig 21.

Fig 20
• Choose the illustration you wish to include

Smart Art

• Smart Art is a collection of graphics you can utilize to
organize information within the document. It includes
timelines, processes, or workflow

• Place your cursor in the document where you want the
illustration/picture

• Click the Insert Tab on the Ribbon

• Click the Smart Art button

• Click the Smart Art you wish to include in your docu-
ment as on Fig 22.

• Click the arrow on the left side of the graphic to insert
text or type the text in the graphic.

Fig 21

Fig 22
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In the Active Voice, the subject of the sentence does the
action.

Example 1: Ravi   wrote   a letter (Active Voice)

            (Subject)  (Verb)  (Object)

In the Passive Voice, the subject of the sentence was
acted upon

A letter was written by Ravi  (Passive Voice)

  (Subject)  (Verb)     (Object)

Notice that the object of the Active sentence became the
subject of the Passive sentence

Rules for changing Active Voice into Passive Voice:

Identify the subject, verb and the object

Change the object  into subject

Put the suitable auxiliary verb

Change the verb into past participle of the verb

Add the preposition 'by'

Change the subject into object

Office Administration and Facility Management          R.Theory for Ex 1.2.18
Stenographer Secretarial Asst. (Eng) - Formation of words phrases and
practice of MS Word

Grammar - Active Voice and Passive Voice

Objectives: At the end of this lesson you shall be able to
• identify sentences according to their voice
• recall rules for changing active voice into passive voice
• recall rules for changing passive voice into active voice.

Example 2: The hunter killed the Tiger. (Active Voice)

                  (Subject)  (Verb)     (Object)
becomes

The tiger was killed by the hunter. (Passive Voice)

    (Subject)   (Verb)    (Object)

We do not include 'by' when the doer of the action is un-
known or unimportant as in the sentence "The money was
stolen".

We cannot  use Passive Voice with intransitive verbs (verbs
that have no object)

Ex: He fixed the clock. (Active Voice)

becomes

The clock was fixed (Passive Voice)

Now, look at the following sentences:

1 He laughed

2 They are coming soon

3 An accident has happened.

(In the above sentences,  laugh, come, happen are intran-
sitive verbs. There are no objects. Therefore there is no
possibility of changing these sentences into the Passive
Voice)

Structure Example

Active Voice
Passive Voice

Active Voice
Passive Voice

Tense

Simple Present

Present Continuous

Present Perfect

Present Perfect Continuous
x

Simple Future

S + Verb
S + am/is/are + Past Participle

S + am/is/are + Verb-ing
S + am/is/are + being + Past Participle

S + have +/has + Past Participle
S + have/has + been + Past Participle

S + have/has + been + Verb-ing
S + have/has + been + being + Past
Participle

S + will/shall + Verb
S + will be + Past Participle

I make a sweet
A sweet is made by me

They are drinking coffee
Coffee is being drunk

Someone has eaten my cake
My apple has been eaten by someone

Ramu has been playing badminton
Badminton has been being played by
Ramu

My friends will take me to the party
I will be taken to the party by my friends
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Structure Example

Active Voice
Passive Voice

Active Voice
Passive Voice

Tense

Future Continuous
Future Perfect

Future Perfect Continuous
Simple Past

Furture Perfect

S + will/shall +be + Verb-ing
S + will/shall + be + being + Past
Participle

S + will + have + Past Participle
S + will have been + Past Participle

S + will + have been + V-ing
S + will + have been + being + Past
Participle

Vijji will be watching TV at 9 p.m. tonight
TV will be being watched by Vijji at  9
p.m. tonight

They will have finished the work before
Sunday

The work will have been finished before
Sunday

Vijji will be watching TV at 9 p.m. tonight
TV will be being watched by Vijji at  9
p.m. tonight

They will have finished the work before
Sunday

The work will have been finished before
Sunday

He will have been eating the fruits
The fruits will have been being eaten by him

They occupied the house
The building was occupied by them

Ramani was writing a letter
A letter was being written by Ramani

He had distributed the prizes
The prizes had been distributed by him

He had been preparing for the CA examina-
tion for two years before he moved to
Chennai

The CA examination had been being pre-
pared by him for two years before he moved
to Chennai

They can do it
It can be done by them

He might have injured Raju
Raju might have been injured by him

Future Continuous
Future Perfect

Future Perfect Continuous
Simple Past

Furture Perfect

Future Perfect Continuous

Simple Past

Past Continuous

Past Perfect

Past Perfect Continuous

Modal Verbs (Present)

Modal Verbs
(Present Perfect)

S + will/shall +be + Verb-ing
S + will/shall + be + being + Past
Participle

S + will + have + Past Participle
S + will have been + Past Participle

S + will + have been + V-ing
S + will + have been + being + Past
Participle

S + will + have been + V-ing
S + will + have been + being + Past
Participle

S + Verb
S + were/was + Past Participle

S + was/were + V-ing
S + were/was +being + Past Participle
S + had + Past Participle

S + Had been + Past Participle
S + Had been + Past participle

S + had been + V-ing

S + had been + being + Past Parti-
ciple

S + modal verb + Verb
S + modal verb + be + Past Participle

S + modal verb + have + Past Parti-
ciple
S + modal verb + have + been + Past
Participle
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Office Administration and Facility Management          R.Theory for Ex 1.2.19
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

Small Circle - Circle with stroke H and circle with stroke L

Objectives: At the end of this lesson you shall be able to
• express the sounds indicated by small circle at different places
• explain how circle is written to straight strokes and curved strokes
• state when small circle should not be exployed
• state how vowels to circles are written
• describe the use of circle with strokes L and H.

Circle - S
The consonant sounds S and Z are represented not only by the strokes S and Z but also by a small circle - o. Initially the
small circle represents the sound of S only and medially, finally the sound of S or Z. The circle is written
a. Inside the curves as in

b. Outside the angles formed by two straight strokes joined together as in

c. With left motion (anti-clockwise) to straight strokes, as in

d. Initial circle is read first and final circle is read last.  Vowels are read in relation to the stroke, not to the circle.

e. Circle S may be added to grammalogues and short forms to get derivatives of words, as in

Circle and the Strokes

Stroke S is used when it stands alone or when it is preceded by a vowel initially or followed by a vowel finally, as in

However, the stroke S is written finally to represent “-ous” when preceded by a diphthong/ diphone sound, as in
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Stroke Z is used initially and finally when followed by a vowel, as in

Circle before aspirate H

Initial sound of S followed immediately by H is represented by doubling the attachment (circle) of H.  The rule of upward

and downward H should be followed when initial S is immediately followed by H, as in

But the sound of SH is always represented by its stroke, as in

Stroke L and Circle S

Stroke L immediately followed or preceded by a circle attached to a curve, is written in the same direction in which the

circle is completed, as in

Grammalogues
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The following are some of the typing equations and formu-
las that are used in calculating  typing speed.

Gross WPM = (All typed entries) / Time (min.).

5

When calculating typing speed, a "word" is any five char-
acters. For instance, "I love keyboarding, don't you?" would
be counted as 6 words (30 characters / 5) and not just 5.
Spaces, numbers, letters, and punctuation are all included,
but any function keys such as Shift or Backspace are not
included. To give an example, if you typed 200 characters
in 1 minute, your net wpm typing speed would be (200
characters/5)/1 min = 40 WPM. If you typed 200 charac-
ters in 30 seconds your net speed would be (200/5) / 0.5
= 80 WPM.

Office Administration and Facility Management          R.Theory for Ex 1.2.20
Stenographer Secretarial Asst. (Eng) -  Formation of Words, Phrases and
Practice of MS Word

Speed calculation, counting of errors, evaluation and marking scheme,
Signs & symbols, Roman numbers and capitalization of letters, punctuation
marks

Objectives: At the end of this lesson you shall be able to
• state the formula for calculation of speed
• state the nature & treatment of errors
• state the evaluation scheme
• understand the formula for calculation of net speed.

Calculating speed on computer

Various methods of calculating Gross Speed, Net Speed,
and Assignment of marks are being used.  Best formula
has been evolved for counting of Gross speed, Net speed
and assignment of marks on the basis of minimum speed
prescribed. 5% errors are allowed.

Counting of strokes

5 Strokes constitute a word. In counting of strokes or let-
ters, every depression of a key is counted, including shift
key, tabulator bar, and space bar for leaving space be-
tween words. In this method the penalty for each error is
2 words which is universally prescribed limit. Before any
calculation is done mark the error in the typed script and
write the gross letters typed. Note the duration of the test

GROSS SPEED    GS = GL/5T (WPM)

GS= Gross speed   GL= Gross Letters     T= Time

NET SPEED   GL-PE/5T

PE = Penalty for errors (10 x Errors) 5 = (5 Strokes= 1
word)

Nature & Treatment of Errors

Overtyping of letter, wrong or non-use of punctuation marks,
wrong or non-capitalization of a letter, spelling mistake,
addition of any letter, typing of a figure forward or vice
versa, leaving no space between different words, wrong or
non-syllabification or words at the end of a line.

Evaluation Scheme

Test of computer

e.g. Speed Test (English) @ 30 WPM

Max. Marks Allotted = 100

(a) Qualifying Speed =30 wpm; Time = 10 Minutes

(b) Qualifying Marks (QM) = 60% of MM (100) =60

(c) Qualifying Penalty Marks (QPM) = MM - QM (100-
60=40)

(d) Marks Obtained (MO) = on applying the formula
given ahead.

(e) Error Committed = Gross Error - Error Admissible.

(f) PE for Penalty for Errors.

Errors Admissible (EA) = 5% of Gross Words Typed, e.g.
GW 300 = 15 WORDS.

Formula for Calculation of Net Speed

Net Speed   = GW (Gross Words) - PE = …w.p.m (words
per minute) T (Time)

A. Example 1 -If GW is = 300; EC = 15 ; The Net Speed
Calculation will be:

Net Speed = GW (300) - PE (2x5)   =    300 -0  = 30 wpm

     Time (10)                              10

B. Example 2 -If GW is = 300; EC = 20 ; The Net Speed
Calculation will be:

Net Speed = GW (300) - PE (2x5) =    300 -10  =  29 wpm

      Time (10)                                                          10

C. Example 3 -If GW is = 300; EC = 30 ; The Net Speed
Calculation will be:
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Net Speed = GW (300) - PE (2x5) =    300 -30  =  27 wpm

     Time (10)                                                           10

A. Marks Obtained = Maximum Marks(100) x Net Speed
(30)   -   QPM (40)  =Marks       Qualifying Speed (30)

     M.O. = MM(100) x NS(30)   - QPM(40)  = 60 Pass

QS(30)                                                            100

B.  M.O. = MM(100) x NS(29)   - QPM(40) = 56 Fail

QS(30)                                                              100

C. M.O. = MM(100) x NS(27)   - QPM(40)= 50 Fail

QS(30)                                                                100

D. M.O. = MM(100) x NS(40)   - QPM(40) =    93
(if  type speed increases)

QS(30)                                                              100

Evaluation Scheme - shorthand practical test

Treatment & Penalty for Errors

Errors Committed to be Marked on the Script and counted
as

Full/One Error to be marked by X sign on the script for the
following types of Errors

a. Omission/ addition/ substitution/ transposition of any
Word or figure

Spelling Error of a word (Spell check facility being avail-
able on Computers)

b. Half Error to be marked by an oval sign  for

• Non-capitalization of Proper Nouns or wrong capitali-
zation of first letter of a sentence (in English Short-
hand Transcription only);

• Spelling error of Proper Nouns (unpopular names or
places, etc.);

• Wrong or non use of Punctuation Marks.

• Maximum 1 Error should be marked for repeated spell-
ing errors of a word.

No Errors should be marked for improper
paragraphing

c. Total Errors  =  Full Errors + ½ of Half Errors;

d. Fraction of an error to be ignored and rounded off to the
nearest figure. Marks to be awarded on Full Errors (e.g.
round figures).

Shorthand Dictation Gross Speed = Total words/ Time

Formula for award of marks

5 Minutes Shorthand Tests @ 80 WPM and transcription
on computer in 45 minutes:

Details of Examination Scheme

(MM) Max Marks allotted = 100Qualifying Marks = 60%
of MM() = 60

(a) Total Words dictated @ 80 w.p.m. for 5 minutes
= 400 words

(b) Errors Admissible =Maximum 5% of total words (400)
= 20 (EA)

(c) Errors Committed (Errors committed by the candidate)
= Total/Actual Errors

(d) Qualifying Marks (60% of Max. Marks 100)
= 60 (QM)

(e) Qualifying Penalty Marks (MM (100) - QM (60)

= 40 (QPM)

Formula

Marks Obtained (MO)  =     MM (100) - EC  x QPM (60)

                          EA (20)

Examples 1 - A candidate committing 25 Errors will get = 100 -  25(EC) x40(QPM)      =        50

                                                                                                        20(EA)                   100

Examples 2 - A candidate committing 20 Errors will get = 100 - 20x 40                        =       60

            20                                   100

Examples 3- A candidate committing 10 Errors will get = 100 - 10x 40                         =        80

             20                                  100

Examples 4 - A candidate committing 0 Errors will get = 100 - 0 x 40                            =      100

           20                                     100

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.20
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Computer keyboard signs & symbols

Key/Symbol Explanation

Windows PC keyboards have a Windows key that looks like a four-pane window.

Command Apple Mac computers have a command key.

Menu PC keyboards also have a Menu key that looks like a cursor pointing to a menu.

Esc Esc (escape) key.

F1 - F12 Information about the F1 through F12 keyboard keys.

Tab Tab key.

Caps lock Caps lock key.

Shift Shift key.

Ctrl Ctrl (control) key.

Fn Fn (function) key.

Alt Alt (alternate) key (PC only; Mac users have Option key).

Spacebar Spacebar key.

Arrows Up, down, left, right Arrow keys.

Back Space Back space (or Backspacer) key.

Delete Delete or Del key.

Enter Enter key.

Prt Scrn Print Screen key.

Scroll Lock Scroll Lock key.

Pause Pause key.

Break Break key.

Insert Insert key.

Home Home key.

Page up Page up or pg up key.

Page down Page down or pg dn key.

End End key.

Num Lock Num Lock key.

~ Tilde.

` Acute, back quote, grave, grave accent, left quote, open quote, or a push.

! Exclamation mark, exclamation point, or bang.

@ Ampersat, arobase, asperand, at, or at symbol.

# Octothorpe, number, pound, sharp, or hash.

£ Pound Sterling or Pound symbol.

• Euro.

$ Dollar sign or generic currency.

¢ Cent sign.

¥ Chinese/Japanese Yuan.

§ Micro or Section.

% Percent.

° Degree.

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.20
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Key/Symbol Explanation

^ Caret or circumflex.

& Ampersand, epershand, or and symbol.

* Asterisk, mathematical multiplication symbol, and sometimes referred to as star.

( Open parenthesis.

) Close parenthesis.

- Hyphen, minus or dash.

_ Underscore.

+ Plus.

= Equal.

{ Open brace, squiggly brackets, or curly bracket.

} Close brace, squiggly brackets, or curly bracket.

[ Open bracket.

] Closed bracket.

| Pipe, or, or vertical bar.

\ Backslash or reverse solidus.

/ Forward slash, solidus, virgule, whack, and mathematical division symbol.

: Colon.

; Semicolon.

" Quote, quotation mark, or inverted commas.

' Apostrophe or single quote.

< Less than or angle brackets.

> Greater than or angle brackets.

, Comma.

. Period, dot or full stop.

? Question mark.

Roman Numbers

The Roman Numerals are represented by the letters that
we have. The Roman numerals 1-10 are: I, II, III, IV, V, VI,
VII, VIII, IX, X. The Romans used this for their numbers.
Some were influenced by Latin. We use Roman numerals
too. Some books use Roman numerals instead of our regu-
lar numbers.

English Capitalisation Rules

1 Capitalise the first word of a sentence

2 Capitalise Names and other Proper Nouns

3 Don’t capitalise after a colon

4 Capitalise the first word of Quote

5 Capitalise Days, Months, and Holidays but not Sea-
sons.

6 Capitalise most words in Title

7 Capitalise Cities, Countries, Nationalities and Lan-
guages

8 Capitalise time periods and events.

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.20

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



66

A Large or big circle represents the addition of SW/SS/SZ to the strokes, according to the following rules:

SW Circle

If the circle is enlarged and joined initially with a stroke (inside curves and with left motion to straight strokes), it
represents the double consonant SW, as in

But "SW" cannot be joined with W, Y, H strokes because of initial attachments, as :

SS/SZ Circle

Medially or finally the large circle represents SS/SZ, as in

Large Circle and the vowels: A first or third place vowel can be indicated inside the large circle, as in

Plurals and Possessives: Plurals and possessives can be indicated after the stroke, as in

Two sounds of S-S are represented by S circle and stroke, as in

Small Loop for ST/SD

An oval shaped circle is called a Loop and represents the addition of ST/SD or STR to the stroke, according to their rules.

a) A small initial loop equal to one third of the length of the stroke, attached to straight strokes (except W/Y/H) with left

motion and inside curves, represents the addition of ST to the stroke initially, as in.

Office Administration and Facility Management          R.Theory for Ex 1.2.21
Stenographer Secretarial Asst. (Eng) - Formation of words, phrases practice
of MS word

Large initial circle for SW - Large Medial Circle & Large final circle of SES /
SEZ circle and vowel places - ST loop & STR loop

Objectives: At the end of this lesson you shall be able to
• state the uses of large circle initially, medially and finally
• explain the use of ST and STR loops
• state the circumstances when large circle and loops cannot be used
• state the use of large circle in Phraseography.
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b) The loop represents addition of ST or SD to the stroke finally, as in

c) The loop is also employed medially, as in

But the loop cannot be employed when a vowel follows T or D finally or occurs between S and T/D, as
in

Large Loop - STR

If the size of ST loop is increased to two-thirds of the length of a stroke and, joined medially or finally, it represents STR,
as in

But STR loop is not employed initially with any stroke.

Phrases

Grammalogues

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.21

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



68

A word processing program is a software program that
includes tools for entering, editing, and formatting text and
graphics. Microsoft Word is a powerful word processing
program that allows you to create and enhance a wide
range of documents quickly and easily. The electronic files
you create using Word are called documents. One of the
benefits of using Word is that document files can be stored
on a hard disk, CD, flash drive, or other storage device,
making them easy to transport, exchange, and revise.

You can use Word to accomplish the following tasks:

Type and edit text

The Word editing tools make it simple to insert and delete
text in a document. You can add text to the middle of an
existing paragraph, replace text with other text, undo an
editing change, and correct typing, spelling and
grammatical errors with ease.

Copy and move text from one location to another

Using the more advanced editing features of Word, you
can copy or move text from one location and insert it in a
different location in a document. You also can copy and
move text between documents. This means you don't have
to retype text that is already entered in a document.

Format text and paragraphs with fonts, colors, and
other elements

The sophisticated formatting tools in Word allow you to
make the text in your documents come alive. You can
change the size, style, and color of text, add lines and
shading to paragraphs, and enhance lists with bullets and
numbers. Creatively formatting text helps to highlight
important ideas in your documents.

Format and design pages

The page-formatting features in Word give you power to
design attractive newsletters, create powerful résumés,
and produce documents such as research papers,
business cards, CD labels, and books. You can change
the paper size and orientation of your documents, organize
text in columns, and control the layout of text and graphics
on each page of a document. For quick results, Word
includes preformatted cover pages, pull quotes, and
headers and footers, as well as galleries of coordinated
text, table, and graphic styles that you can rely on to give
documents a polished look. If you are writing a research

paper, Word makes it easy to manage reference sources
and create footnotes, endnotes, and bibliographies.

Enhance documents with tables, charts, diagrams,
and graphics

Using the powerful graphics tools in Word, you can spice
up your documents with pictures, photographs, lines,
shapes, and diagrams. You also can illustrate your
documents with tables and charts to help convey your
message in a visually interesting way.

Use Mail Merge to create form letters and mailing
labels

The Word Mail Merge feature allows you to send
personalized form letters to many different people. You
can also use Mail Merge to create mailing labels,
directories, e-mail messages, and other types of
documents.

Share documents securely

The security features in Word make it quick and easy to
remove comments, track changes, and unwanted personal
information from your files before you share them with
others. You can also add a password or a digital signature
to a document and convert a file to a format suitable for
publishing on the Web.

The Elements of Word 2010 Screen

The elements are shown in Fig.1

• The title bar displays the name of the document and
the name of the program. Until you give a new document
a different name, its temporary name is Document 1.
The title bar also contains resizing buttons and the
program Close button. These buttons are common to
all Windows programs.

• The Quick Access toolbar contains buttons for saving
a document and for undoing, redoing, and repeating a
change. You can modify the Quick Access toolbar to
include the commands you use frequently.

• The File tab provides access to Backstage view, where
you manage files and the information about them.
Backstage view includes commands related to working
with documents, such as opening, printing, and saving
a document. The File tab also provides access to
resources for help using Word and to the Word Options
dialog box, which is used to customize the way you
use Word.

Office Administration and Facility Management   R.Theory for Ex 1.2.22 & 23
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

MS Word - use of different menus, copying, cutting and pasting, formatting
document and printing

Objectives: At the end of this lesson you shall be able to
• state word processing techniques
• explain how to open and save documents
• describe how to change style and fonts
• explain how to set margins
• explain indenting methods
• describe printing process for documents.
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• The Ribbon contains the Word tabs. Each tab on the
Ribbon includes buttons for commands related to
editing and formatting, documents. The commands are
organized in groups. For example, the Home tab
includes the Clipboard, Font, Paragraph, Styles, and
Editing groups. The Ribbon also includes the Microsoft
Word Help button,which you use to access the Word
Help system.

Fig 1

• The document window displays the current document.
You enter text and format your document in the
document window.

• The Zoom level button and the Zoom slider provide quick
ways to enlarge and decrease the size of the document
in the document window, making it easy to zoom in on
a detail of a document or to view the layoutof the
document as a whole.

Ribbons

Across the top of the Ribbon is a series of tabs. You can
click one of these tabs to expose a set of controls specific
to that tab. Initially, the Ribbon displays these seven tabs:

Home: Basic commands for creating and formatting
documents. You can find controls for working with the
Clipboard, setting the font, formatting paragraphs, applying
styles, and using Find and Replace.

Insert: Commands for inserting various items into your
document, including new pages, tables, pictures, shapes,
and other types of illustrations, headers and footers,
specially formatted text, etc

• The rulers appear in the document window in Print
Layout view. The horizontal ruler displays left and right
document margins as well as the tab settings and
paragraph indents, if any, for the paragraph in which
the insertion point is located. The vertical ruler displays
the top and bottom document margins.

• The vertical scroll bar and the horizontal scroll bar are
used to display different parts of the document in the
document window. The scroll bars include scroll boxes
and scroll arrows, which you can use to scroll through
a document.

• The status bar displays the page number of the current
page, the total number of pages and words in the
document, and the status of spelling and grammar
checking. It also includes the view buttons, the Zoom
level button, and the Zoom slider. You can customize
the status bar to display other information.

• The view buttons on the status bar allow you to display
the document in Print Layout, Full Screen Reading,
Web Layout, Outline, or Draft view.

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.22 & 23
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Page Layout: Commands that let you adjust the layout
of your document's pages. You can apply a theme to your
document to set the overall look of the document or control
details such as the page margins and background colors.

References: Commands that let you create tables of
contents, footnotes,bibliographies, indexes, and other
elements.

Mailings: Commands for creating mail merges.

Review: Commands for proofing and adding comments
to your documents and tracking changes.

View: Commands that let you change the view. You can
use this tab to switch to different document views, to show
or hide certain types of information (such as paragraph
marks), and to zoom in for a closer look at your docu-
ment.

Word 2010 Keyboard Shortcuts

A shortcut key is a function key, such as [F1], or a
combination of keys, such as [Ctrl][S], that you press to
perform a command. For example, instead of using the
Cut, Copy, and Paste commands on the Ribbon or the
Mini toolbar, you can use the keyboard shortcuts [Ctrl][X]
to cut text, [Ctrl][C] to copy text, and [Ctrl][V] to paste
text. You can also press [Ctrl][S] to save changes to a
document instead of  clicking the Save button on the Quick
Access toolbar or clicking Save on the File tab. Becoming
skilled at using keyboard shortcuts can help you quickly
accomplish many of the tasks you perform in Word. If a
keyboard shortcut is available for a command, then it is
listed in the ScreenTip for that command.

Word 2010 offers a number of helpful keyboard shortcuts
for performing tasks quickly. Here are some shortcuts for
common Word formatting, editing, and file and document
tasks.

        WORD 2003 COMMAND                          EQUIVALENT WORD 2010 COMMAND

File  New File tab, New

File  Save File tab, Save

File  Page Setup Page Layout tab, Page Setup group

Edit  Undo Quick Access toolbar, Undo

Edit  Find Home tab, Editing group, Find

Edit  Replace Home tab, Editing group, Replace

Insert  Picture  Clip Art Insert tab, Illustrations group, Clip Art

Insert  Picture  From File Insert tab, Illustrations group, Picture

Insert  Diagram Insert tab, Illustrations group, SmartArt

Format  Font Home tab, Font group, dialog box launcher

Format  Paragraph Home tab, Paragraph group, dialog box launcher

Format  Styles and Formatting Home tab, Styles group, dialog box launcher

Tools  Spelling and Grammar Review tab, Proofing group, Spelling & Grammar

Tools  Letters and Mailings Mailings tab

Tools  Templates and Add-Ins File tab, Options, Add-Ins tab, select Templates in the Manage

drop-down list and click Go

Tools  Options File tab, Options

Table  Draw Table Insert tab, Tables group, Table

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.22 & 23
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Word 2010 Formatting Shortcuts

 Command Shortcut Ribbon Location

 Bold Ctrl+B Home tab, Font group

 Italic Ctrl+I Home tab, Font group

 Underline Ctrl+U Home tab, Font group

 Center Ctrl+E Home tab, Paragraph group

 Left Align Ctrl+L Home tab, Paragraph group

 Right Align Ctrl+R Home tab, Paragraph group

 Justify Ctrl+J Home tab, Paragraph group

 Clear Ctrl+ Home tab, Font group
 Formatting Space bar

Word 2010 File and Document Shortcuts

 Command Shortcut Ribbon Location

 New Ctrl+N File tab, New command

 Open Ctrl+O File tab, Open command

 Save Ctrl+S File tab, Save command

 Print Ctrl+P File tab, Print command

 Help F1 Help button at top right of
Ribbon

 New Page Ctrl+Enter Insert tab, Pages group

Word 2010 Editing Shortcuts

 Command Shortcut Ribbon Location

 Undo Ctrl+Z Quick Access toolbar

 Cut Ctrl+X Home tab, Clipboard group

 Copy Ctrl+C Home tab, Clipboard group

 Paste Ctrl+V Home tab, Clipboard group

 Select All Ctrl+A Home tab, Editing group

 Find Ctrl+F Home tab, Editing group

 Replace Ctrl+H Home tab, Editing group

Open a Document in Word 2010

There are  several ways to open a Word 2010 document
that was previously saved as a file on disk.

1 Choose the Open command from the File tab menu:
Alternatively, you can use the keyboard shortcut Ctrl+O.
Either way, the Open dialog box opens

2 Locate the document you want to open: The Open dia-
log box , you can examine various folders on your PC's
hard drive, and on any computer network your PC is
connected to,  for files to open.

3 When you find the file, select it: The file appears high-
lighted in the dialog box.

4 Click the Open button.

Save a Document in Word 2010

1 Click the File tab and select the Save as com-
mand: The Save As dialog box appears. You need to
use the Save As dialog box is when you first create a
document and if you want to save a document with a
new name or to a different location on disk.

2 Type a name for your document in the File Name
text box: Word automatically selects the first line or
first several words of your document as a filename and
puts it in the Save dialog box. If that's okay, you can
move to Step 4. Otherwise, type a name in the File
Name box.

3 Choose a location for your file (Optional): In the
Save As dialog box to choose a specific folder for your
document.

4 Click the Save button.

Word wrap

In word processing, a feature that causes the word pro-
cessor to force all text to fit within the defined margins.
When you fill one line with text, the word processor auto-
matically jumps to the next line so that you are not re-
quired to keep track of line lengths and to press the Re-
turn key after each line. The word processor divides lines
in such a way that a word is never split between two lines
(unless the word processor supports hyphenation).

Word wrap also occurs if you change the margins. In this
case, the word processor readjusts all the text so that it
fits within the new margins.

Note that word wrap inserts a soft return at the end of
each line, not a hard return. Soft returns are invisible codes
that the word processor utilizes. Hard returns are real char-
acters inserted into the document.

Some word processors allow you to turn off the word-wrap
feature. This is useful for writing programs and other types
of formatted text where you want complete control over
new lines.

Using the Undo , Redo and Repeat commands

Word remembers the editing and formatting changes you
make so that you can easily reverse or repeat them. You
can reverse the last action you took by clicking the Undo
button  on the Quick Access toolbar, or you can undo a
series of actions by clicking the Undo list arrow  and se-
lecting the action you want to reverse. When you undo an
action using the Undo list arrow, you also undo all the
actions above it in the list-that is, all actions that were
performed after the action you selected. Similarly, you
can keep the change you just reversed by using the Redo
button on the Quick Access toolbar. The Redo button ap-
pears only immediately after clicking the Undo button to
undo a change. If you want to repeat an action you just
completed, you can use the Repeat button  on the Quick
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clicking  inserts "thank you" at the location of the inser-
tion point. If you just applied bold, clicking applies bold to
the currently selected text. You also can repeat the last
action you took by pressing [F4].

Selecting Text

One basic editing skill is selecting text. After you select
some text, you can delete it, copy it, move it, apply for-
matting to it, change its capitalization etc. The easiest
way to select text is to click and drag the mouse over the
text you want to select. You can also use one of these
mouse actions to select text:

• To select all text between two points: Click at the start

of the block of text, hold down Shift, and click at the
end of the block.

• To select a single word: Double-click anywhere on the

word. Click, click.

• To select an entire paragraph: Triple-click anywhere

on the paragraph. Click, click, click.

• To select an entire sentence: Hold down Ctrl and click

anywhere in the sentence.

• To select a column of text: Hold down Alt, click and

hold the mouse button, and drag. Drag the mouse left
or right to increase or decrease the width of the column
selected, and drag the mouse up or down to extend
the column up or down.

Deleting Text

Deleting text is one of the basic skills of good editing.Word
has many ways to delete text. The most basic deletion
technique is to delete characters one at a time by pressing
one of these two keys:

Backspace: Deletes the character to the left of the
insertion point

Delete: Deletes the character to the right of the insertion
point

Delete large amounts of text

To delete a sentence: Hold down the Ctrl key and click
in the sentence to select it, and then press Delete or
Backspace.

To delete a paragraph: Triple-click the paragraph to
select it and then press Delete or Backspace.

To delete the entire document: Press Ctrl+A to select
the entire document and then press Delete or Backspace.

Cut, Copy, and Paste in Excel 2010

You can use the Cut, Copy, and Paste commands to move
or copy information in an Excel 2010worksheet Because
of this Clipboard arrangement, you can use these
commands to move or copy information to any other
worksheet open in Excel or even to other programs running
in Windows (such as a Word document).

Moving a cell selection

To move a cell selection with Cut and Paste, follow these
steps:

1 Select the cells containing data you want to move.

2 Click the Cut button in the Clipboard group on the Home
tab (the button with the scissors icon). Alternatively,
press Ctrl+X. The program surrounds the cell selection
with a marquee and displays the following message
on the Status bar: Select destination and press ENTER
or choose Paste.

3 Move the cell cursor to, or click the cell in the upper-
left corner of the destination range. When you indicate
the destination range,  Excel only needs to know the
location of the cell in the upper-left corner of the
destination range.

4 Press Enter or Ctrl+V to complete the move operation.
Alternatively, you can click the Paste button in the
Clipboard group on the Home tab. The cell contents
disappear from where they began and reappear in their
new location.

Copying a cell selection

Copying a cell selection with the Copy and Paste
commands follows a nearly identical procedure to the one
you use with the Cut and Paste commands. After selecting
the range to copy, you click the Copy button on the Home
tab or press Ctrl+C.

An advantage to copying a selection with the Copy and
Paste commands and the Clipboard is that you can paste
the information multiple times. Just make sure that, instead
of pressing Enter to complete the first copy operation,
you click the Paste button on the Home tab of the ribbon
or press Ctrl+V. After you select the first cell of the next
range where you want the selection copied, choose the
Paste command again. When you make the last copy,
press Enter. If you forget and choose Paste, you can
remove the marquee around the original cell range by
pressing the Esc key.

Formatting Text using fonts

Formatting text with fonts is a quick and powerful way to
enhance the appearance of a document. A font is a
complete set of characters with the same typeface or
design. Arial, Times New Roman, Courier, Tahoma, and
Calibri are some of the more common fonts, but there are
hundreds of others, each with a specific design and feel.
Another way to change the appearance of text is to
increase or decrease its font size. Font size is measured
in points. A point is 1/ 72 of an inch.  You change the font
and font size of the body text, title, and headings .

Font & Size selection

Font refers to the manner or style in which text is displayed
in the document. Different fonts contain different collection
of characters and symbols. Word offers many ways to
change fonts and font styles. The text to be formatted
needs to be selected first.
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Fig.2

Formatting Paragraphs (Fig 3)

To format a paragraph, first click anywhere in the paragraph
you want to format. (Where you click in the paragraph
doesn't matter.) Then use one ofthe keyboard shortcuts or
buttons on the Ribbon. To remove all paragraph formatting,
press Ctrl+Q.

Justification (Fig 4)

You can set the paragraph alignment to Align Left, Align
Right, Center, orJustify by using the first four buttons at
the bottom of the Paragraph group on the Home tab on
the Ribbon. The different ways you can align text using
the Ribbon are

Fig.3

Fig.4

Line spacing

In the Paragraph group on the Home tab on the Ribbon,
you find the Line and Paragraph Spacing button, which
you use to add space between the lines of text in a
paragraph. By default, lines are single spaces, with slightly
more than that amount below a paragraph. In the Line and
Paragraph Spacing drop-down list (in the Paragraph group
on the Home tab), you can select several options for the
paragraph's line spacing. The ones you use most are 1.0,
1.5, and 2.0. Click the dialog box launcher to open the
Paragraph dialog box, where you can select one of these
options from the Line Spacing drop-down list:

At Least: Specify a minimum measurement for the line
spacing, such as At Least 14 Points.

Exactly: Set an exact measurement.

Multiple: Set other amounts of line spacing, such as 3
Lines.

The following keyboard shortcuts can help you quickly
format paragraph spacing:

Keyboard Shortcut Effect on Paragraph

Ctrl+1  Single-space

Ctrl+2  Double-space

Ctrl+5  1.5 line spacing

Follow these steps to change fonts and font styles

• Open the File group.

• Use Bold(B), italics(I), Underline(U) buttons on the

format toolbar.

• To add bold formatting to the text, follow these steps:

• Select the text and click on the Bold button.

• Alternatively, click on the bold button and type the text.

Similarly, the characters can be underlined and
italicized.

Changing Font Size

Font size is measured in points and picas are used for
measuring spacing, line thickness, and so on. There are
12 points to a pica and six picas to an inch; therefore,
there are 72 points to an inch. Normal template the font
size, follow these steps:Use the drop-down front size on
the formatting toolbars, type the font size, in the font size
box on the format toolbar and press the Enter key.

Use any of these keyboard shortcuts to increase or
decrease the font size

To increase the Font size select the matter and press
Ctrl+Shift+> keys. To

decrease the font size select the matter and press
Ctrl+Shift+< keys. Alternatively

you can use Ctrl+] or Ctrl+[ to increase or decrease the
font size.

Format Painter (Fig 2)

The Format Painter is a very useful option, it copies the
formatting from specific portions of the document and
applies it to other portions of your document with a few
clicks. The process is very simple, select the portion of
the document, hit the Format Painter option and then select
the new paragraph upon which you wish to apply the format
of the first paragraph.
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Computer

Setting indents and spacing,  use of help options, page set up, margins, ruler, and paper size in word.
Inserting lines and page breaks, viewing documents properties and printing, use of tables, insertion
and deletion of rows and columns, alignments between rows and columns and other MS-word features.

Borders

The Paragraph group on the Home tab on the Ribbon has
a Border button you can use to apply basic borders. You
can click the button to apply the current border type to
whatever text you select. Click the arrow next to the but-
ton to reveal a palette of border types, as shown in Fig.5

Indenting

Some publications require that you indent the first line of
every paragraph.Others require that you indent all lines by
moving them to the right - useful for nested paragraphs (a
paragraph within a paragraph) .Place the insertion point
somewhere in the paragraph you want nested and click
the Increase Indent button in the Paragraph group on the
Home tab. if you continue to click it, you increase the
indent. To unindent an indented paragraph, use the
Decrease Indent button.

1 Open the Paragraph dialog box by using the dialog
box launcher in the Paragraph group on the Home tab
on the Ribbon.

2 In the Indentation area, select the First Line option from
the Special drop-down list.

3 If you want, change the amount in the By box.  The
box automatically says 0.5" and can be changed by
typing over the  figure or using the spinner buttons to
the right of the text.

4 Click OK.

To indent everything except the first line of a paragraph,
select Hanging Indent from the drop-down list in Step 2.

First line & Hanging Indent

In many types of documents, you may wish to indent only
the first line of each paragraph. This helps to visually sepa-
rate paragraphs from one another. It's also possible to
indent every line except the first line, which is known as a
hanging indent.

To create or adjust a First Line Indent or Hanging
Indent (Fig 7)

1 Place the insertion point anywhere in the paragraph
you wish to indent, or select one or more paragraphs.

Fig 5

To draw a simple box around some text and choose a
border, follow these simple steps:

1 Select the text you want to draw a border around.

2 Click the down arrow on the Borders button in the Para-
graph group in the Home tab on the Ribbon and select
the Outside Borders option.

3 To change the border's style, color, or width, select the
Borders and Shading option at the bottom of the Bor-
der buttons dropdown list.   This step opens the Bor-
ders tab in the Borders and Shading dialog box.

4 Make your selections in the Borders and Shading dia-
log box (Fig 6).

Fig 6
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2 To adjust the first line indent, drag the First Line Indent
marker on the ruler.

3 To adjust the hanging indent, drag the Hanging Indent
marker.

4 To move both markers at the same time, drag the Left
Indent marker. This will indent all of the lines in the
paragraph.

To Use the Indent Commands

If you want to indent all of the lines in a paragraph, you
can use the Indent commands on the Home tab.

1 Select the text you wish to indent.

First line Indent

Hanging Indent Spell Check

Word checks your spelling and grammar as you type.
Spelling errors display with a red wavy line under the word.
Grammar errors display with a green wavy line under the
error. If you want to spell check your entire document,
press F7 and click the spelling icon, or choose Spelling
and Grammar from the review group. If you want to spell
check part of your document highlight the area you want
to spell check. Then press F7 and click the spelling icon,
or choose Spelling and Grammar from the review group

Using the Thesaurus

One effective Word feature is a built-in thesaurus that can
quickly show you synonyms for a word you type.

1 Right-click a word you typed and choose Synonyms
from the menu that appears. A menu that lists syn-
onyms for the word appears. (Sometimes, Word throws
an antonym into the list, just to be contrary)

2 Click the word that you want to replace your word.

Word replaces the original word with your selection.

Inserting a Table

A table is a grid made up of rows and columns of cells that
you can fill with text and graphics. A cell is the box formed
by the intersection of a column and a row. The lines that
divide the columns and rows and help you see the grid-
like structure of a table are called borders. You can create

Fig 7

The three indent markers

2 Make sure you are on the Home tab.

3 Click the Increase Indent command to increase the
indent by increments of 1/4 inch (Fig 8).

 Increasing the indent

Fig 8

4 Click the Decrease Indent command to decrease the
indent by increments of 1/2 inch. If you would prefer to
type in your indent amounts, you can use the Indent
fields on the Page Layout tab (Fig 9).

Fig 9

 Typing an indent amount
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a table in a document by using the Table command in the
Tables group on the Insert tab. Once you have created a
table, you can add text and graphics to it.

Insert Table: Create a table with any number of columns
and rows and select an AutoFit behavior

Draw Table: Create a complex table by drawing the table
columns and rows

Convert Text to Table: Convert text that is separated by
tabs, commas, or another separator character into a table

Excel Spreadsheet: Insert a blank Excel worksheet into
the document as an embedded object

Quick Tables: Insert a preformatted table template and
replace the placeholder data with your own data

Format a Table in Word 2010

To format a table in Word 2010 - maybe adding a row,
adjusting the width of a table element - you can use Word's
Table Tools tabs after the table has been created. The
Table Tools tabs show up only when a table is being ed-
ited or selected. .

Manipulating a Word table with the mouse

• Clicking-and-dragging the mouse on a vertical line in

the table's grid allows you to adjust the line left or right,
and resize the surrounding cells.

• You can also adjust cell width by using the Ruler, by

pointing the mouse at the Move Table Column button
that appears above each table cell gridline.

• Clicking-and-dragging the mouse at a horizontal line

allows you to adjust the line up or down, and change
the row height of surrounding cells.

Adjusting the Word table (Fig 10)

It's the Table Tools Layout tab that contains many of the
command buttons and items that let you manipulate and
adjust a table. Start your table design by placing the
insertion pointer somewhere within the table itself, which
makes the Table Tools Layout tab  appear:

Deleting cells, columns, or rows: Position the insertion
pointer in the part of the table you want to remove, then
choose the table element to remove from the Delete
button's menu.

When you choose the Delete Cells command,
you see a dialog box asking what to do with
the other cells in the row or column: move
them up or to the left. Yes, deleting a cell may
make your table asymmetrical.

Inserting columns or rows: Four commands in the Rows
& Columns group make this task possible: Insert Above,
Insert Below, Insert Left, and Insert Right. The row or
column that's added is relative to where the insertion pointer
is within the table.

Adjusting row and column size:  Cell Size group let
you fine-tune the table's row height or column width. The
Distribute Rows and Distribute Columns command buttons,
found in the Cell Size group, help clean up uneven column
or row spacing in a table.

Aligning text: Text within a cell can be aligned just like a
paragraph: left, center, or right. Additionally, the text can
be aligned vertically: top, middle, or bottom.

Reorienting text: The Text Direction button in the
Alignment group changes the way text reads in a cell or
group of selected cells. Normally, text is oriented from left
to right. By clicking the Text Direction button once, you
change the text direction to top-to-bottom. Click the button
again and direction is changed to bottom-to-top. Clicking
a third time restores the text to its normal direction.

Designing a Word table

The Table Tools Design tab is used to help you quickly
format your table. The tab shows up whenever the insertion
pointer lies somewhere in a table

Using Quick Styles: The Table Styles group can quickly
apply formatting to any table. Choose a style or click the
menu button to see a whole variety of styles.

The Quick Styles don't work when you have a table in a
document created by or saved in an older version of Word.

Removing a table's lines: Occasionally, you may want
a table without any lines. Select the table and choose No
Border from the Borders menu.

Fig 10
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Having no lines (borders) in a table makes working with
the table more difficult. The solution is to show the table
gridlines.To do that, select the table and choose the Show
Gridlines command from the Border menu.

Merging cells: You can combine two or more cells in a
table by simply erasing the line that separates them. To
do so, click the Eraser command button found in the Draw
Borders group. The mouse pointer changes to  an eraser.
Click a line and it's gone. Click the Eraser button again
when you  finished  merging.

Splitting cells: To turn one cell into two, you simply draw
a line, horizontally or vertically, through the cell. Click the
Draw Table command button in the Draw Borders group,
and then draw new lines in the table. Click the Draw Table
button again to turn off this feature.

Fig 11

Deleting a Word table

To remove the table from your document, click the mouse
inside the table and then choose Delete?Table from the
Rows & Columns group on the Layout tab.

Add Borders to Text:

Following are the simple steps to add border to any text
or paragraph.

1 Select the text or paragraph to which you want to add
border. You can use any of the text selection method
to select the paragraph(s).

2 Click the Border Button to display a list of options to
put a border around the selected text or paragraph.
You can select any of the options available by simply
clicking over it (Fig 12).

Fig 12
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3 Try to add different borders like left, right top or bottom
by selecting different options from the border options
(Fig 13).

4 To delete the existing border, simply select No Border
option from the border options.

Add Borders to Page

You can add borders of your choice to word pages by
following the simple steps given below.

1 Click the Border Button to display a list of options to
put a border. Select Border and Shading option available
at the bottom of list of the options as shown in fig. This
will display a Border and Shading dialog box. This dialog
box can be used to set borders and shading around a
selected text or page borders (Fig 14).

Fig 13

Fig 14
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2 Click Page Border tab which will display a list of border
settings, styles and options whether this border should
be applied to the whole document or just one page or
first page.

3 You can use Preview section to disable or enable left,
right , top or bottom borders of the page.

4 You can customize yours border by setting its color,
width by using different arts available under style section
(Fig 15).

Fig 15

Fig 16

You can have similar or even better borders as given below
in Fig.16
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Add Shades to Text

1 Click the Border Button to display a list of options to
put a border. Select Border and Shading option available
at the bottom of list of the options as shown in fig 17.

This will display a Border and Shading dialog box. This
dialog box can be used to set borders and shading around
a selected text or page borders (Fig 17).

2 Click Shading tab which will display options to select
fill, color and style and whether this border should be
applied to Paragraph or Text.

Fig 17

3 You can use Preview section to have an idea about the
expected result. Once you are done, click OK button
to apply the result (Fig 18).

Fig 18
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3.3.3 Page Setup

Page setup can be used to change page orientation, set
left, top, bottom margins, page sizes, etc. To change page
size and orientation

1 Select the Page layout group

2 Select the Margins tab.

3 In the orientation area, select Portrait or Landscape.

Setting Margins

1 Select the Page layout group

2 Select the margins tab.

3 Select custom margins and enter the measurement in
the Top, Bottom, Left and Right boxes.

4 Click on the OK button to close the dialog box. When
you set margins, Word applies the measurements to
all the pages in a document .

Choose paper size

1 Select the Page layout group

2 Select the margins tab.

3 Select paper size

Print Preview

Previewing a document means viewing a screen
representation of one or more pages before you print them.
To print preview a document, the steps are:

1 Select the Print from File group. The document can be
previewed

Printing a document

Printing more than one copy

The Copies box on the Print page lets you print more than
one copy of your document. You can click one of the arrows
next to this field to increase or decrease the number of
copies, or you can type directly in the box to specify the
number of copies.

The Collate setting, which lets you choose between
collated and uncollated printing. If you chose collated
printing (the default setting), Word prints each copy of
your document one at a time. In other words, if your
document consists of ten pages and you select three
copies and select collated printing, Word first prints all
ten pages of the first copy of the document, and then all
ten pages of the second copy, and then all ten pages of
the third copy. If you choose uncollated printing, Word
prints three copies of the first page, followed by three
copies of the second page, followed by three copies of the
third page, and so on (Fig. 19)

Printing part of a document

The Print All Pages drop-down list lets you choose how
much of (or what part of) your document you want to print.
When you first access the Print page in Backstage view,
the Print All Pages option is selected so that your entire
document prints. You use the other options in the Print All
Pages drop-down list, as well as the Pages box just below
it, to tell Word to print distinct portions of your document.
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Print Selection: Print just the portion of the document
you selected before entering Backstage view. First, se-
lect the pages you want to print. Then choose File? Print,
select Print Selection from the Print All Pages drop-down
list, and click Print.

Print Current Page: Print just the current page. Before
you display the Print page, move to the page in your docu-
ment that you want to print. Then select this option in the
Print page of Backstage view and click Print. This option
is handy when you make a change to one page and don't
want to reprint the entire document.

Print Range: Select specific pages for printing. You can
print a range of pages by typing the beginning and ending
page numbers, separated by a hyphen, as in 5-8 to print
pages 5, 6, 7, and 8. Or, you can list individual pages,
separated by commas, as in 4,8,11 to print pages 4, 8,
and 11. And, you can combine ranges and individual pages,
as in 4,9-11,13 to print pages 4, 9, 10, 11, and 13. Use the
Pages box to specify the pages you want to print. Enter-
ing page numbers in the Pages box automatically changes
the drop-down list setting to Print Range if it wasn't al-
ready so.

Document Properties: Print information about your docu-
ment.

List of Markup: Print a list of revisions made to the docu-
ment.

Styles: Print the styles in the document.

AutoText Entries: Print any AutoText entries in the docu-
ment.

Key Assignments: Print any custom shortcut keys that
are assigned.

Print Markup: You can enable the Track Changes fea-
ture and then use this option to print your document along
with any revision marks.

Only Print Odd Pages: Print pages 1, 3, 5, and so on.

Only Print Even Pages: Print pages 2, 4, 6, and so on.

Other settings

The Print page of Backstage view has several other
options:

Print One Sided: Most printers print on only one side of
the paper. This option lets you manually print on both sides
of the paper, if you want. If you choose to print manually
on both sides of the paper, Word prompts you to reinsert
each page to print the next page on its backside.

Collated: This option is useful when printing multiple cop-
ies of a document.

Portrait Orientation: Portrait orientation refers to print-
ing on the paper so that the longest side of the paper is
the height and the shorter side is the width. Landscape
orientation flips the page so that the long side is the width
and the short side is the height.

Letter: Change the paper size. The default is usually Let-
ter (8.5 x 11), but you can select different paper sizes.

Margins: You can change the margin settings from the
Print page.

1 Page Per Sheet: Print more than one page on each
sheet of paper.

Page Setup: This hyperlink near the bottom of the page
opens the Page Setup dialog box, from which you can
adjust the document margins again before you print

In numbered lists, each paragraph begins with an expres-
sion that includes a number or letter and a separator such
as a period or parenthesis. The numbers in a numbered
list are updated automatically when you add or remove
paragraphs in the list. Fig.21

Setting Bullet and numbering

Bullets and Numbering is a paragraph level attribute that
applies a bullet character or a numeral to the start of the
paragraph. In bulleted lists, each paragraph begins with a
bullet character, as in Fig.20
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Paragraph formatting

In Word, the term 'paragraph' means any amount of text,
graphics, objects, or other items that are followed by a
paragraph mark (), which is inserted into the document
each time you press the ENTER key. You can show or
hide the paragraph marks by clicking the Show/Hide but-
ton on the Standard toolbar. When you format a paragraph,
you actually format a block of text and inserted objects
that are followed by a paragraph mark. The paragraph mark
stores all the formatting information for the paragraph.

Paragraph formats affect the appearance of the entire se-
lected paragraph, not just certain words or lines of text
within a paragraph. The appearance of a document de-
pends largely on the formatting you apply to the various
paragraphs.

Examples of formats you can apply to paragraphs include:

• Alignment

• Tabs

• Line spacing

• Paragraph spacing

• Indentation

• Dropped initial capital letter

• Borders and shading

• Bullets and numbering
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Office Administration and Facility Management          R.Theory for Ex 1.2.24
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

Initial small hooks R and L - Use of SHR and SHL strokes - Initial hooks and
vowels

Objectives: At the end of this lesson you shall be able to
• form double consonants by adding R and L hooks to straight and F curved strokes
• state how SHR and SHL are written
• describe the placement of vowels to hooked strokes
• state the extended use of R/L hooks.

R Hook to Straight Strokes

A small initial hook written with right motion (clock-wise) adds R to straight strokes, as in

To curved strokes R hook is written inside the curves, as in

L Hook to straight Strokes

A small initial hook written with left motion (anti-clockwise) adds L to straight strokes, as in

L Hook to Curved Strokes: L hook is a large hook written inside the curves, as in

The stroke               (ray)  is not hooked initially because the strokes                  W and              Y are
employed for W and Y sounds.

SHR and SHL

SHR is always written downward while SHL is always written upward, as in

Vowels and Double Consonants

Vowels are read with the double consonants according to their places, as in

Extended use of R and L Hook

In order to obtain easier joining, L hook is employed in many cases, even though it is followed by a vowel, as in

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



85

Grammalogues
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Office Administration and Facility Management          R.Theory for Ex 1.2.25
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

Setting indents, spacing, page set up, Margins, Ruler, Paper size  in word,
Inserting Lines and Page Breaks, Insertion of tables, Deletion of Rows and
Columns, Alignment between rows and columns, viewing document prop-
erties and Printing

Objectives: At the end of this lesson, you shall be able to
• state different type of indents and spacing
• explain page set up and margin settings
• explain inserting lines, tables and page break functions
• describe alignment between rows and columns
• explain viewing document properties
• explain printing options.

Setting Indents

There are two types of indents that can be adjusted: para-
graphs and bullet points. Each has a separate way of
adjusting the indent size.

First line indent with tab

The first line indent can always be created using the Tab
key key on the keyboard.

A complete paragraph can be indented with the keyboard
shortcut Ctrl+M and pressing the keyboard shortcut more
than once will indent the paragraph further. To reverse the
indent, press Ctrl+Shift+M

Adjusting indents using the ruler

To adjust a paragraph indent size, use the Ruler, which is
below the menu bar and resembles the picture shown
below.

markers in the ruler, click Format and then Paragraph.
You can also place the cursor in the paragraph, right-click
with your mouse, and chose Paragraph.

Adjust the indent on the Ribbon in Word 2007 and later

If you're using a newer version of Microsoft Word that uses
the Ribbon, such as Word 2007 or 2013, do the following.

1 Click on the Layout or Page Layout tab.

2 Adjust the indent settings in the Paragraph section.

To view the Paragraph window mentioned in the above
section, click the small down arrow indicated by the red
arrow in the picture below.

The top marker (down arrow) controls the first line indent,
and the middle marker (up arrow) controls the hanging
indent (the indent for lines after the first line in each para-
graph). The bottom marker (small box) controls the left
indent. To adjust these indents, you can click and drag
each marker to the right or left.

Note: To change he orientation for an entire document,
select all text document (Ctrl+A) and then adjust the in-
dent spacing in the ruler as details above.  If a large indent
is created when pressing Tab key and adjusting the in-
dent on the Ruler does not fix the issue, adjust the Left
Tab Stop in the Ruler.

Changing indents in the Paragraph window

Another way to adjust the indents is to view the Para-
graph settings. To view this window, double-click on the

Page set up/Page layout

The page setup is the parameters defined by the user that
help determine how a printed page appears. Those pa-
rameters can include everything from the size, margins,
page orientation, to quality of print. More plainly, it's a
menu that allows users to customize the layout of a page.
The page setup dialog box is usually available from the file
drop-down menu. For Microsoft Word 2007 or later, the
page setup options are available under the Layout tab in
the Ribbon menu

Inserting Lines and Page Breaks

Breaking up sections of a document by typing individual
characters to form a line is time-consuming and may not
achieve the proper formatting effect. Instead of using the
keyboard to draw lines, here are three ways to insert dif-
ferent styles of horizontal lines in MS Word.
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Use AutoFormat to Insert a Line in Word

To quickly insert a line into a word document with the
AutoFormat feature, type a few characters to instantly
create the different types of lines.

To create a line, place the cursor in the location that you'd
like to insert a line, type the three characters for the de-
sired line style, then press Enter. To create the different
types of lines, press the associated keys on the key-
board:

• Plain single line: Three hyphens (---)

• Plain double line: Three equal signs (===)

• Broken or dotted line: Three asterisks (***)

• Bold single line: Three underline symbols (___)

• Wavy line: Three tildes (~~~)

• Triple line with a thick center: Three number signs (###)

Page breaks

Word automatically adds a break at the end of each page.
You can also insert a manual page break anytime you
want to start a new page in your document.

1 Put your cursor where you want one page to end and
the next to begin.

2 Go to Insert > Page Break.

How to Insert a Table in a Microsoft Word Document -
Steps

• Open Word or the document where you wish to put a

table.

• Position the cursor on the area where you want the

table to be inserted.

• Choose your method of inserting your table.

Formatting table

After you create a table, Microsoft Office Word 2007 of-
fers you many ways to format that table. If you decide to

use Table Styles, you can format your table all at once,
and even see a preview of what your table will look like
formatted in a particular style before you actually apply
the style.

You can create a custom look for tables by splitting or
merging cells, adding or deleting columns or rows, or add-
ing borders. If you're working with a long table, you can
repeat the table headings on each page on which the table
appears. To prevent awkward page breaks that disrupt the
flow of your table, you can also specify just how and where
the table should break across pages.

Delete a cell, row, or column

1. Do one of the following:

To select Do this

  A cell      Click the left edge of the cell. .

  A row      Click to the left of the row

                .

  A column   Click the column's top gridline or top border

        .

2   Under Table Tools, click the Layout tab

3 In the Rows & Columns group, click Delete, and then
click Delete Cells, Delete Rows, or Delete Columns,
as appropriate.

Alignment between Rows and columns

The term 'row', represent an arrangement, wherein people,
objects, numbers or any other things lie next to each other,
facing the same way, i.e. in a horizontal line. It goes from
left to right, like the row of a school classroom, or seats of
a movie theatre.

A column is an arrangement of facts, figures, words, etc.,
are placed one after another in a sequence. In a table,
columns are separated from each other by lines which
enhance its readability and attractiveness. It helps in mak-
ing the comparison between two columns by placing them
side by side.

Rows and Columns both are the fundamental part of any
table whether; it is a spreadsheet or matrix on the basis
of, to store data. These are a vital geometric arrangement
which divides any data set on the basis of attributes.

Viewing Document properties and Printing

MS Word Document File Properties is a software spe-
cially designed for bringing changes in the initial configu-
ration of MS word files. It also allows viewing the proper-
ties of each file.  The software gives the user all the nec-
essary tools for modifying the properties and attributes of
word documents. He has the possibility to edit the title,
the author, the file date time or making it in read only
mode.
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Printing

To print a document, your computer needs to be connected
to a printer. For this You'll need a computer with Word
installed and a Printer set up and connected to your com-
puter.

Step 1: Open an existing Microsoft Word document or
start a new document, Before you print, type your text in
the blank document or insert an image.

Step 2: When you are ready, click on File in the top left-
hand corner of your document. Then, click on Print.

Alternatively, some versions of Word may have an Office
button instead of a 'File' button - it's a round Office icon in
the top left-hand corner of the screen, click on this if you
have one.

Choose how many copies of your document you need
and click on the printer you wish to use. You will have to
have your printer already installed on your computer.

Step 3: Depending on your printer options, you can choose
other printing features such as whether you want to print
all pages or only certain pages. You can also change the
orientation of the print from portrait to landscape and set
your computer and printer whether you're printing on a
certain size of paper. You'll also see, on the right, a pre-
view of your printed document will look like.

Step 4: When you're happy with your settings, click Print.
The document will now start printing on your printer.
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The curves of F, V ith and THEE when joined with R & L hooks form two curves called the Left and the Right curves written
according to their motions.

Left and Right Curves

The left curve is used when a vowel precedes and the right curve is used when a vowel follows.

However, initially the left curve of fl is used as in

But when joined to other strokes the convenient curve should be used, as in

Use of Upward SH with hooked strokes

The stroke SH is written upward before K/G initially hooked; and after certain down strokes; as in following cases:

Intervening Vowels

An initially hooked stroke (pr,kr,chr, etc.) can also be used even when a vowel occurs between the stroke and the L/R
hook. If it is a dot vowel, it is indicated by a small circle (o) either after or before the stroke, thus,

An intervening dash vowel/diphthong is indicated by writing the sign through the stroke, as in

Office Administration and Facility Management          R.Theory for Ex 1.2.26
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

Left and Right forms of Curved Hooked Strokes of F/V/th/TH and upward
SH-Intervening Vowels between Strokes and Initial Hooks

Objectives: At the end of this lesson you shall be able to
• illustrate right (alternate) forms of curved hooked strokes
• explain the uses of right forms of curved hooked strokes
• state the use of upward SH with hooked strokes
• explain the placement of intervening vowels between strokes and initial hooks.
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If it is not possible to write through the stroke, it is placed at the beginning for a first place vowel or at the end for a
third place vowel.

The hooked stroke should not be used in monosyllabic words when a vowel intervenes between the hook and the stroke.

S Circle and Hooks

Circle S/SW/ST before straight strokes hooked for ‘R’ can be expressed by writing them in the place of R hook (with
the right motion), as in

Compound Consonants

When two consonants immediately follow each other, they are called compound consonants. Compound consonants
are represented in shorthand in the following manner.

Grammalogues
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Office Administration and Facility Management          R.Theory for Ex 1.2.27
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

Compound Consonants (WH, WHL, KW, GW, MP/MB, WL, LR, RR etc.)

Objectives: At the end of this lesson you shall be able to
• describe compound consonants
• explain rules to be followed
• recal rules.

Letters Primary Added Added Sign Compound Explanation
Stroke Letter stroke

KW k+w Large Large initial hook written with left

= kw initial hook motion to ‘k’ or ‘g’ represents addition

of  ‘w’; thus ‘kw’ ‘gw’

GW g+w Large intial

=gw hook

WH w+h Initial hook  The hook of ‘w’ is enlarged to

=wh enlarged   (up)  represent ‘wh’.

WL w+l Small  Small initial hook inside L represents

= wl initial hook  (up)  the addition of ‘w’; thus ‘wl’.

WHL wh+l Large  Large initial hook inside ‘l’ represents

=whl initial hook  (up)  the addition of ‘wh’; thus ‘whl’.

LR l+r L is thickened  ‘L’ is thickened to represent the

= lr  addition of ‘r’; thus ‘ler’. It is always

(down)  written downward.

RR r+r R is thickened  ‘R’ is thickened to represent the

=rr (down)  addition of ‘r’; thus ‘rer’.

MP/MB m+p M is  ‘M’ is thickened to represent ‘mp’ or

=mp/ thickened  ‘mb’.

m+b for addition

=mb of p or b

Compound Consonants

When two consonants immediately follow each other, they are called compound consonants. Compound consonants
are represented in shorthand in the following manner.

Formation of compound consonants

A large initial hook with left motion to the strokes ‘k’ or ‘g’, adds ‘w’ and forms compound consonants. The compound
consonants ‘kw’ or ‘gw’ can be used initially, medially and finally; thus,
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A small circle may be prefixed to ‘kw’; thus,

Circles, loops or any attachments may be added finally to ‘kw’ or ‘gw’; thus,

The compound consonant of ‘kw’ is not used in words like

                                                  equality, etc., where a clear outline cannot be obtained by writing ‘kw’.

When the sounds of ‘w’ and ‘h’ occur together i.e., ‘wh’, the initial hook of ‘w’ is enlarged to represent the compound

consonant of ‘wh’. Final attachment can be added to ‘wh’. However, ‘wh’ does not occur finally; thus,

                   whip,             wherein,                 nowhere               whisky,              whistle.

A small initial hook written inside the stroke upward ‘l’, prefixes ‘w’ and forms a compound consonant ‘w+l’, which is

used initially, medially and finally; thus,

             well,             woolly,            weldon,                    welcomer,              wealth,                 unwell

Final attachments of circles, loops or hooks are added to ‘wl’; thus,

           well,               wills. 

A large initial hook written inside the stroke upward ‘l’, forms a compound consonant ‘wh+l’, which is used initially, and

finally; thus,

          wheel,              whelm,                  whaler,             while,                       ,meanwhile

Final attachments of circles, loops or hooks may be added to ‘whl’; thus,

When a word begins with vowel and followed by ‘wl’, ‘whl’, the outline is to be written fully; thus,

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.27
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The downward ‘l’ is thickened for the addition of ‘r’ and thereby represents the compound consonant of ‘lr’. The vowel

between ‘l’ and ‘r’ is generally unaccented. Short vowels ‘e’, ‘a’, ‘u’, etc. generally occurr between  ‘l’ and ‘r’ in the end

of spellings –lar, -ler, -lour, -lor, thus,

A small circle can only be attached finally to the compound consonant ‘lr’; thus,

When a strongly sounded vowel occurs between ‘l’ and ‘r’, strokes ‘l’ and ‘r’ are to be used;

When a vowel follows final ‘lr’, stroke ‘l’ and ‘r’ are to be used; thus,

The stroke ‘m’ is thickened to add ‘p’ or ‘b’ and thereby represents the compound consonant ‘mp’ or ‘mb’ and this shall

be used to represent ‘mp’ or ‘mb’ without a vowel between them, initially, medially and finally; thus,

The initial attachments of circles, loops, hooks or tick ‘h’ arc attached to the compound consonants ‘mp’ or ‘mb’, in the

same manner as they are attached to other curves; thus,

Finally, attachments of circles, loops or hooks may be added to ‘mp’ or ‘mb’; thus,

The compound consonant of ‘mp’ or ‘mb’ is not used when a vowel occurs between ‘m-p’ or ‘m-b’; thus,

‘mp’ or ‘mb’ is not used when ‘m’ is followed by ‘pr’, ‘br’, ‘pl’, ‘bl’ and should be written with stroke ‘m’ and hooked form;

thus,

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.27
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Office Administration and Facility Management          R.Theory for Ex 1.2.28
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

Words commonly misspelt

Objectives: At the end of this lesson you shall be able to
• spell correctly words commonly misspelt
• state the types of mistakes that occur in English.

Spelling mistakes in English occur owing to a number
of factors

A It is quite natural that mistakes are bound to occur to
foreign learners

B English language admits words from other languages

C Pronunciation of words  is not according to spelling.
Ex: door, bore

D Influence of native language leads to spelling mistakes

Types of Mistakes

A Addition of unnecessary letter/letters to a word

B Omission of a letter/letters from a word

C Substitution of a letter/letters for the correct letter

D Arrangement of correct letters in the wrong order in a
word

Sl.        Commonly    Correct Spelling
No.       misspelt as

27

28

29

30

31

32

33

34

35

36

37

38

39

40

41

42

43

44

45

46

47

48

49

50

51

Sincearly

suspisious

Temparary

Undoubtly

Vialance

Truely

Haras

perseverence

tommorrow

arguement

attendence

Cemetary

criticisum

descipline

foriegn

Grammer

gidance

imidiate

interferance

managable

mischivous

noticable

occured

Opurtunity

Personel

Sincerely

Suspicious

Temporary

Undoubtedly

Violence

Truly

Harass

Perseverance

tomorrow

argument

attendance

cemetery

criticism

discipline

foreign

grammar

guidance

immediate

interference

manageable

mischievous

noticeable

Occurred

Opportunity

Personnel

appearence

achivement

Begining

comitment

defanitely

embaras

genious

greatful

garantee

influensial

maintainance

Milionair

mystirious

ocational

Openion

Permeanent

physishun

Prefered

Pronounciation

Que

Recipt

Relegion

Rhythem

Saftey

Scenary

Shedule

Sl.        Commonly    Correct Spelling
No.       misspelt as

appearance

achievement

beginning

commitment

definitely

embarrass

genius

grateful

guarantee

influential

maintenance

millionaire

mysterious

occasional

Opinion

Permanent

Physician

Preferred

Pronunciation

Queue

Receipt

Religion

Rhythm

safety

Scenery

Schedule

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26
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52

53

54

55

56

57

58

59

60

61

62

63

64

65

66

67

68

69

70

Possession

Privilege

Psychological

Professor

Receive

Restaurant

Ridiculous

Ninety

Secretary

Separate

Success

Temperature

Technique

Unique

Weather (doubt)

Government

Indispensable

Until

Relevant

Poscession

Previlege

Psyckological

Professer

Recive

Restaurent

Ridiculus

Ninty

Secretery

Sepearate

Sucess

Temparature

Techniqe

Uniq

Whether (climate)

Govenment

Indispensible

Until

Relevent

Sl.        Commonly    Correct Spelling
No.       misspelt as
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Congratulations! That's marvellous! Well done; keep it up!

Oh, that's wonderful! That's splendid! Oh, what an excellent performance!

That's great Oh, it's fantastic! That's really brilliant!

Saying good bye:

See you, guys, Bye. Good bye Good night

Cheerio, Bye.

Making Requests

We use 'will', 'can', 'could' and 'would' when we want to get something done by someone for us.

Ex: Will you put out the fire for me, please?

Please, would you get me a cup of tea?

Please, could you tell me your past experiences?

I wonder if you could lend me your calculator?

Would you mind calling Raghu?

Could I speak to Dr. Sampath?

Could I sit next to you?

Expressing Likes/Dislikes and Emotions

Expressions for 'Likes'

I like  I love I'm fond of

I'm crazy I'd like to have I'd rather have

Yum!  I enjoy

Expressions for Dislikes

I don't like I hate I'm fed up with

It's disgusting It's boring I don't want

I don't like I'm not interested I don't have the inclination

Greeting

Greeting is what you say when you meet your friends and
people who are close to you Common language expres-
sions used to greet people: ' Hello', and  ' Hi'.

Ex: Hi, how goes life?

      Hello, everybody.

'Hi' is not polite when you greet your elders

When something good happens to someone, we congratu-
late them to express our pleasure

Expressions for congratulating and appreciating a person:

Office Administration and Facility Management          R.Theory for Ex 1.2.29
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

Study of conversational English - I

Objectives: At the end of this lesson you shall be able to
• greet people politely
• make requests gently
• express your likes, dislikes and emotions
• ask for and give directions
• make offers and respond to offers.

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



97

Expressing Emotions

We express our joy, wonder, appreciation, surprise, admiration, pain and disgust by the following expressions:

My goodness! My God! Oh, really!

How very beautiful! It's amazing! Fantastic!

That's terrific! Would you believe it! Wow!

Ouch! Just imagine! Just figure it out!

Asking for directions and giving directions

When you approach a stranger on the street to ask for direction, it is always polite to say 'Excuse me' first and say
'please' at the end.

Asking for direction Responses

Excuse me, where is the Post Office, please?

I wonder if you could tell me the way to the Loyola Col-
lege, please?

It's near the church

I'm sorry.  I don't know.  I'm a stranger myself

Yes, there's one on Flowers Road

Yes, walk straight as far as the end of this road and
you will     see it on your right just opposite the Saravana
Hotel

Making offers

Would you like some coffee?

Shall I give you some apples?

What drink do you like, Sir?

Hello, May I help you?

Do you need my help?

Shall I carry your bag for you?

Would you like to have anything to eat

Yes, please

No, thanks

It'll be a pleasure if you help me

No, thanks, it's very kind of you

Mm... I won't say no to it

Don't worry

That's really very kind of you

Making offers Responses

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.29
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Office Administration and Facility Management          R.Theory for Ex 1.2.30
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

Study of Conversational English - II

Objectives: At the end of this lesson you shall be able to
• improve your telephoning skills
• ask for opinion on an issue
• respond when asked to give an opinion
• express apologies and respond to apologies
• ask for permissions
• give or refuse permissions.

Agreeing/Disagreeing

   Expressing Agreement                  Expressing Disagreement

Your're quite right I'm not sure

You're right.  I agree I may not agree with your views

I think you're wrong

No, that's not how I see it

Asking for opinion

                  Asking for opinion        Responses (Positive/Negative)

Do you like it?  What's your view? Yes, it's nice!

How do you like it? It's fantastic!

How do you see it? Yes, it's terrific!

Would you like to say anything about it? No, comments, please

I've nothing to say

I don't know.  It's puzzling

I don't know what to say

Apologising & Responding to Apologies

We feel sorry when we have done something wrong. This act of saying sorry is called apologising.

         Expressions for Apology                     Responses for Apology

Sorry It's OK.  Forget about it

I'm so sorry It doesn't matter

I'm terribly sorry Don't feel guilty about it

I apologise for what I've done to you No hard feelings at all

I'd like to apologise for my blunder Not to worry

Telephoning Skills

Telephoning skills are  very essential to everyone espe-
cially for an officer, secretary or administrator

Example

Client: Hello, can I speak to Mr. Kedar?

Secretary: Yes, hold on, please.  I'll put you through

Client: I'M SORRY HE'S OUT AT THE MOMENT. Can I
take a message?

Secretary: No, I'' call again in the evening

OR

Yes, please tell him Mr. Guru called. Ask him to call back
at 4 p.m.

Secretary: What's your number, please?

Client: Take it down.  It's 22228875
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Asking for Permissions and Responses to Permissions

   Asking for Permissions   Responses (Giving Permissions)    Responses (Refusing Permissions

Can I borrow your bike, Yes, you can Sorry, I'm going to need it

Santanam?

May I come in, Sir? Of course, you can I'm afraid, you can't

Could I see you for a minute? Yes, you may go No, you can't  stay during the holiday

Do you mind my sitting here? All, right Not at all

I wonder if I could use your

computer for an hour? No, you are not allowed

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.30
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Office Administration and Facility Management          R.Theory for Ex 1.2.31
Stenographer Secretarial Asst. (Eng) - Formation of Words, Phrases and
Practice of MS Word

Study of Conversational English - III

Objectives: At the end of this lesson you shall be able to
• warn people
• ask for information
• extend invitation and respond to invitation
• thank people
• sympathize with people.

Warning

We sometimes have to warn or caution people against possible dangers, accidents or mishaps.  The expressions that
can be used are:

Look out Look out for Be aware

Don't eat too much Watch out Be careful

Keep away Be alert

Asking for information

Could you tell me the time, please?

Can you direct me to the SBI Bank, please?

How far is it?  Is it very far?

How can I get there?

How full is this dam?

How much power do you generate?

How long does it take?

Inviting people

         Inviting people     Accepting the invitation          Refusing to accept invitation

Why don' you drop in one day? Yes, please.  I;ll be there at 6.30.   Thank you very much but I can't come

How about this Sunday evening That's very nice of you      I'm extremely sorry.  I can't come
at 7 p.m. at my house?

If you want to come and stay It's a pleasure      I wish I could, but....
with us, you'd be very welcome

Let's spend a day out together That sounds a fine idea     What a pity!  I won't be able to come

Would you like to visit us     That's very kind of you, but Saturday
this evening?     does n't suit me

Please do come this evening

Thanking people

When someone had done a kind thing to you, you express your gratitude to them by saying 'Thanks'
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Thanking People Responses

Thank you very much Not at all.  Enjoy yourself

Thanks a lot You're most welcome

That's really very kind of you It's a pleasure

I'm very grateful That's O.K.

I very much appreciate your help I'm delighted to be of some help to you

I really can't thank you in words Oh! It's nothing, I hope you like the presents

Sympathizing

We say sorry to people when something bad or unpleasant happens to them

Ex: Sorry What a pity!

I'm sorry to hear that How sad!

I'm trribly sorry to hear that How tragic!

I'm extremely sorry to hear that How cruel!

I'm awfully sorry to hear that Can you believe this!

My sympathies are with you My heartfelt condolences

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.2.31
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Office Administration and Facility Management   R.Theory for Ex 1.3.32 &33
Stenographer Secretarial Asst. (Eng) - Speed developing exercise and
English language skills

Final hooks: N&F/V Hooks and Vowels, Circles and Loops with finally hooked
strokes Shun hook

Objectives: At the end of this lesson you shall be able to
• explain how final hooks N and F/V are written
• state when hooks cannot be written
• explain circles and loops with hooks
• illustrate employment of hooks medially
• illustrate the direction of LN and SHN in words
• explain how the final syllable - NER is represented
• explain the large final hook SHUN
• describe SHUN hook after circle and strokes.

Final Hook - N

To Straight strokes

A small final hook attached to a straight stroke with right motion (clock wise) represents the addition of ‘n’ to the stroke.
as in

To Curved Strokes: N Hook is written finally inside the curves as in

F/V Hook

A small hook written with left motion to straight strokes represents the addition of F or V to the stroke, as in

F/V cannot be expressed by hook with curved strokes and  is written by the stroke, as in

Hooks can be employed medially whenever clear outlines are obtained, as in

Final Hooks & Vowels

Final hooks are not used if a vowel follows N/F/V, as in

Termination - NER

The termination "ner" is written according to facility (N hook+downdard R), or by hooked ‘n’             , as in
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Use of Circle & Loops with Final Hooks

S, SES, ST, SD or STR is added to N attached to a straight stroke by writig the circle or loop on the same side as the
N hook.

S Circle gives Z sound when placed inside the F/V and N hooks to indicate plurals or singular verbs, as in

The sound of NS and NZ should be distinguished by using the hooks and the strokes, as in

Large Final Hook - SHUN

If the final hook is enlarged, it represents the sound of Shun.  The hook can extend upto ¼ of the length of a stroke.

A large final hook attached to straight strokes on the opposite side of a vowel or diphone/triphone and inside curves adds
-SHION, -TION, -CIAN, -SION, -TIAN, -SIAN to the strokes, as in

This hook is written on the opposite side of a circle or hook attached to the stroke, as in

This hook is written on the opposite side of F, V & L curves followed by K/G to maintain the straightness of K/G, strokes
as in

This hook is written on the right side of CH, J, T, D strokes to facilitate easy joining, as in

SHUN Hook after circle and strokes

Shun after circle is represented by a small curl (continuation of the circle). A third vowel can be indicated outside the curl,
as in

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.3.32 & 33
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Phrases & Contractions

Grammalogues

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.3.34 & 35
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Office Administration and Facility Management   R.Theory for Ex 1.3.34 & 35
Stenographer Secretarial Asst. (Eng) - Speed developing exercise and
English language skills

Halving principles: Halving of strokes for T or D, Halving of M,N,L,R for D,
Halving of hooked MP/MB/NG, etc.

Objectives: At the end of this lesson you shall be able to
• explain halving for T&D
• state the halving principles for MD,ND, LD & RD
• state the halving principle for MP/MB/NG
• explain grammalogues / contractions /phrases related to the halving principle.

In Shorthand it looks strange to add something to a consonant stroke by halving it. It facilitates speed and clarity of
outlines.

Halving for T or D

In words of one syllable (stroke) a light stroke without any final hook or joined diphthong can be halved for the addition of
T and a heavy stroke without a final hook or joined diphthong can be halved for ‘D’ only.

Any stroke having a final hook or joined diphthong/diphone can be halved for the addition of T or D, as in

A word having more than one syllable (stroke) can also be halved for the addition of T or D, as in

Halving principle cannot be employed if a vowel follows T or D finally, as in

           pit           pity              greed             greedy                    goody

Half length strokes initially are written above the line and on the line according to their vowels, but in no case these can
be written through the line, as in

Halving M, N, L, R

M, N, L, R (downward) strokes can be thickened and halved for D, as in

               made              need            old              aired

MP/MB, NG

The compound consonant of MP/MB and NG can be halved to represent the addition of T or D when they are hooked
initially or finally, as in
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When P/B are not pronounced fully they are represented by halved M stroke, as in

Half sized strokes are sometimes disjoined to get clearcut outlines, as in

RT & LT  are written upward when halved for T, but when thick RD is inconvenient, upward R also can be halved (/) to
represent RD as in

Strokes of unequal length can be joined where there is difference in thickness, as in

Strokes of unequal length can not be joined unless there is an angle at the point of junction, so the following words are,
written with full-length strokes.

In past tenses -ted or -ded is always indicated by half - length T or D, as in

Stroke S (Up/Downward) after SHUN hook is halved as in

A word (verb) represented by a single stroke with initial attachment can be halved for its past tense

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.3.34 & 35

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



107

Practice the following important Grammalogues /Contractions/ phrases related to the Halving principle

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.3.34 & 35
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Office Administration and Facility Management          R.Theory for Ex 1.3.36
Stenographer Secretarial Asst. (Eng) - Speed developing exercise and
English language skills

Pairs of Words Confused and Misused

Objectives: At the end of this lesson you shall be able to
• distinguish between words with the same pronunciation but different spelling and meaning
• use the words correctly into sentences to being out their correct meaning.

S. No.

1

2

3

4

5

6

7

8

9

10

11

12

13

14

Spelling

Farmer

Former

bear

bare

Not

Knot

Medal

Meddle

Dew

Due

Stationary

Stationery

maid

made

Wait

Weight

Holy

Wholly

Sew

Sow

So

Patients

patience

Soul

Sole

Principle

principal

Accept

Except

Expect

Meaning

Agriculturist

previous

an animal/tolerate

naked

negative meaning

loop

Badge

interfere

tiny drop of water

expected to happen

Motionless

Writing material

female domestic servant

produced

allow time to go by

mass

Sacred

Completely/entirely

Stitch

scatter/disperse

extremely

Persons suffering
from ailments

tolerance

spiritual part of a
person

only/exclusive

basic rule

chief/main

Agree

Excluding

await/anticipate

Illustrative Sentence

Farmers are the backbone of our country

She was the former Chief Minister of Tamil Nadu

Bears are wild animals with thick fur
I cannot bear the suspense any longer

Do not walk around outside in your bare feet

He is not a bad guy

He tied the knot around the bride's neck

He has won the gold medal in Table Tennis Competition

Do not meddle into my affairs

We can see dew upon grass in the mornings

The next meeting is due in August

The lorry hit a stationary van

Companies do not spend much on stationery these days

I have employed a maid to assist my mother

He has a Swiss-made watch

The dentist kept waiting for ages

All my efforts to reduce my weight did not work

I visited the holy shrine of Kedarnath

I supported my friend wholly

My grandmother taught me to sew

Sow the rose seeds in pots

The house is so beautiful

The doctor has no time to attend to all his patients

Your patience will be rewarded

Please put your heart and soul into your work

My sole aim is to stand first in the class

Can you define Archimedes' principle?

He cannot give up teaching.  It is his principal source of
income

I accept your suggestion

Except Ravi, everyone attended the meeting

Do not expect miracles to happen
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S. No. Spelling         Meaning                      Illustrative Sentence

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

Pale

Pail

Loose

Lose

toe

tow

Night

knight

Affect

effect

compliment

complement

council

counsel

Practice

practise

cease

seize

Plane

plain

Male

mail

miner

minor

Moral

morale

birth

berth

Human

humane

course

coarse

not bright

bucket

not tight

opposite of gain

one of the digits of human
foot
pull

opposite of day

mounted soldier

Influence

result

praise

that which completes

assembly

advice

exercise (Noun)

exercise (Verb)

stop

to take by force

flat

surface/aeroplane
simple

Masculine

letters and parcels sent
by post

person who works in
a mine

little/small

Lesson

confidence

emergence of a baby from
the body of its mother

bed in a train, etc.

nature of man

kind

a plan of study

rough/harsh

His pale face shows that he is not well

It took two pails of water to put out the fire

He always wears a loose shirt

Keep trying.  Do not lose your heart

He has six toes in his left foot

The car in front of us is on tow.  That's why we are going
slowly

Night travel is not without risks

The princess was rescued by a knight

He was affected by her harsh words

The medicine for headache did not have any effect

I take it as a compliment when you compare me to my
father

The music completes her voice perfectly

Heated arguments were exchanged in the Tamil Nadu
council today

Take his wise counsel and you will see better days

Practice makes a man perfect

Practise shorthand every day

These superstitious practices should cease forthwith

The crow seized the vadai from my hands when I was
looking the other way

He hates travelling by plane

He prefers plain food

She gave birth to a male child

Please redirect any mail to my present address

The miners are on strike

It is only a minor problem

What is the moral of this story?

The team's morale should improve after this victory

She gave birth to five children within ten years

She was able to get a lower berth in the train

To err is human/ I am only human

Humane treatment of animals should be our aim

There are still some vacancies for students in engineering
courses

He is a man of coarse manners

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.3.36
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31

32

33

34

35

36

37

38

lessons

lessens

Bail

bale

site

sight

cite

Hole

whole

sent

scent

cent

Weather

whether

Here

hear

aloud

allowed

Instruction

reduces

Security

bound bundle of paper

area/plot

vision

quote

a  hollow place

entire

despatched

Fragrance

hundred

Climate

if

at this place

listen

in a loud voice

permitted

Life never stops teaching us lessons

Keeping your weight down lessens the risk of heart
disease

He was released on bail

The fire destroyed 200 bales of hay

A building is expected to come up at this site shortly

She has an excellent sight

Can you cite an example to prove your point?

The dog had dug a hole in the ground

The whole town was destroyed by the earthquake

I sent a message to my boss asking for leave

The scent of roses permeated the air

The school achieved cent per cent results

The weather is fine today

The weather is fine but I cannot say whether it will rain

Come here and have a look at this bird

Please hear me out. You can speak later

Do  not speak aloud.  They are writing the examination

Foreigners are not allowed to enter this temple

S. No. Spelling         Meaning Illustrative Sentence

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.3.36
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"Doubling the length of any stroke for the addition of -TR, -DR, -THR or -TURE,  is called Doubling Principle in
Shorthand".

Doubling for TR & DR

i) The curved strokes are doubled for the addition -TR, -DR, -THR or -TURE, thus

                       reminder                   murder                     vender                 voter, etc.,

ii) Straight strokes with initial attachment/hook or with a final hook or joined dipthong are doubled for the addition of -TR,
-TR, -DR, -THR, -TURE. Straight stroke following a consonant can also be doubled.

MP/MB & NG
iii) The compound strokes of MP or MB can be doubled for the addition of R only, while NG can be doubled for

the addition of KR/GR, as in

LTR/LDRL/LTHR

i) L when standing alone or with a final circle is doubled for the addition of -TR only

ii) Strokes of unequal length cannot be doubled, as in

iii) The Doubling principle is not employed when a vowel follows final R or when there is inconvenient joining, as in

iv) Past tenses of words written with doubling principle are obtained by halving principle, as in

Office Administration and Facility Management   R.Theory for Ex 1.3.37 &38
Stenographer Secretarial Asst. (Eng) - Speed developing exercise and
English language skills

Doubling Principles: Doubling of strokes for TR and DR - Doubling of MP/
MB and NG, stroke L, etc.

Objectives: At the end of this lesson you shall be able to
• state the principles for adding TR/DR/THr/TRUE
• state the use of doubled and hooked forms of MPR/MBR
• state the uses of doubled and hooked forms of NG-KR and NG-GR
• express double - length forms for verbs in the present tense
• explain the circumstances when doubling principle cannot be employed
• state the position of double-length strokes
• state the uses of the doubling principle in Phraseography.
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Practise the following important grammalogues/contractions/phrases related to the doubling principle

Grammalogues Character

Culture

Industry

Therefore

Rather (writer)

Cooperative

Wonderful-ly

Speaker

Contractions Characteristic

Internet

Alternative

Federal

Interest

Inventor

Centralise

Phrases in order that

rather than

in their

not later than

I am sure there is

if there were

upon their

Private sector

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.3.37 & 38
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Office Administration and Facility Management           R.Theory for Ex 1.3.39
Stenographer Secretarial Asst. (Eng) - Speed developing exercise and
English language skills

Single word substitution for groups of words in English

Objectives: At the end of this lesson you shall be able to
• substitute single words for groups of words
• enhance your vocabulary of English.

S.No.

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34

35

                                         Group of Words

Study of human societies and cultures

System of Government by one person with absolute power

System of Government in which power is held by the nobility

Study of human history through the excavation of sites

Provision for spouse after separation or divorce

Period during which one develops from a child into an adult

Free from a criminal charge

A partial or total loss of memory

List of items to be discussed at a formal meeting

The assembled spectators or listeners at a public event

A shortened form of word/phrase

A vertebrate animal that lives both on land and in water

Medicine to counteract a poison

Relating to water

A word opposite in meaning to another

One who checks the accounts of a company

A slaughter house

A Government run by officials

A minor change to improve a legislation, etc.

An instrument for measuring atmospheric pressure

To make a problem more serious

A list of books referred to in a scholarly work

A keeper or custodian of a museum

A musical performance given in public

A complete list of items in a systematic order

The arrangement of events or dates in the order of their occurrence

Department that collects the duties levied by a Govt. on imported goods

Causing sudden damage/suffering

A nursery where babies and young children are cared for

A person em,played to drive a private or hired car

An animal that feeds on other animals

Active during the day

A large bed room for a number of people

The identification of an illness by examination of the symptoms

An association typically of several companies

One word

Anthropology

Autocracy

Aristocracy

Archaeology

Alimony

Adolescence

Acquit

Amnesia

Agenda

Audience

Abbreviation

Amphibian

Antidote

Aquatic

Antonym

Auditor

Abattoir

Bureaucracy

Amendment

Barometer

Aggravate

Bibliography

Curator

Concert

Catalogue

Chronology

Customs

Catastrophic

Creche

Chauffeur

Carnivore

Diurnal

Dormitory

Diagnosis

Consortium
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S.No.

36

37

38

39

40

41

42

43

44

45

46

47

48

49

50

51

52

53

54

55

56

57

58

59

60

61

62

63

64

65

66

67

68

69

70

71

72

73

74

75

76

                                        Group of Words

Irrational fear of confined places

The country that a person lives in

A Government by the people

A place where medicines are prepared

Measurement of decrease in monetary value

The painless killing of a person suffering from an incurable disease

The customary code of polite behaviour in society

An outgoing, socially confident person

A tax levied on goods produced within a country

Spoken or done without preparation

A book/or set of books giving information on a wide number of subjects

One with the power to put plans into effect

A long book/poem telling a story  of great events extending over a long
period of time

A feeling of intense excitement and happiness

An exact copy of a written or printed material

Plants of a particular region

Animals of a particular region

That which can be broken easily

A sum of money paid to an employee at the end of a period of
employment

The deliberate killing of a large group of people

A payment given for professional services

A person seized or held as security for the fulfillment of a condition

An office without salary

The killing of one person by another

Special honour or respect shown publicly

A plane figure with six straight sides and angles

An animal that feeds on plants

Of the same kind

Of different kind

A planned route or journey

A shy reticent personb

Not clear enough to be read

Not able to be changed or corrected

Inability to sleep

A person who comes to live permanently in a foreign country

Relating to young people

A nursery school

A person who knows many languages

A person who is killed because of his beliefs

Evil in nature

A person who hates women

      One word

Claustrophobia

Domicile

Democracy

Dispensary

Depreciation

Euthanasia

Etiquette

Extrovert

Excise

Extempore

Encyclopaedia

Executive

Epic

Euphoria

Facsimile

Flora

Fauna

Fragile

Gratuity

Genocide

Honorarium

Hostage

Honorary

Homicide

Homage

Hexagon

Herbivore

Homogeneous

Heterogeneous

Itinerary

Introvert

Illegible

Incorrigible

Insomnia

Immigrant

Juvenile

Kindergarten

Linguist

Martyr

Malignant

Misogynist

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.3.39
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S.No.

77

78

79

80

81

82

83

84

85

86

87

88

89

90

91

92

93

94

95

96

97

98

99

100

                                   Group of Words

A person who dislikes mankind

Active at night

Feeding on food both of plant and animal origin

One who looks at the cheerful side of things

A fertile spot in a desert where water is found

One who knows everything

One who is present everywhere

One who is all powerful

A residential institution for the care and education of orphans

A person who sees the dark side of things

One who collects stamps

A person who travels by foot

One who donates money for the welfare of others

One who loves his country

A person who journeys to a sacred  place for religious reasons

That which can be carried

Killing of a king

A position with salary but no work

Action of killing oneself intentionally

A person who never drinks alcohol

A pupil who stays away from school without leave

An agreement to stop fighting

Deliberate destruction of public property

One who has lost her husband

 One word

Misanthrope

Nocturnal

Omnivorous

Optimist

Oasis

Omniscient

Omnipresent

Omnipotent

Orphanage

Pessimist

Philatelist

Pedestrian

Philanthropist

Patriot

Pilgrim

Portable

Regicide

Sinecure

Suicide

Teetotaller

Truant

Truce

Vandalism

Widow

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.3.39
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Office Administration and Facility Management   R.Theory for Ex 1.4.40 &41
Stenographer Secretarial Asst. (Eng) - Speed enhancing techniques

Prefixes: Definition and Uses

Objectives: At the end of this lesson you shall be able to
• define prefixes
• state the strokes used for prefixes
• explain with examples the use of various prefixes
• explain the use of prefixes in grammalogues, etc.

Definition

“Part of a word which affects the meaning of another word if put in its beginning is called a prefix”
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The prefix Accom- or
accommo- is represented by
joined or disjoined ‘k’; thus

Intro- is represented by joined
double length ‘n’               (ntr); thus

The prefix magna- or magne or
magni- is represented by
disjoined ‘m’; thus

The prefix ‘trans’ -  is
represented by joined ‘trs’ i.e.,
by omitting ‘n’, thus

In some cases full outline is
written to obtain clear outline;

Self- is expressed by a
disjoined small circle written
close to the following stroke in
the second place; thus

Self-con, or self-com is
represented by a disjoined
small circle placed in the
position of con- dot; thus

Accompany

Accommodation

Introduce

Introspect

Magnanimous

Magnetise

Magnificent

transfer

transmission

transact

transcend

self-made

self-reliance

self-control,

self - contained

self - confident

Accom-or
accommo-

Intro-

Magna-magne-
magni

Trans -

Self -

Self-con,
Self-com

In phraseography

after downward dash logogram,

medial –con dot should be

used, but not after downward

logogram

should commence

on-the-committe

of-the-committee

to-commence

Prefix      Explanation Examples

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.4.40 & 41
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Grammalogues

Selfish-ness inscription instruction instructive

Phrases

foundation-stone Ladies and at-the-same-time for-some-time at-some-time

gentlemen

all-parts-of-the-world        that-was      in-the-course- we-are-able-to    according-to-the

        of-your

Contractions

relinquish-ed remarkable-ly removable represent-ed representation

republic republican responsible-ly sensible-ly-ility something

substantial-ly                sufficient/ly/cy     telegram telegraphic         unanimity

unanimous-ly uniform-ity-ly universal-ly        universality                   universe

university whatever          whenever     whensoever    whereinsoever

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.4.40 & 41
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Office Administration and Facility Management   R.Theory for Ex 1.4.42 &43
Stenographer Secretarial Asst. (Eng) - Speed enhancing techniques

Suffixes : Definition and uses

Objectives: At the end of this lesson you shall be able to
• define suffixes
• state the strokes used for suffixes
• explain the use of prefixes in grammalogues, etc.

Definition

"The Part of a word which affects the meaning of another word if joined at the end, is called a Suffix.  Suffixes are
represented by the following strokes or signs".

The following tables explains you the employment of suffixes in shorthand
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Wherever –ing is represented

by dot, -ings is represented by dash

The dot –ing cannot be used

medially and hence stroke

is to be used; thus

-ality, -ility, -arity, -ority, -elty and

similar terminations are expressed

by disjoining the stroke occurring

just before the termination; thus

In a few cases, full form is

written to obtain more distinct

outlines; thus

- Logical and -logically are represented

by disjoined ‘j’  /  thus

-ings

-ing is not

used medi-

ally

-ality, -ility,

-arity, -ority,

-elty and

similar

terminations

-logical and

-logically

Suffix          Explanation              Examples

Terminations

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.4.42 & 43
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.

-ment

-mental

-mentally

-mentality

-ly

-ship

-fullness

-lessness,

-lousness

-ward, -wart, -
wort

-yard

-ment is generally represented

by        -mnt. Where this form

of      -mnt is not convenient to

join, the termination –ment is

represented by        nt; thus

-mental, -mentally, and

–mentality are expressed by

disjoined mnt; thus

-ly is expressed by joined or
disjoined ‘l’ and in some
cases with hook ‘l’ also; thus

-ship is expressed by a joined
or disjoined ‘sh’ ; thus

-fullness is represented by
disjoined ‘fs’        ; thus

-lessness and –lousness are
represented by disjoined          ‘ls’;
thus

-ward, -wart, -wort
 are expressed by joined half-length
‘w’      ; thus

-Yard is represented by joined
half-length ‘y’      ; thus

Suffix          Explanation              Examples

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.4.42 & 43
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The compound words beginning with here; there, where, etc., are written as follows

herein wherein therein

hereon whereon thereon

hereat whereat thereat

hereto whereto thereto

hereof whereof thereof

herewith wherewith therewith

Logograms used as suffixes

The following logograms, joined or disjoined, may be used as suffixes; thus

outbalance overbalance rebuild outnumber foretell

      free-trade over-trade indifference disadvantage bedchair

      armchair out-general     become outcome overcome

     recalled    forgive misgiving safeguard vanguard

self importance self improvement underhand landlord underwriter

untried ungentlemanly unequal-ly un-thinking        un-schooled

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.4.42 & 43
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                                            STROKES          WORDS                 Signs

Stroke B represents the word "billion", after figure (numbers),as in 5 billion

3 billion

10 billion

Stroke TH represents "thousand" after figures (numbers), as in Four thousand

Six thousand

50 thousand

Stroke N represents "hundred" after figures, as in 12 hundred

5 hundred

100

200

Stroke M represents "million" after figures, as in 5 million

200 million

600 million

Stroke KR represents "crore" after figures, as in 6 crores

12 crores

12,000 crores

Stroke L represents "lac (lakh)" after figures, as in 2 lacs

50 lakh

9 lacs

60 lacs

Office Administration and Facility Management          R.Theory for Ex 1.4.44
Stenographer Secretarial Asst. (Eng) - Speed enhancing techniques

Figures - Monetary units and round figures

Objectives: At the end of this lesson you shall be able to
• state the representation of monetary units in shorthand
• explain the representation of round figures in shorthand.

Round Figures

Figures are generally written with numbers, but Round Figures can be represented with disjoined strokes, thus:

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



125

Monetary Units

The principle Monetary Units are represented by their sound strokes after/before round figures, thus

                                 STROKES       WORDS               Signs

Stroke Rs represents "rupees" before round figures, as in Rs. 200

Rs. 2000

Rs. 300

Rs. 260

Stroke PNS (halved) represents £ (pounds) after figures, as in 300 £ (pounds)

2000 £ (pounds)

50 £ (pounds)

Stroke D represents "dollar" after figures, as in 1000 dollars

250 dollars

300 dollars
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Monetary Units & Round Figures

Figures

Figures in shorthand are represented in the following way. The figures one to seven and nine are represented by short-
hand outlines, when standing alone. Other numbers, except round numbers are represented by the ordinary Arabic
numerals.
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Travel, Tourism & Hospitality Related Theory for Exercise 1.4.45 & 46
Stenographer Secretarial Assistant (Eng) - Speed enhancing techniques

Contractions - Formation and uses - Essential vowels and Contractions

Objectives: At the end of this lesson, you shall be able to
• define cont
• distinguish between grammalogues and contractions
• state the different contractions and their derivatives
• explain how contractions are formed
• state the importance of contractions in speed writing
• state the circumstances when vowels need to be inserted
• illustrate the use of essential vowels initially, medially and finally.

Contractions are formed in the following ways:

1 Using the first two or three consonants

2 Omitting a medial consonant or syllable(s)

3 Based on a shortform

4 By intersecting strokes

5 Omitting the first syllable

A contraction is defined as a shorthand sign containing not less than two strokes, in which one or more of the conso-
nants of the word are not represented (omitted).

Difference between contraction and a grammalogue: A contraction is a shorthand sign containing not less than two
strokes and formed by omission of one or more strokes in the outline either medially or finally, whereas a
grammalogue is a word represented by a single shorthand sign called logogram.

Omission of Consonants
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Contractions Related words
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           Contractions                    Related words
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            Contractions                            Related words
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        Contractions                      Related words
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         Contractions Related words
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        Contractions                  Related words
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 Contractions            Related words
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Contractions           Related words
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Contractions            Related words
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 Contractions               Related words
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Essential Vowels

Vocalized Outlines. There are certain word outlines which should be vocalized to some extent, according to the follow-
ing rules:

(a) In single stroke outlines having an initial and a final vowel, the final vowel should be inserted; thus:

(b) An outline should be written in position notwithstanding that it has an initially or a finally joined diphthong-sign; thus:

(c) Where an upward or a downward ‘r’ does not indicate a preceding or a following vowel, the vowel sign should be
inserted: thus;

(1) Insertion of an initial vowel

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.4.45 & 46
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(2) Insertion of medial vowel

(3) Insertion of a final vowel
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Special Contractions

A Contraction is an abbreviated word having more than one stroke.  Simple Contractions are formed by prefixing or
suffixing strokes, circles, etc.  to logograms or grammalogues.  The other forms are Special Contractions formed by
omitting the less spelt sound-strokes, or inconvenient strokes for easy and speedy writing.  Special contractions are
generally written on the line.  However, third vowel sounding contractions should be written through the line for easy
reading and clarity.  No vowels are put on the contractions, as in

PART A

OA&FM : SSA (English) (NSQF - Revised 2022)  R.T. for Ex .1.4.45 & 46
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Office Administration and Facility Management    R.Theory for Ex 1.4.47-49
Stenographer Secretarial Asst. (Eng) - Speed enhancing techniques

Letter writing - different types of letters

Objectives: At the end of this lesson you shall be able to
• take down dictation of all kinds of correspondence
• display letters in the right format
• distingusih between official and demi-official letters
• explain the features of different types of letters.

Letter writing is the most important work of a
stenographer.  It is the art of taking down dictation from the
officer and typing it on an electronic typewriter or a
computer.  He/she has to deal with all types of
correspondence, viz.,  personal, official and business
letters.

Letter writing is not only legally valid but also the cheapest
system of communication.  Hence communication between
individuals, professionals, business houses, companies,
organizations, public sector undertakings, Govt.
Departments, etc. is done in the form of letters.  If a letter
is properly drafted and beautifully typed, it becomes
attractive and impressive at the hands of the receiver and
carries more weight.  The stenographer should type the
letter with accuracy and in proper format keeping in view
the size of the letter.

Letters are broadly classified into three categories

1 Persona l Letters

2 Business Letters

3 Official Letters

Personal Letters

They are informal.  Informal letters are letters of personal
interest exchanged between friends and relatives.  No set
norms are prescribed for typing them.

Business Letters and Official Letters

They are formal in nature.  They have to follow a set pattern
or format.

Important Parts of a Letter

1 Name of the sender or firm

2 Reference No. and date

3 Name and address of the recipient

4 Salutation (Sir, Dear Sir, Mr., Dear....)

5 Subject heading and subject matter

6 Complimentary closure/subscription, viz., 'Thanking
you,' ' With regards,' ' Yours'

7 Name and signature of the sender

8 Enclosures, etc. or Post script (if something is to be
added at the end of the letter)

Personal Correspondence

 In personal letter, heading includes address and date. It
is even  ok to just write the date. Reference No. is not
required for Personal letters. The greeting usually starts
with 'Dear' and is followed by name and a comma. After
skipping a line, the body of the letter is written which forms
the main text of your letter. The subject matter is written
in a personal or natural way. Complimentary closure
depends upon the intimacy of friendship/relationship/age,
etc.  Below the complimentary closure, name and signature
of the sender is given.

Business Letters

They are written between firms, companies, individuals
concerning any business.

Parts of a Business Letter

1 Heading: It contains name and address of the business.
It can also have an e-mail

Address, Contact number, FAX No., etc.

2 Date: Date is typed on the right-hand side corner of the
letter below the heading.

3 Reference: It shows the department of the organization
sending the letter.  It is typed in the same line as the
date on the left-hand corner

4   The Inside: It includes the name, address, postal code
and job title of the recipient. It is Address: typed in the
same line as the date on the left-hand corner.

5 Subject: It is a brief statement mentioning the reason
for writing the letter. It should be short and simple.

6 The Greeting: It generally includes words like Dear,
Respected Sir, or just Sir/Madam. A Salutation  comma
usually follows the salutation.

7 The Body: It contains the actual message of the
sender which may be divided into Paragraphs

8 The compli- It is a humble way of ending a letter.  Ex:
Yours faithfully, Yours sincerely, mentary close:
Thanks, Regards, etc.

9 Signature &It includes the signature, name and
designation of the sender.  The signature Writer's
is hand-written just above the name of the sender
identification

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



146

10 Enclosure: Enclosures show the list of documents
attached to the letter. Ex: Cheque, Draft, Invoices,  etc.

11 Copy Circula: It is needed when the copies of the
letter are sent to other persons. It is tion
denoted as C.C.

12   Post  Script: The sender can mention it when he wants
to add something other than the message in the body
of the letter. It is written as P.S.

Official Correspondence: Official letter is a
communication between two offices of the Central
Government/State Government/Statutory Body/Public
Undertaking.  Letters written from these organizations to
the individuals or employees are also called official letters.
These can be written in the following forms:

1 Simple Official Letter

2 Demi-official letter

3 Office Memorandum

4 Notification/Press Release

5 Unofficial Note

6 Office Order

7 Endorsement

8 Footnote

Parts of an Official Letter

1 Reference No. of Letter

2 Name of the office/Department/Ministry/Organisation

3 Official address of the sender

4 Address  of the recipient

5 Place and Date

6 Subject

7 Salutation

8 Body of the letter

9 Complimentary close

10 Name and Designation of the sender

11 Enclosure

12 Initials of sender/abbreviation of typist

Demi-official Letter

It is the official communication between two officers of
different departments/Ministries, etc. It is written like a
personal letter.  Demi-official letters are different from
official letters in that they are informal, would start with the
salutation 'Dear Mr./Ms...' (instead of Dear Sir or Dear
Madam) and conclude with a 'Sincerely yours'  in contrast
to 'Yours faithfully'. It is used in correspondence between
Govt. officers to draw personal attention of the addressee
officer. It should be written as below.

1 Name of the Government typed in capitals

2 Name, designation of the sender on the left-hand side
top corner just below the name of the Government

3 The department name, address of office and telephone
No. of signatory must be mentioned in the right side top
opposite to the name and designation.

4 The name and address of the person to whom it is
intended is indicated at the left-hand side bottom after
the body of the D.O. letter.

5 Then it must commence with salutation 'Dear Thiru/
Tmt.........' (Name of the officer) or 'My dear........'
(Name of the officer)

6 Letter No.

7 Subject

8 Immediately after the subject, Reference is indicated.
Here, all the references that are required for following
the case should be given

9 Body of the letter in convenient paragraphs comes
next.  It should be in the first person and in a personal
and friendly tone

10 Letter ends with an expression of regards.  Ex: 'With
kind regards',  'With best wishes', etc.

11 The subscription 'Yours sincerely' or 'Sincerely yours'
comes last on the right end of the body of the letter

12 Signature of the officer along with name

13 Indication of Enclosures at the left end of the body of
the letter

In a demi-official letter, the designation of the
signing authority is not repeated at the end of
the letter but only name is written

Office Memorandum

A memorandum is a document typically used for
communication within an organisation. This form of letter
is generally used for subordinate officers and employees
asking for explanation, etc.  It is written as below:

1 Type 'MEMORANDUM' at the top of the page

2 Address the recipient appropriately

3 Add additional recipients in the c.c. line

4 Write your name in the 'From' line

5 Include the date

6 Choose a specific phrase for the subject line

Salutation is not necessary for Office
Memorandum

Notification

It is issued to notify the promulgation of any ordinance,
statutory rules, appointments, promotions, grant of Leave,
suspension, dismissal or retirement orders of any gazetted
officer of the Government. All the notifications are published
in the Official Gazette. Notifications of public interest are
also published in the newspapers.
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Ex: Revision of Voters'List, nomination of candidates to
various posts, etc.

Unofficial Note (U.O.)

"It is written by one department to the other to seek  advice,
comments, clarifications, etc. on files or on separate note
sheets.  No salutation is given.  Reference No.,  name and
designation of the sender and the addressee are given.

Office Order

It is used for issuing instructions for grant or cancellation
of leave, advances, distribution of work, transfer, posting,
etc. of employees.  No salutation or complimentary
closure is given.  Copies are endorsed to the concerned
individuals/sections.

Endorsement

It is the copy of a communication sent to the other
department or individual who may be concerned with it. If
a list of communications is to be sent, the endorsement
of this is done as a separate letter enclosing the list of
communications to be sent. Normally, the endorsement is
made at the bottom of any communication to the individuals/
authorities/departments concerned. An  endorsement  is
addressed as  "Copy to"....

Footnote

It is a reference of some document. It enables the reader
to get the source of the document referred to by the writer.
Footnotes are typed at the bottom of the page on which
reference number is given. To separate footnotes from the
text, a line is drawn by underscore. Footnotes are generally
typed in single space. One, two or three footnotes can be
indicated by asterisks, but if there are many footnotes,
they are indicated by numbers (figures) in the form of
superscripts. Double or triple spaces are given in between
two footnotes to separate them. Nowadays, footnotes are
being given at the end of the chapter in books, articles,
research theses, etc.
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Turning over leaves of notebook

For ease in turning over leaves of your notebook while
writing on a table/desk, follow the following steps:

While writing on the upper half of the leaf, introduce the
second finger of the left hand between it and the next leaf.
At   the same time, keep the leaf (which is being written
on) steady by the first finger and thumb of the left hand.

While writing on the lower half of the leaf, shift  the leaf by
degrees till it is about half-way up the book.  Lift up the first
finger and thumb at a convenient moment.

When writing with the book on the knee, introduce the first
finger of the left hand between the leaf being written on and
the next leaf.  The leaf should be moved up only about 2".
The finger should be introduced at any convenient
opportunity presented by the speaker.  Another method is
to hold the bottom left-hand corner of the leaf with the first
finger and thumb.  On the bottom line being reached, the
lead is lifted and turned over.

The writer should write on one side of the paper till the end
of the book.  After reaching the end of the book, he should
turn the round and write on the blank side of the paper,
proceeding as before.

Essentials of accurate note-taking

1 Unvocalized outlines help a great deal in securing rapid
writing and facile reading.

2 Employing contractions will be a great asset to the
note-taker.

3 Using intersections will assist the note-taker a great
deal

4 Making use of phraseograms will help the note-taker
keep pace with the speed.

5 Without resorting to vocalized outlines, by following
position-writing rules, he can readily distinguish outlines
common to two or more words.

6 Efforts should be made from the beginning to write the
outlines clearly and in position.

7 The ability to dispense with vowels should be cultivated
right from the beginning. Taking notes of public speakers
without vocalizing will come to the aid of a shorthand
writer.

8 All the exercises from elementary rules to advanced
abbreviations illustrating the rules of shorthand should
be practised by taking them down.  The more thoroughly
the rules are studied and practised, the more efficient
the note-taking capabilities of the student will be.

9 Efficient and persistent efforts are  the key for successful
note-taking.

10 Reading of printed unvocalized shorthand in advanced
style should be made a regular habit to gain an
extensive knowledge of outlines.

11 Essential vowels should not be omitted and unnecessary
vowels should not be inserted.  Inserting unnecessary
vowels may render the writer unable to keep pace with
the speaker.

12 Grammalogues and contracted forms form sixty per
cent of any ordinary piece of matter. Hence they should
be practised in writing from dictation of relevant
exercises.

13 To begin with, dictation should be taken for periods of
five minutes with the insertion of only necessary
vowels. Gradually, the speed should be introduced by
ten words a minute.  It is not enough  keeping  two or
three words behind the reader. The student should
practise writing ten or a dozen words behind the reader
so as to acquire the power of doing so in emergencies.

14 When a wrong outline is written, that fact should be
ignored and the student should proceed with the
dictation. It can be corrected later on. If several outlines
are wrongly written, the speed should be reduced.

15 Practice should not only be regular but also systematic.
Practice of an hour a day is better than two, or even
three hours every second day. Writing and reading
practice in both printed and one's own notes will boost
one's confidence

16 The subject matter to be practised should be as varied
as possible. The more the variation, the mored the
vocabulary.

17 The legibility of the notes can be improved if the large
circles, loops and hooks are exaggerated in size.

18 The pen should be held with moderate pressure.  The
whole hand, poised lightly on the little finger, should
move with it.

Office Administration and Facility Management          R.Theory for Ex 1.5.50
Stenographer Secretarial Asst. (Eng) - Note taking and transcription
techniques

Note taking techniques - Transcribing techniques

Objectives: At the end of this lesson you shall be able to
• state how to turn over the leaves of your SH notebook
• explain the essentials of accurate note-taking
• state the advantages of position writing.
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19 Sprawling outlines result when writing at high speed
owding to anxiety to avoid omission. It is preferable to
omit a few outlines rather than risk the legibility of many
outlines.

20 Confidence must be maintained even if something
important has been omitted so that the rest of the note
will not suffer.

21 Concentration on the dmatter dictated together with
the grammatical construction of the sentences is very
important.

22 Special attention should be paid to the speaker's tone
of voice and peculiarities of speech. Mechanical writing
of the shorthand characters will do no good.

23 Full-stops should always be written. It is of great help
in the transcription of notes. Dashes should also be
inserted in orderd to indicate whered the speaker drops
the principal sentence and where he resumes it, if ever.
Ad small space should be left for a parenthesis or
important comma, and somewhat a larger one for a full
stop, if the stop cannot be written.

24 For reporting technical matter, it is important to prepare
oneself before-hand as well as possible.  The shorthand
writer should familiarise himself with the terms which
are likely to be used. Or else, his transcription will not
be satisfactory both to himself and to his boss.
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Office Administration and Facility Management  R. Theory for Ex 1.6.51 - 53
Stenographer Secretarial  Asst. (Eng) - MS Excel - Importance of office -
office layouts registers - Dictation exercise

Office: Introduction - Importance - Departments - Functions, Duties and
Characteristics of Office Manager

Objectives: At the end of this lesson you shall be able to
• define an office
• state the importance of office
• list the different departments of an office
• list the functions and duties of an office manager
• explain the characteristics of a good office manager.

Introduction of an office

According to dictionary an office is a place where busi-
ness is carried on. It means office is a place where office
works are performed like making records, using records
and preserving records. Office is a place where plans for
the business are prepared, policies are framed and records
of the business transactions are kept.

Some other important definitions of office are as under:

a. According to Denyer "Office is a place where clerical
operations are carried on."

b. According to Neuner and Keeling "Office is the focal
point for correlating the service and profit making ac-
tivities of a business enterprise."

c. According to Webster Dictionary "Office is a place
where a particular kind of business is transacted or a
service is supplied."

d. According to Leffingwell and Robinson "Office work is
concerned primarily with the records, using records
and preserving them for future reference."

e. According to Arthur H.Gager "Office management is
the function of administering the communication and
record services of an organization.

Now we are in a position to attempt its definition "Office is
a unit where relevant records for the purpose of control,
planning, and efficient management of the organization
are prepared, handled and preserved. Office provides fa-
cilities for internal and external communication and co-
ordinates activities of different departments of the organi-
zation.

Importance of an office

In the case of a business enterprise, operations must be
planned.  Planning is to be followed by execution. This
process of management required communication, co-or-
dination and control of efforts to achieve the well-defined
objective.  Besides, most of the commercial transactions
of the enterprise necessitate clerical procedures to deal
with orders, dispatch, invoicing and payment.

a. Office an Information Centre:  All kinds of informa-
tion and figures, whether past or present are available
in the office. The information furnished by the office
serves as the basis for forecast, planning, and control.
So office can be called data bank also.

b. Channel of Communication: Office is the channel
through which communications, especially written com-
munications, move from top to bottom and in the re-
verse order as well.  An organization would fail, in spite
of the best organizational talent, if objectives, policies,
orders and results are not communicated in either di-
rection.

c. Aids in Co-ordination: The process of
co-ordination is almost impossible without the
presence of office. Office furnishes the machinery for
coordination. Co-ordination is possible due to the links
that office provides for various activities of the organi-
zation. Office provides the necessary
information and knowledge for co-ordination.

d. Aids in Managerial Controls: Controls can be de-
scribed as the measurement and correction of the per-
formance of subordinates in order to make sure that
enterprise objectives and the plans made to achieve
them are accomplished.

e. Importance in relation to Customers: Office acts
as the channel that links the business organization
with its customers. Their enquiries, orders and com-
plaints are taken care of by the office through direct
personal contact.  Besides, newspaper medium is also
used by the office to inform the customers about prod-
ucts and their uses.

f. Importance in relation to Government and Gen-
eral Public: Today a business organization is recog-
nized as a social institution. It is required to satisfy
government regulations. The office acts as the link
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Office Manager

Objectives: At the end of this lesson you shall be able to
• define office manager
• describe the duties and functions of the office manager
• explain the characteristics/qualities/qualifications of office manager.

Definition of Office Manager

A person on whom the responsibility of the office work is
entrusted is called the office manager. It is not necessary
that his position should be known as office manager. It
may be called by any other name, such as office secre-
tary. Importance is given not to his position/status but to
his work.

Duties /functions of office manager

The duties of office manager can be classified into the
following categories

Duties towards Organization: Organization is the pro-
cess of defining and grouping the activities of enterprisers
and establishing warm relationship among them.

In performing the organizational functions the office man-
ager defines, departmentalizes and assigns activities so
that they can be most effectively executed.

An efficient Manager has to perform the following acts:-

(a) He has to arrange the necessary equipment to orga-
nize smoothly the daily routine of the office.

(b) to select proper office personnel and assign them work
according to their qualifications.

(c) to give them incentives for high quality work with future
prospects.

(d) to establish co-ordination among the office personnel.

(1) Planning: Planning decides in advance as to what is
to be done, how it is to be done, when it is to be done and
who is to do it? Planning decides as to where it to start
and where to reach? Planning is an intellectual process.

According to Alford and Beastly

"Planning is the thinking process, the organized foresight
the vision based on fact and experience that is required
for intelligent action".

The office manager has to determine the policies to ac-
complish the objectives. While planning, the office man-
ager should take this point into consideration that the work
should be made very simple so that the objective may be
achieved. The office manager should be arranging the vari-
ous official activities in such a way so that the need of
various departments may be fulfilled without any delay.

(2) Control: Control is one of the most important elements
of management. Control is a continuous process that helps
the manager to get the performance of his subordinates
correspond to standards fixed, to detect the variations as
soon as they occur or to take corrective steps to prevent

between different government departments and the or-
ganization.  Office is also the link between the general
public and the organization. Office is responsible

for creating a proper type of image for the organization in
the minds of people.  It is responsible for building up a
healthy social image.

g. Importance vis-à-vis Shareholders and Creditors:
Office serves as a link between the shareholders and
the company. Issue of share certificates, share trans-
fer, issue of dividend warrants, issue of notice of com-
pany meetings and answering different enquiries of
shareholders is of great importance which cannot be
performed without the help of the office.  Similarly of-
fice links the creditors with the organization and has to
act as servicing department for them.

h. Importance vis-a-vis Workers: Effective human rela-
tions require effective organization.  Preparation of wages
and salary and their payment are the responsibilities
of the office.  Office is also responsible for opening
employee benefit schemes, e.g. the pension and the
provident fund schemes.

Departments of office

A division of a large organisation or business dealing with
a specificarea of activity such as

a. Finance Department

b. Accounts Department

c. Advertising and Publicity Department

d. Export and Import Department

e. Excise Department

f. Store

g. Production

h. Personnel Department

i. Purchase Department

j. Sales Department

k. Research and Development Department
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them in future.  Controlling involves the comparison of the
performance with the range of standards established be-
forehand. It is the duty of the office manager to see whether
the office work is smoothly going on or not, if not, why?

Characteristics/qualities/qualifications of office
manager

1. Educational qualification: An office manager must
have appropriate educational qualification, proficiency
in English and knowledge of one or more foreign lan-
guages is also a desirable qualification.

2. Training: The office managers must have special train-
ing in business management, administration, account-
ing and business procedures. He must have trained in
office management systems and procedures working
of office machines and data processing methods.

3. Experience: An office manager must have wide busi-
ness experience. It includes the experience of man-
agement and administration that will be helpful to his
success as office manager.

4. Knowledge of the business: An office manager
should have a thorough understanding of his business.
He should be clear about the aims and objectives of
the business.

5. Initiative and capacity to make decisions: The suc-
cess of an office manager, largely depends upon his
ability to make decisions promptly and boldly. Deci-
sion-making is the basic ingredient of executing any
task. Therefore it is necessary that office manager
should be in a position to take correct and prompt
decisions.

6. Ability to co-operate: An office manager must be
soft spoken and adopt co-operative and accommodat-
ing attitude towards all those with whom he comes in
contact with. He must be able to compromise, adjust,
adapt and be willing to admit that his judgment on
occasions was wrong.

7. Consistency: An office manager must be of consis-
tent mind so as to be able to exercise his hirmness in
dealing with others.

8. Dependability: The office manager should hold the
organization together and be dependable. A depend-
able office manager satisfies co- workers who are loyal
to him.

9. Alertness: The office manager is required to keep in
touch with the developments taking place only in his
not country but and the whole world.

10.Personal qualities: The office manager, in addition
to the above, should also possess qualities common
to a leader. He should be intelligent, mentally alert,
self-confident, self-controlled, honest and sincere. He
should be kind-hearted and have human approach to
problems.

Introduction to MS-Excel

Objectives: At the end of this lesson you shall be able to
• state the spreadsheet software
• illustrate elements of electronic spreadsheet
• name the sheets
• explain address cells
• explain how to enter data into worksheet
• state the methods of selecting cells, copying, deleting & moving data
• explain the steps to print and save excel worksheet.

Spreadsheet Software

Microsoft Excel is the electronic spreadsheet program
within the Microsoft Office suite. An electronic spreadsheet
is an application you use to perform numeric calculations
and to analyze and present numeric data. One advantage
of spreadsheet programs over pencil and paper is that
your calculations are updated automatically. So you can
change entries without having to manually recalculate. The
Table below shows some of the common business tasks
people accomplish using Excel. In Excel, the electronic

spreadsheet you work in is called a worksheet, and it is
contained in a file called a workbook, which has the file
extension .xlsx.

When you use Excel, you have the ability to:

• Enter data quickly and accurately

• Recalculate data easily

• Perform what-if analysis

• Change the appearance of information
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• Create charts

• Share information

• Build on previous work

Elements of electronic spreadsheet

Up to Excel 2003, the standard amount of columns has
been 256. They are labelled by letters. After Z you get AA,
AB, AC etc. until you get to AZ. Then it is BA, BB, BC and
so on. The 256th column is IV. There have been 65,536
rows, all numbered. That makes 16,777,216 cells. In Excel
2007 and Excel 2010, the maximum number of rows per
worksheet increased to 1,048,576 and the number of
columns increased to 16,384 which is column XFD. That
makes 17,179,869,184 cells. Excel 2010 has the same
amount or rows and columns. Cells are the basic unit for
storing data. In any spreadsheet program such as Excel,
each rectangular box is referred to as a cell. A cell is the
intersection point of a column and a row. Data entered
into an Excel spreadsheet is entered into a cell. Each cell
can hold only one piece of data at a time.

Business tasks you can accomplish using Excel are
Perform calculations Adding formulas and functions to
worksheet data; for example, adding a list of sales results
or calculating a car payment

Represent values Creating charts based on worksheet
data; for example, creating a chart that displays graphically
expenses

Generate reports Creating workbooks that combine
information from multiple worksheets, such as summarized
sales information from multiple stores

Organize data Sorting data in ascending or descending
order; for example, alphabetizing a list of products or
customer names, or prioritizing orders by date

Analyze data Creating data summaries and short lists
using PivotTables or AutoFilters; for example, making a
list of the top 10 customers based on spending habits

Create what-if data Using variable values to investigate
and sample different outcomes, such as changing
scenarios the interest rate or payment schedule on a loan.

Spread sheet components (Fig.1)

Opening of spreadsheet

1 Click on Start button

2 Select All Programs option from the start menu

3 Select Microsoft Office from the All Programs sub menu
and select Microsoft Excel 2010 option. A blank
spreadsheet gets opened as shown in Fig.2.

Naming the sheet

The sheet names that Excel 2010 uses for the tabs in a
workbook (Sheet1 through Sheet3) are not very descriptive.
You can easily rename a worksheet tab to whatever helps
you remember what the worksheet contains, provided that

Fig 1

this descriptive name is no longer than 31 characters.

1 Select the sheet whose tab you want to rename.

The selected worksheet is active and the current sheet
name appears in bold letters as shown in (Fig.3)

2 Double-click the sheet tab.

You also can right-click the sheet tab and select Rename
on its shortcut menu. The current name on the sheet tab
appears selected as shown in (Fig.4).
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Fig 2

Fig 3

Fig 4
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3 Replace the current name on the sheet tab by typing a
new sheet name. When you begin typing a new name
(students), the previous name disappears as shown in
Fig.5

Fig 5

Press enter Excel displays the new sheet name on its tab
at the bottom of the workbook window.

Addressing of cells

Each worksheet is made up of cells, and cells are a result
of intersection of rows and columns. They are the basic
units for storing data. Each cell gets its name from this
intersection. The address of a cell that is in column A and
has its row number as 4 is referred to as cell A4. A group
of contiguous cells is called a range. An example of a cell
range would be A1:C6 as in fig. 6.

Fig 6

Cell A1, A2 contains the table Sachin, Rahul. Cells B5
and B6 contain the value 300 and 900 respectively. Cell
D7 contains the formula = B5+B6.  Pressing the Enter
key will result in D7 holding the result of the formula =
(B5+B6) as in fig. 7. All formula entries should begin with
an = (equal to) sign. You can make a cell active by clicking
on it. Files created by a spreadsheet package are known
as worksheets. Automatic recalculation feature hastens
the calculation tasks. If data in cell B4 is changed from
300 to 800, then the formula in cell D7 would calculate the
result based on the new B5 cell content. This is due to the
fact that, once the formula is created with cell references
in it, it establishes a relationship with the specified cell
references or address.

Fig 7

You can move around in a worksheet with the aid of a
mouse or the keyboard, or by using the menu bars. You
can use the arrow keys, page up, page down and a host
of other keys in combination, to move around in the
worksheet.

Entering Spreadsheet Data

Each Excel worksheet is such a huge grid of columns
and rows with over 17 billion cells, you have plenty of places
you can enter data. You can enter three types of data in
the cells:

• Labels are traditionally descriptive pieces of information,

such as names, months, or other

• Identifying statistics and they usually include alphabetic

characters.

OA&FM : SSA (English) (NSQF - Revised 2022) R.T. for Ex .1.6.51 - 53

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



156

• Values are generally raw numbers or dates.

• Formulas are instructions for Excel to perform

calculations.

Text

Text entries can include any combination of letters,
symbols, and numbers. You will mostly use text to
describe the contents of your worksheets. This is very
important because spreadsheet can become a confusing
jumble of numbers.  Most text entries are usually labels
such as Sales or Salary that make a worksheet easier to
read.

Numbers

Numbers are the most common type of Excel data. The
numbers you enter into a cell can be dollar values, weights,
interest rates, temperatures, or any other numerical
quantity.

Dates and Times

Date entries appear in spreadsheets that include data,
such as invoices and sales. You can either type out the
full date such as August 23, 2010 or use either the forward
slash (/) or the hyphen (-) as a date separator such as 8/
23/2010 or 8-23-2010. Note that the order you enter the
date values depends on your regional settings. For
example, in the United States the format is month/day/
year. For time values, you use a colon (:) as a time
separator, followed by either AM or PM - such as 9:15
AM.

Change the Active Cell

1 Open an Excel workbook. The Formula bar displays
the active cell location. Columns display the letters
from A to XFD, and rows display numbers from 1 to
1,048,576. A cell address is the intersection of a column
and a row, such as D10 (in which D is the column and
10 is the row).

2 Move the focus to an adjacent cell with one of the
following techniques:

• Down: Press the Enter key or the down-arrow key.

• Up: Press the up-arrow key.

• Right: Press the right-arrow key.

• Left: Press the left-arrow key.

3 To move to a cell farther away, use one of these
techniques:

• Click any cell to move the active cell location to that

cell. You can use the scroll bars to see more of the
worksheet. In (Fig. 7), the cell focus is in cell E9. Notice
the border surrounding cell E9 and the name box that
indicates the current cell.

• Choose Home >> Find & Select >> Go To in the Editing

group. The Go  to dialog box displays, as shown in
(Fig 8). In the Reference box, enter the address of the
cell you want to make active and then click OK.

Fig 8

Press the F5 key to display the Go To dialog
box.

Press Ctrl+Home. Excel jumps to cell A1.

Press Ctrl+PageDown or Ctrl+PageUp. Excel
moves to the next or preceding worksheet,
respectively, in the workbook.

Select Multiple Cells

1 Click the first cell in the group you want to select.  2
Depending on the cells you want to select, perform
one of the following actions:

• To select sequential cells, select a cell, hold down the

Shift key, and select the last cell you want to include.
All cells in the selected area are highlighted, with the
exception of the first cell. (It's selected, too; it's just
not highlighted.) (Fig.9) shows a sequential area
selected from cells B4:F15. Notice the black border
surrounding the selected area.

Fig 9

Click any cell to clear the selection.
Alternatively, click and drag the mouse over a
group of cells to select a sequential area.

• To select non-sequential cells, select a cell, hold down

the Ctrl key, and click each additional cell you want to
select. (Fig.10) shows the non-sequential cells A4, B6,
and C8:C11, as well as all of row 2, selected.
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• To select a single entire column, click a column heading.

• To select multiple columns, drag across multiple

column headings.

• To select a single entire row, click the row number.

• To select multiple rows, drag across multiple row

numbers.

When making non-sequential cell selections,
you can include entire rows and entire columns
along with individual cells or groups of cells.

• To select the entire worksheet, click the small gray

box with a triangle located to the left of column A and
above row 1. Alternatively, you can select all cells in a
worksheet by pressing Ctrl+A. To cancel the selection
click anywhere in the screen.

Edit or Delete Cell Data

1 To delete the entire contents of a cell, use one of the
following methods:

• Choose Home? Clear in the Editing group; then select

what you want to clear.

• Press the Delete key.

If you clear the wrong cell, use the Undo
command

2 To edit cell contents, use one of these methods:

• Delete the contents and retype new cell information.

• Click the cell and edit contents in formula bar.

Copy and Paste Data

1 Select the data you want to copy.

2 Choose Home? Copy in the Clipboard group. A marquee
(which looks like marching ants) surrounds the cells
as shown in (Fig.11).

3 Click the cell to which you want to paste the copied
data.

4 Choose Home ⇒ Paste. The selected cells are pasted

into the new location (Fig.12)

Fig 10 Fig 11

5 Copied cells are pasted in C8:G10.

6 Press  Esc key to cancel the marquee.

Alternatively, press Ctrl+C to copy the selected
cells, Ctrl+X to cut the selected cells, or Ctrl+V
to paste the selected cells.

Move Data

1 Select the data you want to move.

2 Choose Home? Cut in the Clipboard group. A marquee
(which looks like marching ants) surrounds the cells.

3 Click the first cell that you want to move the selected
cells to(E3).

4 Choose Home? Paste in the Clipboard group. The
selected cells are pasted into the new location. The
cells originally in E3:E5 are now located in cells F3:F5
as in (Fig.13 & 14)

Drag and Drop Data

1 Select the data you want to move

2 Position the mouse pointer around any portion of the
selection area edge, but not in the lower-right corner.
The mouse pointer shows four arrowheads.

3 Drag the borderline to the area you want the cells moved
to. A border shows the new area. (Fig.15-16) shows in
which cells C3:C5 are being moved to cell D7:D9.

4 Release the mouse button. The data moves to the new
location.

Fig 12

OA&FM : SSA (English) (NSQF - Revised 2022) R.T. for Ex .1.6.51 - 53

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



158

Fig 13

Fig 15

Fig 16

Saving and Printing

Saving an Excel 2010 workbook on Windows 7 or
Vista

Follow these steps to save your workbook when running

Excel 2010 on Windows 7 or Vista:

1 Click the File tab and choose Save As. The Save As
dialog box appears.

2 Click the Browse Folders button (with the triangle
pointing downward) to expand the Save As dialog box
if necessary. When you expand the Save As dialog
box, the dialog box displays the Navigation pane, where
you can select a folder.

3 In the Navigation pane, select the folder in which you
want to save the file.

4 Type a descriptive name for the file in the File Name
box as shown in Fig.17

5 Click the Save button to save the file in the selected
folder.

Fig 14

Drag and drop works best if you're moving a
small amount of cells to an area that isn't far
from its original spot.

Fig 17
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Save an Excel 2010 Workbook

As you work in Microsoft Excel 2010, remember to save
your work often or you risk losing your data if the computer
crashes or the power goes out. When you save an Excel
workbook for the first time, you see the Save As dialog
box.

Printing of Spread sheets

1 Print a partial or entire worksheet or workbook do one
of the following:

• To print a partial worksheet, click the worksheet, and

then select the range of data that you want to print.

• To print the entire worksheet, click the worksheet to

activate it.

2 To print a workbook, click any of its worksheets.

 Click File and then click Print (Shortcut Ctrl + P)

Under Settings select an option to print the selection, the
active sheet or sheets, or the entire workbook.

If a worksheet has defined print areas, Excel will print
only those print areas. If you don't want to print only a
defined print area, select the Ignore print area check box.

Print several worksheets at once

1 Select the worksheets that you want to print.

2 Click File, and then click Print.

Preview worksheet pages before printing

1 Click the worksheet or select the worksheets that you
want to preview.

2 Click File, and then click Print Preview ( shortcut Ctrl
+ F2)

Unless you are configured to print on a colour
printer, the preview window will display in
black and white, regardless of whether your
worksheet(s) includes colour.

3 To preview the next and previous pages, at the bottom
of the Print Preview window, click Next Page and
Previous Page.

Next Page and Previous Page are available
only when you select more than one
worksheet, or when a worksheet contains more
than one page of data. To view multiple
worksheets, under Settings, click Entire
workbook.

4 To exit print preview and return to your workbook, click
any other tab above the preview window.

5 To view page margins, at the bottom of the Print Preview
window, click the Show Margins button.

To change margins, you can drag the margins to the height
and width that you want. You can also change the column
widths by dragging the handles at the top or bottom of the
print preview page.

To make page setup changes, including
changing page orientation and page size,
select the appropriate options under Settings.

Defining and clearing a print area

If you print a specific selection on a worksheet frequently,
you can define a print area that includes just that selection.
A print area is one or more ranges of cells that you
designate to print when you don't want to print the entire
worksheet. When you print a worksheet after defining a
print area, only the print area is printed. You can add cells
to expand the print area as needed, and you can clear the
print area to print the entire worksheet. A worksheet can
have multiple print areas. Each print area will print as a
separate page.

Set one or more print areas

1 On the worksheet, select the cells that you want to
define as the print area. You can create multiple print
areas by holding down CTRL and clicking the areas
that you want to print.

2 On the Page Layout tab, in the Page Setup group,
click Print Area, and then click Set Print Area.

The print area that you set is saved when you
save the workbook.

Add cells to an existing print area

1 On the worksheet, select the cells that you want to
add to the existing print area.

If the cells that you want to add are not
adjacent to the existing print area, an
additional print area is created. Each print area
in a worksheet is printed as a separate page.
Only adjacent cells can be added to an existing
print area.

2 On the Page Layout tab, in the Page Setup group,
click Print Area, and then click Add to Print Area.

Clear a print area

If your worksheet contains multiple print areas,
clearing a print area removes all the print areas
on your worksheet.

1 Click anywhere on the worksheet for which you want
to clear the print area.

2 On the Page Layout tab, in the Page Setup group,
click Clear Print Area.
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Motivation is defined as the process that initiates, guides,
and maintains goal-oriented behaviours. Motivation is what
causes you to act, whether it is getting a job to reduce the
financial burden or reading a book to gain knowledge.

Motivating people to perform better and thus to achieve
organizational objectives has been the greatest challenge
to managers. Why do some people perform better than
others? Why does the same person act differently at
different times? These and many other questions related
to work performance have been confronting managers
continuously

Meaning of Motiation: Motivation is the word derived from
the word 'motive' which means needs, desires, wants or
drives within the individuals. It is the process of stimulating
people to actions to accomplish the goals. In the work
goal context the psychological factors stimulating the
people's behaviour can be - desire for money, success
etc.

Role of Motivation: The role of motivation cannot be
understated in an organisation. It is a simpe process that
requires an understanding of human mind and behavious.
Such an understanding and proper action thereby
stimulating the motives of an individual helps in initiating
and mainaining action  and helps extensively in satisfying
ones objectives.

Importance Motivation in an organisation

1 Greater efficiency: Motivation enhances the efficiency
of the employees and of organization. When employees
are motivated, they can perform with commitment and
dedication.

2 Reduction in absenteeism and labour turnover:
Motivated employees may not remain absent or leave
the organization. They develop a sense of belonging
towards the organization and thus improve their overall
performance.

3 Team spirit: Motivation improves team spirit of
employees, and this improves the work environment
and the overall performance of the employee and the
organization.

4 Reduction in wastages and breakages: Motivated
employees take great care in handling machines and
other resources. This will reduce wastages and
breakages, thus resulting in higher benefits to the
organization.

5 Cordial relations: Motivation enables cordial and
healthy relationship in the organization. Moti-vation
helps reduce labour grievances and disputes. It ensures
sound relations between the management and the

Motivation: Introduction - Process

Objectives: At the end of this lesson you shall be able to
• explain what is motivation
• state importance of motivation in an organisation
• list types of motivation
• state process of motivation.

labour. It improves the overall efficiency of the
organization.

6 Promotion of innovation: Motivated employees use
their initiative to find out innovative ways in the
performance of their operations. Such employees are
more creative and help the organization to gain the
competitive advantage.

7 Optimum use of resources: Motivation leads to
greater employee involvement and lesser wastages.
This leads to optimum utilization of resources.

8 Corporate image: Motivated employees are more loyal
to the organization. They work with a sense of
commitment and dedication. This improves the overall
performance of the employee, which enables better
results for the company. This results in better relations
with all the stakeholders.

Features of Motivation

1 Interaction between the individual and the situation:
Motivation is not a personal trait but an interaction
between the individual and the situation.

2 Goal-directed behaviour: Motivation leads to an action
that is goal oriented. Motivation leads to
accomplishment of organizational goals and
satisfaction of personal needs.

3 Systems oriented

Motivation is influenced by two forces

a Internal forces: These forces are internal to the
individual, i.e., their needs, wants and nature.

b External forces: These forces are external to the
individual, which may be organizational related such
as management philosophy, organizational structure,
and superior-subordinate relationship, and also the
forces found in the external environment such as culture,
customs, religion and values.

4 Positive or negative: Positive motivation or the carrot
approach offers positive incentives such as appreciation,
promotion, status and incentives. Negative motivation
or stick approach emphasizes penalties, fines and
punishments.

5 Dynamic and complex in nature: Human behaviour
is highly complex, and it becomes extremely difficult
to understand people at

Characteristics of Motivation: Motivation Is Personal and
Psychological Concept

• Motivation is a process

• Motivation is a continuous process
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• Motivation is a complex subject

• Motivation is goal oriented

• Motivation is behaviour-oriented

Process of motivation

The process of motivation starts with the need which may
be the perception of deficiency in an individual. For
example, an employee in the organization considers the
need for higher pay, more challenging work, for time off
etc. These needs influence the thought processes of
employee that directs him to satisfy the needs by adopting
a particular pattern of action. In case the selected course
of action of an employee leads him towards expected
results in the form of reward than he will definitely be
motivated by the similar reward to give the same
performance in the future. On the other hand, if the
anticipated rewards are not resulted by adopting a certain
line of action, then the employee would not be likely to
repeat his behaviour. So the rewards of certain action, act
as a feedback mechanism that supports the employee to
evaluate the consequences when he is considering his
future action.

Following are the basic phases of the process of motivation.

1 Need Identification

In the first phase of the process of motivation is the
employee feels certain need that is unsatisfied & hence
he identifies that need. Then the unfulfilled need stimulates
the employee to search certain goal by creating tension
in him. This tension acts as driving force for the
accomplishment of the set goals which can satisfy the
tension creating need.

2 Exploring Ways to Fulfil the Need

In this phase of the process of motivation, different
alternative ways are explored that can satisfy the
unsatisfied need that is identified in the first phase. In fact
the unsatisfied need stimulates the thought processes of
the employee that direct him to adopt a certain course of
action.

3 Selecting Goals

In the third phase of the process of motivation, the goals
are selected on the basis of identifying needs and
alternative course of actions.

4 Performance of Employee

In the fourth phase of Motivation Process, the identified
need stimulates the employees perform in a certain way
that has already been considered by him. So the employee
performs certain course of action to the satisfaction of
unsatisfied need.

5 Rewards/Punishments as Consequences of
Performance:

If the consequences of the particular course of action
followed by an employee are in the form of rewards, then
the employee would be motivated to perform the same
level of efforts for acquisition of similar rewards in future.
Whereas when the anticipated results of the actions of an
employee lack the rewards, then he would not be willing
to repeat his behaviour in the future.

6 Reassessment of Deficiencies of Need

When an employee feels satisfaction for his certain
unsatisfied need through the rewards of a certain line of
action, then he again reassesses any further unsatisfied
need and resultantly the whole process is repeated again.
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Office Administration and Facility Management         R. Theory for Ex 1.6.54
Stenographer Secretarial Asst. (Eng) - MS Excel - Importance of office - office
layouts registers - Dictation exercise

Office layout - open office and private office

Objectives: At the end of this lesson you shall be able to
• state the importance of office layout
• state the advantages and disadvantages of an open office
• state the advantages and disadvantages of a private office.

Office layout - Introduction

Office layout is the most important task of office manage-
ment.  It can be defined as "the arrangement of all physi-
cal components within the available floor space to provide
maximum effectiveness and the co-ordination of these com-
ponents into an efficient and attractive unity." In other
words, it can be described as the arrangement of different
departments, equipment and men within a given available
floor space with a view to make optimum utilization of
space and ensure maximum efficiency of the office.

According to George R. Terry "Office layout is the deter-
mination of the space requirements and of the detailed
utilization of this space in order to provide a practical ar-
rangement of the physical factors considered necessary
for the execution of the office work within reasonable costs."

According to Hicks & Place "Office layout relates to the
arrangement of work stations in the space involved so that
all equipment supplies, procedures and personnel can func-
tion at maximum efficiency.

Types of office layout

In planning the office layout one of the major problems
before the office manager is whether to have suites of small
rooms and private offices, for the department and execu-
tives or a number of large open offices with a few private
offices for the top executives. Office can be arranged in
two forms:

1. Private Office

modated. Each section or department is allotted a sepa-
rate space within the same rooms.

Advantage/Merits of open office

The main advantage of open office are as follows

1. Straight flow of work

In open office there is a straight flow of work without any
distribution and as a result of it, quantity and quality of the
work improves.

2. Saving in space

In open office there is a more profitable utilization of the
space. In constructing private room, space in the form of
wall is wasted but in open office arrangement there is not
such type of wastage of space.

3. Less cost

In open office arrangement cost is comparatively less.  In
such arrangement there is no cost of construction of walls.

4. Flexibility

There is a greater flexibility in planning the layout under
open office arrangement. This type of office layout may be
changed according to the requirement/ need.

5. Effective supervision

Open office arrangement makes supervision easier and
less costly. Very few supervisors can supervise the work
of the department more easily as the supervisor sits in
the same room facing all the staff.

6. Convenience in communication

Under open office arrangement the officers and employ-
ees are sitting face to face. It facilitates inter
departmental communication.

2.  Open Office

(A) Meaning of open office

By open offices we mean large rooms where the staff and
equipment of several departments or sections are accom-
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Disadvantages/demerits of open office

The open office arrangement suffers from the following dis-
advantages

1 Noise

There is a great noise under this arrangement because a
large number of employees work in a big room. As a re-
sult of it, the concentration of the employees is disturbed.
It also affects the efficiency of the employees adversely.

2 Lack of secrecy

Open office arrangement is not suitable for work which
requires secrecy.

3 Harmful for health

This arrangement is also not suitable for employees’ health
point of view. If any person is suffering from any danger-
ous disease that may be harmful to other fellow employ-
ees.

4 Lack of concentration

Under this arrangement, there is a great noise which dis-
turbs the concentration of employees in work.

5 Interruption in work

Under this arrangement the movement of employees from
one place to another in the same room creates interrup-
tion in work and consequently, quantity and quality of the
work declines.

What is a Private Office (Office Rooms)?

Private office is small rooms or cabinets which are sepa-
rated from the open office by partitions. ... Sometimes,
private office is provided to a group of people who are do-
ing special project, performing confidential nature of work
or need of concentration of work.

Advantages of Private Office

The advantages of private office are listed below

1 Privacy: A private office provides a good privacy for
confidential work and discussions.

2 Personal Atmosphere: A sense of prestige or impor-
tance to concerned staff promotes the personal atmosphere
in a private office.

3 Concentration: There is an absence of noise in a pri-
vate office. Hence, greater concentration of mind is pos-
sible. This gives room for improvement of efficiency of Staff.

4 Tidy Appearance: A private office can be tidier and
less regimented. Over crowding or congestion is also elimi-
nated.

5 Healthy Atmosphere: Better lighting, ventilation, heat-
ing and cooling are available in private office. There is no
transmission of diseases from one person to another.

Disadvantages of Private Office

Private office suffers from the following disadvantages

1 Uneconomical: A lot of space is used for partitions
and corridors. Therefore, the cost of office space is in-
creased. More expense is involved in decorations, clean-
ing and maintenance.

2 Costly Supervision: Private office leads to difficult su-
pervision. The supervisor loses personal contact with the
staff. Hence, more supervisors are appointed for effective
supervision. Thus, the cost of supervision is stepped up.

3 Poor Natural Lighting and Ventilation: Flow of natu-
ral air and natural lighting is interrupted due to many walls
and partitions. Therefore, artificial lighting and ventilation
are provided to every staff member. This type of practice
results in high cost of operation.

4 Affects free Flow of Work: Many walls and partitions
are adversely affecting the free flow of work.

5 Poor Communication: Transmission of information
is hindered due to walls and partitions. Movement of files
is also delayed.

6 Inflexible: Many walls and partitions make the task
of office layout more complicated and less flexible.
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Office Administration and Facility Management  R.Theory for Ex 1.6.55 &56
Stenographer Secretarial Asst. (Eng) - MS Excel - Importance of office -office
layouts registers - Dictation exercise

MS Excel - Inserting/Deleting rows and columns, Data, Cut, Copy and Paste

Objectives: At the end of this lesson you shall be able to
• describe how to insert, delete, set width for rows and columns
• state how to insert/delete data using cut/copy and paste functions
• state how to work with formulas, functions.

Add Rows and Columns

1 Select the row numbers or column letters where you
want the new rows or columns. Excel highlights the
entire rows or columns. Here we select the B column
as shown in Fig.

2 Choose  Home → Insert in the cells group (Fig.1)

Fig 1

3 The entire content in column C is shifted  to column D
(Fig 2)

Fig 2

Excel inserts the same number of rows or col-
umns that you selected in Step1.Data in the
selected columns and columns to the right
move to the right.

3 Here the contents of entire C column moves to D, D to
E, E to F  as in (Fig.2)

4 Similarly select row(s) and insert row(s).

4 Make a selection

Shift Cells Right: Select this if you want data in the cells
in the same row moved to the right. Excel doesn't move
the data in the cells to the left of the selection. Shift Cells
Down: Select this if you want data in the lower cells in the

same column moved down. Excel doesn't move data in
the cells above the selection.

Entire Row: Select this if you want to add a new row and
move down lower data.

Entire Column: Select this if you want to add a new col-
umn and move data to the right.

Remove Rows and Columns

1 Select the row numbers or column letters you want to
remove. Excel highlights the entire rows or columns.

Here we select rows 7 and 8 as shown in (Fig. 3).

Fig 3

2 Choose Home? Delete in the Cells group. Excel re-
moves any data in the rows or columns and moves
existing data up or left. (Fig.4)

Fig 4

This fills the void from the deleted rows or columns.(Fig.5)

Right-click the selected row numbers or col-
umn letters and choose Delete from the short-
cut menu.
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Fig 5

Delete Cells

1 Select the cells you want to remove.

2 Choose Home and in the Cells group, click the arrow
on the Delete button. A menu of options appears.(fig.6)

3 Choose Delete Cells. The Delete dialog box appears,
as shown in (Fig. 6).

Fig 6

Alternatively, right-click over the selected cells
and choose Delete from the shortcut menu.

4 Select a deletion option

• Shift Cells Left: Select this if you want data in the cells
in the same row moved to the left.

• Shift Cells Up: Select this if you want data in the lower
cells in the same column moved up.

• Entire Row: Select this if you want to remove a row
and move lower data up.

• Entire Column: Select this if you want to remove a
column and move data to the left.

Change Column Width and Row Height in Excel 2010

In Excel 2010, you can change any column widths or row
heights in your worksheets to improve the readability and
appearance of data. For example, if your worksheet con-
tains many numbers, you can widen the columns to make
the worksheet less cluttered. You should always widen
columns that contain cells with truncated text entries or
numbers that Excel shows as.

Adjusting column widths

To adjust the width of one or more columns, first select

the columns whose width you want to change. (You se-
lect an entire column by clicking its column letter. If you
want to adjust a single column, click any cell in that col-
umn) then choose a method to adjust column width.

• To manually change the width of columns, position the
mouse pointer on the right boundary  of a column head-
ing until it turns into a double-sided arrow. Drag left or
right until the column has the width that you want as
shown in (Fig.7)

Fig 7

• To automatically change the column width so it fits the
widest entry, use AutoFit. Double-click the boundary
on the right side of the column heading or choose For-
mat → AutoFit Column Width on the Home tab.

Changing row heights

To change the height of one or more rows, start by select-
ing the rows whose height you want to adjust. (To select
an entire row, click on the row number on the left. If you
want to adjust a single row, click any cell in that row.)
Choose a method to adjust row height:

To manually change the row height, position the mouse
pointer on the bottom boundary of the row heading until it
turns into a double-sided arrow. Drag until the row is the
height that you want.

To set a row height to a specific setting, choose Format→
Row → Height on the Home tab. Type the exact height
you want in the Row Height dialog box as shown in (Fig.9)
and then click OK.

• To set a column width to a specific setting, choose
Format → Column Width on the Home tab. Type the
exact width you want in the Column Width dialog box
as shown in (Fig.8) then click OK

Fig 8
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To automatically change the height of a row so it fits the
tallest entry in the row, use AutoFit. Double-click the bound-
ary on the bottom of the row heading or choose Format?
AutoFit Row Height on the Home tab.

Fig 9

Formulas and functions in Excel

Objectives: At the end of this lesson you shall be able to
• explain how to work with formulas and functions
• explain inbuilt functions in Excel sheet.

You can add a formula to a worksheet cell using a tech-
nique similar to adding data to a cell. To ensure that Ex-
cel treats the text as a formula, be sure to begin with an
equal sign (=) and then type your operands and opera-
tors. When you add a formula to a cell, Excel displays
the formula result in the cell, not the formula itself. For
example, if you add the formula =C5:C8 to a cell, that cell
displays the sum of the values in cells C5 to C8  to C9. To
see the formula, click the cell and examine the formula
bar. (Fig.1)

Fig 1

arguments are the details you provide to Excel to indicate
which numbers to calculate in the function. Some func-
tions require several arguments to function correctly. Ex-
cel contains a Function Wizard to walk you through the
entire process. Excel separates functions into categories,
including Financial, Date & Time, Math & Trig, Statistical,
Lookup & Reference, Database, Text, Logical, Informa-
tion, Engineering, Cube, and Compatibility categories. For
example, the SUM function is in the Math & Trig category,
whereas AVERAGE, COUNT,MAX, and MIN are Statisti-
cal functions. Functions that calculate a payment value
are considered Financial functions.

Change the Cell Text Case

From the cell where you want the function result, choose
Formulas → Text and then choose one of the following:

UPPER: Displays the referenced cell in all upper case
letters.

LOWER: Displays the referenced cell in all lower case
letters.

PROPER: Displays the referenced cell with the first letter
of each word capitalized.

Select the cell you want to change and then click OK.
(Fig.2)

Functions

Excel includes almost 400 built-in calculations - or func-
tions-in 12 categories. Functions contain arguments, which
appear in parentheses following the function's name. The

Fig 2
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Use Functions to Calculate Time

1 From the cell where you want the function result, choose
Formulas → Date & Time in the  Function Library
group.

2 Choose NETWORKDAYS, which calculates the num-
ber of whole workdays (excluding weekends) between
two dates you specify. The Function Arguments dia-
log box appears.

3 From the Start date text box, select the cell containing
the beginning date you want to evaluate.

4 From the End date text box, select the cell containing
the ending date you want to evaluate. The End date
must be a date later than the Start date; otherwise, the
function returns a negative value.

5 Click OK. Excel calculates the number of working days
between the two specified dates, as in Fig.3

Fig 3

Two other useful Date & Time functions include
TODAY,=TODAY(), which displays the current date or
NOW,

=NOW(), which displays the current date and time. Nei-
ther function contains an argument.

Round Values with Math Functions

1 From the cell where you want the function result, choose
Formulas →  Math & Trig in the Function Library group,
and then choose one of the following:

ROUND: Rounds a value to a number of digits you specify.

ROUNDUP: Rounds a value up to a number of digits you
specify.

ROUNDDOWN: Rounds a value down to a number of dig-
its you specify.

2    From the Number text box of the Function Arguments
dialog box, select or enter the cell you want to evalu-
ate.

3 In the Num digits text box, enter the number of deci-
mal places you want the value rounded to. Enter zero
if you want a whole number; if you want the number

rounded to the left of the decimal point, enter the value as
a negative number. Here 2 is entered for rounding to 2
decimal places 4 Click OK. The results appear in your
worksheet as in (Fig.4).

Fig 4
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Creating Charts

There is an old saying 'A picture is worth a thousand words"
is most certainly referring to a chart. We like looking at
pictures more than we like looking at sheets of data.
Charts, or graphs, provide an effective way to Illustrate
your worksheet data by making the relationships among
numbers easier to see. The chart turns numbers into
shapes and enables you to compare the shapes to each
other. If you've ever spent hours drawing a chart on graph
paper, you'll really appreciate the ease with which you
can create dozens of different chart styles with your Ex-
cel data. And you don't really have to draw a thing! With
just a few decisions on your part and a few clicks of the
mouse, you have a two- or three- dimensional illustration
of your data. Charts let you get your thoughts across with
simplicity and strength and because different charts may
cause you to draw varied conclusions. Whatever the idea
you're trying to convey, charts make it easier.

Trim function

The trim function is often very useful when you work with
data imported from other programs.

1 Select the cell where you want the function result and
then choose

Formulas →Text ? TRIM  in the Function library group.
The function Argument dialog box appears

2 Select the cell containing the text you want to trim the
spaces

3 Click OK. Excel displays the result of the formula in
the cell you selected in step 1

4 Fig.5 you can see the data before the TRIM function
and after it.

Fig 5

Excel Formulas Simple formatting tricks

Conditional statements
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Meaning of office environment

By office environment, we mean working environment. The
environment in which the office employees perform duties
is known as office environment. The requirements of of-
fice environment include

1.  Working place

2.  Working conditions

3.  Working hours

4.  Working equipment

5.  Training facilities

6.  Incentive payment system, etc.

Importance / advantages of office environment

Office environment affects the efficiency of office person-
nel directly. The reason for this is that mental work is the
primary office work, much of which is monotonous and
repetitive in nature. There is a close connection between
the mind and the body. Therefore an employee working in
the office cannot work efficiently unless he is provided
with the right type of working environment.

Advantages to employees

The advantages of a good office environment to the em-
ployees, are as follows

1. Ease in work

2. Simplicity in work

3. Improvement in mental and physical fitness.

Advantages to the business concern

The advantages of a good office environment to the con-
cern are as follows

(a) Increase in production

(b) Increase in profits

(c) Increase in efficiency

(d) Improvement in employee’s relations

(e) Reduction in employee’s absenteeism

(f) Reduction in employee’s turnover

(g) Increase in the goodwill

Effective scheme of office environment

The following points should be taken into consideration
while planning scheme for effective office environment

(a) Location of office building

The location of the office building plays an important role
in impacting the office environment. If office building is
located in a far off place, it will affect the health of employ-
ees adversely. Similarly if the office building is located at
a dirty and noisy place it will also have an adverse effect
on the efficiency of the employees.

(b) Structure of office building

The structure of office building also has an effect on the
office environment. If the office building restricts the en-
trance of light, air, etc., then the office environment will
not be healthy.

(c) Internal decoration

The internal decoration of the office also has an effect on
the office environment. The internal decoration of the of-
fice puts a psychological effect on the mind of the em-
ployees of the office. Because of internal decoration, of-
fice environment becomes cheerful.

(d) Cleaniness and sanitation

The cleanliness and sanitation of office also has an effect
on the office environment. Office must be cleaned daily
and should be kept free from dust.

(e) Lighting

Lighting should be sufficient enough to enable a worker to
see what he is doing clearly quickly and accurately. Inad-
equate lighting results in delays and mistakes. Bad light-
ing causes eye strain, fatigue and headache to the em-
ployees. It is better if natural day light is sufficient enough.
Otherwise the provision for artificial light in the form of
tubes can be made to facilitate the work.

(f) Ventilation

The provision for ventilation for the flow of cool and fresh
air should be made as bad air causes headache to the
employees.

(g) Transport facilities

In the employees are provided transport facilities to reach
the office, it will increase the efficiency of the employees.

(h) Freedom from noise

Noise disturbs continuity in work. To make the environ-
ment ideal, the office should be kept free from internal
and external noise.

Office Environment - Importance - Impact of Light, Temperature, Ventilation
and  Noise - Interior decoration - Cleanliness - Safety

Objectives: At the end of this lesson you shall be able to
• state the meaning of office environment
• state the importance of a good office environment
• narrate  the factors that promote an effective office environment
• explain the effect of interior decoration on the office staff
• describe how lack of cleanliness can affect the working of employees
• explain the measures to be taken to ensure the safety of the office.
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(i) Safety provisions

The office manager should make safety provisions in the
office or else employees may meet with accidents and in
your themselves.

Health

Overcrowding in the rooms should be avoided as it affects
the health of the staff. Too hot, too cold or humid atmo-
sphere does not create a proper working environment in
an office. A balance has to be struck taking into consider-
ation the health conditions and requirements of an indi-
vidual office. Temperature can be managed and controlled
artificially. Clean and adequate drinking water should be
available for the staff. Coolers, if possible, should be in-
stalled within easy reach of the staff. Washing facilities
should be provided where necessary. Officers should have
rest rooms or retiring rooms where workers may rest dur-
ing rest intervals. Comfortable easy chairs, sofas, etc.,
should be provided in such rooms. A canteen should be
provided and such a canteen should be subsidised, if pos-
sible. It should be located at a suitable place and ensured
that the quality and quantity sold is not below the stan-
dard.

Interior decoration & colour conditioning

It refers to decoration of office space internally in a man-
ner which creates a healthy atmosphere in the office and
produces a distinct effect on the psychology of the office
staff.

Interior Decoration includes the following

i Colouring of walls

ii Colour and design of furnishings

iii Floor covering's colour and design

iv Decoration of corridors and stairways

Pleasant colouring and tasteful furnishings produce a cheer-
ful effect on the mind of the staff. Interior decoration plays
a soothing role in creating a better physical condition
thereby producing a better working environment. There is
a close connection between mind and the body, and be-
tween the will to work and capacity to work. Hence inte-
rior decoration does create a will in mind of staff to come,
sit, and prolong the stay and work hard. Rooms may be
decorated by painting, corridors and stairways may be
made attractive with pleasing colours and tasteful decora-
tion. Curtains, draperies, carpets, rubber sheets, linoleum,
coir matting, etc., should be of good and pleasing colours
and material. All these help in developing a better working
environment.

A combination colour and painting of walls and ceilings
must be done artistically and tastefully in such a manner
that employees feel cheerful and derive pleasure and get
inspired. The colour used on walls must be of a pleasing
nature. Walls of the office should be in light colour. Dark
colours will not be pleasing to the eyes. Sharp contrasts
in colour should be avoided as it tends to distract the
mind. Pastel shades have the most pleasing effect.

The methods adopted for colour conditioning are

1 Walls are to be painted and decorated in a tasteful
manner.

2 Corridors, stairways, reception room, visitors room and
furniture are to be tastefully coloured and designed.

3 Specified colours are to be used. Orange, yellow and
brown colours bring warmth feeling while blue and green
colours bring coolness.

Furniture

After deciding the layout of office accommodation and its
decoration, it is natural to decide on the furniture that is to
be installed in it. Office work is mostly indoor work. Suit-
able furniture should therefore be provided for the person-
nel so that they are ensconced comfortably enough to
perform office work swiftly and efficiently. Office furniture
is the basic facility the employee identifies himself with. It
is the duty of the office manager to provide the right type
of furniture to the office. It has been increasingly felt now
that office furniture is bought not only for its utility but also
for its looks. The artistic design is worth paying for. It makes
the office look more impressive and appeals to the office
workers who must use it. Modern and eloquently designed
furniture not only improves the general efficiency of the
employees but adds to the prestige of the organisation as
well. At the same time, furniture should be viewed as a
long - term investment for it is unwise to make arbitrary
and abrupt replacement because of the heavy cost in-
volved.

Amongst the usual furniture found in any modern office
are desks, chairs, tables, racks, cabinets, cupboards,
lockers, safe, trays, etc. The number of pieces and the
kind of furniture to be purchased for any office depends on
various factors.

1 The number of departments and employees

2 The nature and volume of work to be performed

3 The office space available for accommodating the fur-
niture

Security / Safety

One of the vital functions of a modern office is to preserve
documents and records for future reference. All documents
or records should naturally be secured. No record or docu-
ment should be allowed to be taken out of the office pre-
mises by any person without permission from his/her su-
perior officer. Security measures, however, vary from
organisation to organisation. In some organisation like
military or defence production units, outsiders are not per-
mitted to enter the main premises without the prior ap-
proval of the Administrative Officer. Even if permitted, they
have to deposit their bags or containers at the gate against
token. Similarly, in the strong rooms of banks, no outsider
is allowed to enter. But this kind of security measure is
not applied to other organisations though care is taken to
prevent any possibility of theft, removal or destruction of
office records. All office records, however, do not enjoy the
same importance. Important and valuable documents such
as share certificates, debentures, deposit receipts, title
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deeds, bills of exchange, promissory notes, contracts,
cheque books, registration documents, etc., are kept in
office safes or bank lockers. Other documents like office
files, correspondence, etc., are kept in safe places so
that outsiders cannot access them. For securing official
documents or records, it is necessary that the responsi-
bility be vested in a particular employee. The employee
should be responsible for any loss of or damage to official
records or documents under his/her charge. In addition,
the following precautions should be taken.

1 First Aid Box: One first Aid Box should be provided for
every 150 workers. The box should be in the charge of a
person trained in First Aid. A least two or three members
of the staff should be trained to render first aid in case of
need. The First Aid Box should be kept at a convenient
place.

2 Fire Precautions: Adequate fire precautions should
be taken as stated above for the preservation of office
records and documents against risk of loss or destruction
by fire. Fire fighting equipment like fire extinguishers should
be provided. The workers should know how to use a fire
extinguisher in case of emergency. Such fire extinguish-
ers should be placed at a convenient place. Fire alarm
should be fixed and tested from time to time. The workers
should be made familiar with these precautions.

3 Security arrangements: In large organisations, em-
ployers make extensive security arrangements. A large
number of caretakers, guards and housekeepers are em-
ployed to take charge of the building after office hours.
The caretakers are generally held responsible for any loss
of furniture, equipment or records.

Safety measure is a step to avoid accidents. It is con-
cerned with bodily matters.

1 Employees may slip due to water on the floor or stair-
case.

2 Employees may fall if the floor or staircase is highly
polished.

3 Employees may be injured if floor covering is torn and
waste paper baskets or goods are haphazardly placed
and due to trailing of telephone wires.

4 Accidents may occur if desks, filing cabinets, draw-
ers, etc., are kept open and edges of windows are not
covered.

5 Accidents may also occur due to electric shock, etc.

Measure to ensure safety: Precautionary measures to
ensure safety are

1 Regular inspection of electricity management should
be arranged.

2 Electric machines, switches, and appliances should
be tested from time to time.

3 Telephone wires must not be allowed to trail.

4 Floors should not be highly polished.

5 Ladders should be provided to reach high shelves.

6 Floors, passages and stairs must be properly con-
structed, maintained, cleaned and lighted.

7 First aid box should be provided.

8 Fire extinguishers should be provided in each floor.

9 Stairs should have railings and floor opening should be
fenced.
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Office Administration and Facility Management          R.Theory for Ex 1.6.57
Stenographer Secretarial Asst. (Eng) - MS Excel - Importance of office -office
layouts registers - Dictation exercise

Handling of mails - Inward mail & outward mail

Objectives: At the end of this lesson you shall be able to
• state the types of office mails
• narrate the procedure for handling inward mails
• narrate the procedure for handling outward mails.

Mailing

Meaning - A written form of communication is called mail-
ing.

Every office receives and sends out a number of commu-
nications in the form of letters, circulars, orders, printed
material, information booklets or bulletins, telegrams, etc.

Mails can be divided into two categories, i.e., Inward Mail
or Incoming Mail and Outward Mail or Outgoing Mail.

Procedure for handling incoming mail

a Receiving of Mail: Letters are received in an office
from the postman once or twice a day.  The big business
houses hire a Post Box at the Post Office.  The mail ad-
dressed to the Post Office once or twice a day is put in
this Box by the postal authorities.  The peon of the office
goes to the Post Office once or twice a day to take the
mail.  To avoid the possibilities of tampering with the mail
and theft of important documents such as cheques, drafts,
etc., by the peons, many business concerns hire a Post
Office Bag which has a lock on it.  One key of this lock
remains with the Post Master and the other in the office.
The mail addressed to the office is put in this bag and
then locked.

b Sorting of Mail: After receiving the mail, the enve-
lopes are sorted out into different categories as Sealed
Letters, Quotations, Registered Letters, 'Personal', 'Con-
fidential', 'Most Urgent', etc.

c Opening of Mail: After sorting of mail, envelopes are
opened carefully.  A letter opener machine is used if the
mail is in large in quantity.  All the contents inside the
envelope are taken out without leaving anything inside.

d Scrutiny of Letters: After opening the mail, all the
contents and enclosures therein should be examined care-
fully.  Any mistake or missing document should be brought
to the notice of the person concerned immediately by at-
taching a note.

e Stamping of Letters: After the letters are scrutinized,
they are stamped.  For this purpose, a rubber stamp is
used.  It contains all the details such as receipt No., date,
time, signature of receiver, etc.

f Recording of Letters: All the letters must be recorded
in the Diary Register or Incoming Mail Register.  This Reg-
ister contains columns, i.e., Serial No., date of receipt,
Letter No., sender's name and address, subject in brief
and to whom the letter is addressed and the date the
reply is sent.  Diary Register ensures quick acton on the
letters.  It is a proof of the receipt of letters.  If any letter is
misplaced, lost or destroyed, its particulars can be found
from this Register.

g Distribution of Letters: Sorting of mail can be done
department wise and kept in a tray marked for that depart-
ment.

Format of Inward Mail Register/Letter Received Book/Diary Register

 S. No. Date Letter Name & Address of Sender Subject            Referred to            Date           Sign
  No. Department of Disposal
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c Addressing Envelopes: Proper addressing of enve-
lopes is very important for despatching letters. The ad-
dress of the receiver is written or types neatly, legibly and
correctly on th envelope. The size of the envelope/wrapper
should be in accordance with the enclosures to be sent.
In large organizations, addressing machines are used to
save time.

The address of the receiver is typed on the envelopes leaving
sufficient space for postal stamps to be affixed or imprinted
and for writing other instructions such as 'R.P.A.D.',
'O.I.G.S', 'UPC', URGENT', etc.  Th address should be
complete in all respects.  Name, address, street, village/
town/city, state and country.  PIN should be written below
the address.

Address should be written or typed in blocked style or
indented style Name and address of the sender is also
written or printed on the left bottom of the envelope,  Air-
mail envelopes should be used for mail to be sent by air-
mail with the words 'AIR MAIL' written on them.

Procedure for handling of outward mail

a Collection of Mail: All the outgoing mail is collected
from every unit or department at specific intervals.  A tray
marked 'outgoing' is collected from each section by a
messenger and delivered to the central mailing section for
despatch.

Local and inter-departmental letters can be sent by mes-
sengers or peons after details are entered in the Peon

Book.  Signatures of the addressees  are obtained in the
Peon Book which serve as  proof of letters having been
received by them.

b Recording of outward mail: All the letters to be sent
by post should be entered in the Despatch Register giving
a Serial No. to the letter on the letter and a Ref. No. in the
corresponding letter.  It helps to trace the letter, its date of
posting, postage charged, etc. as shown in the format.

Format of outward/despatch register

S.No. Date Despatch No. Name & Address of Receiver   Subject     Mode of Sign
   Despatch

After the letter and its enclosures are ready, they are
stapled or pinned carefully.  The folding of letter is done
according to the size of the envelopes used for despatch.
Before the letter is inserted in the envelope, its address is
confirmed to avoid wrong despatch of letters.  Big organi-
zations use folding machines for folding and inserting let-
ters.

d Closing and sealing of envelopes: After the letter is
inserted into the envelope, it is sealed with gum carefully
so that gum may not spread out.  Book-Posts, VPP ar-
ticles are not sealed but are stapled or tied by a thread
around.  To save time, sealing machines are also used.
After the sealing is done, postage stamps are affixed or
imprinted on the right top of the envelope.  For weighing
and calculating the correct postage on the envelope, Frank-
ing machines are used.  After the postage stamps are
affixed, the letters are sent to the nearest letter box at
specified intervals.
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Office Administration and Facility Management          R.Theory for Ex 1.6.58
Stenographer Secretarial Asst. (Eng) - MS Excel - Importance of office -office
layouts registers - Dictation exercise

Arithmetic, logical, relative and absolute cell referencing

Objectives: At the end of this lesson you shall be able to
• explain arithmetic, logical cell referencing
• narrate relative and absolute cell referencing
• state formatting worksheets.

Basic arithmetic in Excel

Formulas are the backbone of most advanced calculations
within Excel. Think of a formula as an equation - it's a
series of steps that lead to a final output. You can tell
Excel that you're entering a formula in Excel by starting
your input with the equals sign (=). For example, try enter-
ing the following into a cell:

=5+4

Output: 9

Since Excel sees the = sign at the beginning of the line, it
realizes that it's being given a formula to calculate. It then
sees 5+4 and adds the two numbers together, outputting
a final value of 9.

Formulas in Excel use the standard mathematical order
of operations to evaluate. As such, operations within for-
mulas are processed in this order:

• Parentheses

• Exponents (^)

• Multiplication (*)

• Division (/)

• Addition (+)

• Subtraction (-)

Take a look at the following equations, and see whether
you can figure out how Excel arrives at the outputs speci-
fied:

=8+4; Output: 12

=8+4/4; Output: 9

=(8+4)/4; Output: 3

=8+4^2; Output: 24

=(8+4)^2; Output: 144

Logical Functions

If, And, Or, Not

Learn how to use Excel's logical functions such as the IF,
AND, OR and NOT function.

The IF function checks whether a condition is met, and
returns one value if true and another value if false.

1. For example, take a look at the IF function in cell C2
below. (Fig.1)

Explanation: if the score is greater than or equal to 60,
the IF function returns Pass, else it returns Fail. Visit our
page about the IF function for many more examples.

And

The AND Function returns TRUE if all conditions are true
and returns FALSE if any of the conditions are false.

For example, take a look at the AND function in cell D2.
(Fig.2)

Fig 1
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Explanation: The AND function returns TRUE if the first
score is greater than or equal to 60 and the second score
is greater than or equal to 90, else it returns FALSE.

Or

The OR function returns TRUE if any of the conditions are
TRUE and returns FALSE if all conditions are false.

For example, take a look at the OR function in cell D2.
(Fig.3)

Explanation: The OR function returns TRUE if at least
one score is greater than or equal to 60, else it returns
FALSE. Visit our page about the OR function for many
more examples.

Not

The NOT function changes TRUE to FALSE, and FALSE
to TRUE.

For example, take a look at the NOT function in cell D2.
(Fig.4)

Fig 2

Fig 3

Fig 4

Explanation: In this example, the NOT function reverses
the result of the OR function (see previous example).
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Relative & Absolute cell references

Excel uses three types o cell references to create formu-
las.  Each has its own purpose. Read on to determine
which type of cell reference to use your formula.

Relative cell reference

This is the most widely used type of cell reference in
formulas. Relative cell references are basic cell references
that adjust and change when copied or when using Auto
Fill. Let us take a simple example to explain the concept
of relative cell references in Excel. To calculate the total
for each item, we need to multiply the price of each item
with the quantity of that item. (Fig.5)

Fig 5

For the first item, the formula in cell D2 would be B2* C2
(as in Fig.6)

Fig 6

Now, instead of entering the formula for all the cells one
by one, you can simply copy cell D2 and paste it into all
the other cells (D3:D8). When you do it, you will notice
that the cell reference automatically adjust to refer to the
corresponding row. For example, the formula in cell D3
becomes B3*C3 and the formula in D4 becomes B4*C4.
(Fig.7)

Fig 7

Absolute Cell Reference

Situations arise in which the cell reference must remain
the same when copied or when using AutoFill.

Example

Unlike relative cell references, absolute cell references
don't change when you copy the formula to other cells.
Suppose you have the data set as shown below where
you have to calculate the commission for each item's to-
tal sales.The commission is 20% and is listed in cell G1.
(Fig.8)

Fig 8

To get the commission amount for each item
sale, use the following formula in cell E2 and
copy for all cells: =D2*$G$1

To get the commission amount for each item sale, use
the following formula in cell E2 and copy for all cells: (Fig.9)

Fig 9

Note that there are two dollar signs ($) in the cell refer-
ence that has the commission - $G$2.

What does the Dollar ($) sign do?

A dollar symbol, when added in front of the row and col-
umn number, makes it absolute (i.e., stops the row and
column number from changing when copied to other cells).

For example, in the above case, when we copy the for-
mula from cell E2 to E3, it changes from =D2*$G$1 to
=D3*$G$1.  Note that while D2 changes to D3, $G$1
doesn't change.

Since we have added a dollar symbol in front of 'G' and '1'
in G1, it wouldn't let the cell reference change when it's
copied. Hence this makes the cell reference absolute.
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Formatting options of cell in worksheets

Objectives: At the end of this lesson you shall be able to
• explain what is formatting
• state the steps to format cell content.

Formatting Cells

Format display of text in cell (i.e., numbers, dates,
etc.)

How to format the display of a cell's text in Excel 2007
such as numbers, dates, etc. (with screenshots and step-
by-step instructions).

1 Select the cells that you wish to format. (Fig.1)

Right-click and then select "Format Cells" from the popup
(Fig.2)

Fig 1

Fig 2
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When the Format Cells window appears, select the Num-
ber tab. In the Category listbox, select your format. A sample
of your text will appear on the right portion of the window
based on the format that you've selected. Click the OK
button when you are done. (Fig. 3)

In this example, we've chosen to format the content of the
cells as a currency number. (Fig.4)

Fig 3

Fig 4
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MS Excel - Align centre, left, right and justify cell contents and concepts of
charts

Objectives: At the end of this lesson you shall be able to
• understand how to align text using format cells dialog
• state how to align text left, right and justify in excel
• change alignment with custom number format
• align numbers in a column by a specific character
• explain different types of charts to represent data
• state how to modify charts.

How to change alignment in Excel using the ribbon

To change text alignment in Excel, select the cell(s) you
want to realign, go to the Home tab > Alignment group,
and choose the desired option. (Fig.1)

Vertical alignment

If you'd like to align data vertically, click one of the follow-
ing icons:

Top Align - aligns the contents to the top of the

cell.

Middle Align - centers the contents between the

top and bottom of the cell.

Bottom Align - aligns the contents to the bottom of

the cell (the default one).

Please note that changing vertical alignment does not have
any visual effect unless you increase the row height.

Horizontal alignment

To align your data horizontally, Microsoft Excel provides
these options:

Align Left  - aligns the contents along the left edge

of the cell.

Align  Center  - puts the contents in the middle of

the cell.

Align Right  - aligns the contents along the right

edge of the cell.

By combining different vertical and horizontal alignments,
you can arrange the cell contents in different ways, for
example. (Fig.2)

Change text orientation (rotate text)

Click the Orientation button on the Home tab, in the
Alignment group, to rotate text up or down and write ver-
tically or sideways. These options come in especially
handy for labelling narrow columns. (Fig.3)

Indent text in a cell (Fig.4)

In Microsoft Excel, the Tab key does not indent text in a
cell like it does, say, in Microsoft Word; it just moves the
pointer to the next cell. To change the indentation of the
cell contents, use the Indent icons that reside right under-
neath the Orientation button.

To move text further to the right, click the Increase Indent
icon. If you have gone too far right, click the Decrease
Indent icon to move the text back to the left.

Align to upper-left Align to bottom-right Center in the middle
of a cell

Shortcut keys for alignment in Excel

To change alignment in Excel without lifting your fingers
off the keyboard, you can use the following handy short-
cuts:

Top alignment - Alt + H then A + T

Middle alignment - Alt + H then A + M

Fig 1

Fig 2

Fig 3

Fig 4
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Bottom alignment - Alt + H then A + B

Left alignment - Alt + H then A + L

Center alignment - Alt + H then A + C

Right alignment - Alt + H then A + R

At first sight, it looks like a lot of keys to remember, but
upon a closer look the logic becomes obvious. The first
key combination (Alt + H) activates the Home tab. In the
second key combination, the first letter is always "A"
that stands for "alignment", and the other letter denotes
the direction, e.g. A + T - "align top", A + L - "align left",
A+C - "center alignment", and so on. (Fig.5)

To simplify things further, Microsoft Excel will display all
alignment shortcuts for you as soon as you press the
Alt+H key combination:

How to align text in Excel using the Format Cells dialog

Another way to re-align cells in Excel is using the Align-
ment tab of the Format Cells dialog box. To get to this
dialog, select the cells you want to align, and then either:

Press Ctrl + 1 and switch to the Alignment tab, or

Click the Dialog Box Launcher arrow at the bottom right
corner of the Alignment. (Fig.6)

In addition to the most used alignment options available
on the ribbon, the Format Cells dialog box provides a num-
ber of less used (but not less useful) features: (Fig.7)

Now, let's take a closer look at the most important ones.

Text alignment options (Fig.8)

Apart from aligning text horizontally and vertically in cells,
these options allow you to justify and distribute the cell
contents as well as fill an entire cell with the current data.

Fig 5

Fig 6

Fig 7

Fig 8
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How to fill cell with the current contents (Fig.9)

Use the Fill option to repeat the current cell content for
the width of the cell. For example, you can quickly create

a border element by typing a period in one cell, choosing
Fill under Horizontal alignment, and then copying the cell
across several adjacent columns:

How to justify text in Excel

To justify text horizontally, go to the Alignment tab of the
Format Cells dialog box, and select the Justify option
from the Horizontal drop-down list. This will wrap text and
adjust spacing in each line (except for the last line) so
that the first word aligns with the left edge and last word
with the right edge of the cell: (Fig.10)

The Justify option under Vertical alignment also wraps
text, but adjusts spaces between lines so the text fills
the entire row height: (Fig.11)

How to distribute text in Excel

Like Justify, the Distributed option wraps text and "dis-
tributes" the cell contents evenly across the width or height
of the cell, depending on whether you enabled Distributed
horizontal or Distributed vertical alignment, respectively.

Unlike Justify, Distributed works for all lines, including the
last line of the wrapped text. Even if a cell contains short
text, it will be spaced-out to fit the column width (if distrib-
uted horizontally) or the row height (if distributed verti-
cally). When a cell contains just one item (text or number
without in-between spaces), it will be centered in the cell.

This is what the text in a distributed cell looks like: (Fig.12)

                    Justified Horizontally         Distributed horizontally       Justify distributed

When changing the Horizontal alignment to Distributed,
you can set the Indent value, telling Excel how many
indent spaces you want to have after the left border and
before the right border.

If you don't want any indent spaces, you can check the
Justify Distributed box at the bottom of the Text align-
ment section, which ensures that there are no spaces
between the text and cell borders (the same as keeping
the Indent value to 0). If Indent is set to some value other
than zero, the Justify Distributed option is disabled (grayed
out).

The following screenshots demonstrate the difference be-
tween distributed and justified text in Excel.

Tips and notes

• Usually, justified and/or distributed text looks better in

wider columns.

• Both Justify and Distributed alignments enable wrap-

ping text In the Format Cells dialog, the Wrap text box
will be left unchecked, but the Wrap Text button on the
ribbon will be toggled on.

Fig 9

Fig 10

Fig 11

Fig 12
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Wrap text Shrink to fit Merge cells

• As is the case with text wrapping, sometimes you may

need to double click the boundary of the row heading
to force the row to resize properly.

Center across selection (Fig.13)

Exactly as its name suggests, this option centers the

contents of the left-most cell across the selected cells.
Visually, the result is indistinguishable from merging cells,
except that the cells are not really merged. This may help
you present the information in a better way and avoid un-
desirable side-effects of merged cells.

Text control options

These options control how your Excel data is presented
in a cell.

Wrap text - if the text in a cell is larger than the column
width, enable this feature to display the contents in sev-
eral lines. For more information, please see How to wrap
text in Excel. (Fig.14)

Shrink to fit - reduces the font size so that the text fits
into a cell without wrapping. The more text there is in a
cell, the smaller it will appear.

Merge cells - combines selected cells into one cell. For
more information, please see How to merge cells in Excel
without losing data.

The following screenshots show all text control options in
action.

Fig 13

Fig 14

What is a chart?

A chart is a visual representative of data in both columns
and rows. Charts are usually used to analyse trends and
patterns in data sets. ... You can also draw charts to
compare set targets against actual achievements.

The importance of charts

• Allows you to visualize data graphically.

• It’s easier to analyse trends and patterns in the charts

• Easy to interpret compared to data in cells.

Concept of charts

Objectives: At the end of this lesson you shall be able to
• state importance of charts
• explain different types of charts in MS Excel.

On the recommended Charts tab, scroll through the list of
charts that Excel recommends for your data, and click
and click any chart to see how your data will look....

When you find the chart you like, click it > OK. (Fig.1)

By default, the chart will appear directly on the spread-
sheet where your data is; when the chart is selected, you
will see additional Ribbons. In Excel 2010, you have the
Design, Layout, and Format Ribbons. The 'Layout' options
have been consolidated into the Design ribbon. (Fig.2)

Modifying Charts

Once your chart appears in Excel, there are many ways
to modify the way it looks and its location. A few ways are
described below, but explore to find more. In all cases,
you have to select the chart first to see the context sensi-
tive Ribbons (Design, Layout, and Format).

Creating a Chart

Select the data for which you want to create a chart.

Click INSERT > Recommended Charts.
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Fig 3

Fig 1

Fig 2

• To add any labels (for example, for the title or axes),

use the Chart Tools Layout Ribbon.

• In Excel 2013, the label options are under Add Chart

Element on the far left of the Design Ribbon.

• To change the chart type, data, or location, use the

Chart Tools Design Ribbon.

From either the Chart Tools Layout Ribbon or the Chart
Tools Format Ribbon, you can select an element on the
chart (for example, a series), then choose the Format
Selection icon in the Current Selection Group. In the For-
mat [Selected item] dialog box, you can change the shape,
style and color. (Fig.3)
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To insert a chart

1 Select the cells you want to chart, including the col-
umn titles and row labels. These cells will be the source
data for the chart ....

2 From the Insert tab, click the desired Chart command...

3 Choose the desired chart type from the dropdown
menu....

4 The selected chart will be inserted in the worksheet.
(Fig.4)

Fig 4

Excel Charts types

Column Chart: A Column Chart typically displays the
categories along the horizontal (category) axis and val-
ues along the vertical (value) axis. To create a column
chart, arrange the data in columns or rows on the
worksheet. (Fig.5)

Line Chart: Line charts can show continuous data over
time on an evenly scaled Axis. Therefore, they are ideal
for showing trends in data at equal intervals, such as
months, quarters or years. In a Line chart (Fig.6)

• Category data is distributed evenly along the hori-
zontal axis.

• Value data is distributed evenly along the vertical
axis.

Pie Chart: Pie charts show the size of items in one data
series, proportional to the sum of the items. The data points
in a pie chart are shown as a percentage of the whole pie.
To create a Pie Chart, arrange the data in one column or
row on the worksheet. (Fig.7)

Bar Chart: Bar Charts illustrate comparisons among indi-
vidual items. In a Bar Chart, the categories are organized
along the vertical axis and the values are organized along
the horizontal axis. To create a Bar Chart, arrange the
data in columns or rows on the Worksheet. (Fig.8)

Combo Chart

Combo charts combine two or more chart types to make
the data easy to understand, especially when the data is
widely varied. It is shown with a secondary axis and is
even easier to read. To create a Combo chart, arrange the
data in columns and rows on the worksheet. (Fig.9)

Fig 5

Fig 6

Fig 7

Fig 8
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Office stationery - office forms & manuals - types of office stationery

Objectives: At the end of this lesson you shall be able to
• state the advantages of using office forms and manuals
• list the different kinds of stationery.

Stationery and supplies are needed by every type of of-
fice, whether big or small. Supplies of different kinds
needed by the office are writing papers, carbon papers,
pads, computer rolls, teleprinter rolls, duplicating papers,
inks, pans, pencils, ball-point pens and refills, nibs, sten-
cils, gum, stamps, stamp pads, typewriting ribbons, ink
and pencil erasers, cellotape, staplers, pins and clippers,
sealing wax, tags, rubber bands, registers, file covers, file
boards, file boxes, etc. These items are available in differ-
ent qualities, shapes and sizes and under different brand
names.

Paper is the centre of action in an office and it is needed
for many purposes, which are as follows:

i. Letterheads of different types--small, medium and busi-
ness size;

Stock Chart

As the name implies, Stock charts can show fluctuations
in stock prices. However, a Stock chart can also be used
to show fluctuations in other data, such as daily rainfall or
annual temperatures.

To create a Stock chart, arrange the data in columns or
rows in a specific order on the worksheet. For example, to
create a simple high-low-close Stock chart, arrange your
data with High, Low, and Close entered as Column head-
ings, in that order.

Surface Chart

A Surface chart is useful when you want to find the opti-
mum combinations between two sets of data. As in a to-
pographic map, colors and patterns indicate areas that
are in the same range of values.

To create a Surface chart

• Ensure that both the categories and the data series
are numeric values.

• Arrange the data in columns or rows on the worksheet.

Radar Chart

Radar charts compare the aggregate values of several data
series. To create a Radar chart, arrange the data in col-
umns or rows on the worksheet.

Doughnut Chart: A Doughnut chart shows the relation-
ship of parts to a whole. It is similar to a Pie Chart with the
only difference that a Doughnut Chart can contain more
than one data series, whereas, a Pie Chart can contain
only one data series.

A Doughnut Chart contains rings and each ring represent-
ing one data series. To create a Doughnut Chart, arrange
the data in columns or rows on a worksheet.

Area Chart: Area Charts can be used to plot the change
over time and draw attention to the total value across a
trend. By showing the sum of the plotted values, an area
chart also shows the relationship of parts to a whole. To
create an Area Chart, arrange the data in columns or rows
on the worksheet.

XY (Scatter) Chart: XY (Scatter) charts are typically used
for showing and comparing numeric values, like scientific,
statistical, and engineering data.

A Scatter chart has two Value Axes

• Horizontal (x) Value Axis

• Vertical (y) Value Axis

It combines x and y values into single data points and
displays them in irregular intervals, or clusters. To create
a Scatter chart, arrange the data in columns and rows on
the worksheet.

Place the x values in one row or column, and then enter
the corresponding y values in the adjacent rows or col-
umns.

Bubble Chart

A Bubble chart is like a Scatter chart with an additional
third column to specify the size of the bubbles it shows to
represent the data points in the data series.

Fig 9

ii. Writing pads;

iii. Slip or sctrach pads;

iv. Printed and cyclostyled forms of different categories;

v. Plain paper sheets for typing reports or continuing long
letters;

vi. Thin second sheets or 'copy sheets' and with the word
COPY embossed across;

vii. Thin sheets or manila sheets for typing rough drafts;

viii. Stencil paper; and

ix. Duplicating paper, etc.,
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Office forms and stationery

Meaning and nature of office forms

An office form may be defined as a ‘printed piece of paper
or card on which entries are usually made against marked
headings’. A form has some fixed data which are generally
pre-printed in it and provides space for variable data or
information which the user of the form has to fill in. The
persons using the form need not write the fixed data again
and again. He has to fill in only the variable data. Thus, a
form is piece of paper containing some information printed
or reproduced by an method with blank spaces left for the
entry of additional information by the persons using it.

Forms are the basic tools of all office work. Forms function
as the vehicle by which the various data are collected
and brought together for use by the management. With
the help of office forms, information can be collected,
processed and supplied in a systematic way. Forms help
in increasing the efficiency of office work. Forms also
help in saving time and energy considerably by reducing
the amount of manual or machine writing. Consequently,
there will be reduction in the cost of office operations.
Thus, printed forms have become an essential part of office
procedure and nearly every office routine centres round
one or more forms.

Classification

Forms can be classified

1 According to the office operations as follows

Office manuals and office forms

An office manual can be described as a written record of
information and instructions regarding policies, regulations,
functions, systems, procedures and methods framed with
a view to guide the efforts of the employees in the organi-
zation. In other words, an office manual is a guide book
containing enough guidelines necessary for the best per-
formance of the job.

Need for office manuals

Office manuals are needed for a variety of reasons, more
important of which have been outlined below:

1. Elimination of repetition of instructions

Office manuals are prepared with a view to eliminate
the need for constant repetition of instructions.

2. Standardization of instructions

Instructions are standardized so that there is unifor-
mity in the implementation of policies, regulations, pro-
cedures and methods.

3. Fixation of responsibility

Office manuals fix responsibility for performing duties.
Once instructions have been issued in book form, each
employee can be held responsible for them and the
manner in which they are carried out.

4. To aid employee training

Manuals are prepared to aid employee training, both
of new and old employees.

a Purchase forms

b Accounts forms

c Sales forms

d Correspondence forms

2 According to their use the forms may further be
classified into 2 groups

a Outside contract forms – orders, Invoices,
statements, etc.

b Internal contract forms – memorandum,
requisitions, reports, etc.

3 According to the number of copies made or required
to be made the ‘forms’ may be divided into 2 groups:

A Single copy forms – No copy is required to be made.

Multiple copy forms – prepared in duplicate, triplicate or
as required for transmission, distribution, etc.

Necessity of office forms

Need for office forms: The office forms serve a number
of purposes and hence they are very much used in offices.

1 Forms make clear what information must be gathered.

2 Forms provide a specific location for each item of
information required and thus the work of data entry,
processing and reference becomes easy.

3 Forms eliminate the need for re-copying standard or
repetitive information, thus enabling the management
to save much time and money.

4 Forms facilitate the use of multiple copies. This helps
in simplifying the procedure.

5 Forms help to identify the records, and also facilitate
filing and future reference.

Advantages of using forms

The important advantages of using forms are as follows:

1 Simplify the Office Procedure: The office forms
simplify the office procedure and help to establish a
system. They not only reduce the volume of work
considerably, but also help in expediting office work.

2 Save Time: Office forms eliminate the need for
recopying repetitive and standard information. This
saves time.

3 Reduce chances of Mistakes: As the information to
be collected is already known in advance to the
persons handling office forms, the chances of mistakes
and errors occurring are considerably reduced.

4 Preservation of records: Forms help to preserve
records of business for filing and future reference in
case of need.

5 Fix individual responsibility: Generally, forms have
a column for the signature of the person who gathers
the information at any stage. This helps in fixing
individual responsibility.

6 Aid to Planning: Forms help to preserve records and
this aids the organisation in better planning.
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Office Manual

An office manual is an authoritative guide to office
organisation. It is a source of information, knowledge of
which is essential for the performance of office work. It
may be in the form of book or booklet and contains
information on operating office systems and procedures,
methods and routines, standard practices, organisational
policies, etc. If office employees are supplied with copies
of the office manual, they don’t have to approach their
superiors again and again for guidance, instruction and
decision. Therefore, there is no interruption of work no
waste of their time and the time of the executive.

Office manuals are used to fix responsibility for the
performance of office work and set up procedures for the
performance of these office works.

An office manual usually contains

1 General information: Name, Address of company,
branches, nature of business, etc.

2 Office rules and regulations: Office hours, salary
structures, pay days, leave rules, medical benefits,
vacation and holiday arrangements, promotions,
transfers, compensations, disciplinary action,
retirement, dismissal, etc.

3 Safety instructions: These instructions indicate what
should be done in case of fire, accident, serious illness
or any other emergency.

4 Job Descriptions: Laying down the basic function of
each job in terms of the authority and responsibility
attached to it, so that employees may know what is
expected of them.

Advantages

1 General Information: Name, address of company,
branches, natures of business, etc.

2 Office rules and regulations: Office hours, salary
structures, pay days, leave rules, medical benefits,
vacation and holiday arrangements, promotions,
transfers, compensations, disciplinary action,
retirement, dismissal, etc.

3 Safety instructions: These instructions indicate what
should be done in case of fire, accident, serious illness
or any other emergency.

4 Job descriptions: Laying down the basic function of
each job in terms of the authority and responsibility
attached to it, so that employees may know what is
expected of them.

7 Better Human Relations: Employees are assured
of keeping a proper record of their work, wages, bonus,
etc. This builds confidence in the employees about
the organisation’s efforts to protect their interests and
this may promote better human relations in the
organisation.

8 Reduce cost of office operations: The forms by
reducing the amount of manual or machine work help
in increasing the efficiency and output of each worker.
Thus, the use of forms reduces the cost of office
operations.

9 Help in Systematic recording of Information:
Forms serve as a tool which assures that all necessary
and relevant information is supplied and recorded in a
systematic manner.

10 Better customer service: By making use of the
forms, the records of the customer can be preserved
with greater ease. This enables the organisation to
serve the customers better.

Stationery

Every office requires a large variety of stationery and other
articles for various purposes in connection with office work.
These are often known as “office supplies”. Office supplies
have become an integral part of any office organisation
and we cannot think of carrying out any clerical operations
in office without the use of stationery. Office supplies are
those small items which are used regularly in any office.
These include items like paper, letter-heads, paper pads,
carbon papers, typewriter ribbon, pens, pencils,
envelopes, duplicating paper, duplicating ink, paper
fasteners (pins, clips, paste, glue, etc.) tags, sealing
wax, stamp pads, stencils, etc.

Different kinds of stationery

Stationery and supplies are needed by every type of office,
whether big or small. Supplies of different kinds needed
by the office are writing paper, pads, computer rolls, tele-
printer rolls, duplicating papers, ink, pencils, ball-point,
refills, erasers, cello taps, staplers, pins, clippers, sealing
wax, tags, rubber bands, registers, file covers, file boards,
file boxes, etc. These items are available in different
qualities, shapes and sizes and under different brand
names.

Paper is the centre of action in an office and it is needed
for many purposes, which are as follows:

1 Letterheads of different types – small, medium and
business size;

2 Writing pads;

3 Slip or scratch pads;

4 Printed and cyclostyled forms of different categories;

5 Plain paper sheets for typing reports or continuing
long letters;

6 Thin second sheets or ‘copy sheets’ with the word
COPY embossed across;

7 Thin sheets or manila sheets for typing rough drafts;

8 Thin sheets for second copies;

9 Stencil paper; and

10 Duplicating paper.
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Advantages

1 It contains printed instructions of office work. So
instructions on the method of doing jobs reduce the
need for explaining these to the employee again and
again.

2 An office manual is an aid in the training of new
employees, because it gives them readily available
information from the established systems, procedures
and duties existing in the organisation.

3 The use of manuals is particularly helpful in large
offices or firms having branches in each of which
similar activities are performed. It brings uniformity in
the office systems and procedures followed in each
branch.

4 An office manual enables the executive to make
decisions promptly by referring to the instruction and
policies contained in it.

5 Everyone gets an idea of the responsibility, duties
and authority of his job.

6 When employees are transferred an office manual
makes it possible for them to pick up their work at
the new location quickly without delay or hesitation.

Disadvantages

1 Small firms cannot afford to have an office manual for
its writing and compilation are costly and time
consuming.

2 A written manual leaves little room for personal initiative
on the part of the executive.

3 If written in ambiguous language, a manual is likely to
be misinterpreted.

4 To keep a manual up-to-date is often a difficult job.

5 It may put on record the relationship which everyone
may not like.

Need for office manuals

Office manuals are needed for a variety of reasons more
important of which have been outlined below

1 Elimination of repetition of instructions

Office manuals are prepared with a view to eliminate the
need for constant repetition of instructions.

2 Standardization of instructions

Instructions are standardized so that there is uniformity in
the implementation of policies, regulations, procedures
and methods.

3 Fixation of responsibility

Office manuals fix responsibility for performing duties. Once
instructions have been issued in book form, each
employee can be held responsible for them and the manner
in which they are carried out.

4 To aid employee training

Manuals are prepared to aid employee training, both of
new and old employees.

OA&FM : SSA (English) (NSQF - Revised 2022) R.T. for Ex .1.6.58

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



189

Office Administration and Facility Management    R.Theory for Ex 1.6.59&60
Stenographer Secretarial Asst. (Eng) - MS Excel - Importance of office -office
layouts registers - Dictation exercise

Computer viruses, use of anti virus, precautions and scanning

Objectives: At the end of this lesson you shall be able to
• explain what is virus
• state what computer viruses do?
• narrate history of virus
• explain how to protect computer from virus
• explain what is antivirus software
• explain the scanning process on computer.

Computer viruses

A computer virus is a malicious program that self-repli-
cates by copying itself to another program. In other words,
the computer virus spreads by itself into other executable
code or documents. The purpose of creating a computer
virus is to infect vulnerable systems, gain admin control
and steal user sensitive data. Hackers design computer
viruses with malicious intent and prey on online users by
tricking them.

One of the ideal methods by which viruses spread is
through emails - opening the attachment in the email,
visiting an infected website, clicking on an executable file,
or viewing an infected advertisement can cause the virus
to spread to your system. Besides that, infections also
spread while connecting with already infected removable
storage devices, such as USB drives.

It is quite easy and simple for the viruses to sneak into a
computer by dodging the defence systems. A successful
breach can cause serious issues for the user such as
infecting other resources or system software, modifying
or deleting key functions or applications and copy/delete
or encrypt data.

Use of Anti-virus

• Scan specific files or directories for any malware or
known malicious patterns

• Allow you to schedule scans to automatically run for
you

• Allow you to initiate a scan of a particular file or your
entire computer or of a CD or flash drive at any time.

• Remove any malicious code detected -sometimes you
will be notified of an infection and asked if you want to
clean the file, other programs will automatically do this
behind the scenes.

• Show you the 'health' of your computer

Precautions and Scanning

Install antivirus software and keep the virus definitions up-
to-date.  Anti-virus software scans files for unusual changes
in file size, programs that match the software's database
of known viruses, suspicious email attachments, and other
warning signs.  It's the most important step you can take
towards keeping your computer clean of viruses.  Subse-
quently, updating of antivirus allows updating of current
virus definitions which protect computer from new viruses.

Scanning

An anti-virus scanner is a component of an anti-virus soft-
ware package that scans a hard drive for viruses and other
harmful items. These programs are made for various oper-
ating systems, and scanning methods can be manual or
automatic.  Scanning is a process of using antivirus soft-
ware to scan and identify viruses in a computing device.  It
is an information security process that aims to review and
identify threatening viruses and programs.  It is the core
feature of anti-virus software.

Motivation - Types of Motivation

Objectives: At the end of this lesson you shall be able to
• explain different types of Motivation
• state intrinsic motivation with examples
• state extrinsic motivation with examples.

Types of Motivation

• Achievement Motivation It is the drive to pursue and

attain goals. An individual with achievement motivation
wishes to achieve objectives and advance up on the
ladder of success. Here, accomplishment is important
for its own sake and not for the rewards that accom-
pany it. This motivation is more important for profes-
sionals. It is the drive to pursue and attain goals.

• Affiliation Motivation - It is a drive to relate to people

on a social basis. Persons with affiliation motivation
perform work better when they are complimented for

their favourable attitudes and co-operation. This moti-
vation is of greater use where money cannot be used
to motivate, especially minimum-wage employees and
contingent professionals.  It is a drive to relate to people
on a social basis.

• Competence Motivation - It is the drive to be good at

something, allowing the individual to perform high quality
work. Competence motivated people seek job mas-
tery, take pride in developing and using their problem-
solving skills and strive to be creative when confronted
with obstacles. They learn from their experience.
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• Power Motivation - It is the drive to influence people

and change situations. Power motivated people create
an impact on their organization and are willing to take
risk to do so.

• Attitude Motivation - Attitude motivation is how people

think and feel. It is their self- confidence, their belief in
themselves, and their attitude to life. It is how they feel
about the future and how they react to the past.

• Incentive Motivation- It is where a person or a team

reaps a reward from an activity. It is "you do this and
you get that", attitude. It is the type of rewards and
prizes that drive people to work a little harder. Most of
the unorganized job workers get motivated when they
are offered more money.

Fear Motivation: Fear motivation coercions a person to
act against will. It is instantaneous and gets the job done
quickly. It is helpful in the short run. Managers following
Theory come into this category. In Indian army, this kind
of motivation is very popular.

Intrinsic Motivation

Definition: Stimulation that drives an individual to adopt or
change a behaviour for his or her own internal satisfaction
or fulfilment. Intrinsic motivation is usually self-applied,
and springs from a direct relationship between the indi-
vidual and the situation. It is very important factor in the
design of learning or training course.

• taking on more responsibility at work because you
enjoy being challenged and feeling accomplished, rather
than to get a raise or promotion.

• painting a picture because you feel calm and happy
when you paint rather than selling your art to make
money.

Extrinsic Motivation

Extrinsic motivation refers to behaviour that is driven by
external rewards such as money, fame, grades, and praise.
This type of motivation arises from outside the individual,
as opposed to intrinsic motivation, which originates inside
of the individual.

Examples of extrinsic Motivation

• Going to work because you must earn money

• Studying because you want to get a good grade

• Helping others because you hope for praise from friends
or family

• Doing a certain work because you are looking for at-
tention

Some examples of intrinsic motivation are

• participating in a sport because it's fun and you enjoy

it rather than doing it to win an award

• learning a new language because you like experienc-

ing new things, not because your job requires it

• spending time with someone because you enjoy their

company and not because they can further your social
standing

• cleaning because you enjoy a tidy space rather than
doing it to avoid making your spouse angry

• playing cards because you enjoy the challenge instead
of playing to win money

• exercising because you enjoy physically challenging
your body instead of doing it to lose weight or fit into
an outfit

• volunteering because you feel content and fulfilled rather
than needing it to meet a school or work requirement

• going for a run because you find it relaxing or are trying
to beat a personal record, not to win a competition

• Volunteering because it looks good on your resume.

• Going to the same shop because you benefit from cus-
tomer loyalty programs.

• Going to new places because you want to post it on
Face book.

• Paying taxes because you want to avoid a fine

• Buying a new car just because it looks nicer than the
old one

• Going on a business trip because your boss tells you

• Staying at home because your doctor told you to relax

• Competing in a contest because you want to get a
scholarship

• Buying branded clothes because you want to keep up
with your friends

• Exercising because you want to lose weight

• Working extra hard because you want to become the
employee of the month

• Completing tasks because you want to look good in
public

• Posting on LinkedIn because you want to get recog-
nized by other professionals

• Participating in a survey because you want the incen-
tive

• Reading a book because you have to prepare for a test

• Doing tasks because you want to avoid judgment

• Participating in a sport because you want to win awards
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Definition of filing

A systematic process or arrangement of papers in a file is
called filing.  Filing can be described as the core of records
management.

Meaning

Systematic preservation of letters, documents, telegrams,
etc., received and copies of those sent out for future refer-
ence is known as filling. In other words, filing is the pro-
cess of arranging, sorting and storing  the original records
or copies of them, so that they can be readily located
when required.

Advantages of a good filing system

• Protection: It protects the documents against pos-
sible loss or damage.

• Ready reference: It serves as a useful method of ob-
taining information without loss of time, without it a
modern business cannot hope to function at all.

• Planning: Future planning is greatly helped by the old
records. They serve as the basis for future action.

• Better control: Process of control is greatly facilitated
by filing. A check is kept on incoming and outgoing
letters and letters requiring immediate attention are thus
disposed of quickly.

• Follow-up for sales: Follow-up for sales is unthink-
able without a good filing system. When new products
are launched old customers are to be approached for
co-operation. Also price changes and product changes
are to be notified to the customers. This can be done
only if old records are available.

• Basis for evidence: Old records are useful as evi-
dence in a law suit or in proving title and existence of
the firm as well.

Essential characteristics of a good filing system

• Compactness: A good system of filing must be com-
pact. In other words it should occupy the minimum of
space because modern office space is costly.

• Accessibility: This is fundamental to filing. Without
accessibility records are useless. The importance of
accessibility is greater in situations where records are
to be written on.

• Economy: Filing system must not be costly. There
should be minimum cost in its installation and opera-
tion.

• Simplicity: The system should be simple. The work-
ers may easily understand the system and operate it
successfully.

• Elasticity: The system should be elastic and flexible.
It may be easily changed to suit the changing needs
of business. Sometimes it may have to be expanded
and sometimes it may be contracted.

• Easy location: Records must be easily located when
needed for reference.

• Cross reference: This is needed so that a document
may be found under different headings, especially cor-
respondence.

• Retention: The records must be retained or discarded
on the basis of their usefulness. Dead material must
be discarded forthwith. There should be specific policy
for this purpose.

• Classification: It is necessary to employee the most
suitable method of classification. For this purpose too
many miscellaneous files and too much bulk must be
avoided.

• Out guides: Out guides indicate the documents which
have been withdrawn. They indicate the person or de-
partment withdrawing them. Out guides are thus a ne-
cessity for a good filing system.

• Classification of filing: Every file is given a title or
heading according to the subject dealt with in the pa-
pers.  It is necessary to classify a document before it
is put into the file. The organization should select a
system of filing suitable and convenient for its busi-
ness activities.

Office Administration and Facility Management          R.Theory for Ex 1.7.61
Stenographer Secretarial Asst. (Eng) - MS Power Point - Office Secretary -
Filing - Dictation exercise

Filing - Meaning of records - compilation & classification

Objectives: At the end of this lesson you shall be able to
• define filing
• state the advantages of a good filing system
• narrate the essentials/characteristics of a good filing system
• list various methods of filing
• list filing equipment
• explain e-filing.
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(a) Alphabetical Filing: In this system records are kept
in alphabetical order like telephone directories. In case
of individuals the surname is written first. This filing
system is easy to understand and to locate the file.
No separate indexing is necessary in it. It can be ex-
panded as and when required. However, it is difficult to
estimate the space required for each name with differ-
ent letters.

(b) Numerical Filing: In this system files are kept in nu-
merical order.  A number is allotted to a name or a firm.
Every department is given a block of numbers however
it is difficult to locate the files. Books are arranged in
this method in the libraries.

(c) Subject-wise Filing: In this system classification of
papers is done on the basis of subjects. All the papers
are filed alphabetically. The advantage of this system
is that it has the capacity of expansion and files are
easily located.

(d) Chronological Filing: In this system file is maintained
in order of time. It is simple to operate. It is useful for
small offices. It is useful in filing vouchers of accounts
etc.

(e) Geographical System: In this system files are grouped
on the basis of States, cities, districts, towns, and ar-
ranged alphabetically. This system is easy to locate
the files.

Filing equipment and filing method

1. Guard File: In this system papers to be filed are
posted on different pages of a register. It is an old sys-
tem.

3. Box File: Papers are placed in the files in a box of the
appropriate size which are held by a spring loaded arm.
This method is cheap and simple to operate.

2. Spike File: This system is generally used for keeping
receipts of newspaper bills, electricity bills, l.P.G deliv-
ery slips, etc. All the papers are inserted through spike
by piercing.

4. Concertina File: A number of light cards are used to
keep papers inside them for temporary storage. It is
like a photo album. It is durable. It has limited storage
capacity.

5. Pigeon hole cupboard: A special type of almirah is
constructed with small compartments which have spe-
cial boxes like pigeon holes. Each pigeon hole is al-
lowed a letter of alphabet. Papers of different subjects
or parties are kept separately.

6. File (clip) file: This is made of plastic or thick paper
board in which papers are kept tied with a clip.

Lever File

It is made of strong card metal archer, the archer can be
opened by raising the lever. Papers are punched with two
holes and archer, inserted. The archers are then closed
by loading the lever.

Vertical Filing

1. Folders: A folder is made of heavy sheet of paper- fold-
ers are larger than paper so that they protect them.
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The extended back portion of the folder is used to write
the content and necessary details about the subject
and are visible in a sequence so that the contents can
be read easily.

2. Drawer File: A typical pull-out drawer file cabinet is
used in which the files are placed on their spinner, one
behind another. They are pulled out and the files are
traced. At drawer contains about 200 files. It can be
divided into sections which are named according to
the filing system.

2 Simplicity: The filing system should be simple and
not too elaborate. At the same time, the usefulness of
the filing system cannot be sacrificed for the sake of
simplicity.

3 Accessibility: A good filing system should be arranged
in such a way that the records are easily available
whenever required. The filing system should allow the
insertion of additional documents without disturbing the
existing order of files.

4 Economy: The filing system should be economical in
time, space, money and operations. The cost of in-
stallation and operation of filing system should be as
low as possible. The selected filing equipment should
occupy minimum space but can accommodate maxi-
mum number of files.

The cost of filing equipment should be very low. The
filing equipment should save the time of operation i.e.
locating, inserting and placing of documents and pa-
pers in a file. The unwanted records may be disposed
of in order to economise space.

5 Flexibility: The filing system can be expanded if the
volume of business transactions increased. An inflex-
ible system is not useful after crossing a certain limit.

6 Classification: The filing system should be supported
by a proper system of classification. Proper classifica-
tion reduces the number of files to be maintained and
helps in inserting as well as locating the documents in
the files.

7 Safety: The filed documents and records should be in
safe condition and available whenever required. The
documents and records should be protected from in-
sects, rain, dust, or mishandling.

8 Cross Reference: A cross reference should be given
wherever a document can be filed more than one head
to avoid confusion and to facilitate easy location of files.
It saves time and human resources.

9 Easy Location: Documents and records should be kept
in such a way that they can be easily located when-
ever required with the minimum delay possible. At the
same time, it does not require heavy expenditure to
achieve this purpose.

10 Indexing: A well designed index is also used to supple-
ment the filing system. It will help to locate the file
quickly when it is required.

11 Retention: Documents and records are maintained for
a minimum period of time. Then, the dead records and
documents can be discarded.

12 Out guides: A reference is to be maintained in the
files that the list of documents or records are with-
drawn by the office staff or department and the docu-
ments returned with date. Rules and procedures can
be framed and followed to prevent misfiling.

13 Minimum Misfiling: The main difficulty is not con-
cerned with filing but in finding the documents. Misfil-
ing causes delay in the location of a desired docu-

Importance of filing, Essentials of Good filing Methods,
Classification of Files - Alphabetical, Numerical, Geo-
graphical and subject wise, Centralization and Decentrali-
zation of filing.

Importance of filing

The importance of filing in an organization arises from the
simple fact that a large number of papers and documents
can be preserved and handled with proper arrangement.
Records remember where people forget. If these records
cannot be found quickly when needed, the labour involved
in producing and storing them in wasted. Hence inward
and outward correspondence should be carefully preserved
for future reference. Future reference is necessary in case
of disputes, and in case of receiving repeat orders, etc. It
is possible when the records are systematically filed.

Essentials (or) Characteristics of Good Filing System

1 Compactness: The compact filing system should be
adopted by every business office. It means that the
filing system should not require any unnecessary
space.
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Classification of Filing System

The chief difficulty in office management is not filing but
in finding. It is essential to determine the nature of each
and every document, sort them on a predetermined ba-
sis and then filed. Then only a document, which is needed
for reference in future can be traced out and made avail-
able. The process of sorting out the document on some
definite basis is called classification of filing.

Classification can be defined as the process of selecting
headings under which documents are grouped or classi-
fied on the basis of certain common characteristics be-
fore filing takes place.

We all know that the principal object of classification of
files is to ensure prompt availability of information when-
ever it is needed. Classification aids the filing functions
to attain these principal objects.

The efficiency, particularly, the accessibility of a filing
system depends largely upon the care with which docu-
ments are classified. By classifying papers belonging to
a particular head or subject, office staff are able to trace
documents required at any time with minimum delay and
trouble.

The office manager, while designing a plan for filing de-
partment should also evolve suitable classification sys-
tem. The decision regarding classification generally de-
pends upon the purpose for which it is required.

Direct and Indirect Classification of Files

Classification systems may be either direct or indirect.
Direct filing means that the documents can be stored or
retrieved without reference to an index. In an indirect sys-
tem, index is necessary.

Methods of Classification of Files

The files can be arranged on the following basis.

1 Alphabetical classification.

2 Numerical classification.

3 Geographical classification.

4 Subject-wise classification.

5 Chronological classification.

1 Alphabetical Classification of filing

Alphabetical filing is the most widely used method. In
this system of classification the papers or records are
classified in accordance with the first letter of the name
in alphabetical order. The Telephone Directory is a good
example of such a classification.

For example, correspondence with those whose names
or surnames begin with ‘A’ will be classified and arranged
together. If there are several names having the same first
letter the arrangement takes into account the subsequent
letters also.

The main divisions of the alphabet can be further sub-

ment. Hence, the authorized staff alone is permitted to
have access to files.

divided and colour coding can be employed to facilitate
selection and replacement of files. Alphabetical classifi-
cation can be either by name or by subject or by geo-
graphical location.

Advantages of Alphabetical Filing

1 Most people are familiar with alphabetical filing. Hence,
it is easy and simple to understand and operate.

2 It is self-indexing. No separate index is needed for
alphabetical filing.

3 This system is highly elastic i.e. new headings can
be introduced at any point without disturbing the clas-
sification.

4 Chances for misfiling are minimized.

5 There are useful provisions for miscellaneous papers.

Disadvantages of Alphabetical Classification

1 Alphabetical classification of filing is not always the
fastest system i.e., it takes a long time to find papers
in large organizations.

2 Difficulties may arise through the misspelling of
names.

3 In setting up a new system, it is difficult to estimate
how much space is to be allowed for each letter of the
alphabet.

4 Dead files removed from the system leave gaps, which
cannot be filled except by correspondence bearing the
same or a very similar name.

5 If the number of records increases, extensive rearrange-
ments of guide cards and files become necessary.

In spite of these limitations, it is the most suitable method
of filing inward and outward letters and other documents,
Generally, there is a separate file for each letter in alpha-
bet. However, in small organizations two or three files are
sufficient for all the 26 letters.

2 Numerical classification of files

Under this method, each folder or record is given a num-
ber and the files are arranged in the numerical order i.e.
each customer or subject is allotted a number. All papers
relating to a particular customer or supplier or subject are
placed in one folder bearing its distinctive number.

Folders are arranged in the cabinet in numerical sequence
and guide cards are used to divide them into suitable
groups of 10 or 20. Thus, if a customer, is allotted the
number 14, all papers and documents connected with
him will be found in folder number 14.

Index will have to be maintained to facilitate location of a
particular file.

Advantages of Numerical Classification

1 Greater accuracy in filing is ensured. Hence, chances
for misfiling are reduced to the minimum.

2 This system is highly flexible because it has unlim-
ited scope for expansion.

OA&FM : SSA (English) (NSQF - Revised 2022) R.T. for Ex .1.7.61

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



195

3 There is no need for keeping miscellaneous files as in
the case of alphabetical system.

4 Replacement of files shall be quicker and more cer-
tain.

5 Numbered files can be easily located.

Disadvantages of Numerical Classification

1 This system will operate efficiently only when there is
an index. The index must be carefully managed and
kept up-to-date.

2 Index should be referred before ascertaining the loca-
tion of a file. This will cause delay in locating the files.

3 Since no miscellaneous files are kept it is not easy to
arrange files for miscellaneous papers.

4 Errors in filing will result due to transposition of fig-
ures.

3 Geographical Classification

Under this system, files are arranged according to the
location or addresses of the persons or parties to whom
they relate.

The classification can be street-wise, town-wise, district-
wise, state-wise or country-wise. This system will oper-
ate efficiently only when it is combined with either nu-
merical system or alphabetical system.

This system of classification is generally followed in or-
ganizations engaged in export trade or doing business
over a wide geographical area. Mail order houses, banks,
insurance companies, etc. also adopt this system of clas-
sification. This system is also suitable in those concerns
where records are required according to the sales terri-
tory.

Advantages of Geographical Classification

1 Speedy location of files is possible.

2 It is simple to adopt.

3 Direct filing is possible.

Disadvantages of Geographical Classification

1 This system will work only when combined with al-
phabetical classification. Hence, it is not an indepen-
dent system.

2 An index should be prepared. Without index this sys-
tem shall become inoperative.

3 Errors may result if the geographical knowledge of the
filing clerk is poor. Hence, chances for misfiling will
be more.

4 Proper training must be given to filing clerks. Other-
wise, errors shall become frequent.

4. Subject-wise Classification

Under this system, all documents concerned with a par-
ticular subject are brought together in one file. Such docu-
ments may have come from different sources and from
different people.

This system is adopted only when the subject or content
of a letter is more important than the name of the corre-
spondent. Each subject matter is kept in a separate file.
These files may then be arranged alphabetically, numeri-
cally or on some other basis.

For instance, separate files may be maintained for pur-
chase quotations, purchase orders, income tax returns,
traveling allowance bills and so on.

Advantages of Subject-wise Classification

1 Once the subject is known, it is very easy to trace out
the required information.

2 Each subject file gives complete particulars and infor-
mation on that subject.

3 There is scope for unlimited expansion.

Disadvantages of Subject-wise Classification

1 This system is not suitable for filing miscellaneous
papers.

2 Its greatest drawback is that it is difficult to classify.

3 If the subject classification is not understood prop-
erly, it will become difficult to locate a document.

4 If the number of subjects is more, an elaborate index
is necessary. This will make the system costly.

5 Liberal cross-references are often needed. This would
make the system slow and time consuming.

5 Chronological Classification

Under this arrangement, records are filed in strict date
order. Records like vouchers, invoices, bills etc. mostly
connected with accounts are filed in this fashion. How-
ever, this system cannot be adopted independently.

The records must be classified according to their subject
and may then be placed in date order inside the file re-
lated to that subject.

Merits of Chronological Filing System

Chronological filing system is good for overall classifica-
tion because records may be separated month-wise. In
particular, this system has the following points to its merit.

1 Speedy location of records is possible.

2 Simple to operate.

3 Less expensive because ordinary files are sufficient
to preserve the records under this system.

Demerits of Chronological Filing System

1. This system is suitable only for small business enter-
prises.

2. This system is not useful when exact dates are not
known.

3. Incoming letters are separated from outgoing replies.
Hence the history of particular transaction cannot be
ascertained at a glance.

Combination of Various Methods

In practice, no single filing system is particularly suitable
to all offices. Hence, more than one system can be com-
bined to obtain speed and economy. Of them the most
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popular and effective system is Alpha Numerical System,
which is a combination of numerical as well as alphabeti-
cal classification. Under this method, records are filed in
alphabetical order, but under each alphabet, there are
numbered folders.

Besides, numerical-sequential classification, numerical-
subject classification, alpha-numeric sequential classifi-
cation etc. are also in usage.

3. Simplicity of the filing System

Simple methods should be selected. Of the various meth-
ods, alphabetical method seems to be simpler. It is prob-
ably the best understood and perhaps is the generally
used method in preference to some complex method,
unless there are real advantages to be gained by adopt-
ing such a method.

Centralized vs. Decentralized Filing

There are several decisions that need to be made when
you're setting up your records management program. One
of the hardest decisions, and sometimes the most con-
troversial, is whether or not your records should be "cen-
tralized" or "decentralized."

There are several issues to consider when making the
decision on where your records should be located. One
of the best ways to approach it is to review the advan-
tages and disadvantages of each system and choose the
one, or combination, that has the most advantages for
your situation.

Centralized System

A centralized filing system is:

One in which the records for several people or units are
located in one, central location; and,

• Generally, under the control of a records staff person
or in the case of large centralized filing systems, sev-
eral people.

Advantages

• Responsibility is easily placed.

• Effective use of equipment, supplies and space.

• All related data kept together.

• Reduces duplication.

• Uniform service provided to all users.

• Improved security.

Disadvantages

• Records may be too distant from staff for adequate
service.

• Can result in increased personal filing systems.

• Requires full-time staffing.

• May require investment in more efficient filing equip-
ment and/or automation.

Decentralized System

A decentralized filing system is:

• One in which the files are located throughout the of-
fice, generally at individual work stations; and,

• Usually controlled by the person who creates and/or
receives them.

Advantages

• Records located near staff creating and using them.

• Does not require "extra" space needed for centralized
files.

• Does not require full-time staffing.

• Staff feels more comfortable knowing they are in con-
trol of their own filing and retrieving.

Disadvantages

• Confusion as to where information can be found, es-
pecially if staff member is absent.

• Can result in "fragmented" documentation - informa-
tion related to the same topic or subject filed in mul-
tiple places.

• Individual staff members may not know how to prop-
erly maintain their files.

• Lack of uniformity or consistency.

Combination System

There are also ways to structure your program using a
combination, of centralized/decentralized system.
Centralized control is established through a "records liai-
son" or "records manager" who is the centralized point of
contact for records management in the office and who
has responsibility for maintaining the office file plan and
ensuring established procedures are followed.

Here are some examples where specific types of records
are maintained in a central location while the rest of the
records are maintained at individual work stations.

• A centralized reference collection of documents;

• A file room for files which are inactive but which are
not ready to be sent to the Federal Records Center
(FRC);

• A public reference room for files which are accessed
by the public.

Those records which are maintained at individual work
stations are also part of the organization's filing system
and included in the office file plan so that everyone in the
office knows where the records are located and who is
responsible for maintaining them.

E-filing

The full form of e-filing is "Electronic Filing".  In view of
expansion of internet, e-filing has not only been popular
but is also mandatory in large number of cases. E-filing
is the process of submitting data over the Internet (tax
returns), using tax preparation software that has been
pre-approved by the relevant authority.

The biggest advantage of  e-filing  is that you can do this
from any place at any time, thereby saving a lot of time
and effort. It is simple, easy and faster than filing returns
manually.
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Office Administration and Facility Management     R.Theory for Ex 1.7.62-66
Stenographer Secretarial Asst. (Eng) - MS Power point - Office Secretary -
Filling - Dictation exercises

MS Power Point - Introduction, Presenting documents, addition graphics &
creating self running presentation

Objectives: At the end of this lesson you shall be able to
• explain about MS-Powerpoint
• narrate how to add text to the slide
• explain different options to create a self-running presentation
• explain how to add clip arts, graphics and pictures to the document
• view and run a presentation.

Microsoft PowerPoint is yet another application from the
Microsoft office suite. It is primarily used to create
presentations, demo and slides. PowerPoint has quite a
few built-in design templates and wizards that make it
Number 1 choice for creating professional presentations.

Most PowerPoint users will find this program helpful when
creating a PowerPoint presentation for school, work, even
personal.

Starting Microsoft PowerPoint 2010

If you have Microsoft Office on the computer, just do the
following to start Microsoft PowerPoint 2010.

Start  Programs  Microsoft Office  Microsoft Office
PowerPoint 2010

When open PowerPoint 2010 will be opening a new project.
All of the basic commands are located in the upper left hand
corner of the screen under a button that looks like the office
2010 icon. Let's start by clicking the icon in the left hand
corner so that one can describe what all of these functions
do as in Fig 1.

Fig 1
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Starting Power Point

Click Start point to All Programs, point to Microsoft Office
and then click Microsoft Office Power Point 2007 or 2010
as the case may be, a blank slide opens as shown in Fig.2

To add another slide, go to insert menu or right click the
blank slide already opened and click new slide. (Fig.3)

Fig 2

Fig 3

The Status Bar

The status bar at the bottom of the window can display
items such as the current slide number, theme, language,
etc.  Right-click the bar, to select the options required.

Zoom Slider

In the bottom-right hand corner of the window, on the status
bar, is the Zoom slider.  To view the document at different
percentages, click the plus or minus buttons.
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Fig 4
Views

When starting PowerPoint, the default view is Normal
View.

Normal View - divides the window up into three working
areas, allows to see three different views simultaneously.

• Slide pane - gives you a detailed view of the layout of
your current slide. Builds up the slides one at a time in
this pane, including text and graphics.

• Outline/Slide tabs - Outline shows the text of all the
slides in your presentation.  It can type in the text of the
presentation directly into this pane instead of into
individual slides and use it to move text between slides.
Slide displays the slides as thumbnails.  You can only
select, copy, delete and change the order of slides in
this pane.

• Notes pane - Lets you add speakers' notes to individual
slides.  These will not be seen in the presentation, but
can be printed out for the presenter.

Notes Page View - This is only available from the View tab
and allows the Notes pane to be viewed in its own window.

Document View Buttons

These are situated next to the Zoom Slider. Simply click
one of the buttons to view the document as Normal, Slide

Sorter or Slide Show .

Slide Sorter view - used for re-ordering slides, and also
for adding transitioneffects.

Slide Show (from current slide) view- used for present-
ing the slide show.  Each slide is displayed without menus
or tool bars.  To exit from Slide Show, press the [Esc] key
at the top left of the keyboard.

Creating a New Slide

1 On the Home tab, in the Slides group, click on New
Slide. (Fig.4)

The Layout gallery now displays 'thumbnails'
of different layouts to choose from.

2 Select the Title and Content option.

There are two placeholders on this slide, title
and content. The content placeholder can be
text, pictures, clip art, a SmartArt graphic,
tables, charts, etc.

3 Add the title: The Four Steps to a Presentation

4 In the content placeholder type:  Plan

5 Press [Enter].

Notice that the text is formatted as a bulleted list.

6 Type the following pressing [Enter] at the end of each
word:

Prepare

Practise

Present

7 Save the presentation.

Having entered the text, it can easily change
the layout of a slide. Just select the slide and
choose another layout from the Home tab -
Slides group - Layout button.

Adding Text to a Slide

If you have not already done so, start PowerPoint which will
open a New Blankpresentation. In the Slide pane, it will  be
noticed that there are two place holders where text can be
added.

1 Click in the title placeholder. 

2 Type: Presentation Guidelines

3 Click in the subtitle placeholder and type your name.

4 Save the Presentation as: Presentation Guidelines

Selecting text in "Text Mode" or "Graphic Mode"

In PowerPoint, all elements are considered graphic ob-
jects. Text however, can be formatted in Text mode or
Graphic mode. In "Text mode," just the text selected will
be effected by the formatting to apply.  In "Graphic mode,"
all the text within the placeholder will be effected by the
formatting to apply.

In "Text mode" will see a text cursor (blinking bar) within the
placeholder you have activated. The border of the placeholder
will appear as dashed lines.

In "Graphic mode," no cursor will be visible.  The border of
the placeholder will appear as a solid border.

One method to enter the Graphics mode in a text place
holder is to click into it and press the <Esc> key.
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Fig 5

Fig 6

Fig 7

Fig 8

Placeholder in Text Mode

Text Mode: Border is made up of dashes as on Fig 5.
Cursor is visible in placeholder.  Only the selected text will
be effected by formatting changes.

Placeholder in Graphic Mode

Graphic Mode: Border is solid as on Fig 6.  Cursor is not
visible in placeholder. All the text will be effected by
formatting changes.

Formatting Text and Paragraphs

PowerPoint 2007 includes a variety of ways to quickly and
professionallyformat text in a presentation. There are
formatting options on the HomeTab (Fig 7) including font,
size, font style, shadowing, embossing, text color,bullets,
alignment, line spacing, indenting, and setting tabs.

The Format Tab (Fig 8) under the Drawing Group contains
commands for applying formatting styles to text and
paragraphs. These commands include Shape Styles and
WordArt Styles.

Undo and Redo

If there is any mistake in PowerPoint, just simply undo it.
PowerPoint is set to undo the last 20 actions.

To undo your last action:

• In the Quick AccessToolbar, click on the Undo button.

To undo several actions at once:

• Click on the arrow  to the right of the Undo button, move
the cursor down the list of actions to select the ones
you  want to undo, and then click.  (Use the vertical
scroll bar to scroll down the list if the actions do not all
fit into the window)

The Redo feature   works in exactly the same way as Undo.

Adding ClipArt

1 On the Home tab - Slides group - New Slide button -
select the Two Content Layout.

2 In the title placeholder type: Prepare

3 In the content placeholder on the left, type the following:

An attention-getting opening

Visuals to support key points

A memorable close

4 In the content placeholder on the right, click on the Clip

Art icon .

The Clip Art pane will appear.

5 In the Search text: box type:  ideas and then click on
Go.

You can choose whether or not Microsoft Office
automatically looks on the web for Clip Art or
other resources such as Help files.

6 To select a picture, point to the picture of the man
holding a light bulb in the Clip Art pane.  An arrow button

will appear at the right of the picture .

7 Click on the arrow and select Insert.

Tip: To insert a graphic that you have on file, go to the Insert
tab and in the Illustrations group, select Picture.

8 Save your presentation.
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Fig 10

Fig 9

Resizing and Moving a Graphic

An Introduction to Microsoft. Please read the following
points:

• When a graphic is selected, re-size handles appear
around its border.

• When you point to a re-size handle, the cursor changes
into the re-size cursor.  To resize the graphic click and
drag one of these handles.

Tip: If you drag a side handle, you will distort the graphic,
but if you drag a corner handle, the relative dimensions will
stay the same.

• When the cursor is moved over the graphic, it will
change into the move cursor. To move the graphic,
make sure the cursor is the move cursor and then click
and drag the graphic to a new position.

Selecting Placeholders and Text

In order to change the appearance of text, it is necessary
to select or highlight either the text or the placeholder that
the text sits in. There are a number of different methods
used for selecting the text.

Selecting Placeholders

Selecting the entire frame or placeholder is a very quick,
efficient and consistent method of selecting text. Any
formatting applied to a selected place holder will format all
text sitting in the place holder.

To select the Placeholder (Fig 9 & 10)

Mouse

i Click into the text to be formatted.

ii Click on the shaded border of the text box. This will
change the pattern of the border line to indicate that all
text in it is selected.

or

Keyboard

iii Click into the text to be formatted.

iv Press CTRL+A.

Moving Between Slides

In PowerPoint there are various ways in which you can
quickly move between slides.  Try moving between slides
using the three methods mentioned below:

• Click and hold the mouse button on the scroll bar slider,
the number and title of the current slide will appear. Now
drag the slider until the slide that you want to view is
indicated.

• Click on the double-headed arrows below the vertical
scroll bar to move to the next, or previous, slide.

• Select the Slide tab in the Outline View pane and then
click on the slide to be displayed.

Running the Slide Show

To run the Presentation Guidelines slide show from the
beginning, do one of the following:

• On the Slide Show tab, in the Start Slide Show group,
click on the From Beginning button.  Notice that each
slide now takes up the whole screen.

• Press the [F5] key on the keyboard.

To run your slide show from the current slide, either:

• In the status bar, click on the Slide Show document
view button.

• On the Slide Show tab, in the Start Slide Show group,
click on the From Current Slide button.

Moving Through the Slide Show

To move to the:

• Next slide - press the [right arrow] key.

• Previous slide - press the [left arrow] key.

• To exit the slide show - press the [Esc] key.

After the last slide, the slide show ends with a black
screen.  To exit from theSlide Show click anywhere on the
black screen or press any key on the keyboard.
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MS PowerPoint - layouts, themes and designs, tables and charts

Objectives: At the end of this lesson you shall be able to
• explain layouts, themes and designs on a PPT presentation
• understand how to add charts and tables in PowerPoint
• explain PowerPoint templates and slide themes for presentation.

What is a slide layout? (Fig.1)

Slide layouts contain formatting, positioning, and place-
holders for all of the content that appears on a slide. Place-
holders are the containers in layouts that hold such con-
tent as text (including body text, bulleted lists, and titles),
tables, charts, SmartArt graphics, movies, sounds, pic-
tures, and clip art. Slide layouts also contain the theme
(colors, fonts, effects, and the background) of a slide.

All of the layout elements that you can include on a
PowerPoint slide

You can change the slide layouts that are built into
PowerPoint in Slide Master view. The picture below shows
the slide master and two of the layout masters for a theme
in Slide Master view. (Fig.3)

If you want to customize the definition of a slide lay-
out and later apply to individual slides, on the toolbar rib-
bon, select View →→→→→ Slide Master. (Fig.4)

PowerPoint includes built-in slide layouts, and you can
modify these layouts to meet your specific needs, and
you can share your custom layouts with other people who
create presentations by using PowerPoint.

If you want to apply a defined slide layout to a par-
ticular slide, select the slide. Then, on the toolbar rib-
bon, select Home > Layout and choose a layout from
the gallery of options that appears. (Fig.2)

The layout masters appear as thumbnails in the thumb-
nail pane under the slide master. Click a layout master in
the thumbnail pane, and then begin customizing. (Fig.5)

Fig 1

Built-in slide layouts, showing the placement of various
placeholders for text or graphics

Fig 2

Fig 3

Fig 4

Fig 5
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Slide Types and Layouts

Slides are the main articles of use in PowerPoint and have
been mentioned many times so far in this manual. They
are the building blocks of the presentationand as such will
form the content of the presentation showing one slide
afteranother displaying the contents that have inserted,
formatted and animated fromthe first to the last slide. They
are not, however, the best or fastest way toconstruct a
formatted presentation.

Slide Layouts (Fig.6)

After inserting a slide had chosen a different layout. There
is no need to delete a slide and reinserting one of another
type. It may justchange the layout this is especially useful
if the slide already has content.

To change the layout of a slide

Mouse

i Make sure that the slide that wish to change the layout
for is in the main window in normal view.

ii Click on the drop down arrow to the right of the LAYOUT
button.

iii Select a new layout for the chosen slideby clicking with
the left mouse button as shown in Fig 6.

iv The selected layout is applied.

Slide Formatting (Fig.7)

The formatting of all objects on the slide. You may wish to
make changes to the slide format globally by either
colouring the background of each slide in one go or
manually formatting one slide and applying it to all slides
this can save much time when it have many slides within
the presentation. Presentations with in PowerPoint are
based on a theme and the formatting of that theme
determines the placement and colours and styles of all
objects within the presentation.

Fig 6

Themes

Themes are used to give slide presentations a consistent
and stylish appearance. They contain colour schemes,
slides and title masters with custom formatting, and some
also include background graphics which have been placed
into the masters.

When you apply a Theme to the presentation, the Office
Thememaster and its subjet of slide layouts have the colour
scheme of the theme applied and it will replace the previous
office theme master and colour scheme ofthe presentation.

Once apply a Design Template, each slide to add, regardless
of the layout, has the same custom look to it. PowerPoint
2010 comes with a variety of professionally designed
themes.

Fig 7

To apply a theme

i Ensure no object is selected as this may confuse you
having two design ribbons. (one for the object and one
for the slide)

ii Choose the DESIGN ribbon, go to THEMES as shown
in Fig 8.

iii Click on the drop down arrow to the bottom right hand
side of the visible themes.

iv Move the mouse over a theme to see a preview of how
it will lookon your slide.

v Click on a template thumbnail. Itwill be applied to all the
slides in the presentation.

Changing the Background (Fig 9)

PowerPoint offers some interesting background effects,
including textures, and two colour gradient effects.

To apply a standard background

i Select BACKGROUND STYLES from the DESIGN
ribbon

ii Choose a style from the dropdown list.
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Fig 9

Fig 10

iii Right Click on the style ->APPLY TO ALL OR TO JUST
SELECTED SLIDES (Fig.10)

Fig 8

Several slides are using the same layout then apply to
matching slides.

To use a fill effect for the background

Mouse

i Select BACKGROUND STYLES from the DESIGN
ribbon

ii Select FORMAT BACKGROUND at the bottom of the
displayed list. A dialog appears.

iii Use the guidelines below to select GRADIENT,
TEXTURE, or PICTURE fills for the slide background.

iv Click on CLOSE to apply to selected slides or click on
APPLY TO ALL.

Different Ways To View Slides

When you are creating your presentation you can switch
between different views within PowerPoint, each of which
allows you to work in different ways. The views available in
PowerPoint 2007 are:

Normal (Tri Pane) View

Notes Page View

Slide Sorter View

Slide Show

Normal View

There are several views in which to work in PowerPoint.
Each view allowsyou to perform some specific work. The
primary view in PowerPoint is the Normal View.  It actually
contains several views but its primary purpose is to allow
you to create and work on the detail of a slide.

The Normal View allows you to access the Notes Pages
view as well as the Outline view and the Slide Tab view.  The
Slide Tab view provides an efficient method of navigating
between slides. Each pane can be adjusted in size by
dragging the edge of the pane window with your mouse.

Other views such as Slide Sorter view and Slide Show view
can be accessed through the View menu or by clicking the
View Buttons on the bottom left of the screen. All these
views are discussed in upcoming pages.

Notes Pages View

Notes Pages View (Fig 11), also known as Speaker Notes,
allows to addnotes that can be used by the presenter
during the presentation. This is an excellent method to
remind the presenter of important items to discuss during
the presentation that is not displayed on the slides. They
can also be used as handouts to the audience, if preferred.

PowerPoint also allows to print the slides with their notes.
It is important to note that you can only view the actual
formatted text when you print or preview presentation.
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Fig 11

Powerpoint templates and Slides themes for pre-
sentations

Powerpoint templates and Slides themes focus on
communicating your ideas in your presentations. These
professional designs cover all styles from playful and cre-
ative to formal and business presentations. You’ll find that
all templates are completely customizable and easy-to-
edit. Use them freely for your own presentation needs
(personal or commercial), use right away as a slides theme
as a Powerpoint template and continue working on your
computer.

To create a simple chart from scratch in PowerPoint,
click Insert > Chart and pick the chart you want.
(Fig.12)

• On the Insert tab, in the Illustrations group, click Chart.

• In the Insert Chart dialog box, click the arrows to scroll

through the chart types. ...

• Edit the data in Excel 2010. ...

Fig 12

• Click the File tab and then click Close.

Converting Tables to Charts (Fig.13)

• Select the table you want converted to a chart.

• Make sure the Insert tab of the ribbon is displayed.

• Click the Object tool within the Text group. ...

• From the list of Object Types, choose Microsoft Graph

Chart.

• Click on OK. ...

• Format your graph as desired.

Select the slide that you want to add a table to. On the
Insert tab, select Table. Shows the Table Option in the
Insert tab on the ribbon in Powerpoint. In the Insert Table
dialog box, do one of the following. Use the mouse to
select the number of rows and columns that you want.
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Fig 14

Slide Sorter View (Fig 14)

Slide Sorter view provides some key "file management"
options that can't perform in the other views as efficiently.

They include:

• Re-Arrange Slides

• Duplicate Slides

• Delete Slides

• Hide Slides (Hidden Slides do not show in a Slide Show
or Print)

• Copy Slides From Other Presentations

• Set Slide Show Effects

• Time Your Presentation

Slide Sorter View

Steps

To Re-Arrange the Order of the Slides

• Drag Slides to new location between slides

Fig 13

To Duplicate Slides

• Click on the slide

• Press <Ctrl+D> (shortcut key to duplicate a slide)

To Delete Slides (You can undo the deletion of a slide)

• Click on the slide

• Press the <Del> key

To Hide Slides (Same command to Un-Hide Slides)

• Click on the slide

• Click the Slide Show Tab: Hide Slide command

To Copy Slides From Another Presentation

• Open the other presentation and switch to Slide Sorter
View

• Select the Slides you want to copy (use the Shift key or
the Control key for multiple slides)

• Click Edit menu: Copy (or the Copy toolbar button)

• Switch to the original presentation and

• Click where you want to place the slide(s)

• Click Edit menu: Paste (or the Paste toolbar button)

To Set Slide Show Effects

• Select the Slide(s)

• Click the Animations Tab: Transitions To This Slide
command

• Select the transition you prefer

To Time Your Presentation

• Click the Slide Show Tab: Rehearse Timings command

• The Slide Show will begin to run

OA&FM : SSA (English) (NSQF - Revised 2022) R.T. for Ex .1.7.62 - 66

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



207

• As you practice your presentation, PowerPoint will
record how muchtime each slide was on the screen

• At end of presentation the timings can be assigned to
the slides

• You can then run the slide show automatically from
those timings

Slide Show View

Viewing A Slideshow

Instead of having OHP transparencies produced to show
the presentation directly from the computer, use the
electronic slide show. And you can show the presentation
on the computer monitor or use an LCD panel and project
the show on to an overhead screen.

Slides fill the whole screen and display exactly as formatted.
And click with the mouse or press ENTER on the keyboard
it will automatically be taken through each slide.

Incorporate a range of extra features such as transitions
(the way one slide makes way for the next) and animated
build effects (which allow objects such as text and graphics
to "fly" onto the slide in different ways). You can also
include movies and sounds in your presentation as well as
buttons which allow the user to branch from one slide to
another.

Outline View (Fig 15)

Outline View allows editing the text of the presentation in
a "textonly" environment.  Without the graphics of the
slide, it provides a more efficient method of editing the text.
The Outline View is an excellent  method to create the
presentation.

Fig 15

When choosing the slide show button at the bottom left of
your screen,your slide show is started from the slide you
have selected. However,when starting the slide show from
View Slide Show, you will always be started from the first
slide in the presentation.

To view a slide show presentation

Mouse

i Go to the view ribbon and select slide show from the
presentation views group. Or

ii Use the slide show button from the status bar view icons

Or

Keyboard

i Press the F5 key

ii Use the left mouse click or ENTER key to move through
to the end of the presentation.

iii The ESC key will end the presentation at any time.
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To insert a chart (Fig.16)

• Insert a new slide with a title and chart icon.

• When the slide appears, click the Insert Chart icon.

Fig 16
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The word Secretary is derived from Latin word
"Secretarious" which means a confidential person.  It gives
the idea of secrecy.  Therefore the title of Secretary was
used for an officer handling confidential correspondence
for kings.  The duties and functions of the secretary be-
came wider and more useful and more popular.

Qualities of a Good Secretary

1.  Good Education

A secretary has to work with the executive. Therefore he/
she must be a graduate so that he/she has better under-
standing, presence of mind, intelligence and initiative for
work.

2. General Knowledge

A secretary must be aware of the activities of his organi-
zation including the day-to-day developments related to
the business of his organization.  He must also be aware
of the political, economic and social developments in the
country and the policies followed by the Government.

3. Professional & secretarial skills

A professional course is very essential for a private secre-
tary. The professional course includes training in profes-
sional skills, that is shorthand, typewriting and computer
application. A minimum speed of 100/40 words per minute
in shorthand typewriting is essential. In addition to the
professional skills the secretary should be trained in the
art of letter writing, drafting, and display typing and han-
dling of all types of correspondence. Taking down dicta-
tion and transcribing it on the typewriter or computer is
the basic function of the personal secretary without which
he cannot get employment in any organization. His ap-
pointment is done mainly on the basis of testing his speed
in shorthand/typewriting and his knowledge in the profes-
sional skills.

4. Command over languages

Major part of a secretary's work is of correspondence,
public relations, answering and connecting telephone
calls, writing reports, preparing notice agenda, minutes of
the meetings, etc. All these functions require a thorough
knowledge and command of the language concerned. In
addition to the language in which the business of the or-
ganization is done the personal secretary should also know
the local or the regional language in which the employees
or the visitors communicate. Knowledge of the concerned
international language is considered an additional qualifi-
cation of the personal secretary.

Office Administration and Facility Management    R.Theory for Ex 1.7.67-69
Stenographer Secretarial Asst. (Eng) - MS Power point - Note taking and
transcription

Office Secretary - Definition - Qualities & Qualifications - Types of Secretary

Objectives: At the end of this lesson you shall be able to
• define a secretary
• narrate the qualities of a good secretary
• state the personal qualities of a secretary
• list the various functions of a secretary
• state the duties of a secretary in organizing meetings
• list the types of secretary and explain their functions.

5. Knowledge of the profession

The private secretary should be familiar with the profes-
sion or business of his employer or the organization. He
should know the various activities of the organization since
he is the key figure in the organization. He should be able
to help his employer or the executive in achieving the ob-
jectives of the organization.

Personal qualities of a Private Secretary

1. Courtesy

A secretary should be polite and courteous in dealing with
the members of the organization and the public. He  should
give proper respect to his superiors and the employees so
as to command respect from them. He should not make
embarrassing comments belittling anyone but rather
should use 'Please' or ‘thank you’ even to those who are
not courteous to him. He must greet visitors pleasantly
and cheerfully, offering a seat and also say 'good bye'
when they leave. He should always be cool in his temper
and control emotions under all circumstances. Minor irri-
tants should not disturb his temperament and cheer
fulness. This will keep his balance of mind and he will be
able to decide matters in a peaceful manner.

2. Alertness

The private secretary must be alert about his duties and
functions. He should give due attention to the directions
or instructions given by his employer or superiors and
should take timely action on them.
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4 Arranging appointments, engagements and recording
messages and assisting his employer in these tasks.

5 Organizing and attending meetings, preparing agenda,
reports, minutes, etc.

6 Supplying information, controlling papers and filing
work, office stationery and materials.

7 Security of office equipments and supervision of junior
secretarial and other staff.

8 Making travel arrangements, tour programmes.

9 Organizing conferences, meetings and social activities
of the organization.

10 Handling cash, bank transactions of his employer.

Duties of a Secretary for organizing meetings

The duties of a secretary in relation to meetings are mani-
fold. He has to prepare the agenda for the meeting in con-
sultation with the chairman and members. He has to per-
form many duties during the meeting. He has to act as a
gracious host, an efficient receptionist and secretary. Af-
ter the meeting, he has to express thanks to the mem-
bers, prepare the minutes of the meeting and send them
in the form of draft for the approval of the chairman.

These can be broadly divided into three stages

(A) Duties before the organizing meeting

1 The secretary or P.S. has to plan for a meeting in con-
sultation with the chairman of the organization. He has
to fix the time, date and suitable place for the meeting.
It may be according to the number of members. It can
be organized in a hotel, a public hall, etc.

2 An agenda is to be finalized in consultation with the
chairman and officers of the organization about the
items to be discussed in the meeting along with a de-
tailed agenda for the chairman.

3 All the files, reports, etc., must be kept ready for ready
reference. Sometimes copies of reports, annual ac-
counts, etc., are circulated to the members for their
approval, etc. These have to be circulated to the mem-
bers along with the notice of the meeting. The P.S
should send the minutes of the last meeting for confir-
mation and information of members.

4 He has to arrange refreshments for the members and
special invitees like auditors, press, experts, etc. He
has also to keep proper stationery items, that is, writ-
ing paper, pen, pencils and books.

3. Loyalty & punctuality

Loyalty is the prime quality of a secretary. He should be
punctual in his office work and faithful to his employer and
the organization. He should be prepared to work at all
times to fulfill the tasks assigned to him. He should be
dedicated to his job and do the work honestly and sin-
cerely. He must be a person of confidence and reliability
so that the executive could depend on him in handling
confidential matters delegated to him. He should be able
to maintain complete secrecy about his work in the orga-
nization and outside.

4 Tactfulness

A tactful secretary can deal with difficult matters in a simple
way by his proper judgment. He must have the capacity
to handle difficult situations in the right way. By giving
serious thought to the problem he should arrive at an ami-
cable solution between the parties. He should handle the
disputes in such a way that neither party is offended. That
is why 'Tactfulness' is called the fine art of avoiding of-
fence.

5 Personal Relationship

A private secretary should develop good human relation-
ship in the office and outside. He should be able to adopt
himself to the nature and temperament of his employer or
the various employees in the organization. He must ad-
just himself under all circumstances according to the na-
ture of his superiors. By maintaining his or her own dig-
nity by good personal relationship, he can get more work
done from the employees.

6 Discipline

The secretary should be a disciplined person. He should
attend office in time and leave office after doing all impor-
tant work. He should also be able to enforce discipline in
the office. He should be a methodical worker and keep his
own desk and that of his executive neat and well arranged.
Properly arranged table is an indicator of his discipline.

7 Personality

The secretary should have a pleasing personality. His or
her appearance is a great asset to the office. A secretary
should be well dressed, neat and clean. A good posture,
personality and poise are the three points of attraction in
a private secretary. Good posture creates a good impres-
sion. Personality differs from individual to individual. It is
linked to what you are, what you do and how you do it. It
creates an impact on other people and makes you differ-
ent from other people. Personality is the way you dress,
walk and talk with others.

Poise is the element of intelligence and confidence in an
individual. It comes from knowing one's own abilities and
limitations

Functions of Secretary

1 Handling of telephone calls, receiving and entertaining
visitors.

2 Taking dictation, typing it and doing all types of corre-
spondence, preparing reports.

3 Handling incoming and outgoing internal and external
mail.

(B) Duties during the meeting

The secretary has to ensure proper seating arrangement
for the participants. He has to keep an attendance regis-
ter at a suitable place for the signatures of the members.
He has to read out the apologies for absence and mes-
sages received from the members. He has to ensure the
quorum for the meeting. He has to read out the minutes of
the last meeting on the direction of the Chairman. If there
is any objection to it he has to rectify before the minutes
are confirmed and signed by the Chairman. He has to
distribute all the relevant papers, reports, to the mem-
bers. He has to take notes of the proceedings of the meet-
ing. He has to write the names of the persons who have
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brought in resolutions. He has to ensure proper refresh-
ment for the members at the meeting. He has to assist
the Chairman in the conduct of the meeting.

(C)  Duties after the meeting

After the meeting is over, the secretary has to prepare the
draft of the minutes of the meeting for the approval of the
Chairman. He has to make all arrangements for circulat-
ing the minutes. He has to ensure that decisions taken at
the meeting are implemented by the concerned depart-
ments or officers. He has also to fix the next date for the
meeting. He has to ensure safety of all the records kept
for ready reference. He has to collect the reference books,
papers, documents from the members after the meeting
is over.

Types of Secretaries

The word ‘secretary’ has a different meaning in a Govern-
ment Department or an institution or a company or a busi-
ness organisation having different types of functions. There-
fore, it is necessary to understand the difference between
different types of Secretaries so that the clear meaning of
the Secretary and its importance is understood in relation
to this course of office Secretaryship or Secretarial Prac-
tice.  In this course  of study, a special type of Secretary
called the “Private Secretary”, his importance and his func-
tions have been discussed.  Before discussing the duties
and functions of the Private Secretary, the importance and
functions of the following Secretaries should be understood.

1 Secretary of a Government Department

The Secretary of a Government Department/Ministry is its
executive head who works under a Minister and is also his
adviser.  Various other Secretaries, e.g., Special Secre-
tary, Additional Secretary, Joint Secretary, Director, Deputy
Secretary, Under Secretary, Section Officer are appointed
to assist him in his work.  The Cabinet Secretary is head
of all Secretaries.

Secretary General

The Chief Executive of the Lok Sabha or the Rajya Sabha
is called the Secretary General. The Secretary General is
responsible for the conduct of business in the concerned
House and the various Parliamentary Committees attached
to the House.  The Secretary General holds the rank of a
Cabinet Secretary of the Govt. of India. State Legislatures
also have Secretaries attached to them for their conduct
of business.

Secretary of a Club or Association

Every Club or Association elects a Secretary for carrying
out the day-to-day activities of the Club or Association.
This type of Secretary is elected and not appointed like
his counterparts.

Secretary of an Embassy

Every country is represented by an Ambassador or a  High
Commissioner through its Embassy or High Commission
in that country.  A Secretary is appointed to assist the
Ambassador or the High Commissioner.

Secretary of a local body

Local bodies like Municipal Corporations, Municipalities,

Metropolitan Councils or District Councils have a Secre-
tary responsible for its functioning and day-to-day activi-
ties.

Secretary of Co-operative Society or Union

A co-operative society or a Union has an elected Secre-
tary to perform its various functions.  The Secretary is
responsible for calling the meetings of the Board of Trust-
ees, writing of reports, enforcing labour laws and welfare
activities relating to the organisation.

Company Secretary

The company Secretary is an important person quite dif-
ferent from the Secretary of a Govt. Department or the
Secretary of a Union or Association.  He works as a pivot
between share-holders and the management.  He acts as
the representative of the management, its adviser, admin-
istrative officer and the public relations officer.  He is ap-
pointed under the Company Law and is responsible for
conducting all statutory functions on behalf of the
organisations. The Company Secretary has to perform
the following specific functions

(a) Statutory functions

(b) Liabilities towards management

(c) Liabilities towards share holders

(d) Liabilities towards debenture holders

(e) Liabilities towards public

(f) Liabilities towards the organisation

e.g. Contractual Liabilities, etc.,  and

(g) any other work entrusted by the Company

For efficient discharge of his duties, the qualifications of
the Company Secretary are laid down according to which
only, his appointment can be made.  He can be removed
from service only under the rules laid down in the Compa-
nies Act.

Private Secretary

Every type of Secretary has a place and importance ac-
cording to his responsibilities in the organisation con-
cerned. For assisting these types of Secretaries, a spe-
cial post of 'Private Secretary' also exists.  He is appointed
by the Secretary or Chief Executive to assist him in his
various routine types of work. The Private Secretary is a
person with multi-farious functions. He takes care of his
mail, prepares drafts for him, answers phone calls, keeps
the records and arranges tour programmes, meetings and
makes travel arrangements.

The Private Secretary works under the Chief Executive
and is a trusted person. That is why he is also called the
Confidential Assistant. Officers generally delegate their
routine work to the Private Secretary so that they are able
to attend to the more important work of the organisation.
Therefore, it is the duty of the Private Secretary to work
according to the guidance of his Officer and maintain his
confidentiality. The Private Secretary extends his ears,
memory and hands to his officer. The success of the ex-
ecutive depends on the competence of his Private Secre-
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tary. There is always an able Secretary behind the execu-
tive. Much of the work is done by him but the credit goes
to the executive. Today the Private Secretary is an indis-
pensable person and is receiving great public recognition
adding more and more to his functions in the organisation.

The Private Secretary has to work according to the direc-
tions of his officer under all circumstances. He has to
accompany his boss on tour. His main work is to handle
correspondence for which he must know the twin arts of
Shorthand & Typewriting. The position of the Private Sec-
retary is not only of a Stenographer or an Assistant, he is
the right hand of his officer. His relationship with his officer
is not of a master and servant, but of a close associate.
He knows all the secrets of his officer.  Therefore, he must
win the confidence of his officer that he is a man of trust
who can act on his behalf, to whom he can delegate his
routine duties and who can tactfully deal with persons
coming into contact with him.

Duties of the Private Secretary

Various types of functions have to be performed by a Pri-
vate Secretary in different organisations. Details of these
have been given in the 17 chapters of this book, by the
study of which he can function as a successful Private
Secretary. In this chapter, the general functions and the
duties of the Private Secretary are given

1 Secretarial functions

1 Taking down dictations and transcribing them on type-
writer or computer:

2 Exchange and communication of letters, messages
and orders:

3 typing letters, stenciling; duplicating, etc.

4 opening, sorting and distribution of mail;

5 keeping confidential letters in files and in proper cus-
tody;

6 keeping records of incoming (inward) and outward (out-
going) mail;

7 handling office equipments, their maintenance;

8 receiving telephone calls and communicating messages
to the concerned persons;

9 connecting telephone calls of the office with the calling
or required persons;

10 receiving visitors and arranging their meeting with the
concerned officers;

11 exchanging necessary information with the visitors;

12 making travel arrangements of the officer;

13 Preparing TA Bills, handling banks, insurance;

14 sending the messages, obituaries, etc.,

2 Specialised Functions

1 issuing notices, making arrangements for holding meet-
ings, workshops, training programmes and interviews
etc.;

2 Preparing agenda for the meetings, topics for discus-
sion, writing minutes of the meeting and communicat-
ing decisions taken at the meeting.

For performing these highly specialized functions the Pri-

vate Secretary must have some essential qualifications.
e.g.

1 educational background;

2 good general knowledge;

3 a study of Secretarial Practice, e.g., full knowledge of
Shorthand & Typewriting with experience of practical
skills;

4 good command over the language concerned;

5 knowledge of the profession of the employer or busi-
ness organisation.

A less important work is done by the Confidential/Per-
sonal Assistant who can be promoted to the post of Pri-
vate Secretary on attaining the required expertise in the
field.

All the functions which a Private Secretary has
to perform have been discussed in the following
chapters. After studying these chapters, a Private
Secretary can perform his functions with full con-
fidence and efficiency. In addition to the knowl-
edge of these functions, a Private Secretary must
cultivate personal qualities to function effectively
in an organisation. These have been given in
the last chapter of this book.

Professional, personal duties and functions of office
secretatry

A Secretary may be known as the 'face of the organiza-
tion'. Secretaries perform a variety of tasks throughout the
day. Some of these tasks may include scheduling meet-
ings or appointments, maintaining files, taking minutes of
meeting, sending e-mails, answering phones and making
travel arrangements for guests. An Office Secretary main-
tains the smooth running of an office through a variety of
administrative and clerical duties. He handles office sched-
ules, coordinates meetings and visits, organizes files an-
swers phones and performs a huge array of other essen-
tial tasks.

Personal duties and functions
• Answering calls, receiving messages and handling

correspondence.
• Maintaining diaries and arranging appointments.
• Typing, preparing and collating reports.
• Preparing agendas and taking minutes of meetings.
• Maintaining calender and planning meetings.
• Maintaining data bases and filing systems.
• Organisational abilities.
• Clear, friendly and professional communication skills.
• I.T. literacy
• Efficient time-management skills.

Skills required

• Good organisational skills.
• Good time management.
• Good communication skills, written and verbal.
• Knowledge of general office procedures.
• Familiarity with IT and computer packages.
• Ability to stay calm and tactful under pressure.
• Ability to operate office equipment (fax, copier, mail,

etc.)
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Here's how you can add animation effects to text, shapes,
and images.Animation effects can be applied to text,
shapes and objects on any slide in PowerPoint . When
you explore the number of animation effects, you will no-
tice that they are grouped into four types. Let's see what
they are and how to use them.

• Entrance - This group of effects serves to introduce

text or objects into a slide during a presentation.

• Exit - This group helps to mark the end of the text or

object's time on the slide.

• Emphasis - This group provides you the option to draw

attention to text or objects. It can be used to highlight
important details.

• Motion Paths - This group allows you to move text

and objects along a predetermined path. These can
be used as transitions of sorts on a slide.

With the exception of Motion Paths, most of the anima-
tion types contain subgroups of effects. They include Ba-
sic, Subtle, Moderate and Exciting effects. (Fig.2)

Fig 1

What is animation?

Animation is something that makes slide objects move
on a slide and slide objects can be anything on a slide;
these inclue text, pictures, charts, smart Art graphics,
shapes, even movie clips.

Animate text or objects

You can animate the text, pictures, shapes, tables, smart
art graphics, and other objects in your Power point pre-
sentation.

MS Power Point - Building animation effects, transitions, speaker notes,
copying presentation to a CD/DVD/Pen drive - Editing and Printing

Objectives: At the end of this lesson you shall be able to
• explain animation effect to the presentation
• narrate transition effect and its limitations
• explain the importance of speaker notes, its use
• understand how to copy a presentation to CD/DVD/Pen Drive
• explain how to editi and rearrange the slide before presentation.

Effects can make an object appear, disappear, or move.
They can change an object's size or colour.

Apply an animation

- Select the object or text on the slide that you want to
animate (Fig.1)

- On the Animation tab of the ribbon, click Add Ani-
mation and pick an animation effect.

Fig 2
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Fig 3

- To exit select an effect as shown in (Fig.3)

How to add an animation effect to text or objects

1 Select the text or object you need to animate

2 Click on the Animations tab in the navigation ribbon.

3 Click Add Animation.

4 Select an animation effect from the list.

You can apply more than one effect to the same object.
This can only be done by clicking on Add Animation. If
you try to add another animation by any other means, you
will only replace the previous effect.

The default naming convention for animation effects could
be somewhat confusing to look at. The ability to rename
animations to clarify target objects is available in the Se-
lection pane from the Home tab. Double-click on a name
to be able to edit it.

How to change the order of the animation effects

1 Click the Animations tab in the navigation ribbon.

2 Select the Animation pane from the Advanced Anima-
tion group.

3 Select the Animation you wish to move in the Anima-
tion pane.

4 Select either the up and down arrow, next to the Play
From button, to move the animation earlier or later in
the sequence.

How to set the start time and duration of an effect

1 Navigate to the Animation pane.

2 Select an animation effect from the list.

3 Click the Down Arrow to the right of the effect listing.

4 Select Timing from the drop-down list.

5 Select Start from the Timing tab to select an option.

6 Choose a value under the Delay option.

7 Choose the length of the animation effect under the
Duration section.

By adjusting the duration, you are altering the speed of
the animation, which can potentially alter the impact the
effect has on the audience.

How to activate an animation effect by clicking on it

1 Click on the object or text in question.

2 Click on the Animations tab.

3 Add the animation as described.

4 Locate the Advanced Animation group.

5 Select Animation pane.

6 Select the object or text to be triggered with a click.

7 Select Trigger from the Advanced Animation group.

8 Select On Click from the drop-down.

9 Select the object to confirm.

How to begin an animation during audio and video
content

1 Select the audio or video clip on a slide.

2 Click Play from the media controls.

3 Click Pause where you want to add a bookmark.

4 Locate the Playback tab in the Video Tools section.

5 Select Add Bookmark from the Bookmark group.

6 Select the Animation tab.

7 Select Advanced Animation.

8 Select Animation pane.

9 Select an animation effect.

10 Select Trigger under Advanced Animation.

11 Select On Bookmark from the drop-down list.

12 Choose the bookmark you have set.

How to Repeat and Rewind an animation effect

1 Select the Animations tab.

2 Select the Show Additional Effect Options icon.

3 Select the Timing tab.

4 Select an option from the Repeat drop-down.

5 Click the Rewind when done playing checkbox.

How to use motion path animation effects in
PowerPoint

How to add a motion path to text or objects

1 Select the Animations tab.

2 Click Add Animation under the Advanced Anima-
tion group.

3 Navigate to the Motion Path group of effects.

4 Select a path.

If you were to select the Custom Path option, you will be
required to draw out the path to be taken. Click and drag
to create a visible, freehand path or just point and click to
create lines with connection points. Double-click the left
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Fig 4

Fig 5

mouse button to mark the end of the path and see a pre-
view of the movement.

How to modify a motion path

1 Select Effect Options in the Animation group.

2 Select from the presented motion alternatives to
change the path.

3 Navigate to the Path group in the drop-down.

4 Click on Edit Points.

5 Click on any points on the path and drag to a new
location.

6 Click Preview to see the revised animation in action.

Animate text or objects

You can animate the text, pictures, shapes, tables, Smart
Art graphics, and other objects in your PowerPoint pre-
sentation.

Effects can make an object appear, disappear, or move.
They can change an object's size or colour

Apply an animation

Select the object or text on the slide that you want to
animate (Fig.4)

On the Animation tab of the ribbon, click Add Animation,
and pick an animation effect. (Fig.5)
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Animation time settings

The speed of the effect is determined by the Duration set-
ting

On the slide, select the animation effect that you want to
change

On the Animation tab, under Timing options, in the Du-
ration box, enter the number of seconds that you want
the animation effect to last. (Fig.6)

(Maximum 59 seconds. Minimum .01 seconds. You can
type a duration or use the up or down arrows to select a
standard incremental value

Fig 6

In the Animation tab, under Timing options, open the start
list, and choose one of the three options described below
(Fig.7)

Fig 7

Select To start the animation effect

On click When you click the slide

With previous At the same time as the previ
ous animation effect in the list

After previous Immediately after the previous
animation effect in the list
finishes plying

Set the time between animation effects

The Delay option determines how much time elapses be-

Fig 8

fore a specific animation effect begins - either after you
click or after a prior animation effect concludes.

On the slide, select the animation effect that you want to
change.

On the Animation tab, under Timing options, in the De-
lay box, specify an amount of time in seconds. (Fig.8)

To reorder a set of animations on a slide

Open the Animation pane: On the animations tab, in the
Advanced animation group,

select Animation Pane.  In the Animation pane, select the
animation effect you want to reorder. (Fig.9)

Fig 9
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Fig 11

Fig 12

Fig 13

1 Select move Earlier to move the effect up one place in
the animation order

2 Select Move Later to move the effect down one place
in the animation order

You can select an option multiple times, if necessary, to
move your selected effect to the appropriate place in the
animation order.

Remove animation effect

When you animate an object, a small numerical marker
appears just to the left of that object to indicate the pres-
ence of an animation effect and its place in the sequence
of animations on the current slide. (present case slide 1
star) (Fig.10)

Fig 10

Select the numeral of the animation that you want to re-
move

Press Delete key on your keyboard.

Transition

Introduction

Transition effects-or transitions as they are often called-
are the movements you see when one slide changes to
another in Slide Show view. Transition effects are different
from animation effects. The term animation in PowerPoint
refers to the movements of text and objects on the slide,
while transitions refer to the movement of the slide as it
changes to another slide. (Fig.11)

Applying transitions

To apply a transition to one slide:

• Select the slide you want to modify.

• Select the Animations tab.

• Locate the Transition to This Slide group. By de-

fault, No Transition is applied to each slide. (Fig.12)

Click the More drop-down arrow to display all available
transition effects. (Fig.13)

Click a slide transition effect to apply it to the selected
slide.

Hover over a slide transition effect to see a live preview of
the effect on the slide.

• To apply a slide transition to all slides:

• Select the slide you want to modify.

• Select the Animations tab.

• Locate the Transition to This Slide group. By default,

No Transition is applied to each slide.

• Click the More drop-down arrow to display all transi-

tion effects.

• Click a slide transition effect to apply it to the se-

lected slide.

• Click Apply To All to apply the transition to all slides

in the presentation. (Fig.14)

Fig 14
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Fig 16

Fig 17

By default, in Slide Show view, you click your mouse to
advance--or move--to the next slide. This setting is de-
fined in the Transition to This Slide group on the Anima-
tions tab. You can modify this setting so that each slide
displays for a specific period of time before automatically
advancing to the next slide. This is useful for unattended
presentations, such as at a trade show booth. (Fig.17)

Fig 15

Select another slide and repeat the process until all de-
sired slides have the timing set.

If you want to apply the same transition effect and timing
for each slide, set the transition effect timing for one slide
and click Apply to All.

Here's how you can add animation effects to text, shapes
and images. Animation effects can be applied to text,
shapes and objects on any slide in PowerPoint . When
you explore the number of animation effects, you will no-
tice that they are grouped into four types. Let's see what
they are and how to use them.

• Entrance - This group of effects serves to introduce

text or objects into a slide during a presentation.

• Exit - This group helps to mark the end of the text or

object's time on the slide.

You can set the transition speed when you apply the tran-
sition effect, or you can return to the Animations tab and
apply it later. If you want to apply the transition effect and
transition speed to all slides, click Apply to All.

To set slide transition sound

• Apply a slide transition effect to a slide.

• Click the Transition Sound drop-down menu in the

Transition to This Slide group on the Animations tab.

• Select a sound to apply it to the selected slide.

Click Apply To All if you want to apply the transition ef-
fect and transition sound to all slides.

To remove a slide transition effect:

• Select the slide you want to modify.

• Select the Animations tab.

• Click No Transition in the Transition to This Slide group.

(Fig.16)

You can also advance to the next slide by pressing the
Enter key.

To set timing for slides:

• View the slides in Slide Sorter view.

• Select a slide.

• Select the Animations tab.

• Locate the Advance Slide section of the Transition to

This Slide group.

• Enter the time in the Automatically After field. Use the

arrows or type the number. (Fig.18)

Modifying transitions

To set slide transition speed:

• Apply a slide transition effect to a slide.

• Click the Transition Speed drop-down menu in the Tran-

sition to This Slide group on the Animations tab.

• Select a menu option to apply the transition speed to

the selected slide. (Fig.15)

Repeat this process for each slide you want to modify.

OR

Click Apply To All to remove the slide transition effect
from each slide in the presentation.

Advancing slides

Advancing to the next slide
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• Emphasis - This group provides you the option to draw

attention to text or objects. It can be used to highlight
important details.

• Motion Paths - This group allows you to move text

and objects along a predetermined path. These can
be used as transitions of sorts on a slide.

With the exception of Motion Paths, most of the anima-
tion types contain subgroups of effects. They include Ba-
sic, Subtle, Moderate and Exciting effects. (Fig.19)

- To exit select an effect as shown in (Fig.20)

3 Click the Down Arrow to the right of the effect listing.

4 Select Timing from the drop-down list.

5 Select Start from the Timing tab to select an option.

6 Choose a value under the Delay option.

7 Choose the length of the animation effect under the
Duration section.

By adjusting the duration, you are altering the speed of
the animation, which can potentially alter the impact the
effect has on the audience.

How to activate an animation effect by clicking on it?

1 Click on the object or text in question.

2 Click on the Animations tab.

3 Add the animation as described in How to animate text
or objects in PowerPoint 2016.

4 Locate the Advanced Animation group.

5 Select Animation pane.

6 Select the object or text to be triggered with a click.

7 Select Trigger from the Advanced Animation group.

8 Select On Click from the drop-down.

9 Select the object to confirm.

How to begin an animation during audio and video con-
tent?

1 Select the audio or video clip on a slide.

2 Click Play from the media controls.

3 Click Pause where you want to add a bookmark.

4 Locate the Playback tab in the Video Tools section.

5 Select Add Bookmark from the Bookmark group.

6 Select the Animation tab.

7 Select Advanced Animation.

8 Select Animation pane.

9 Select an animation effect.

10 Select Trigger under Advanced Animation.

11 Select On Bookmark from the drop-down list.

12 Choose the bookmark you have set.

How to Repeat and Rewind an animation effect?

1 Select the Animations tab.

2 Select the Show Additional Effect Options icon.

3 Select the Timing tab.

4 Select an option from the Repeat drop-down.

5 Click the Rewind when done playing checkbox.

How to use motion path animation effects in PowerPoint

How to add a motion path to text or objects

1 Select the Animations tab.

Fig 19

Fig 20

How to add an animation effect to text or objects

5 Select the text or object you need to animate.

6 Click on the Animations tab in the navigation ribbon.

7 Click Add Animation.

8 Select an animation effect from the list.

You can apply more than one effect to the same object.
This can only be done by clicking on Add Animation. If
you try to add another animation by any other means, you
will only replace the previous effect.

The default naming convention for animation effects could
be somewhat confusing to look at. The ability to rename
animations to clarify target objects is available in the Se-
lection pane from the Home tab. Double-click on a name
to be able to edit it.

How to change the order of the animation effects

1 Click the Animations tab in the navigation ribbon.

2 Select the Animation pane from the Advanced Anima-
tion group.

3 Select the Animation you wish to move in the Anima-
tion pane.

4 Select either the up and down arrow, next to the Play
From button, to move the animation earlier or later in
the sequence.

How to set the start time and duration of an effect

1 Navigate to the Animation pane.

2 Select an animation effect from the list.
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Entering speaker notes for each slide is easy, just need
to locate the bottom area of the slide and start entering
text there.

How to view Speaker Notes in PowerPoint

In order to view your speaker notes or notes pages in a
better view or prepare it for printing, you can change the
view in your PowerPoint presentation.

1. Open your PowerPoint file or start a new presentation

2. Click on View tab and then choose Notes Page

You can click on the notes area and start typing or changing
your existing notes. (Fig.22)

Copying a presentation on a CD/DVD/Pen drive

1 Open the presentation in PowerPoint and then choose
File-Publish-Package For CD.

2 The Package For CD dialog box appears. (Fig.23)

3 Click Options.

4 The Options dialog box opens. (Fig.24)

Change options settings

1 The options that are available are:

• Make a Self-Running Package: Creates a CD that

automatically plays the presentation when the CD is
inserted into a computer.

Fig 21

2 Click Add Animation under the Advanced Animation
group.

3 Navigate to the Motion Path group of effects.

4 Select a path.

If you were to select the Custom Path option, you will be
required to draw out the path to be taken. Click and drag
to create a visible, freehand path or just point and click to
create lines with connection points. Double-click the left
mouse button to mark the end of the path and see a pre-
view of the movement.

How to modify a motion path?

1 Select Effect Options in the Animation group.

2 Select from the presented motion alternatives to change
the path.

3 Navigate to the Path group in the drop-down.

4 Click on Edit Points.

5 Click on any points on the path and drag to a new
location.

6 Click Preview to see the revised animation in action.

Speaker Notes in PowerPoint  presentation

Speaker notes is a concept used in presentations and
Microsoft PowerPoint has a special section in the slide
that you can use for speaker notes.

The speaker notes or notes pages are a reserved space
for each slide in your presentation that is intended to be
used by the presenter for many different purposes.

The presenter can add some key points that he wants to
cover during a Power Point presentation or meeting, and
does not want to miss. The following figure shows a sample
PowerPoint presentation with speaker notes in the slide.
(Fig.21)
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Fig 22

Fig 23

Fig 24

• Make a Package by Using Original File Formats:

Instructs the Package to CD Wizard to copy the pre-
sentation files to CD.

• Linked Files: Select this option to include any linked

video or audio files.

• Embedded TrueType Fonts: Ensures that the fonts

you use in your presentation are on another computer.

• *Password to Open Each File: Require a password

if the presentation contains top-secret information.

• Password to Modify Each File: Require a password

to prevent unauthorized people from changing the pre-
sentation.

• Inspect Presentations for Inappropriate or Private

Information: Checks for any personal information that
might be embedded in your presentation.

2 Click OK to return to the Package to CD dialog box.

3 If you want to add other presentations to the CD, click
Add Files, select the files that you want to add, and
then click Add.

4 Click Copy to CD.

Insert a blank CD into the drive when prompted.

5 Remove the CD and then click Yes to make another
copy. Otherwise, click No and then click Close.

The presentation starts running when you insert the CD
into a computer. If it doesn't, open My Computer, open the
CD drive, and double-click the pptview.exe link. A list of
presentations on the CD appears. Double-click the one
that you want to run.
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Fig 25

In windows 2010 the following dialogue box
will appear when you click file option and fol-
low the steps therein.

1 Click Options. ...

2 Change options settings. ...

3 Click OK to return to the Package to CD dialog box.

4 If you want to add other presentations to the CD, click
Add Files, select the files that you want to add, and
then click Add. (Fig.25)

5 Click Copy to CD.

Edit or print PowerPoint handouts in Word

You can print handouts from PowerPoint, but if you want
to use the editing and formatting features of Word, you
can work on and print your handouts using Word.

In the open presentation, do the following:

1 Click the Microsoft Office Button , point to Pub-

lish, and then click Create Handouts in Microsoft Of-
fice Word. (Fig.26)

Copy a presentation to a USB flash drive

Open the presentation that you want to copy, or, if you
are working with a new presentation that has not been
saved, save the presentation. Insert a USB flash drive into
a USB port of the computer. Click Save & Send.

Fig 26

In the Send to Microsoft Office Word dialog box, click
the page layout that you want, and then do one of the
following:

To paste content that you want to remain static, or un-
changed, when the content in the original PowerPoint 2007
presentation is updated, click Paste, and then click OK.

To ensure that any updates that occur to the original
PowerPoint 2007 presentation are reflected in the Office
Word 2007 document, click Paste link, and then click
OK.

Material Management - Introduction

Objectives: At the end of this  lesson  you shall be able to
• define Material management
• explain the importance of Material Management
• explain objectives of Material management.

Definition of Materials Management: Materials Man-
agement is the planning, directing, controlling and coordi-
nating those activities which are concerned with materi-
als and inventory requirements, from the point of their in-
ception to their introduction into the manufacturing pro-
cess.

It begins with the determination of materials quality and
quantity and ends with its issuance to production to meet
customer's demand as per schedule and at the lowest
cost.

• Materials Management is a basic function of the busi-

ness that adds value directly to the product itself
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• Materials Management embraces all activities con-

cerned with materials except those directly concerned
with designing or manufacturing the product.

• Materials Management deals with controlling and regu-

lating the flow of material in relation to changes in vari-
ables like demand, prices, availability, quality, delivery
schedules etc.

Thus, material management is an important function of an
organisation covering various aspects of input process,
i.e., it deals with raw materials, procurement of machines
and other equipment's necessary for the production pro-
cess and spare parts for the maintenance of the plant.
Thus in a production process materials management can
be considered as a preliminary to transformation process.

It involves planning and programming for the procurement
of material and capital goods of desired quality and speci-
fication at reasonable price and at the required time.

It is also concerned with market exploration for the items
to be purchased to have up to date information, stores and
stock control, inspection of the material received in the
enterprise, transportation and material handling operations
related to materials and many other functions. In the words
of Bethel, "Its responsibility end when the correct finished
product in proper condition and quantity passes to the
consumer."

Objectives of Materials Management

i Material Selection

Correct specification of material and components is deter-
mined. Also the material requirements in agreement with
sales programme are assessed. This can be done by
analysing the requisition order of the buying department.
With this standardisation one may have lower cost and
the task of procurement, replacement etc. may be easier.

ii Low operating costs

• It should endeavour to keep the operating costs low

and increase the profits without making any conces-
sions in quality.

• Receiving and controlling material safely and in good

condition.

• Issue material upon receipt of appropriate authority.

• Identification of surplus stocks and taking appropriate

measures to produce it.

The outcome of all these objectives can be listed as given
below

• Regular uninterrupted supply of raw-materials to en-

sure continuity of production.

• (ii) By providing economy in purchasing and minimising

waste it leads to higher productivity.

• (iii) To minimise storage and stock control costs.

• By minimising cost of production to increase profits.

There can be more sub-sections of the department but in
general, materials manager controls the four major sec-
tions and is responsible for reporting to the president of
the organisation.

Objectives of Materials Management

The objectives of material management can be classified
into two categories viz; primary objectives and secondary
objectives.

Primary Objectives

The following are the primary objectives:

1. Low Prices: If materials department succeeds in re-
ducing the price of items it buys, it contributes in not only
reducing the operating cost but also in enhancing the prof-
its.

2. Lower Inventories: By keeping inventories low in rela-
tion to sales, it ensures that less capital is tied up in
inventories. This increases the efficiency with which the
capital of the company is utilized resulting in higher return
on investment. Storage and carrying costs are also lower.

3. Reduction in Real Cost: Efficient and economical han-
dling of materials and storage lowers the acquisition and
possession cost resulting in the reduction in the real cost.

4. Regular Supply: Continuity of supply of materials is
essential for eliminating the disruption in the production
process. In the absence of regular supply of materials,
production costs go up.

5. Procurement of Quality Materials: Materials depart-
ment is responsible for ensuring quality of materials from
outside suppliers. Therefore, quality becomes the single
most objective in procurement of materials.

6. Efficient handling of Materials: The effective mate-
rial control techniques help the efficient handling of mate-
rials resulting in the lowering of production cost.

7. Enhancement of firm's goodwill: Good relations with
the suppliers of materials enhance the company's stand-
ing in the society as well as in the business community.

8. Locating and developing future Executives: Mate-
rials manager must devote special effort to locate men at
lower position who can take up the executive posts in

• To purchase items of best quality at the most com-

petitive price.

Organization of Materials Management Department:

To facilitate planning, direction, control and co-ordination
of various activities related to material in an enterprise
there should be a separate department of materials man-
agement. The organisational structure of the department
can be.
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future. It helps in developing talented personnel who are
ready to undertake future responsibilities of the business
relating to materials management.

Secondary Objectives

The following are the important secondary objectives of
materials management.

1. Reciprocity: The purchase of raw materials from the
organisations/customer's by the concern and in turn, sale
of finished products to the above customers is known as
reciprocity. It serves the twin purpose of increasing pur-
chasing as well as sales.

2. New Developments: The staff of the materials depart-
ment deals regularly with the suppliers responsible for new
developments in material handling. These developments
can be successfully applied in material handling and man-
agement.

3. Make or Buy Decisions: The material manager with
regular reviews of cost and availability of materials can
safely conclude that whether the material is to be pur-
chased or developed in the organisation itself.

4. Standardisation: Standardisation of materials is greatly
helpful in controlling the material management process.
With regular stock-taking, the non-standardised items can
be rejected and standard components may be brought
into product designs to reduce the cost of production. It is
further helpful in promoting the standardisation with sup-
pliers.

5. Assistance to Production department: By supplying
the standardised materials or components to the produc-

tion department, quality products can be assured. It is
helpful in imparting the economic knowledge in bringing
about the desired improvement in the product.

6. Co-operation with other departments: Successful
management of materials department contributes to the
success of every other department in the organisation. At
the same time the success of materials department de-
pends on how successful it is in getting the co-operation
of the staff of the other departments.

7. Conception of future outlook: The materials man-
ager must have some conception of future outlook for
prices, cost and general business activity. Forecasting
can be made about the future trends in materials. The
materials manager should be able to foresee the prices
and costs of the raw materials and general business con-
ditions through their daily contracts with the suppliers.

From the above it is clear that materials management
serves two fold objectives viz., to strive for a reduction in
cost of production and distribution and to help the enter-
prise in attaining its objectives.

These dual objectives of the materials management fur-
ther aim at maintaining the regular flow of production by
purchasing materials of right quality, in a right quantity at
a right time from a right source, on right terms and condi-
tions and at lower price.

It is helpful in efficiently controlling the inventories. It is
further beneficial in developing good buyer seller relations.
Coordination with other departments is established and
considerably helps the organisation to grow and advance
in technical field.

Professional  duties and functions of Office
Secretary

A Secretary is known as the 'face of the organization'.
Secretaries perform a variety of tasks throughout the day.
Some of these tasks may include scheduling meetings or
appointments, maintaining files, taking minutes of meet-
ing, sending e-mails, answering phone calls and making
travel arrangements for guests.  An office Secretary main-
tains the smooth running off an office through a variety of
administrative and clerical duties.  He handles office sched-
ules, co-ordinates meetings and visits, organizes files,
answers phones and performs a huge array of other es-
sential tasks.

Personal duties and functions of Office Secretary

• Answering calls, receiving messages and handling
correspondence

• Maintaining diaries and arranging appointments

• Typing, preparing and collating reports

Professional & personal duties and functions of Office Secretary

Objectives: At the end of this lesson you shall be able to
• state  the various duties and functions of an Office Secretary
• state the skills required for an Office Secretary.

• Preparing agenda and taking minutes of meetings

• Maintaining calendar and planning meetings

• Maintaining data bases and filing systems

• Organisational abilities

• Clear, friendly and professional communication skills

• I.T. literacy

• Efficient time-management skills

• Skills required:

• Good organisational skills

• Good time management

• Good communication skills, written and verbal

• Knowledge of general office procedures

• Familiarity with IT and computer packages

• Ability to stay calm and tactful under pressure

• Ability to operate office equipment (FAX, copier, mail-
ing equipment, etc.)
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What is the internet?

The internet is a worldwide network of computer networks.
The networks spread over different locations are connected
together so that you can send and receive data from a
computer on one network to a computer on the other net-
work. Similarly, when several networks are connected to-
gether, a network of networks is formed. The Internet con-
nects millions of computers all over the world, forming a
network in which computers across different locations can
communicate with each other.

The Internet represents the transformation and evolution
of the information age. The flexibility, ease and speed with
which people can communicate by using the Internet, as
compared to the other means of communication, have
made it very popular.

History of the Internet in India

In India, Videsh Sanchar Nigam Limited (VSNL) started
providing Internet services from August 1995. Internet ser-
vices were initially offered from Mumbai, New Delhi, Kolkatta
and Chennai. The services were excellent and the demand
increased. By 1998 the services were expanded to cover
a Network of 42 nodes operated by the Department of Tele-
communication (DOT) and VSNL. Other companies such
as Sify, BSNL, Dishnet, Airtel, Hathway, Jio, Tata Com-
munications, Asianet Broadband, Connect Broadband,
DEN Networks, Rail Tel Corporation of India, Tikona Infinet
Limited, etc. Also started providing Internet services. There
were 262 Internet service providers (ISPs) offering Broad-
band and narrow band Internet services in India as on 30th
June 2018. The number of Internet users are 512.26 mil-
lion, out of which 65.14 million are narrowband subscrib-
ers and 447.12 million are broadband users.

Advantages of the Internet

The Internet is a vast sea information. It provides informa-
tion on all topics and can be accessed by people across
the globe. All you need in order to gain access to the
Internet is a PC, a modem and a telephone line through
which you connect to the Internet Service Provider (ISP).
Internet Service Providers are companies that provide ac-
cess to the Internet is simultaneously all of the following:

• Network

• Medium

• Marketplace

• Transaction Platform

• Source of Information

The Internet as Network

Organisations use the Internet to link their offices and
employees, thus using the Internet as a private network.
Such a network can be used to transfer official data and to
conduct meetings and conferences.

The Internet as a Medium

The Internet is used as an effective means of communica-
tion for product marketers, corporate communications and
so on. For example, by using the Internet, a company can
advertise its products to the whole world the moment they
are launched.

The Internet as a Marketplace

The Internet is a vast virtual market. Thousands of compa-
nies promote their products by advertising them on the
Internet. They also allow you to order products on the
Internet. This is called online shopping or e-shopping. For
example, on the Web site www.indianbooks.com, you can
shop for books and place orders online.

The Internet as transaction Platform

You can use the Internet to complete business and finan-
cial transactions online by connecting to suppliers, cus-
tomers or financial institutions.

The Internet as a Sources of Information

The Internet is a vast sources of information. You can
search information on any topic by using the Internet. For
example, you can search for information on the various
cultures prevalent in India, the latest technologies followed
in education or medicine and so on. You can also share
information with others over the Internet by using various
Internet services, such as e-mail and chat, to name a few.

Connecting to the Internet

Connecting a computer to the Internet involves the pro-
cess of connecting your computer with another computer
that provides the Internet services. (Fig.1)

To connect to the Internet, you need the following

Computer

It must have sufficient memory to run your browser, along
with other programs you might run simultaneously.

Office Administration and Facility Management    R.Theory for Ex 1.8.70-72
Stenographer Secretarial Asst. (Eng) - Internet - Office tools & Equipment -
Networking - Dictation exercises

Office - Introduction to Internet

Objectives: At the end of this lesson you shall be able to
• explain what internet is
• explain the history of internet in India
• state the advantages of internet
• explain the steps to connect to the internet
• identify URLs or web addresses
• state different types of internet connection.
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Browser

A browser is a software program that is necessary in order
for you to view web pages on the web, for example,
Microsoft Internet Explorer.

Internet connection

The most widely used Internet connection requires a mo-
dem and telephone line, but broadband connections are
gaining in popularity.

Internet Service Provider (ISP)

Internet Service Providers are companies that provide ac-
cess to the Internet. ISPs have computers that are always
connected to the Internet. The biggest service provider in
India is Videsh Sanchar Nigam Limited (VSNL). Other
common ISPs are Dishnet, Sify and Rediff.

Types of Internet connection

There are three different ways of connecting to the Internet.
They are:

Dedicated Internet Connection

With a dedicated Internet connection, you can gain ac-
cess to the Internet directly, without going through an ISP.
A dedicated connection allows your computer to remain
connected to the Internet all the time. You do not have to
specifically dial up, as you would with a standard modem
connection. A dedicated connection requires a leased tele-
phone line, rented from a telephone company. Usually,
large companies and universities have dedicated Internet
connections. This type of connection is quite expensive,
because it requires special hardware.

Dial-up Internet Connection

To use this type of connection, you have to purchase an
Internet connection for a specific duration (typically, hours
per month) from an Internet Service Provider. When you
purchase an Internet connection, the ISP provides you with
a CD that contains a software package, a user name and
a password. To activate the connection, you have to in-

stall the software on the CD by following the step-by-step
instructions provided during the process. After you install
the software, you can connect to the ISP and you have to
provide your user name and password when you dial the
ISP's number. The user name and password are used to
check whether you are an authorised user. When you are
using the Internet through a dial-up connection, you can-
not make or receive phone calls via the telephone line
that your modem is using.

Broadband Internet Connection

A broadband connection allows a great amount of infor-
mation to pass through a high-capacity cable to speed
up the delivery of data. Standard dial-up connections are
sometimes described as narrowband. A broadband con-
nection is a high-speed permanent connection to the
Internet. You can stay connected to the Internet from the
minute you turn on your computer until you turn it off.
Broadband uses a DSL (Digital Subscriber Line) or a cable
modem to connect to the Internet. A broadband connec-
tion can send and receive vast amounts of data up to 10
to 40 times faster than a standard dial-up connection. It
uses a fibre optic cable to transmit data at high speeds. A
broadband cable is similar to a narrow lane.

Wireless - Wireless or Wi-Fi, as the name suggests does
not use telephone lines or cables to connect to the internet.
It was radio frequency. Wireless is always on connection
and it can be from anywhere.

Satellite: Satellite accesses the internet via a satellite in
earth's orbit. The enormous distance that a signal travels
from earth to satellite and back again, provides a delayed
connection compared to cable and DSL.

Cellular - Cellular technology provides wireless internet
access through cell phone. The speeds vary depending
on the provider, but the most common are 3G and 4G
speeds. 3G is a term that describes a 3rd generation
cellular network obtaining speeds of around 2.0 mbps.
4G is the 4th generation cellular network. The goal of 4G
is to achieve peak mobile speed of 100mbps.

Material management

Objectives: At the end of this lesson you shall be able to
• explain importance of material management
• state the functions of material management.

The importance of material management may be summa-
rized as follows

1 The material cost content of total cost is kept at a
reasonable level. Scientific purchasing  helps in ac-
quiring materials at reasonable prices. Proper storing
of materials also helps in reducing their wastages.
These factors help in controlling cost content of prod-
ucts.

2 The cost of indirect materials is kept under check.
Sometimes cost of indirect materials also increases
total cost of production because there is no proper
control over such materials.

3 The equipment is properly utilized because there are
no break downs due to late supply of materials.

4 The loss of direct labour is avoided.

5 The wastages of materials at the stage of storage as
well as their movement is kept under control.

6 The supply of materials is prompt and late delivery
instances are only few.

7 The investments on materials are kept under control
as under and over stocking is avoided.

8 Congestion in the stores and at different stages of
manufacturing is avoided.
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Functions

1 The following functions are assigned for material man-
agement:

2 Production and Material Control

3 Production manager prepares schedules of production
to be carried in future. The requirements of parts and
materials are determined as per production schedules.
Production schedules are prepared on the basis of or-
ders received or anticipated demand for goods. It is
ensured that every type or part of material is made
available so that production is carried on smoothly.

4 Purchasing department is authorized to make buying
arrangements on the basis of requisitions issued by
other departments. This department keeps contracts
with suppliers and collects quotations etc. at regular
intervals. The effort by this department is to purchase
proper quality goods at reasonable prices. Purchasing
is a managerial activity that goes beyond the simple
act of buying and includes the planning and policy ac-
tivities covering a wide range of related and comple-
mentary activities.

5 Non-production materials like office supplies, perish-
able tools and maintenance, repair and operating sup-
plies are maintained as per the needs of the business.
These stores may not be required daily but their avail-
ability in stores is essential. The non-availability of such
stores may lead to stoppage of work.

6 The transporting of materials from suppliers is an im-
portant function of materials management. The traffic
department is responsible for arranging transportation
service. The vehicles may be purchased for the busi-
ness or these may be chartered from outside. It all
depends upon the quantity and frequency of buying
materials. The purpose is to arrange cheap and quick
transport facilities for incoming materials.

7 It is concerned with the movement of materials within
a manufacturing establishment and the cost of han-
dling materials is kept under control. It is also seen
that there are no wastages or losses of materials dur-
ing their movement. Special equipment's may be ac-
quired for material handling.

8. The receiving department is responsible for the unload-
ing of materials, counting the units, determining their
quality and sending them to stores etc. The purchas-
ing department is also informed about the receipt of
various materials.
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Now -a- days, in every walk of life, machines are used.
On account of extensive use of machinery, the modern
age is known as machine age.  In a modern day office,
the use of machines is increasing day by day.

Objectives of office machines

1 To Save Labour Cost: The use of machines not only
saves time but also saves physical labour as they do
the work with more speed.

2 To Save Time: The use of machinery saves time.  Time
saved in office routine by use of machines improves
operations elsewhere in the concern.

3 To Promote Accuracy: The machines ensure a
greater accuracy. The changeover from manual opera-
tion to machine operation should help in arriving at ac-
curacy and in eliminating mistakes.

4 To Reduce the Possibility of Frauds: With the in-
stallation of accounting machines, etc. the possibility
of fraud is considerably reduced.

5 To Reduce Monotony: Unlike men, machines do not
get fed up with the boring and monotonous jobs.  When
such jobs are assigned to machines, mental health of
the office staff can be maintained.

6 To Provide Uniformity: The job performed on ma-
chines has an element of uniformity which looks pleas-
ing to the eyes.

Principles for selection of the right machines

    The following points should be taken into consideration
before starting the use of mechanical appliances in an
office.

1 Cost: Before going in for any office appliance, the con-
cept of cost must be taken into account. The cost of
machines should not be beyond the reach of a con-
cern.  However, it does not mean that cheap and sub-
standard devices should be installed.

2 Suitability: Before buying any office appliance, it
should be taken into account that it suits the require-
ments of the office.  An unsuitable machine will be of
no use for the concern.

3 Full Utilization: Before buying any office appliance, it
should be taken into consideration that it must be used
again and again.

4 Cost of Operation and Maintenance: Only those
machines should be taken which require minimum cost
of operation and maintenance.

5 Simple and Modern: While buying any machine it
should be taken into consideration that its operation
should be simple but must be latest and not outdated.

Types of office machines

There are many types of machines available to a modern
office. They are,

Fax Machine:  A fax machine is a device that is used to
send documents electronically over a telephone network.
The transmissions it sends are called "faxes," and these
can be between two fax machines, or between a fax ma-
chine and a computer or online fax service that is equipped
to send and receive faxes.

Travel, Tourism & Hospitality  Related Theory for Exercise 1.8.73-75
Secretarial Practice - Internet - Office tools & Equipment - Networking -
Dictation exercises

Office Equipment - Selection of right machines/equipment - Photocopier -
Xerox - Intercom - EPABX - Scanner - Personal Computer - Internet, FAX,
Printer, etc. - Concept of office Security

Objectives: At the end of this lesson you shall be able to
• state the utility of office machines
• state the objectives of office machines
• state the principles of office machines
• state the principles for selection of the right machines
• list the various types of office machines
• explain safe handling of the office machines.

Desktop computer: A desktop computer is a personal
computer designed for regular use at a single location on
or near a desk or table due to its size and power require-
ments. The most common configuration has a case that
houses the power supply, motherboard, disk storage; a
keyboard and mouse for input; and a computer monitor,
speakers, and, often, a printer for output.

The case may be oriented horizontally or vertically and
placed either underneath, beside, or on top of a desk.
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Photocopying machine: A photocopier is an electronic
machine that takes copies of documents and images.
Photocopiers were once single function devices. Now en-
terprise-grade photocopiers are usually networked and per-
form multiple functions. They are available in Desktop or
free-standing models. For high and small business use,
photocopying is often bundled with scanning, printing and
faxing capabilities in a multifunction peripheral (MFP) de-
vice.

Addressing and mailing machine: A machine that au-
tomatically imprints names, addresses, or other informa-
tion on successive envelopes or forms as required.

Calculating & Billing machine: An electronic calcula-
tor is typically a portable electronic device used to per-
form calculations, ranging from basic arithmetic to com-
plex mathematics.

Duplicating machine:  Duplicating machines were the
predecessors of modern document-reproduction technol-
ogy. They have now been replaced by scanners, laser
printers and photocopiers, but for many years they were
the primary means of reproducing documents for limited-
run distribution.

Intercom: An intercom (intercommunication device),
talkback or door phone is a standalone voice communica-
tion system for use within a building or small collection of
buildings, functioning independently of the public telephone
network.
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EPABX (Electronic Private Automatic Branch Exchange)
A private branch exchange (EPABX) is a Telephone Ex-
change that serves a particular business or office, as op-
posed to one that a common carrier or telephone com-
pany operates for many businesses or for the general
public.

Electronic Stencil Cutter:  Cuts stencils and signs in an
almost unlimited amount of fonts and symbols with an
easy to use, Windows based software.

Networking - LAN, MAN, WAN using internet, sending and receiving e-mail
messages; searching information from websites by the use of search
engines

Objectives: At the end of this lesson you shall be able to
• define computer network and its advantages
• explain application areas of networks
• name the types of networks and their characteristics
• explain topologies and protocols
• explain ISP and list out the ISPs in india.

Computer network

A computer network is an interconnection of various
computer systems located at different places. In computer
network two or more computers are linked together with a
medium and data communication devices for the purpose
of communicating data and sharing resources. The
computer that provides resources to other computers on a
network is known as server. In the network the individual
computers, which access shared network resources, are
known as workstations or nodes.

Advantages of Computer Networks

Following are some of the advantages of computer
networks

• File Sharing: Networks offer a quick and easy way to
share files directly. Instead of using a disk or USB key
to carry files from one computer or office to another, you
can share files directly using a network.

• Security: Specific directories can be password
protected to limit access to authorized users.

• Resource Sharing: All computers in the network can
share resources such as printers, fax machines,
modems, and scanners.

• Communication: Even outside of the internet, those
on the network can communicate with each other via
electronic mail over the network system. When
connected to the internet, network users can
communicate with people around the world via the
network.

• Flexible Access: Networks allow their users to access
files from computers throughout the network. This
means that a user can begin work on a project on one
computer and finish up on another. Multiple users can
also collaborate on the same project through the network.

• Workgroup Computing: Workgroup software like
Microsoft BackOffice enables many users to contribute
to a document concurrently. This allows for interactive
teamwork.

• Error reduction and improved consistency: One
can reduce errors and improve consistency by having all
staff work from a single source of information, so that
standard versions of manuals and directories can be
made available, and data can be backed up from a single
point on a scheduled basis, ensuring consistency.

Network Application Areas

There is a long list of application areas, which can be
benefited by establishing Computer Networks. A few of the
potential applications of Computer Networks are:

1 Information retrieval systems which search for books,
technical reports, papers and articles on particular
topics

2 News access machines, which can search for past
news, stories or abstracts with the given search criteria.

3 Airline reservation, hotel booking, railway-reservation,
car-rental, etc.

4 A writer's aid: a dictionary, thesaurus, phrase generator,
indexed dictionary of quotations, and encyclopaedias.
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5 Stock market information systems which allow searches
for stocks that meet certain criteria, performance
comparisons, moving averages, and various forecasting
techniques.

6 Electronic Financial Transactions (EFT) between banks
and via cheque clearing house.

7 Games of the types that grow or change with various
enthusiasts adding to the complexity or diversity.

8 Electronic Mail Message Systems (EMMS).

9 Corporate information systems such as marketing
information system, customer information system,
product information system, personnel information
system, etc.

10 Corporate systems of different systems such as Order-
Entry System, Centralized Purchasing, Distributed
Inventory Control, etc.

11 On-line systems for Investment Advice and Management,
Tax Minimization, etc.

12 Resources of interest to a home user.

13 Sports results.

14 Theatre, movies, and community events information.

15 Shopping information, prices, and advertisements.

16 Restaurants; good food guide.

17 Household magazines, recipes, book reviews, film
reviews.

18 Holidays, hotels, travel booking.

19 Radio and TV programmes.

20 Medical assistance service.

21 Insurance information.

22 Computer Assisted Instruction (CAI).

23 School homework, quizzes, tests.

24 Message sending service.

25 Directories.

26 Consumer reports.

27 Employment directories and Job opportunities.

28 Tax information and Tax assistance.

29 Journey planning assistance, viz. Train, bus, plane,
etc.

30 Catalogue of Open University and Virtual University
courses.

Computer Networks may be classified on the basis of
geographical area in two broad categories.

1 Local Area Network (LAN)

2 Wide Area Network (WAN)

3 Metropolitan Area Network (MAN)

A classification of computer networks can be done based
on distance as in the table.

  Interprocessor Network Type
      Distance

0 to 1 Km Local Area Network (LAN)

1 Km to 10 Km Metropolitan Area Network
(MAN)

10 Km to 1000 Km Wide Area Network (WAN)

Above 1000 Km Internet

Local Area Network (LAN)

Networks used to interconnect computers in a single
room, rooms within a building or buildings on one site are
called Local Area Network (LAN). LAN transmits data with
a speed of several megabits per second (106 bits per
second). The transmission medium is normally coaxial
cables.

LAN (Fig 1) links computers, i.e., software and hardware,
in the same area for the purpose of sharing information.
Usually LAN links computers within a limited geographical
area because they must be connected by a cable, which
is quite expensive. People working in LAN get more
capabilities in data processing, work processing and other
information exchange compared to stand-alone computers.

Fig 1
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Because of this information exchange most of the business
and government organisations are using LAN.

Use of LAN

Following are the major areas where LAN is normally used

• File transfers and Access

• Word and text processing

• Electronic message handling

• Remote database access

• Personal computing

• Digital voice transmission and storage

Metropolitan Area Network (MAN)

A Data network designed for a town or city. In terms of
geographical breadth, MANs are larger than LANs, but
smaller than WANs. MANs (Fig.2) are usually characterized
by very high-speed connections.

Fig 2

Characteristics of MAN

1 The network size falls intermediate between LANs and
WANs. A MAN typically covers an area of between 5
and 50 km range. Many MANs cover an area the size
of a city, although in some cases MANs may be as
small as a group of buildings.

2 A MAN (like a WAN) is not generally owned by a single
organisation. The MAN, its communication links and
equipment are generally owned by either a consortium
of users or by a network service provider who sells the
service to the users.

3 A MAN often acts as a high speed network to allow
sharing of regional resources. It is also frequently used
to provide a shared connection to other networks using
a link to a WAN.

Campus Area Network (CAN)

A Campus Area Network or Corporate Area Network (CAN)
is a network that is made up of an interconnection of local
area network within a limited geographical area. A CAN
(Fig 3) is larger than a local area network but smaller than
a Wide area Network.

Fig 3
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Fig 4

Wide Area Network (WAN)

The term Wide Area Network (Fig 4) is used to describe a
computer network spanning a regional, national or global
area. For example, for a large company the head quarters
might be at Delhi and regional branches at Bombay,
Madras, Bangalore and Calcutta. Here regional centres
are connected to head quarters through WAN. The dis-
tance between computers connected to WAN is larger.
Therefore the transmission mediums used are normally
telephone lines, microwaves and satellite links.

2 Remote Data Entry: Remote data entry is possible in
WAN. It means sitting at any location you can enter
data, update data and query other information of any
computer attached to the WAN but located in other
cities. For example, suppose you are sitting at Madras
and want to see some data of a computer located at
Delhi, you can do it through WAN.

3 Centralised Information: In modern computerised
environment you will find that big organisations go for
centralised data storage. This means if the organisation
is spread over many cities, they keep their important
business data in a single place. As the data are
generated at different sites, WAN permits collection of
this data from different sites and saves at a single site.

Examples of WAN

1 Ethernet: Ethernet developed by Xerox Corporation is
a famous example of WAN. This network uses coaxial
cables for data transmission. Special integrated circuit
chips called controllers are used to connect equipment
to the cable.

2 Arpanet: The Arpanet is another example of WAN. It
was developed at Advanced Research Projects Agency
of U. S. Department. This Network connects more than
40 universities and institutions throughout USA and
Europe.

Characteristics of WAN

Following are the major characteristics of WAN.

1 Communication Facility: For a big company spanning
over different parts of the country the employees can
save long distance phone calls and it overcomes the
time lag in overseas communications. Computer
conferencing is another use of WAN where users
communicate with each other through their computer
systems.

Difference between LAN and WAN

• LAN is restricted to limited geographical area of a few
kilometers. But WAN covers great distance and operates
nationwide or even worldwide.

• In LAN, the computer terminals and peripheral devices
are connected with wires and coaxial cables. In WAN
there is no physical connection. Communication is
done through telephone lines and satellite links.

• Cost of data transmission in LAN is less because the
transmission medium is owned by a single organisation.
In case of WAN the cost of data transmission is very
high because the transmission medium used is hired
either by telephone lines or satellite links.

• The speed of data transmission is much higher in LAN
than in WAN. The transmission speed in LAN varies
from 0.1 to 100 megabits per second. In case of WAN
the speed ranges from 1800 to 9600 bits per second
(bps).

• Few data transmission errors occur in LAN compared
to WAN. It is because in LAN the distance covered is
negligible.
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Sending and receiving e-mail messages

What is email?

Email is short for 'electronic mail'. Similar to a letter, it is
sent via the internet to a recipient. An email address is
required to receive email, and that address is unique to
the user. Some people use internet-based applications
and some use programs on their computer to access and
store emails.

Key benefits and features of using email

• It's quick – your recipient receives your email as soon

as they go online and collect their mail.

• It's secure.

• It's low cost.

• Photos, documents and other files can be attached to

an email, so that more information can be shared.

• One email can be sent to more than one recipient at a

time.

How to get an e-mail account

When it comes to choosing an e-mail account, there are
lots of options.  Most internet service providers (ISPs) of-
fer e-mail addresses with a broadband account  and some
offer more than one e-mail address so that members of
the family can set up separate e-mail accounts through
the main internet account.

How to send an e-mail

The following steps show you how to send an e-mail using
email account-

Step 1: log on your e-mail account so that you are on the
dashboard (main page) of your mail account

Step-2: Click Compose - a blank e-mail window will open
up. In the ' To' box  type the email address of the recipient.

Step -3: You might want to include someone else in your
email, keep them in the loop by clicking cc or Bcc.  cc
means carbon copy and Bcc means blind carbon copy.

Step-4: Subject field (optional) allows you to give the re-
cipient an idea of the topic of your email, like a heading.

Step-5: Email text can be formatted in a similar way to
text in a word document. Type your message in the main
body field of your e-mail.

Step-6: Click the send button at the bottom of the com-
pose window.

Default e-mail folders

The default e-mail folders for emails are:

Sending and receiving e-mail

Objectives: At the end of this lesson you shall be able to
• explain what are the hardware and software required to establish an e-mail account
• state the steps to create an e-mail account
• explain how to send, receive and open e-mail and attachments.

Inbox

Inbox folder places your incoming e-mails. To open the
inbox, click inbox icon on the bar or folder list. Once the
messages are in inbox folder, they can be read. One can
read the messages using a small preview pane or in a
separate message window. If you receive lots of e-mails,
you will probably use the preview pane to sort interesting
messages.

Searching information from websites by the use of
search engines

What is a search engine

A search engine is a website that collects and organizes
content from all over the internet. Those wishing to locate
something would enter a query about what they'd like to
find and the engine provides links to content that matches
what they want.

List of Popular Search Engines In the World (Updated
2019)

1. Google

No need for further introductions. The search engine giant
holds the first place in search with a stunning difference of
65% from second in place Bing.

2. Bing

Bing is Microsoft's attempt to challenge Google in search,
but despite their efforts they still did not manage to con-
vince users that their search engine can produce better
results than Google.

3. Yahoo

Yahoo is one of the most popular e-mail providers and
holds the fourth place in search with 3.90% market share.

4. Ask.com

Formerly known as Ask Jeeves, Ask.com receives ap-
proximately 0.42% of the search share. ASK is based on
a question/answer format where most questions are an-
swered by other users or are in the form of polls.

5. AOL.com

According to net market share the old time famous AOL
is still in the top 10 search engines with a market share
that is close to 0.06%. The AOL network includes many
popular web sites like engadget.com,

6. Baidu

Baidu was founded in 2000 and it is the most popular
search engine in China. Its market share is increasing
steadily and according to Wikipedia, Baidu is serving bil-
lions of search queries per month. It is currently ranked at
position 4, in the Alexa Rankings.
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7. Wolframalpha

Wolframalpha is different from all the other search engines.
They market it as a Computational Knowledge Engine
which can give you facts and data for a number of topics.

8. DuckDuckGo

Has a number of advantages over the other search en-
gines. It has a clean interface. It does not track users. It is
not fully loaded with ads and has a number of very nice
features.

9. Internet Archive

archive.org is the internet archive search engine. You can
use it to find out how a web site looked since 1996. It is a
very useful tool if you want to trace the history of a domain
and examine how it has changed over the years.

10. Yandex.ru

According to Alexa, Yandex.ru is among the 30 most popu-
lar websites on the Internet with a ranking position of 4 in
Russian.

11.Opera

Opera is a free, fast and standard-compliant web browser.
Opera is the preferred browser for a number of small de-
vices like mobile phones and hand-held computers.

12. Mozilla Firefox

The Mozilla project has grown from the ashes of netscafe.
Browsers based on Mozilla code are the largest browser
family on the internet today.

13. Netscape

Netscape was the first commercial web browser.  Netscape
was released in 1994, but gradually lost its popularity to
internet explorer. The development of Netscape officially
ended in February 2008.

Searching, browsing website, using search engines

Objectives: At the end of this lesson you shall be able to
• explain what is search engine
• list some important websites that provide links for information sought for.

Browsing

Browsing is the act of looking through a set of information
quickly, without a specific sense of purpose. In the con-
text of the internet, it usually refers to using the world
wide web

Search engine

A search engine is software, usually accessed on the
Internet, that searches a database of information accord-
ing to the user's query. The engine provides a list of re-
sults that best match what the user is trying to find. To-
day, there are many different search engines available on
the Internet, each with their own abilities and features.

Website

A website is a collection of publicly accessible, interlinked
Web pages that share a single domain name. Websites
can be created and maintained by an individual, group,
business or organization to serve a variety of purposes.
Together, all publicly accessible websites constitute the
World Wide Web.

List of Popular Search Engines In the World (Updated
2019)

1. Google

No need for further introductions. The search engine giant
holds the first place in search with a stunning difference
of 65% from second in place Bing.

2. Bing

Bing is Microsoft's attempt to challenge Google in search,
but despite their efforts they still did not manage to con-

vince users that their search engine can produce better
results than Google.

3. Yahoo

Yahoo is one of the most popular e-mail providers and
holds the fourth place in search with 3.90% market share.

4. Ask.com

Formerly known as Ask Jeeves, Ask.com receives ap-
proximately 0.42% of the search share. ASK is based on
a question/answer format where most questions are an-
swered by other users or are in the form of polls.

5. AOL.com

According to net market share the old time famous AOL
is still in the top 10 search engines with a market share
that is close to 0.06%. The AOL network includes many
popular web sites like engadget.com,

6. Baidu

Baidu was founded in 2000 and it is the most popular
search engine in China. Its market share is increasing
steadily and according to Wikipedia, Baidu is serving bil-
lions of search queries per month. It is currently ranked at
position 4, in the Alexa Rankings.

7. Wolframalpha

Wolframalpha is different from all the other search engines.
They market it as a Computational Knowledge Engine
which can give you facts and data for a number of topics.

8. DuckDuckGo

Has a number of advantages over the other search en-
gines. It has a clean interface. It does not track users. It is
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not fully loaded with ads and has a number of very nice
features.

9. Internet Archive

archive.org is the internet archive search engine. You can
use it to find out how a web site looked since 1996. It is a
very useful tool if you want to trace the history of a domain
and examine how it has changed over the years.

10. Yandex.ru

According to Alexa, Yandex.ru is among the 30 most popu-
lar websites on the Internet with a ranking position of 4 in
Russian.

11.Opera

Opera is a free, fast and standard-compliant web browser.
Opera is the preferred browser for a number of small de-
vices like mobile phones and hand-held computers.

12. Mozilla Firefox

The Mozilla project has grown from the ashes of netscafe.
Browsers based on Mozilla code are the largest browser
family on the internet today.

13. Netscape

Netscape was the first commercial web browser.  Netscape
was released in 1994, but gradually lost its popularity to
internet explorer. The development of Netscape officially
ended in February 2008.

Office  Security - Meaning and concept

It is basically the process to protect an employee from
work related illness and injury and to make the workplace
(building etc) secure from intruders. Every company should
have a workplace safety plan.

In this modern and fast paced world, security is more im-
portant than ever.  An important aspect of security whether
guarding physical assets or electronic assets is security
guards. Their main goal is to monitor and protect assets
and act as a deterrent to violence

Protecting important data, confidential information, net-
works, software, equipment, facilities, company's assets,
and personnel is what physical security is about.

A comprehensive workplace security is very important
because it will reduce liabilities, insurance, compensa-

tion and other social security expenses to be paid by the
company to the stakeholders. Thus, business revenue
can be increased and operational charges can be reduced.

Other equipment hazards may include lack of planned
maintenance, lack of regular testing, lack of training of
equipment, and faulty utility services, such as water, gas,
electricity and compressed air. Electrical and utility equip-
ment must be well-maintained in order to prevent danger.

Physical hazards include slips, trips, falls, exposure to
loud noises, working from heights, vibrations, and un-
guarded machinery.

Employers have a legal duty to prevent violence in the
workplace. All employers have a responsibility, as far as
reasonably practicable, to provide a workplace that is safe
and secure.

To keep the office secure, an office needs to

1 be  well lit in parking areas, walkways and building
entrances.

2 have emergency call boxes or buttons in parking ar-
eas.

3 separate employees from visitors or clients.

4 have monitoring or surveillance tools (such as video/
CCTV monitoring and recording, security patrols)

1 use a monitored alarm system. ...

2 use effective lighting

3 keep important documents in locked cabinets. ...

4 put cash in a safe

5 appoint a workplace security coordinator.

6 lock away tech gadgets when not in use.

7 check and fix all entry and exit points.

8 have a health and safety plan in place, including an
emergency procedure. ...

9 maintain premises & machinery

10 educate  employees about safety and security and
involve them in safety planning

11 foster a culture of safety & security.
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Importance of Pincode

A Postal Index Number or PIN or Pincode is a code in the
post office numbering or post code system used by India
Post, the Indian postal administration. The code is six
digits long.

History

The PIN Code system was introduced on 15th August
1972. The system was introduced to simplify the manual
sorting and delivery of mail by eliminating confusion over
incorrect addresses, similar place names and different
languages used by the public.

Postal Zones

There are nine PIN zones in India, including eight regional
zones and one functional zone (for the Indian Army). The
first digit of the PIN code indicates the region. The sec-
ond digit indicates the sub-region, and the third digit indi-
cates the sorting district within the region. The final three
digits are assigned to individual post offices.

The 9 PIN zones cover the Indian states and union territo-
ries as follows:

• 1 - Delhi, Haryana, Punjab, Himachal Pradesh, Jammu
and Kashmir, Chandigarh

• 2 - Uttar Pradesh, Uttarakhand

• 3 - Rajasthan, Gujarat, Daman and Diu, Dadra and
Nagar Haveli

• 4 - Goa, Maharashtra, Madhya Pradesh, Chhattisgarh

• 5 - Andhra Pradesh, Karnataka, Telangana

• 6 - Tamil Nadu, Kerala, Puducherry, Lakshadweep

• 7 - Odisha, West Bengal, Arunachal Pradesh,
Nagaland, Manipur, Mizoram, Tripura, Meghalaya,
Andaman and Nicobar Islands, Assam, Sikkim

• 8 - Bihar, Jharkhand

• 9 - Army Post office (APO) and Field Post office (FPO)

Post card

Open communication on a card of prescribed size. Avail-
able in two varieties: Single & reply post card. Post cards

are for transmission within India only. Dimensions 14 cm
× 9 cm (length and breadth). Privately manufactured post
cards shall not be thinner or more flexible than an em-
bossed post card, and will have the same size and thick-
ness of embossed post card. There are other varieties of
Post cards also such as.

Printed post cards

Post cards containing communication recorded by print-
ing, cyclostyling or by any other mechanical process are
classified as 'Printed Post Cards'. Printed matter includes
printed pictures also.

Inland letter card

Communication is contained on a sheet of paper with pre-
scribed size & folding. Inland letter card is used for trans-
mission within India only.

Office Administration and Facility Management    R.Theory for Ex 1.9.76-79
Stenographer Secretarial Asst. (Eng) - Postal services - E mail- Excel
tabulation work - Enhancing dictation speed

Postal Services:  Importance of PIN Code, Post Card, Registered Letters,
Ordinary Letters,   Insured  Letters,  Parcels, Business Reply Post Cards,
VPP, UPC , etc.

Objectives: At the end of this lesson you shall be able to
• explain what internet is
• explain the history of internet in India
• state the advantages of internet
• explain the steps to connect to the internet
• identify URLs or web addresses
• state different types of internet connection.

Registered newspaper

A Newspaper is a publication consisting wholly or in great
part of political or other news, with or without advertise-
ment. It is published in large numbers at intervals of not
more than 31 days.

It should have a bonafide list of subscribers.
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If such newspaper is registered in the office of the Super-
intendent or Senior Superintendent of Post offices of the
area where Newpaper is to be published, it will be treated
as 'Registered Newspaper' for concessional rates of post-
age. There is no fee for registration.

The registration number allotted to the paper should be
printed on the top of the front page of the Newspaper pre-
ceded by the word 'Registered’.

Blind literature packet

India Post allows free transmission of blind literature pack-
ets up to 7 kilograms. Papers of any kind, periodicals and
books impressed in "Braille" or other special type for the
use of blind are allowed to be transmitted by post as Blind
literature packets.

Parcel

Anything can be sent in a parcel excepting articles whose
transmission is prohibited. It can contain single commu-
nication to the addressee of the parcel. If the parcel is
suspected to contain other than the permitted communi-
cation, it will be opened in the presence of the addressee
or his authorized agent, and each written communication
will be charged on delivery with double the letter postage.
If the addressee refuses to pay the charges, the parcel
will be returned to the sender from whom the charge will
not be recovered.

Registration

The postal article that is registered is given identification
and is recorded at every stage of handling. Letters, letter
cards, Books and Pattern Packets, Parcels, Newspapers
prepaid with postage may be registered for transmission
at any post office. The registered postal article is deliv-
ered specifically to the addressee.

Insurance

Insurance covers all risks during the course of transmis-
sion by post. The following types of articles can be in-
sured

- Registered letters

- Value Payable Letters

- Registered Parcels

- Value Payable Parcels

Limits

• Branch offices are allowed to book up to the value of
INR 600

• Other offices can book up to the value of INR 100000

• Insured value should not exceed the value of the ar-
ticles insured

• When articles having intrinsic value such as gold and
currency notes are sent they should be insured for the
actual

Types of telegrams

A telegram is a telegraph - a method for communicating
messages over long distances - that is taken from its elec-
tronic format and transformed into written format. Tele-
grams normally are hand-delivered and have been used
throughout history since the early 19th century. Before
the telephone was in wide use, telegrams were a popular
form of long-distance communication. Many types of tele-
grams still are in use today: same-day or next-day hand-
delivered telegrams, international telegrams, phone-in tele-
grams, singing telegrams and postal-delivered telegrams.

Other services

Hand-Delivered Telegrams

Hand-delivered telegrams can be produced by companies
and delivered to the recipient the same day that the tele-
gram is submitted, the next day or even via three-day de-
livery. The quicker delivery format that the sender chooses,
the higher the cost. Telegram companies typically charge
a delivery fee, plus a certain amount per word on the tele-
gram message. Some telegram companies will allow cus-
tomers to try sending telegrams to celebrities, VIPs and
government officials. A telegram sender provides as much
information as he or she can concerning the recipient of
the message. Telegram companies do their best to find
the recipient; if they are not able to locate or reach the
recipient, they notify the sender.

International Telegrams

International telegrams are sent immediately to offices that
receive telegrams in international locations. An interna-
tional telegram is delivered according to the destination
country's telegram delivery protocols. International tele-
grams are delivered as telegrams with priority.

Phone-In Telegrams

A sender can opt for a telegram to be read to the recipient
via a phone call. If a recipient is not available at the time of
the first phone call, the telegram company repeatedly at-
tempts to call the recipient to convey the telegram mes-
sage.

Singing Telegrams

Singing telegrams are a fun and creative way to convey a
message to a recipient. Singing telegrams are commonly
used for special occasions such as birthdays, anniversa-
ries, congratulations and more. A singer or group of sing-
ers goes to the recipient's location and sings the recipient
a personalized song, usually to a familiar, standardized
tune. After finishing the song, the singer gives the recipi-
ent a typed telegram containing a message from the
sender.
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Monetary Services, Speed  Post and Courier Services, Post Box and Post
Bag

Objectives: At the end of this lesson you shall be able to
• explain  the various monetary services offered at Post Offices
• state the importance of Speed Post and Courier Service
• explain the advantages of  Post Box and Post Bag.

Monetary Services offered at post offices

• Post Office Time Deposit Account (TD)

• Post Office Monthly Income Scheme Account (MIS)

• Senior Citizen Savings Scheme (SCSS)

• 15 year Public Provident Fund Account (PPF )

• National Savings Certificates (NSC)

• Kisan Vikas Patra (KVP )

• Sukanya Samriddhi Accounts

UPC (Under Postal Certificate)

This service is now rarely used whereas this service was
frequently used before courier services came into being.
In UPC, the sender will deliver the parcel or letter by ordi-
nary post at the specified counter of post office at the
extra nominal cost, say Rs.1/- for 3 envelopes and obtain
proof of having posted the letters.

Speed Post

It is a service to send the mail as fast as possible.  In this,
the post office provides time bound delivery of mail, letters
and other documents.  The charges of speed post are
higher than ordinary mail.

Postal-Delivered Telegrams

Postal-routed telegrams are the most inexpensive method
of telegrams, and they normally take the longest time to
reach the recipient as they have neither instant nor prior-
ity status.

Retail Services

Through its vast network of Post Offices across the coun-
try, India Post offers the facility to collect consumer bills
for service industries like telephone / electricity / mobile
phone users etc, for Government and private organiza-
tions through Retail Post. Post Offices also sell forms for
public bodies across counter of Post Office. Besides this,
facility of reservation of Railway Tickets through comput-
erized passenger reservation system terminals has been
commenced from 7.10.2007 in selected Post Offices.
Retail Post leverages the vast network of Post Offices for
sale of products across the counter on behalf of other
organizations. It projects India Post as a 'One Stop Solu-
tion Provider' for various utility services and it is in a posi-
tion to offer the retail services to the customers of any
agency. Some of the agency services that Retail Post
offers are as follows

• Telephone revenue collection

• e-Ticketing for Road Transport Corporations and Air-
lines

• Sale of UPSC forms, University applications, etc

• Sale of Passport application forms

• Sale of GOLD  Coins, Forex Services

• Sale of SIM and recharge coupons

• Sale of India Telephone cards

• e-Ticketing of Railway tickets

The Heads of Circles have also been empowered to pro-
vide various area specific business packages under Re-
tail Post in their Circles.

VPP (Value Payable Post)

The value payable system is designed to meet the re-
quirements of persons who wish to pay for articles sent
to them at the time of receipt of the articles.  It is also
intended to meet the requirements of traders and others
who wish to recover, through the agency of the Post Of-
fice the value of articles supplied by them.  Registered
articles may be transmitted by the inland post   provided
they do not contain prohibited items.  The sender should
give a declaration to this effect.

Courier Services

This service is provided by private post offices for provid-
ing desk-to-desk services.  They are faster and more reli-
able.  This service is comparatively cheaper than services
provided by post offices.

Business Reply Services

A person who wishes to obtain a reply from his client
without putting him to the burden of paying the postage
charges, may attach or enclose with his communication
an addressed reply card, envelope or label of a special
design.  Such a card, envelope or label can be posted by
the client in the ordinary manner, but without any stamp.
The usual postage charges plus ten paise for each article
will be collected from the addressee.

Envelopes and labels must bear on the address side, a)
the printed name and address of the permit holder to whom
the card/envelope is to be delivered b) the permit no. c)
the name of the post office issuing the permit d) two thick
vertical lines in black or any other colour near the right
hand edge e) the words 'Business Reply Card', 'Business
Reply Envelope' or 'Business Reply Label', as the case
may be f) the words 'No postage stamp necessary if posted
in India' and g) 'Postage will be paid by the Addressee'.
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Book Packets

They should not contain any publication published at regu-
lar intervals.  Book packets shall bear on the outside the
inscription 'Printed Books'.  They shall consist of reading
matter, printing, photographs, diagrams or any other simi-
lar matter. They should not contain any character or in-
scription reproduced by any other means.  It may contain
in writing the name of the person to whom it is sent, the
date, the name and address of the sender and not more
than five words or initials of a complimentary nature.

Post Office Savings Account

It fetches an interest of 4% per annum on individual or
joint accounts.  A minimum balance of Rs.500/- in an ac-
count is to be maintained to avail cheque facility.  Interest
earned is tax-free upto Rs.50,000/- per year.  Nomination
facility is available.  Account can be transferred from one
post office to another.  Account can be opened in the name
of minor also and a minor of 10 years and above  can open
and operate the account.  Deposits and withdrawals can
be done through  electronic mode in CBS post offices.
ATM facility is available.

5-Year Post Office Recurring Deposit A/c

From 1.1.2019, interest rate is 7.3% per annum com-
pounded quarterly.  On maturity, Rs.10/- account fetches
Rs.725.05.  All facilities available for Savings Account ap-
ply for this Account also.

Time Deposit Account

It is popular in rural and remote areas of India. The rate of
interest applicable for 5 year account is 7.8% p.a.  Tenure
of Time Deposit Account can be extended upon maturity.
There is no cap on the number of Time Deposit Accounts
that can be opened.  A parent or guardian can open a Post
Office Time Deposit Account on behalf of a minor.  5-year
Time Deposits qualify for tax deduction under Section 80C.
Premature withdrawals of deposits is allowed.

Monthly Income Scheme Account (POMIS)

A certain amount can be invested for a period of five years
and interest can be earned every month.  One can invest
upto Rs.4.5 lakhs individually or Rs.9 lakhs jointly.  Rate
of interest is 7.3%.  After maturity, one can withdraw the
principal amount from any post office. Income is subject
to tax. Account can be opened in the name of a child
provided the child is aged 10 or above.

Public Provident Fund Account: (PPF)

It is a long-term investment scheme. It offers tax exemp-
tion and attractive interest rates. Only one PPF account
can be opened by an individual. One of the parents can
open the account in the name of their child. The account
matures after 15 years.  The documents required for open-
ing the account are: Aadhaar card/Driving Licence/Voter's
ID and PAN card.  The maximum deposit allowed within a
year is Rs.1.5 lakh. The maturity amount is exempted
from tax. The minimum deposit required to open the ac-
count is Rs.500/- and the maximum amount allowed is
Rs.70,000/-

National Savings Certificates

This scheme is a secured and low-risk product.  It can be
bought jointly or in the name of a minor too.  Investments
upto Rs.1.5 lakh in the scheme can earn a tax break un-
der Sec.80C of the Income Tax Act.  The current rate of
interest is 7.6.% per annum.  There are two maturity peri-
ods-5 years and 10 years.  Nomination facility and facility
to transfer certificate from one post office to another is
available.  These certificates can be given a collateral se-
curity to get loans from banks.  Upon maturity, the entire
maturity value is paid to the certificate holder.

Senior Citizen Savings Scheme (SCSS)

This scheme is meant primarily for the senior citizens of
India.  Senior citizens of India aged 60 years or above and
retirees who have opted for Voluntary Retirement Scheme
in the age bracket of 55-60 are eligible. An individual can
invest a maximum amount of Rs.15 lakh individually or
jointly in SCSS account. The scheme offers 8.6% inter-
est. Nomination facility is available. Tax deduction of upto
1.5 lakh can be claimed under Sec.80C of the Income
Tax Act. The tenure of this investment is flexible with an
average tenure of 5 years which can be extended upto 3
additional years.

Kisan Vikas Patra (KVP)

This scheme doubles a one-time investment in a period of
approximately 118 months. The minimum investment is
Rs.1,000/- and there is no upper limit. Initially it was meant
for farmers. Now it is available for all. To deposit Rs.10
lakh and above, income proof (Salary slips, bank state-
ment, ITR document, etc.) must be submitted. As proof of
identity of A/c holder, Aadhaar No. should be submitted.
Regardless of market fluctuations, one can get the sum
guaranteed. The income from the scheme is taxable. The
amount of deposit can be withdrawn after 118 months.
But the lock-in period is 30 months. KVP is available in
denominations of Rs.100/-, Rs.500/-, Rs.1,000/-, Rs.5,000/
-, Rs.10,000/-, and also Rs.50,000/-. There is no maxi-
mum limit. Nomination facility is available.

Sukanya Samriddhi Yojana

Sukanya Samriddhi Yojana Account promises a viably
secure future for the girl child at the time of her higher
education and marriage. To open the account for your girl
child, you need a) birth certificate of the girl child b) proof
of residence of the parents or the legal guardian and c)
proof of identity of the parents or the legal guardians. The
initial amount required for opening the account is  Rs.1,000/
-. After the account is activated, one can deposit any
amount in multiples of Rs.100/- any number of times. The
girl child's parent (mother/father) has to sign in front of the
post office official at the time of opening the account.
Passbook should be collected and kept in safe custody.

Post Box and Post Bag

Post box facility is available at Head Post office on pay-
ment of the required fee. The postmaster allots a Post
Box Number and gives a key to the hirer. The duplicate
key is retained by the postmaster. All letters or articles
are put into the box and are collected by the authorised
agent of the company or person.
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A Post Bag is also provided on hire by the Post Office with
lock and keys.  One key along with the bag is given to the
hirer, while another one is kept at the post office.

The mail is put into the bag and locked. The bag is carried
by the authorised person to his office and opened by the
manager or incharge. This ensures secrecy of the letters.
In both these services, the biggest advantage is that the
mail is collected in time and distributed to the depart-
ments for prompt action, instead of waiting for the post-
man to deliver it.Book Packets.

Office security

Objectives: At the end of this lesson you shall be able to
• state the necessity of providing security to office
• state the types of security that can be provided to office.

Office security can be broken down into two main
areas

1 Protecting office and employees from vandalism, theft
and personal attacks

 There should be no nooks or crannies where an intruder
could hide in the shadows.  All areas should be well lit.
Doors and windows  should be secure.  Entranceway doors
should be steel or steel-sheathed.  Deadbolt locks are
best whether they are electronically controlled or manual
in nature.  Closed-circuit surveillance systems, access-
control systems such as  access cards, swipe cards,
hidden cameras, panic buttons, electronic door chimes,
laminated photo identification cards, etc. provide protec-
tion.  Alarm systems are another popular office security
tool.  There are two primary types of alarm systems:  those
that sound a loud siren  when a break-in is detected, and
those that send a silent alarm directly to a security com-
pany or to the police.  As with closed-circuit television
systems, the key to a good alarm system is that  it must
be monitored at all times.  Security guards can be used
to monitor the front desk of a company or building(the
access control point) or to patrol the grounds of a larger
company or office complex. They are primarily expected
to do four  things at all times:  deter, detect, observe, and
report.   Employees should also be vigilant and alert.

2 Protecting office from corporate sabotage both from
inside the company and out side.

For most companies, the greatest risk of theft or sabo-
tage often comes from the firm's employees themselves.
Theft, misappropriation of company funds by the employ-
ees are quite common (forgery of company cheques, us-
ing a 'ghost payroll', outright theft of cash from a register
drawer, undercharging a friend, etc.).   Internal computer
theft has taken many forms including false data entry,
slicing off small amounts of data  or money that add up
over time and using the data for illegal purposes.

 Because employee theft is so prevalent and so costly to
businesses, a business owner needs to take every pre-
caution and use every means possible to stop employee
theft.  They include:

Installation of a security program

Establishment of a clear policy on theft and security

Keeping cheque books locked up

Auditing financial documents, checking invoices at regu-
lar intervals

Not leaving bookkeeping to just one person

Allowing only a few to have authority to sign cheques.

There shall be no personal communication enclosed or
written up on a book packet. It shall not contain any paper
money, postage or other stamps, cheque leves, etc.
Maximum, weight allowed is 2 kilograms.
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Parts of an application

An application has the following 6 parts

1. Name and address of the sender (addresser)

2 Reference No. and date

3 Name and address of the recipient (addressee)

4 Salutation or the beginning, e.g. Dear Sir, Dear Mr......,
Dear Mrs....... etc.

5 Subject (brief about the subject matter)

6 Subject matter or body of the application.  In this de-
tailed points are given.  Sub-paragraphs can be made
for varous points.

7 Subscription or complimentary closure, e.g. yours faith-
fully, With regards, Yours sincerely,

8 Signature of the writer

In addition to this PS (Post Script) - anything left out in
the body of the application is added towards the left end
bottom of the letter.  Then the address of the receiver on
the inland card or envelope is written which is known as
Superscription.

E.g.

P.O. Box. 5872
Chennai

28 February 2015
Ministry of Finance
Government of India,
New Delhi.

Dear Sir/Madam,

RE: Application for Tax Administrator Position

In response to you advertisement in the press recently, I
hereby submit my application for consideration to the above
mentioned post.

You will find my curriculum vitae enclosed for your consid-
eration.  Although you require a person with two years’ tax
law experience in the corporate field, you will note from
my curriculum vitae that I do not have the length of expe-
rience.

Notwithstanding this, I am applying because I have ob-
tained a diploma in tax law.  I am currently studying for the
higher Diploma in Law through the University of Nambia.
Though it does not appear in my curriculum vitae, I have
been tutoring LLB students in the field of Tax Law.

It should also be mentioned that recently my article on
tax law dealing with the corporate situation appeared in
the SA Law Journal.  A copy is enclosed for your perusal.

Yours faithfully,

Applicant’s Name

Address

Phone number

Company name

Name of the person in charge of hiring

Title Address

Date

Dear Mr. or Ms. (Name of the person who is in charge of
hiring),

With reference to your advertisement in the Local News
on August 28, I wish to apply for the position of clerk at
your video store.

I believe I have the necessary skills and abilities for this
job. I am organized, resourceful, personable and a fast
learner. I am also fluent in local languages.

Your company excels at customer service, a field in which
I would like to pursue a career.  I am also very eager to
become part of a winning team like yours.  Joining your
organization would give me a chance to develop useful
skills that will help in pursuing my long-term career goals.

If you are interested in me, I am available for interview on
weekdays after 3.30 p.m. or any time on the weekend.

I look forward to hearing from you.

Signature

Encl:

The format of formal letters may be used for
various purposes and can be explained by the
instructor to enable the trainees for better un-
derstanding. These topics are Illustrative in na-
ture. Reference books may also be used for the
same.

Office Administration and Facility Management  R.Theory for Ex 1.10.80&81
Stenographer Secretarial Asst. (Eng) - Letter format - online tasks and
creation of performance record

Types of letters -  Application, enquiry, quotation, order, social letters,
condolence letters, letters to the editor, social letters, invitation letter,
congratulation letter, thanks giving letter etc.

Objectives: At the end of this lesson you shall be able to
• state the essential components of a letter
• differentiate the different kinds of letters
• transcription of dictation on computer  in proper format.
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Complaint Writing

For any complaint the following procedure should be
adopted carefully.

"Anybody can find fault, but few persons can make a claim
in clear, unmistakable language even when they have the
best of reasons for doing so. A clumsy claim letter is likely
to be given little consideration. A well written claim letter

• Should state precisely what is wrong

• Should make tracing easy by referring to definite dates,
invoice numbers, etc.

• Should state what remedy or adjustment, is desired

• Should be addressed to the person, or company, re-
sponsible for the damage or omission"

• Your Contact Information

E.g.

Date of Letter

Dear Contact Person

I purchased a Model Number and Brand Name camera at
Name of Store on Date of Purchase and Other Pertinent
Purchase Information.

Unfortunately, this camera model has not performed as
expected, and I believe the defective camera should be
replaced under terms of the warranty. The problems with
camera include List of Defects.

To resolve this problem satisfactorily, I would appreciate a
Replacement Camera, a Refund, a Repair, Credit Toward
Another Model, or Another Specific Action. I have included
copies of all pertinent documents regarding my purchase
of this model, as well as a list of calls and correspon-
dence from my previous attempts to have this matter re-
solved.

I am looking forward to your reply in this matter. I will wait
until Specific Date for a reply before seeking assistance in
resolving this dispute from a third party. Please contact
me using the information above.

Sincerely,

Your Name

Social Letters

E.g.

1 Sample formal wedding invitation letter

Jogi Thakoor requests the pleasure of your company on
the auspicious occasion of the wedding of his brother
Vikram with Priyanka on (date) at (Time) at (address)

R.S.V.P.

Address.

Name.

2 Sample informal Invitation letter

Address.

Date.

My dear Suresh,

I am glad to inform you that the marriage of my younger
brother Vikram comes off on ........ (date) at ..... (time) at

....... (address). You are cordially invited to attend the aus-
picious occasion and bless the newly weds.

Yours sincerely,

Name.

3 Formal Letter of Refusal to an Invitation

The undersigned acknowledges with thanks the kind invi-
tation of Jogi Thakoor on the auspicious occasion of the
marriage of his brother Vikram Thakoor, on........ (date) at
..... (time) at  ....... (address). He regrets to inform that he
will not be able to attend the function owing to some previ-
ous engagement.

Name.

Address.

4 Formal Letter of Acceptance to an Invitation

It is a great pleasure to me to accept the kind invitation of
Jogi Thakoor on the auspicious occasion of the marriage
of his brother Vikram Thakoor on ........ (date) at ..... (time)
at  ....... (address).  I shall be delighted to attend.

Name.

Address.

5 Informal Letter of Refusal to an Invitation

Address.

Date.

My dear (Name),

Thank you for your kind invitation on the auspicious
occasion of the marriage of your brother Vikram on ........
(date) at ..... (time) at  ....... (address). I very much regret
to inform you that owing to some previous engagement I
shall not be able to attend the function.

My heartiest good wishes for the couple,

Yours sincerely,

Name.

6 Informal Letter of Acceptance to an Invitation

Address.

Date.

My dear (Name),

Thank you for your kind invitation on the auspicious occa-
sion of the marriage of your brother Vikram on day,  on
........ (date) at ..... (time) at  ....... (address). I shall be
delighted to come.

Yours sincerely,

Name.

7 Thanks giving letters

Me dear friend,

Please take my friendly salute. I got your invitation to at-
tend your dinner party. Just at that time, I got a letter from
home that my grandfather was seriously ill. I had to hurry
to my uncle's house. I was in such a hurry that I failed to
drop a card to you to this effect. So, I could not attend the
function at your place. I hope, you will not mind my ab-
sence and will excuse me for this.
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Please convey my best regards to your parents and my
blessings to younger ones.

Your loving friend

Your Name

Condolence Letter

A sympathy or condolence note can be a great source of
comfort to someone who is grieving the loss of a loved
one. It is a simple way of letting that person know that he/
she is in your thoughts as he/she goes through the diffi-
cult process of grief and mourning.

Did I just say simple? Finding the right words to say isn't
always a simple a task, but it's one that's worth your time
and energy. Anyone can pick up a mass-produced con-
dolence card from a store. That's a nice gesture but writ-
ing words of sympathy from your heart that are specific to
the grieving person will be more treasured. These per-
sonal and heartfelt words of condolence serve as a tribute
to the deceased and words of comfort to the bereaved.

Guidelines for Writing a Letter

A letter of sympathy, or condolence, should be written
and sent promptly. A good guideline is within the first two
weeks following the loss. If possible, hand write the letter
on stationery rather than typing and printing from a com-
puter. If you want to use a store-bought card, write a per-
sonal note on stationery and tuck it inside the card.

Write the letter in your own voice, meaning the way you
would normally speak to the person. There is no reason
to get too fancy and try to come up with a poem or verse
unless that is how you normally speak or you're a writer
by profession.

Components of a Condolence Letter

There are seven main components you may want to in-
clude in your letter:

1 Acknowledge the loss and refer to the deceased by
name.

2 Express your sympathy.

3 Note any special qualities of the deceased that come
to mind.

4 Include your favourite memory of the deceased.

5 Remind the bereaved of their personal strengths or
special qualities.

6 Offer help, but make sure it is a specific offer. Instead
of "Let me know if I can help with anything at all," try
something like "I know that Phil took you to church
every Sunday. I'd be glad to do that for you. Shall I
pick you up on Sunday at 8:30 a.m.?" (Need ideas?
Here are some more ways to help a grieving friend.)

7 End the letter with a thoughtful word, a hope, a wish,
or expression of sympathy e.g. "You are in my
thoughts" or "Wishing you God's peace". Closings such
as "Sincerely", "Love", or "Fondly", aren't quite as per-
sonal.

Example of Condolence Letter

Below is an example of a condolence letter using the seven
components above:

" Dear_____________.

• Acknowledge the loss, refer to deceased by name.

I was deeply saddened to hear about the death of
_____________.

• Express your sympathy.

I know how difficult this must be for you. You are in my
thoughts and prayers.

• Note special qualities of the deceased.

____________ was such a kind, gentle soul. She would
do anything to help someone in need.

• Include your favorite memory.

I remember one time _________________.

• Remind the bereaved of their personal strengths and
qualities.

I know how much you will miss _______________. I
encourage you to draw on your strength and the strength
of your family. Perhaps you could use your special
talent of scrap booking to make a lasting memory book
of _________________.

• Offer specific help.

If you would like, I can come over on Tuesday evenings
to help you make your scrapbook. I have some lovely
pictures of _______________ I'd love to share.

• End the letter with a thoughtful closing.

May God bless you and your family during this time and
always,

Sign your name _____________________

Keep in mind that this is only an example. Write from
your heart and whatever elements you include will be the
right ones.

The next page includes information on writing a shorter
version of the condolence letter: the condolence note.

Letters to Editors

Since the earliest days of newspaper and magazine pub-
lishing, community members have written letters to publi-
cation editors as a way to respond to stories they've read.
These letters could range in topics from heartwarming
human interest notes, to comments about publication
design, to the more common and sometimes passionate
political rants.

As more and more of our publications have gone entirely
"online," the art of writing well-researched, well-constructed
letters has dwindled.

But letters to editors are still appearing in many publica-
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tions, and teachers find that assigning this type of letter
is useful in developing many skills. Teachers could use
this exercise to encourage student participation in politi-
cal discourse, or they may find this exercise valuable as
a tool for developing logical argument essays.

1. Select a topic or a publication. If you are writing be-
cause you've been instructed to do so in a class as-
signment, you should start by reading a publication
that is likely to contain articles that interest you. It is a
good idea to read your local newspaper to look for
local and current events that matter to you.

You may also choose to look in magazines that con-
tain articles that interest you. Fashion magazines, sci-
ence magazines, and entertainment publications all
contain letters from readers.

2. Read instructions provided. Most publications provide
guidelines. Look over the first few pages of your publi-
cation for a set of suggestions and guidelines and fol-
low them carefully.

3. Include your name, address, email address and phone
number at the top of your letter. Editors often require
this information because they will need to verify your
identity. You can state that this information is not to
be published.

If you are responding to an article or letter, say so right
away. Name the article in the first sentence of the body
of your letter.

4. Be concise and focused. Write your letter in pithy,
clever statements, but remember that this is not easy
to do! You will probably need to write several drafts of
your letter to condense your message.

5. Limit your writing to two or three paragraphs. Try sticking
to the following format:

In your first paragraph, introduce your problem and sum
up your objection.

In the second paragraph, include a few sentences to
support your view.

End with a great summary and a clever, punchy line.

6. Proofread your letter. Editors will ignore letters that
contain bad grammar and poorly-written rants.

7. Submit your letter by email if the publication allows it.
This format enables the editor to cut and paste your
letter.

Banking corespondence

Correspondence with banks is essential for organizations.
Banks also are business houses and they have to corre-
spond with clients and customers. Banks whether Pri-
vate or Public, Local or Foreign, have to face stiff compe-
tition from others. Computerised accounts, Automatic
Teller Machine, Credit and Debit cards have enlarged the
scope of business. Banks which were the monopoly of
the rich men, today are attracting common and ordinary
people. The whole competition of banking business has
undergone a sea-change. Banking correspondence is of

a special nature because it deals with finance. Letters
have to be carefully written to protect the interest of the
bank as well as its clientele. In the first place, it has to be
very confidential in nature. The financial status of its clien-
tele can be quite fluctuating owing to extraneous reasons.
The interest of the client has to be protected as well as
the interest of the bank. The correspondence should also
be tactful. A bank cannot afford to be judgemental in is-
sues connected with a transaction. Banks can suffer from
bad debts but it cannot afford to hastily call a client a bad-
debtor. Courtesy is another important feature of banking
correspondence. Banks should always look at a situation
from the receiver's point of view.  'You-attitude' in letters is
very important for all correspondence connected with
banks.

For carrying out business every business house requires
to maintain some sort of relation with the banks as such
which cater to the fulfillment of various needs of these
houses. Personal liaison has got to be maintained harmo-
niously with the staff of the bank. Bluntness or curtness
should be shed off. On the other hand, these letters should
be politely addressed and these should be drafted very
carefully so as to avoid any sort of pitfall. All the informa-
tion furnished should be quite clear and precise. The infor-
mation furnished should be more factual. Thus the banks
that provide various facilities of safe deposit of money,
operation and transfer of money, etc., should be approached
in a civil and more cultured manner.

Personal approach and correspondence may become the
various media of relationship with the banks. Somewhere
we may need some sort of technical decencies. Thus we
may say that all sorts of correspondence must be aglow
with a personal touch that should impress the bank
officers.

E.g.

Sample letter format

To

_________________________(Bank name).

_________________________(Address)

Sir,

I wish to invest a sum of ____________________in fixed
deposit at your branch at the ________________Road,
___________, for a period of _______________years, I
shall be highly indebted to you if you very kindly write to
me the rate of interest pertinent thereto.

Furthermore, I wish to know that if such deposits are made
occasionally for a period of one year, what rate of interest
is admissible in these deposits. Please send to me all the
rules governing such transactions at your earliest pos-
sible convenience.

I am sure you will deal with this issue expeditiously:

Yours faithfully,
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Enquiry: Enquiry is just a simple document showing the
interest shown by a prospective customer on products and
services. Date and price are not relevant here.

Quotation:  is a legal agreement offered by a merchant/
seller to customer. The seller assures the customer that
he will charge a particular amount to a particular quantity
of a particular product.  This agreement is time limited and
not valid after that time duration.  Based on Inquiry Quota-
tion. Is created

Order is an

a  authoritative direction or instruction; command; man-
date.

b  a command of a court or judge.

c a command or notice issued by a military organization
or a military commander to troops, sailors, etc.

Social letters

The Social Letters which are written to relations and inti-
mate friends should be written in an easy, conversational
style. So, it must for us to take care and preserve some
order in expressing our thoughts. Above all, it must be
remembered that, however free-and-easy may be our style,
we are as much bound by the rules of spelling, punctua-
tion, grammar and idiom in writing a letter as we are in
writing the most formal letter.

Sample letter to the Editor

Gandhinagar is a thickly populated locality inhabited mainly
by the working class people. Unfortunately, there is no
milk booth in the locality. Write a letter in 100 - 120 words
to the editor of a local daily drawing the attention of the
authorities to the problem faced by the people, requesting
them to open a milk booth.

Your name & Address.........

Dated: 15th March 2018

The Editor

Hindutan News

Mumbai.

Subject: Absence of  milk booth in Gandhinagar

Respected Sir / Madam

I am (your name) a resident of Gandhinagar. I am writing
to you in order to raise the issue of absence of a  milk
booth in my locality.

Gandhinagar has a huge population which comprises of
daily wagers. Still, the area does not have a  milk booth.
The residents face many problems as they have to walk
upto 10 kilometers every morning to get their daily stock
of milk and milk products. This has also led to black mar-
keting. The people of the area are getting harassed.

As the situation is serious, I request you to highlight it
through your newspaper so that the  authorities are sensi-
tized towards it and do the needful.

Thanking You

Yours sincerely

(name)

Invitation letter

Invitation letters are generally written in order to notify and
invite the guests for a particular ceremony or event. For
example suppose an art exhibition is going to be held and
the invitation letter would serve the purpose of inviting the
art lovers to the exhibition. The invitation letter is generally
written by the host.

For marriage and other religious ceremonies we usually
send an invitation card with full details to the invitees.

Congratulation letter

Congratulation letters are letters written to praise others
for their achievements or to express good wishes on a
special occasion. These letters are a great gesture to
maintaining professional and personal relationships. There
are many situations you may find necessary for you to
congratulate someone. Whether it is a colleague who has
made a new business connection, a friend who is getting
engaged, or a subordinate who has been promoted, a con-
gratulations letter will be a great and classy way to show
that you are sincerely happy for them. Congratulation let-
ters show others that you see their efforts and that you
are proud of their achievements.
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Office Administration and Facility Management         R.Theory for Ex 1.10.82
Stenographer Secretarial Asst. (Eng) - Letter format - online tasks and
creation of performance record

Office correspondence - Drafting of notice/agenda/minutes and reports,
circular & memorandum

Objectives: At the end of this lesson you shall be able to
• state essential components of drafting on different subject
• explain preparation of minutes of meeting and preparation of reports
• explain circular and memorandum.

Office correspondence

Correspondence. This article describes the letter format
of an official or Government correspondence. The letters
written between different offices and departments of Gov-
ernment, autonomous bodies and government or semi-
government are called OFFICIAL or GOVERNMENT COR-
RESPONDENCE.

Drafting of Notice/agenda/Minutes, etc.

A meeting is an important instrument in the corporate de-
cision-making process. The business at a meeting is pre-
ceded by a notice containing the agenda. Derived from
this meaning, a resolution is a formal agreement as to
adoption of proposal put before an assembly of persons.

Minutes of Meeting

Minutes of the meeting are the official record of the ac-
tions and decisions taken in a meeting. Minutes capture
the important actions of a meeting without recording a
verbatim transcript of what was said. The format for keep-
ing minutes of meeting starts with the date and purpose of
the meeting. It then lists those attending as well as who is
chairing the meeting. An agenda of what is to be covered
follows. Motions and resolutions presented during the
meeting are listed and are identified as having been passed
or denied. The minutes are presented for approval to the
body that held the meeting the next time that they con-
vene.

Reports

Report is a self explanatory statement of facts relating to
a specific subject and serves the purpose of providing in-
formation for decision making and follow up actions. It is a
systematic presentation of ascertained facts about a spe-
cific event or a subject. Report is a summary of findings
and recommendations about a particular matter or prob-
lem. Report is for the guidance of higher authorities to
facilitate timely decisions and follow up actions.

Importance of Circulars and Memos in Business Com-
munication

Circulars and memos are a very common method of con-
veying specific messages across widely spread out units
or branches in any large multi-branch organization. A cir-
cular is generally understood as a written communication
addressed to a circle of persons and customers. A circu-
lar may cover a notice or advertisements, etc., reproduced
for distribution. The process of sending circulars is re-
ferred to as circularizing.

A memo, on the other hand, is the abbreviation of the word
memorandum. It is understood as a note to help the
memory or record of events for future use. In law, a memo-
randum means a document recording terms of contract. It
is also described as an informal letter without signature.

Maintaining calendar of events

This handout is intended to provide guidance to employ-
ees who are responsible for managing and maintaining
calendars. Good calendar maintenance makes it easier
for the secretary to process requests involving calendars
by ensuring that entries are accurate, clear, concise and
do not include unnecessary information.

• Avoid using any personal comments in making calen-

dar entries.

• Any government business must be shown in the cal-

endar.

• Only include appointments for one individual - do not

include appointments of other people

• Calendar of appointments should be clear and consis-

tent

• The subject of the meeting should be clear - clearly

identify the purpose of the meeting as well as who is
expected to attend to avoid any kind of last minute
confusion.
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Banking corespondence

Correspondence with banks is essential for organizations.
Banks also are business houses and they have to corre-
spond with clients and customers. Banks whether Private
or Public, Local or Foreign, have to face stiff competition
from others. Computerised accounts, Automatic Teller
Machine, Credit and Debit cards have enlarged the scope
of business. Banks which were the monopoly of the rich
men, today are attracting common and ordinary people.
The whole competition of banking business has under-
gone a sea-change. Banking correspondence is of a spe-
cial nature because it deals with finance. Letters have to
be carefully written to protect the interest of the bank as
well as its clientele. In the first place, it has to be very
confidential in nature. The financial status of its clientele
can be quite fluctuating owing to extraneous reasons. The
interest of the client has to be protected as well as the
interest of the bank. The correspondence should also be
tactful. A bank cannot afford to be judgemental in issues
connected with a transaction. Banks can suffer from bad
debts but it cannot afford to hastily call a client a bad-
debtor. Courtesy is another important feature of banking
correspondence. Banks should always look at a situation
from the receiver's point of view.  'You-attitude' in letters is
very important for all correspondence connected with
banks.

For carrying out business every business house requires
to maintain some sort of relation with the banks as such
which cater to the fulfillment of various needs of these
houses. Personal liaison has got to be maintained harmo-
niously with the staff of the bank. Bluntness or curtness
should be shed off. On the other hand, these letters should
be politely addressed and these should be drafted very
carefully so as to avoid any sort of pitfall. All the informa-
tion furnished should be quite clear and precise. The infor-
mation furnished should be more factual. Thus the banks
that provide various facilities of safe deposit of money,
operation and transfer of money, etc., should be approached
in a civil and more cultured manner.

Personal approach and correspondence may become the
various media of relationship with the banks. Somewhere
we may need some sort of technical decencies. Thus we
may say that all sorts of correspondence must be aglow
with a personal touch that should impress the bank
officers.

Office Administration and Facility Management         R.Theory for Ex 1.10.83
Stenographer Secretarial Asst. (Eng) - Letter format - online tasks and
creation of performance record

General Banking correspondence -  Opening of saving Account - Fixed
Deposit Account - Loan and overdraft

Objectives: At the end of this lesson you shall be able to
• explain different type of banking correspondence
• state the limitations of overdraft facility
• state the different between savings account and fixed deposist.

E.g.

Sample letter format

To

_________________________(Bank name).

_________________________(Address)

Sir,

I wish to invest a sum of ____________________in fixed
deposit at your branch at the ________________Road,
___________, for a period of _______________years, I
shall be highly indebted to you if you very kindly write to
me the rate of interest pertinent thereto.

Furthermore, I wish to know that if such deposits are made
occasionally for a period of one year, what rate of interest
is admissible in these deposits. Please send to me all the
rules governing such transactions at your earliest pos-
sible convenience.

I am sure you will deal with this issue expeditiously:

Yours faithfully,

Savings Account

It is an interest-bearing account held at a bank or any
other financial institution.  It  may  be charged fees unless
a certain average monthly balance is maintained in the
account.  Cheque books may be issued to the Account
Holder.

Advantages of a Savings Account

Easy to open

1. Cash can be withdrawn or deposited any time

2.  You can easily access your money  either by using
your ATM card or by going to the bank to make a with-
drawal.  You can also transfer money quickly and easily
online

3. Your money is well protected
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Disadvantages of a Savings Account

1. Low interest

Current Account

It is a general-use account on which you can write
cheques, use ATM/Debit cards and have unlimited trans-
actions.  It is opened by businessmen who have a higher
number of regular  transactions with the bank.  It includes
deposits, withdrawals.

Advantages of opening of Current Account

1 Carries out all business transactions promptly and
properly

2 Credit limit can be availed if there is no balance

3 No transactions and withdrawal limits

Disadvantages

No interest paid by the bank

Fixed Deposit Accounts

A fixed deposit is a financial instrument provided by banks
or Non Banking Financial Institutions which provides in-
vestors a higher rate of interest than a regular savings
account.  It is a deposit for a fixed or specified period for a
fixed rate of interest.  Money can be deposited for as short
a period as 7 days and upto 10 years.  The interest can be
obtained after maturity of fixed deposit or even before that
on a monthly, quarterly, half-yearly or annual basis.

Loan/Overdraft Account

It is a financial instrument in which the money can still be
withdrawn from the current or savings account, even if the
account balance is NIL. It is a variable amount of borrow-
ing agreed with your bank up to a set limit.  This can be
helpful  for short term financial requirements.  However,
interest rates are often higher and the bank has the right
to change your overdraft limit, or request that the overdraft
is paid back at any time.   Overdraft facility has the advan-
tage of flexibility as it may be taken at any time, for any
amount (up to the limit allotted) , and for even as less as
one or two days

Loans

Unlike overdrafts, loans have fixed terms and repayment
schedules.  You can borrow larger amounts with loans.
But failing to repay  on time can damage your credit rating

In conclusion, overdrafts are good for short-term operating
expenses and loans are better for longer term higher value
purchases.

in the age bracket of 55-60 are eligible. An individual can
invest a maximum amount of Rs.15 lakh individually or
jointly in SCSS account. The scheme offers 8.6% inter-
est. Nomination facility is available. Tax deduction of upto
1.5 lakh can be claimed under Sec.80C of the Income
Tax Act. The tenure of this investment is flexible with an
average tenure of 5 years which can be extended upto 3
additional years.
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